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3



4

Chapter 23 Setup Relating to Router Interface and Tally (Router/Tally)
Chapter 24 Simple Connection of the MKS-8080/8082 AUX Bus Remote 

Panel
Chapter 25 DIAGNOSIS
Appendix (Volume 3)

• Data Saved by [Setup Define] and [Initial Status Define]
• Error Messages

Index



Table of Contents

Chapter 1 MVS-6000 Functions

Introduction ..................................................................................................16
Features of the MVS-6000 Multi Format Switcher System......................18
Basic Video Processing.................................................................................20

Transitions .............................................................................................20
Keys.......................................................................................................24
Wipes.....................................................................................................25
DME Wipes ...........................................................................................25
Frame Memory ......................................................................................26
Color Backgrounds................................................................................26
Copy and Swap......................................................................................26
Video Process ........................................................................................27
Color Corrector......................................................................................27
Side Flags ..............................................................................................27
Simple P/P Software..............................................................................28

Creation of Special Effects and Management of Data and Operations...29
Digital Multi Effects (DME) .................................................................29
External Devices....................................................................................30
Keyframes .............................................................................................30
Snapshots...............................................................................................31
Utility.....................................................................................................32
Shotbox..................................................................................................32
Macros ...................................................................................................32
Files .......................................................................................................33

Setup ..............................................................................................................34

Chapter 2 Menus and Control Panel

Names and Functions of Parts of the Control Panel .................................37
Control Panel: Example Configuration 1

(With Standard Transition Modules) .........................................37
Control Panel: Example Configuration 2

(With Simple Transition Modules) ............................................40
Control Panel: Example Configuration 3

(With Compact Transition Modules) .........................................42
Cross-Point Control Block ....................................................................43
5Table of Contents



6

Transition Control Block (Standard Type)............................................47
Flexi Pad Control Block (Standard Type) .............................................51
Key Control Block.................................................................................54
Device Control Block (Trackball) .........................................................58
Device Control Block (Joystick) ...........................................................62
Device Control Block (Search Dial)......................................................63
Keyframe Control Block .......................................................................66
Numeric Keypad Control Block............................................................69
Fade to Black Control Block .................................................................71
Auxiliary Bus Control Block (for AUX Buses) ....................................72
Auxiliary Bus Control Block (for Router Control) ...............................75
Menu Control Block ..............................................................................78
Memory Card/USB Adaptor Block .......................................................79
“Memory Stick”/USB Connections Block ............................................80
Utility/Shotbox Control Block ..............................................................82
Transition Control Block and Flexi Pad Control Block (Simple Type)83
Independent Key Transition Control Block (Simple Type) ..................88
Downstream Key Control Block ...........................................................90
Downstream Key/Fade-to-Black Control Block ...................................92
Transition Control Block (Compact Type) ...........................................94
CCP-6224 2M/E Control Panel .............................................................96
CCP-6324 3M/E Control Panel .............................................................97
Cross-Point Control Block (CCP-6224/6324) in the AUX Operating 

Mode ..........................................................................................98
Multifunction Flexi Pad Control Block...............................................100

Basic Menu Operations ..............................................................................103
Menu Organization..............................................................................103
About the Top Menu List ....................................................................103
Accessing Menus.................................................................................104
Displaying a Menu ..............................................................................112
Interpreting the Menu Screen ..............................................................113
Menu Operations .................................................................................115
Operation With a Mouse .....................................................................121
Switching Between the Main Menu Site and Subsidiary Menu Site ..127
Shortcut Menu .....................................................................................127

Chapter 3 Signal Selection and Transitions

Video Processing Flow ...............................................................................133
Signal Selection ...........................................................................................135
Table of Contents



Basics of Signal Selection ...................................................................136
Bus Selection .......................................................................................136
AUX Panel-less Function ....................................................................139
Signal Assignment and Selection ........................................................139
Signal Name Display...........................................................................143

Transitions...................................................................................................145
Selecting the Next Transition ..............................................................145
Transition Types..................................................................................145

Procedure for Basic Transition Operation...............................................148
Key Priority Setting....................................................................................151

Setting the Key Priority in the Transition Control Block....................151
Setting the Key Priority by a Menu Operation....................................153
Display of the Key Output Status and Key Priority ............................155

Selecting the Transition Type by a Menu Operation ..............................156
Super Mix Settings .....................................................................................157
Color Matte Settings...................................................................................158
Executing a Transition ...............................................................................161

Transition Indicator Function ..............................................................161
Setting the Transition Rate ..................................................................162
Pattern Limit ........................................................................................167
Executing an Auto Transition..............................................................170
Executing a Transition With the Fader Lever (Manual Transition) ....171
Combinations of Auto and Manual Transitions ..................................172
Non-Sync State....................................................................................172
Fader Lever Operation in Bus Fixed Mode.........................................173

Transition Preview .....................................................................................175
Independent Key Transitions ....................................................................177

Basic Independent Key Transition Operations....................................180
Setting the Independent Key Transition Type by a Menu Operation..182
Setting the Independent Key Transition Rate......................................183

Fade to Black...............................................................................................187
Fade to Black Operation......................................................................187
Setting the Fade to Black Transition Rate...........................................188

Simple Transition .......................................................................................189
Basic Operations for Simple Transitions.............................................189
Display of the Key Output Status and Key Priority ............................191
Split Fader ...........................................................................................192
Independent Key Transitions With a Simple Transition Module........192
7Table of Contents



8

Chapter 4 Keys

Overview......................................................................................................197
Key Types............................................................................................197
Key Modifiers......................................................................................199
Key Memory........................................................................................202
Key Default .........................................................................................203

Key Setting Operations Using Menus.......................................................204
Key Setting Menus ..............................................................................204
Key Type Setting.................................................................................205
Chroma Key Composition...................................................................207
Chroma Key Adjustments ...................................................................208
Selecting Key Fill and Key Source .....................................................214
Key Edge Modifications......................................................................216
Masks...................................................................................................223
Applying a DME Effect to a Key ........................................................226
Key Modify Clear................................................................................227
Blink Function .....................................................................................227
Video Processing .................................................................................228

Key Setting Operations With the Key Control Block .............................230
Operations in the Key Control Block ..................................................230
Key Edge Modifications......................................................................234
Masks...................................................................................................238
Applying a DME Effect to a Key ........................................................239
Other Key Setting Operations .............................................................240

Key Adjustment Operations With the Multifunction Flexi Pad Control 
Block .................................................................................................242

Resizer .........................................................................................................249
Two-Dimensional Transformations of Keys .......................................249
Resizer Interpolation Settings .............................................................254
Resizer Crop/Border Settings ..............................................................254
Applying Resizer Effects.....................................................................257

Key Snapshots.............................................................................................259
Key Snapshot Operations ....................................................................259
Key Snapshot Operations Using a Simple Transition Module............262

Chapter 5 Wipes

Overview......................................................................................................266
Basic Procedure for Wipe Settings ...........................................................267

Wipe Settings Menu ............................................................................267
Table of Contents



Wipe Pattern Selection ........................................................................267
Setting Wipe Modifiers .......................................................................268
Wipe Modify Clear..............................................................................278

Wipe Settings for Independent Key Transitions .....................................279
Basic Procedure for Independent Key Transition Wipe Settings........279
Setting Independent Key Transition Wipe Modifiers .........................280

Wipe Snapshots...........................................................................................284
Wipe Snapshot Operations With the Flexi Pad ...................................284
Wipe Snapshot Operations With the Menus .......................................287

Wipe Pattern Operations in the Multifunction Flexi Pad Control Block
...........................................................................................................290

Recalling a Wipe Snapshot..................................................................290
Selecting the Wipe Pattern ..................................................................291
Editing the Wipe Pattern .....................................................................291
Saving, Canceling, and Deleting Edited Wipe Patterns ......................294

Chapter 6 DME Wipes

Overview......................................................................................................298
Types of DME Wipe Pattern ...............................................................298
DME Wipe Pattern Variation and Modifiers.......................................305
Relation Between DME Wipes and Other Effects ..............................306

Basic Procedure for DME Wipe Settings .................................................308
DME Wipe Settings Menu ..................................................................308
DME Wipe Pattern Selection ..............................................................308
Setting DME Wipe Modifiers .............................................................310
DME Wipe Modify Clear....................................................................317

DME Wipe Settings for Independent Key Transitions ...........................318
Basic Procedure for Independent Key Transition DME Wipe Settings

..................................................................................................318
Setting Independent Key Transition DME Wipe Modifiers................319

Resizer DME Wipe Setting ........................................................................322
DME Wipe Snapshots ................................................................................324

DME Wipe Snapshot Operations With the Flexi Pad .........................324
DME Snapshot Operations With the Menus .......................................325

Creating User Programmable DME Patterns .........................................326
User Programmable DME Transition Mode .......................................326

DME Wipe Pattern Operations in the Multifunction Flexi Pad Control 
Block .................................................................................................331

Recalling a DME Wipe Snapshot........................................................331
9Table of Contents



10
Selecting the DME Wipe Pattern ........................................................331
Editing the DME Wipe Pattern ...........................................................332
Saving, Canceling, and Deleting DME Wipe Snapshots ....................335

Chapter 7 Frame Memory

Overview......................................................................................................338
Still Image Operations ...............................................................................341

Preparations .........................................................................................341
Interpreting the Frame Memory Menu ................................................342
Selecting an Input Image .....................................................................345
Selecting Outputs and Target Frame Memory ....................................346
Capturing and Saving an Input Image .................................................347
Recalling Still Images .........................................................................351
Image Processing.................................................................................353
Image Output .......................................................................................358
Continuously Capturing Still Images (Record) ...................................359
Recalling a Continuous Sequence of Still Images (Animation)..........361

Frame Memory Clip Function ..................................................................364
Frame Memory Clip Operations...............................................................366

Preparations for Operation ..................................................................366
Recalling Clips ....................................................................................366
Clip Playback ......................................................................................368
Clip Creation .......................................................................................372
Creating and Handling Frame Memory Folders..................................374
Clip Output ..........................................................................................375
Recording and Playback of Ancillary Data .........................................375

Clip Transition Operations........................................................................378
Image Data Management...........................................................................381

Pair File Processing .............................................................................381
Moving Files........................................................................................382
Deleting Files ......................................................................................383
Renaming Files....................................................................................384

External Hard Disk Drive Access .............................................................385
Hard Disk Formatting..........................................................................385
Saving Files .........................................................................................386
Recalling Files .....................................................................................387

Chapter 8 Color Backgrounds, Copy and Swap, and Other Settings

Color Background ......................................................................................390
Table of Contents



Color Background Settings Menu .......................................................390
Basic Color Background Setting Operations.......................................390

Copy and Swap ...........................................................................................394
Copy and Swap Operations .......................................................................398

Copy and Swap Menu Operations.......................................................398
Copy by Button Operation ..................................................................399

Misc Menu Operations...............................................................................401
Port Settings for Control From an External Device ............................401
Editing Keyboard Settings...................................................................402
Safe Title Settings ...............................................................................403
Displaying a List of Transition Rates and Changing the Settings.......404

AUX Menu Operations ..............................................................................406
AUX Bus Settings ...............................................................................406

Status Menu ................................................................................................407
Router Control Menu Operations.............................................................408

Checking the List of Inputs for Each Destination ...............................408
Switching the Source for Each Destination.........................................409

Video Process ..............................................................................................410
Video Process Adjustments of a Primary Input Signal .......................410
Video Process Adjustments on a Particular Bus .................................410
Video Process Memory .......................................................................411

Video Process Settings................................................................................412

Chapter 9 Color Corrector

Preparations ................................................................................................414
Overall Color Corrector Operations ........................................................416

Enabling Color Corrector ....................................................................416
Copy and Swap Operations .................................................................416

Color Corrector Functions ........................................................................418
Input Video Processing Operations .....................................................418
Primary Color Correction Operations .................................................419
Secondary Color Correction Operations .............................................422
RGB Clip Operations ..........................................................................423
Luminance Processing Operations ......................................................424
Spot Color Adjustment ........................................................................427
Output Video Processing Operations ..................................................429
YUV Clip Operations ..........................................................................430
11Table of Contents



12
Chapter 10 Special Functions

Side Flags.....................................................................................................434
Overview .............................................................................................434
Side Flag Settings ................................................................................434
Wipe Action on Images With Side Flags ............................................436
DME Wipe Action for an Image With Side Flags ..............................437

Simple P/P Software ...................................................................................439
Overview .............................................................................................439
Restrictions on Use..............................................................................439
Simple P/P Output Signal Selection on an M/E ..................................442

Appendix (Volume 1)

Wipe Pattern List .......................................................................................444
DME Wipe Pattern List .............................................................................445

DME Wipe Patterns Available in One-Channel Mode .......................445
DME Wipe Patterns Available in Two-Channel Mode.......................449

Resizer DME Wipe Pattern List ...............................................................452
Menu Tree ...................................................................................................454

Recalling Menus..................................................................................454
M/E-1 to M/E-3 Menus .......................................................................454
PGM/PST Menu ..................................................................................457
Frame Memory Menu..........................................................................459
Color Bkgd Menu ................................................................................460
AUX/MON Menu................................................................................460
CCR Menu...........................................................................................461
Copy/Swap Menu ................................................................................462
Misc Menu...........................................................................................462
Status Menu .........................................................................................462
DME Menu..........................................................................................463
Global Effect Menu .............................................................................464
Device Menu .......................................................................................464
Macro Menu ........................................................................................465
Key Frame Menu.................................................................................466
Effect Menu .........................................................................................467
Snapshot Menu ....................................................................................468
Shotbox Menu .....................................................................................469
File Menu ............................................................................................470
Engineering Setup Menu .....................................................................471
Table of Contents



Diagnostic Menu .................................................................................475

Index ............................................................................................................476
13Table of Contents



14
 Table of Contents



Chapter 1 MVS-6000 Functions
Introduction ................................................................................................16
Features of the MVS-6000 Multi Format Switcher System ....................18
Basic Video Processing ...............................................................................20

Transitions ...........................................................................................20
Keys .....................................................................................................24
Wipes ...................................................................................................25
DME Wipes .........................................................................................25
Frame Memory ....................................................................................26
Color Backgrounds ..............................................................................26
Copy and Swap ....................................................................................26
Video Process ......................................................................................27
Color Corrector ....................................................................................27
Side Flags ............................................................................................27
Simple P/P Software ............................................................................28

Creation of Special Effects and Management of Data and Operations .29
Digital Multi Effects (DME) ...............................................................29
External Devices ..................................................................................30
Keyframes ...........................................................................................30
Snapshots .............................................................................................31
Utility ...................................................................................................32
Shotbox ................................................................................................32
Macros .................................................................................................32
Files .....................................................................................................33

Setup ............................................................................................................34



16

   C
hapter 1 

M
V

S
-6000 F

unctions
Introduction

This manual is the User’s Guide for the MVS-6000 Multi Format Switcher 
system. 
This manual describes principally the operation of the system using the CCP-
8000 series of center control panels.
The User’s Guide for this system comprises three volumes.
For the contents of each volume, see the section “Organization of This User’s 
Guide” at the front of this volume.

Devices and system nomenclature
In this manual, when discussing the principal components of the MVS-6000 
system, in place of the formal product names, abbreviated names 
characterizing the functions and features are sometimes used. When 
distinctions between system configurations must be drawn, the terms in the 
following table are used.

Principal components and naming
The formal product names of the principal components of the MVS-6000 
system, and the terms used in this manual are as follows.

System nomenclature
The following terms are used for systems, depending on the combination of 
installed options, and the signal format.

Formal product name Term used in this manual

MVS-6000 Multi Format Switcher Processor Switcher or switcher processor

MKS-6470 DME Board Set DME or DME board set or MKS-6470

MVE-8000A Multi Format DME Processor DME or DME processor or MVE-
8000A

MVE-9000 Multi Format DME Processor DME or DME processor or MVE-9000

CCP-8000-series, CCP-6224, CCP-6324 
Center Control Panel

Control panel or center control panel

DCU-8000 (MKS-8700) Device Control Unit DCU or MKS-8700

DCU-2000 (MKS-2700) Device Control Unit DCU or MKS-2700

System configuration and features Term for system

System with installed option boards and 
settings to support HDTV format

HD system
Introduction
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Related manuals
The following manuals are supplied with the individual products of the MVS-
6000 Multi Format Switcher system.

MVS-6000 Switcher Processor Pack
• MVS-6000 Operation Manual
• MVS-6000/8000 Installation Manual

MVE-8000A DME Processor Pack
• MVE-8000A Operation Manual
• MVE-8000A Installation Manual

MKS-6470 DME Board Set
• MKS-6470 Operation Manual
• MKS-6470 Installation Manual

MVE-9000-C DME Processor Pack
• MVE-9000-C Operation Manual
• MVE-9000-C Installation Manual

CCP-6000/8000 Center Control Panel Pack
• CCP-6000/8000 Operation Manual
• CCP-6000/8000 Installation Manual

DCU-8000 Device Control Unit Pack
• DCU-8000 Operation Manual
• DCU-8000 Installation Manual

DCU-2000 Device Control Unit Pack
• DCU-2000-C Operation Manual
• DCU-2000-C Installation Manual

System with installed option boards and 
settings to support SDTV format

SD system

A system in which the center control panel has 
two M/E banks

2M/E system

System configuration and features Term for system
17Introduction
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Features of the MVS-6000 Multi Format 
Switcher System

The MVS-6000 Multi Format Switcher System boasts high performance and 
multifunctionality. The following are some of the principal features of this 
system.

System configuration flexibility

Multiformat support
This system supports both HDTV and SDTV signal formats. The format 
selection can be switched by a simple control panel operation. 

For the signal formats that can be selected, see “Setting the Signal Format” in 
Chapter 18 (Volume 3).

Extensible system configuration
By suitable combination of options, the switcher can be configured with 
various inputs and outputs, and different numbers of M/E banks. The system 
offers the flexibility to change and expand as required.
When the optional MKS-6470 DME Board Set is installed, the system allows 
you to use up to two DME channels. Further, you can connect an MVE-8000A 
or MVE-9000 extensible DME processor, which provides any number from 
one to four channels, for a maximum of six channels of DME functionality.

Powerful external device interfaces
By connecting to a Sony routing switcher or similar, a large system can be 
built. From the control panel, it is also possible to operate other equipment, 
including VTRs and disk recorders.

Powerful tally system
The complete system including routing switcher provides an all-inclusive tally 
system. The system can be adapted to different applications and settings, using 
multiple tally outputs, including both on-air and recording tallies.

Comprehensive video manipulation

M/E banks
Each mix/effects bank (M/E bank) is equipped with four keyers, and each 
keyer is capable not only of chroma keying, but also independent key 
Features of the MVS-6000 Multi Format Switcher System
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transitions separate from the background transitions. The four keys can be 
freely combined, to carry out four different program outputs.

Powerful frame memory functions
An HDTV system can hold approximately 1,000 still image frames or 2,000 
frames in 720P/59.94 format, and an SDTV system can hold approximately 
5,000 frames in 480i/59.94 format or 4,000 frames in 576i/50 format in 
memory, and up to eight frames can be recalled and used simultaneously.

Link operation with DME
Using the MKS-6470 DME Board Set (option), a range of DME functions 
including DME wipes and processed keys can be handled as switcher 
functions.
You can use a maximum of two DME channels.
The number of DME channels can be increased up to six by connecting to an 
MVE-8000A or MVE-9000 system through an SDI interface.

Designed for use in a live broadcasting environment

Flexible control panel layout
Because of its modular design, the various sections of the control panel can be 
laid out as required. This allows a flexible layout appropriate to the system 
operation.

High-performance user interface
The menu control block provides a large color LCD panel, with rapid touch-
panel menu selection.
The source name displays and buttons in the Flexi PadTM and shotbox control 
blocks have color backlit LCD displays. The signal names, and graphical 
representations of the patterns associated with buttons provide intuitive 
feedback, and allow the immediate decisions that are required in a live 
operating environment.
19Features of the MVS-6000 Multi Format Switcher System
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Basic Video Processing

This section introduces basic functions used for video processing on the 
switcher.

Transitions

In the M/E banks and PGM/PST bank, the switch from the current video stream 
(appearing on the corresponding program monitor) to a new video stream is 
referred to as a transition.
In the M/E banks and PGM/PST bank, you can change one of the images, the 
background, and keys 1 to 4 (downstream keys 1 to 4 in the PGM/PST bank), 
and also vary combinations of these simultaneously.
The following are examples of transition.

Changing the background
A background transition switches from the video currently selected on the 
background A bus (the current video) to the video selected on the background 
B bus (the new video).

In the default selection of flip-flop mode (see page 173), the background 
always switches in the direction from the A bus to the B bus. When the 
transition completes, the cross-point selections on the A and B buses are 
interchanged.

Background BBackground A

Transition
Basic Video Processing
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Inserting and deleting a key

You can insert one or more of the four keys (downstream keys on the PGM/
PST bank).
If you select a key which is already inserted, the transition will delete the key.
A simultaneous combination of deleting and inserting keys is also possible.

Inserting or deleting key 1 and key 2

Deleting key 1 and inserting key 2

Delete

Insert

Key 1

Key 2

Key 1

Key 2

Transition
21Basic Video Processing
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Simultaneously changing the background and keys
You can change any of the four keys (downstream keys on the PGM/PST bank) 
and the background at the same time.

Changing the background and key 2 simultaneously

Changing the background and keys 1 to 4 simultaneously

Selecting the transition type determines the way in which the transition occurs. 
The following are the transition type.
• Mix
• NAM (non-additive mix)
• Super mix 
• Preset color mix (color matte)
• Wipe
• DME wipe
• Clip transition
• Cut

Key 1

Key 2

Transition

Key 1

Key 2 Key 3 Key 4

Transition
Basic Video Processing
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There are two modes for carrying out a transition: auto transitions are carried 
out by a button operation, and manual transitions are carried out using the fader 
lever. It is also possible to combine these two modes.

Independent Key Transitions
In addition to common transitions, it is possible to carry out independent 
transitions on the keyers of the M/E banks and PGM/PST bank. These are 
called “independent key transitions.”
By carrying out an independent key transition in combination with a common 
transition, different transition types can be used for the background and keys. 
The following description compares the independent key transition with a 
common transition, taking a simultaneous change of the background and key 
as an example.

Video used in the transition

Effect of a common transition
In the case shown in the previous illustration, carrying out a common transition 
produces the following change in the image.

Effect of a common transition

Background A Background B Key to insert

Same wipe is applied to 
background and key.

Transition type: wipe
23Basic Video Processing
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Effect of use with an independent key transition
The key is inserted with an independent key transition as the background 
changes with a common transition, providing the following result.

Effect of a background transition and independent key transition

For details of transitions, see Chapter 3 “Signal Selection and Transitions” 
(page 131).

Keys

A key is an effect in which a part of the background image is replaced by an 
image or superimposed text. The signal determining how the background is cut 
out is termed “key source,” and the signal that replaces the cut-out part is 
termed “key fill.” The system component responsible for processing a key is 
referred to as a keyer.
Each switcher bank has four keyers.
On each switcher bank, you can use the following key types (methods of 
processing the key source).
• Luminance key
• Linear key
• Color vector key
• Chroma key
• Key wipe pattern key

Key modifiers
You can apply borders and other modifiers to the edge of the key image.

Different wipe patterns are applied to 
the background and key transitions.

Transition type: 
wipe

Independent key 
transition type: 
wipe
Basic Video Processing
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Masks

A mask allows a part of the image to be replaced by the background or a key. 
To prevent unwanted holes in the background, or if a key is not the desired 
shape, you can correct this with a mask.

Resizer
This function allows you to apply effects, similar to a DME, such as zoom, 
movement, or aspect ratio change to a part of a created key. You can use the 
following operations.
• Two-dimensional transform of a key
• Resizer interpolation settings
• Resizer crop/border settings
• Resizer effect settings (mosaic, defocus)

For details, see Chapter 4 “Keys” (page 195).

Wipes

A wipe is a transition from the current video stream to a new video stream, 
using a wipe pattern.
Changing the background by means of a wipe is referred to as a “background 
wipe,” and inserting or deleting a key with a wipe is termed a “key wipe.”
There are two types of wipe: those that can be selected in a common transition, 
and those that can be selected in an independent key transition.

You can also specify the wipe direction, or set the pattern position, applying 
various changes and modifiers to the selected wipe pattern.

For details, see Chapter 5 “Wipes” (page 265).

DME Wipes

A DME wipe is a wipe transition that uses a DME effect to change from one 
video image to the next. 
There are two types of DME wipe: those which can be selected for a normal 
transition, and those which can be selected for an independent key transition.

The patterns that can be used for a DME wipe are as follows. 
Slide, Squeeze, Door, Flip tumble, Frame in-out, Picture-in-picture, 2D 
trans, 3D trans, Mosaic, Defocus, Brick, and User programmable DME
25Basic Video Processing
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You can also specify the wipe direction, or set the pattern position, applying 
various changes and modifiers to the selected DME wipe pattern.

Resizer DME wipes
Using the resizer, you can carry out key DME wipes.

For details, see Chapter 6 “DME Wipes” (page 297).

Frame Memory

Frame memory is a function for using a still image or video (frame memory 
clip) as material for editing.
You can create a still image by capturing a frame of input video or a clip by 
specifying a range of input video. The created images and clips can be written 
to memory for playback, editing, and output.

For details, see Chapter 7 “Frame Memory” (page 337).

Color Backgrounds

This function can be used to obtain color background video.
One color signal generated from the dedicated generators can be output.

For details, see “Color Background” (page 390).

Copy and Swap

This function can be used to copy and swap the settings among the M/E-1 to 
M/E-3, and PGM/PST banks or between keyers.
The following settings can be copied or swapped.
• Overall settings for the M/E and PGM/PST banks
• Keyer settings
• Wipe settings in a transition control block
• Wipe settings in an independent key transition control block
• DME wipe settings in a transition control block
• DME wipe settings in an independent key transition control block
• Matte data (color 1, color 2, and how to compose them)
• Color settings
• DME channel settings
• Format converter input settings (copy only)
• Format converter output settings (copy only)
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For details, see “Copy and Swap” (page 394).

Video Process

The term “video process” is applied to adjustments to the gain, hue, black level 
of the input video signal. There are two types of adjustment; adjustment of an 
individual primary input signal and adjustment as image effects on a particular 
bus

For details, see “Video Process” (page 410).

Color Corrector

The color corrector enables video signal color correction (black balance/white 
balance adjustment, gamma correction, knee correction, etc.).
The color corrector includes the following adjustments.
• Input video processing
• Primary color correction
• Secondary color correction
• RGB clip
• Luminance processing
• Spot color adjustment
• Output video processing
• YUV clip

For details, see Chapter 9 “Color Corrector” (page 413).

Side Flags

The term “side flags” refers to the areas to left and right of an image with aspect 
ratio 4:3 embedded within a 16:9 frame, when these areas are filled with a 
separate image selected from the utility bus. 
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For details, see “Side Flags” (page 434).

Simple P/P Software

By installing the BZS-6250 Simple P/P Software in the MVS-6000 Switcher 
Processor, you can use a separate program/preset function without using the M/
E hardware.

For details, see “Simple P/P Software” (page 439).

Input source with aspect ratioImage to fill the side flag 
areas (selected from utility 
bus) Turn the side flag 

function on

Side flag area Side flag area
Basic Video Processing
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Creation of Special Effects and 
Management of Data and Operations

This section introduces functions used for creation of special effects, control of 
external devices or switcher operations, and data management.

Digital Multi Effects (DME)

When used with the switcher, DME allows you to add three-dimensional 
effects such as image movement, rotation, magnification and shrinking, as well 
as a wide variety of special effects. 
Each channel can be used on its own or in combination with other channels, 
which allows you to create advanced effects with more complexity.

The following types of DME special effects are available.
• Edge effects: Border, Crop, Beveled Edge, Key Border, Art Edge, Flex 

Shadow, Drop Shadow
• Effects for entire image: Defocus, Blur, Multi Move
• Effects for video image: Sepia, Mono, Posterization, Solarization, Nega, 

Contrast, Mosaic, Mask, Sketch, Metal, Dim and Fade, Glow
• Freeze effects
• Nonlinear effects: Wave, Mosaic Glass, Flag, Twist, Ripple, Rings, Broken 

Glass, Flying Bar, Blind, Split, Split Slide, Mirror, Multi Mirror, 
Kaleidoscope, Lens, Circle, Panorama, Page Turn, Roll, Cylinder, Sphere, 
Explosion, Swirl, Melt, Character Trail

• Lighting effects: Lighting, Spotlighting
• Recursive effects: Trail, Motion Decay, Keyframe Strobe
• Background color
• Separate Sides (effects for front and back sides)
• Signal inversion (Invert effect)
• Key density adjustment
• Key source selection

Global effects
Global effects are special effects created by combining the images of 
successive channels. The following types of global effects are available.
• Combiner
• Brick
• Shadow

For details, see Chapter 11 “DME” (Volume 2).
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External Devices

In this system, you can operate while controlling the following types of 
external device:
• Devices supporting P-Bus (Peripheral II protocol)
• Devices supporting GPI
• VTRs
• Disk recorder (Sony disk 9-pin protocol and video disk communications 

protocol)
• Extended VTR (Abekas A53 protocol)

For details on the devices that can be connected, consult your Sony 
representative.

You can control an external device by previously registering timeline 
keyframes.

For details, see Chapter 12 “External Devices” (Volume 2).

Keyframes

A keyframe represents an instantaneous state of an image; it can be saved in a 
register (see “Register” in Chapter 13 (Volume 2)) and recalled for reuse.
By arranging a number of keyframes on the time axis, and interpolating 
between successive keyframes, you can create an effect in which there is a 
continuous change from each keyframe to the next.
Creation of Special Effects and Management of Data and Operations
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The following figure shows three keyframes created with a wipe pattern (the 
circle) in different positions. This is interpolated to create the effect shown.

Example of keyframes and effect execution

You can save the sequence of keyframes representing a single effect in a 
register. Then by recalling this register, you can replay the same effect.

For details, see Chapter 13 “Keyframe Effects” (Volume 2).

Snapshots

The term “snapshot” refers to a function whereby the various settings required 
to apply a particular effect to an image are saved in a register as a set of data, 
for recall as required, to recover the original state.

Snapshots are divided as follows.
• Snapshots applying to a particular region (functional block of the switcher or 

DME)
• Master snapshot
• Key snapshot
• Wipe snapshot
• DME wipe snapshot:

An individual snapshot may also have attached special conditions relating to 
switcher or DME operation when the snapshot is recalled.

Background A

Background B
Interpolated images

Keyframe 1 Keyframe 2 Keyframe 3

Effect execution
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These conditions are called “attributes” of the snapshot, and can be added when 
the snapshot is saved or recalled.

For details, see Chapter 14 “Snapshots” (Volume 2).

Utility

The utility function refers to a function whereby you can assign an arbitrary 
action or a shortcut for frequently used menu to a particular button, then 
instantly recall the action or menu by pressing the button.

For details, see “Utility Execution” in Chapter 15 (Volume 2).

Shotbox

The term “shotbox” refers to a function whereby for each specified region (see 
“Region” in Chapter 13 (Volume 2)) any snapshot or keyframe effect can be 
recalled simultaneously.

For details, see “Shotbox” in Chapter 15 (Volume 2).

Macros

The term “macro” refers to the function whereby a sequence of signal 
selections and other operations on the control panel is saved as data in memory, 
so that it can be recalled as required to automatically execute the same 
sequence of operations.
The individual control panel operations constituting a macro are termed 
“events.
Macros also provide the following functions.

Menu macros
The term “menu macro” refers to the function whereby a sequence of menu 
operations is saved as data in memory, so that it can be recalled as required to 
automatically execute the same sequence of operations.

Macro timeline
By recording macro recall and execute action on a timeline, in the same way as 
for keyframes in an effect, you can automatically execute them in a sequence.
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Macro attachment
Macro attachment is a function whereby a macro register is assigned to a 
control panel button or a particular position of a fader lever, linking the 
execution of the button function or a fader lever operation with a macro 
execution.

For details, see Chapter 18 “Macros” (Volume 2).

Files

You can save register data, including setup information and snapshot 
information, as a file on a hard disk or memory card, and recall it as required.
You can operate on individual files or registers, or together in a batch.
Regarding frame memory, it is possible to capture image data stored in an 
external device into frame memory. You can also convert the format of image 
data in frame memory into a different format and save it in an external device.

The following files can be saved and recalled.
• Operation mode setup data for system as a whole and individual devices
• Device status data for system startup
• Key memory setting data
• Video process memory setting data
• Keyframe effect setting data
• Snapshot setting data
• Wipe snapshot setting data
• DME wipe snapshot setting data
• Key snapshot setting data
• Shotbox setting data
• Macro setting data
• Macro attachment data
• Menu macro setting data
• Frame memory image data

For details, see Chapter 17 “Files” (Volume 2).
33Creation of Special Effects and Management of Data and Operations



34

   C
hapter 1 

M
V

S
-6000 F

unctions
Setup

Various settings are required, in order to operate the switcher, control panel, 
DME, external devices, and so on, connected together in a single system.
This is referred to as “setup,” and you can carry out the setup operations from 
the Engineering Setup menu.

The settings in the Engineering Setup menu are grouped under the following 
headings.

• System setup (System)

For details, see Chapter 18 “System Setup” (Volume 3).

• Panel setup (Panel)

For details, see Chapter 19 “Panel Setup (Panel)” (Volume 3).

• Switcher setup (Switcher)

For details, see Chapter 20 “Switcher Setup (Switcher)” (Volume 3).

• DME setup (DME)

For details, see Chapter 21 “DME Setup (DME)” (Volume 3).

• DCU setup (DCU)

For details, see Chapter 22 “DCU Setup (DCU)” (Volume 3).

• Router/tally setup (Router/Tally)

For details, see Chapter 23 “Setup Relating to Router Interface and Tally 
(Router/Tally)” (Volume 3).
Setup
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Names and Functions of Parts of the 
Control Panel

Control Panel: Example Configuration 1
(With Standard Transition Modules)

The MVS-6000 system control panel 
comprises a number of modules.
The following illustration shows a typical 
32-button, 4-M/E configuration, with 
standard transition modules used in the 
transition control block.

Note
The following figures show the 
configuration examples. In the MVS-6000 
system you cannot use four M/E banks at a 
time.
As a standard control panel for the MVS-
6000 system, the CCP-6224 2M/E control 
panel or the CCP-6324 3M/E control panel 
is provided.
The CCP-6324 control panel can be used in 
the 3M/E equivalent configuration by 
integrating simple P/P software into the 
MVS-6000 system.

For details, see “CCP-6224 2M/E Control 
Panel” (page 96) or “CCP-6324 3M/E 
Control Panel” (page 97).
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Control panel configuration 1 (left side)
(with standard transition modules)

Auxiliary bus control block (page 72)

M/E-1 bank

M/E-2 bank

M/E-3 bank

PGM/PST (program/
preset) bank

Cross-point control block (page 43)
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Control panel configuration 1 (right side)
(with standard transition modules)

Memory card/USB adaptor block (page 79)
“Memory Stick”/USB connections block (page 80)

Key control block (page 54)

Keyframe control block (page 66)

Device control block (page 58/page 62)

Menu control block (page 78)

Transition control block 
(standard type) (page 47)

Fade to black control block (page 71)

Flexi Pad control block (standard type) (page 51)

Downstream key control block (page 90)

Utility/Shotbox control 
block (page 82)

Numeric keypad control block (page 69)
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Control Panel: Example Configuration 2
(With Simple Transition Modules)

The following illustration shows a typical 
configuration, with simple transition 
modules used in the transition control 
block. 

Except for the simple modules, this is the 
same configuration as in example 
configuration 1.

Control panel configuration 2 (left side)
(with simple transition modules)
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Control panel configuration 2 (right side)

(with simple transition modules)

Transition control block and Flexi Pad control 
block (simple type) (page 83)

Independent key transition control block 
(simple type) (page 88)
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Control Panel: Example Configuration 3
(With Compact Transition Modules)

The following illustration shows a typical 
configuration, with compact transition 

modules used in the transition control 
block. 

Control panel configuration 3
(with compact transition modules)

Transition control block (compact type) (page 94)
Names and Functions of Parts of the Control Panel
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Cross-Point Control Block

In the cross-point control block, you can 
select the signals to be used in this M/E 
bank or PGM/PST bank.

a Cross-point buttons
These buttons select the signals used for 
video creation on this M/E bank or PGM/
PST bank. Each row of buttons corresponds 
to one or more signal buses within the 
switcher.

Key 1 row: The buttons in this row select 
the key 1 or key 3 signals to be inserted 
into the video on this M/E bank or 
PGM/PST bank.
To select the key 1 fill signal, check 
that the right-hand [KEY3] button in 
the M/E bank (or the [DSK3] button in 

M/E
1

M/E
1

SHIFT

SHIFT
XPT

HOLD

XPT
HOLD

PRE
MCRO

KEY3

KEY4

POST
MCRO

XPT
HOLD

XPT
HOLD UTIL

M/E
1

M/E
1

M/E
2

M/E
2

M/E
2

M/E
2

M/E
3

M/E
3

M/E
3

M/E
3

SHIFT

SHIFT

SHIFT

MCRO
ATTCH
ENBL

1 Cross-point buttons

5 Source name displays

7 M/E bank display

3 Key bus selection buttons

4 UTIL button

8 Macro buttons

2 XPT HOLD buttons

6 SHIFT button

Key 1 row

Key 2 row

Reentry buttons

Reentry buttons

Background A row

Background B row
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the PGM/PST bank) is off, then press 
the button assigned to the desired 
signal. To select the key 3 fill signal, 
press the [KEY3] button, turning it on.
While the [UTIL] button on the right 
hand side is held down, these buttons 
are assigned to the DME external video 
bus allowing you to select the signal on 
that bus.

Key 2 row: The buttons in this row select 
the key 2 or key 4 signals to be inserted 
into the video on this M/E bank or 
PGM/PST bank.
To select the key 2 fill signal, check 
that the right-hand [KEY4] button in 
the M/E bank (or the [DSK4] button in 
the PGM/PST bank) is off, then press 
the button assigned to the desired 
signal. To select the key 4 fill signal, 
press the [KEY4] button, turning it on.

Background A row: Press the desired 
button to select the signal as the current 
background video on this M/E bank or 
PGM/PST bank.
While the [UTIL] button on the right 
hand side is held down in Hold mode, 
these buttons are assigned to the utility 
bus, and can be used to select the signal 
on that bus.

Background B row: Press the desired 
button to select the signal as the 
background video after the transition 
on this M/E bank or PGM/PST bank. 

Reentry buttons: These allow you to select 
the video created on another bank as 
background A or B or one of the keys 1 
to 4. For example, to use the video 
created on the M/E-1 bank as 
background B on the M/E-2 bank, press 
the reentry button [M/E 1] in the 
background B row of buttons on the M/
E-2 bank.

Cross-point button numbers
Cross-point button and reentry buttons are 
respectively numbered.

For details, see “Cross-point button 
control block button numbers” (page 140).

Assigning signals to button
You can assign a signal to each button using 
the Setup menu.

For details on the operation, see “Cross-
Point Settings (Xpt Assign Menu)” in 
Chapter 19 (Volume 3).

Visual indications on cross-point 
buttons

For details on the operation, see “Colors of 
lit cross-point buttons” (page 143).

b XPT (cross-point) HOLD buttons
Turning one of these buttons on enables 
you to recall a keyframe or snapshot while 
keeping the current cross-point selection 
unchanged.
Function of this button varies depending on 
the operation mode selected in the Setup 
menu.

For details, see “Selecting the Bank to 
Make the Settings” in Chapter 20 (Volume 
3).

c Key bus selection buttons
KEY3 button: Press this button, turning it 

on, to assign the key 1 cross-point 
buttons to the key 3 fill bus.

KEY4 button: Press this button, turning it 
on, to assign the key 2 cross-point 
buttons to the key 4 fill bus.

Pressing one of the key delegation buttons 
[KEY1] to [KEY4] in the transition control 
block (standard type) twice in rapid 
succession changes the state of the 
corresponding one of these buttons, so that 
Names and Functions of Parts of the Control Panel



  C
hapter 2 

M
enus and C

ontrol P
anel
you can make cross-point selections on the 
key bus (see page 50).

d UTIL (utility) button 
While this button is held down, the cross-
point buttons are assigned to the following 
buses, respectively.
Background A row: utility bus
Key 1 row: DME external video bus
In a Setup menu, you can select either of the 
following two modes for these buttons.
• The button takes effect while being held 

down.
• Every time the button is pressed, it 

toggles between the on and off states for 
key 1 and key 2 rows. For background A 
and background B rows, utility buses 
remain disabled.

e Source name displays
These show the names of the signals which 
can be selected on the cross-point buttons, 
in two or four characters, or in auto mode.
While the [SHIFT] button on the right hand 
side or the [SHIFT] button assigned to the 
column of cross-point buttons is enabled, 
the source name of the signal assigned to 
the column of cross-point buttons in shift 
mode appears. You can select green, 
orange, or yellow for the background color 
of the source name display, for each source 
separately. You can set the source name 
display mode and background color in a 
Setup menu.

f SHIFT button
When this button is enabled, either the 
source name displays show the shifted 
signal names, or the shifted signals for all 
buses in this M/E (P/P) bank are enabled. 
You can select either mode in a Setup 
menu.
Each press of the button toggles between 
the enabled and disabled states.

In the case of a module without source 
name displays, when “Display” is selected 
in the Setup menu, this button is invalid.

g M/E bank display
This indicates the notional mix/effect bank 
name to which the particular M/E or PGM/
PST bank is assigned, as a four-character 
identifier.

h Macro buttons
PRE MCRO (pre macro) button: Use this 

button to set a macro attachment in pre 
macro mode. For setting in macro only 
mode, use this in combination with a 
macro only set button assigned to the 
utility/shotbox control block or a user 
preference button. Alternatively, 
without using the button, you can make 
the selection simply, by pressing 
simultaneously with the [PRE MCRO] 
button.
Function of this button varies as 
follows depending on the operation 
mode selected in the Setup menu. 
• Switching dual background bus 

mode 
• Switching utility/shotbox mode
• Disabling cross-point button 

operations

For details, see “Setting the 
Assignment of Macro Operation 
Buttons” in Chapter 19 (Volume 3).

POST MCRO (post macro) button: Use 
this button to set a macro attachment in 
post macro mode. For setting in macro 
only mode, use this in combination 
with a macro only set button assigned 
to the utility/shotbox control block or a 
user preference button. Alternatively, 
without using the button, you can make 
the selection simply, by pressing 
simultaneously with the [PRE MCRO] 
button.
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This button is disabled when some 
operation modes are selected in the 
Setup menu. 

For details, see “Setting the 
Assignment of Macro Operation 
Buttons” in Chapter 19 (Volume 3).

MCRO ATTCH ENBL (macro 
attachment enable) button: When 
this button is on, the macro attachments 
set for the buttons of the M/E bank are 
enabled.
Names and Functions of Parts of the Control Panel
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Transition Control Block (Standard Type)

In the transition control block, you can 
modify the output of the M/E bank or PGM/
PST bank, and perform transitions. Both 

common transition and independent key 
transition operations are possible.

BKGD KEY1 KEY2 KEY3 KEY4

KEY1 KEY2 KEY3 KEY4
K-MOD
ENBL K-SS

K-TR
ENBL

K-SS
STOREMIX WIPE DME

KEY
PRIOR MIX

ALL
PST

COLOR
MIX

NAM

WIPE

SUPER
MIX

DME

PRIOR
SET NORM

NORM
/REV REV

TRANS
PVW

PTN
LIMIT

LIMIT
SET KF

KEY1
ON

AUTO
TRANS CUT AUTO

TRANS

KEY2
ON

AUTO
TRANS

KEY3
ON

AUTO
TRANS

KEY4
ON

AUTO
TRANS

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

9 PRIOR SET button

1 Next transition selection buttons

8 Key status display

2 Transition type selection buttons

7 KF button

6 Pattern limit buttons

5 TRANS PVW button

3 Transition execution section

4 Wipe direction selection buttons

q; Key delegation buttons

qd Key source name display/key 
snapshot buttons

qf Key snapshot setting buttons

qa Independent key transition type 
selection buttons

qs Independent key transition 
execution section
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a Next transition selection buttons
Press these buttons, turning them on, to 
determine what the next transition will 
apply to.
BKGD: Next transition changes the 

background.
KEY1 to KEY4 (DSK1 to DSK4 in the 

PGM/PST bank): Press this button, 
turning it on, to make the next 
transition insert or remove the 
corresponding key (keys 1 to 4). If a 
key is currently inserted it will be 
removed, and vice versa.
In the PGM/PST bank, this inserts or 
removes downstream keys 1 to 4.

KEY PRIOR (priority): When this button 
is lit, the setting of the key priority after 
the next transition is enabled. The key 
priority after the next transition appears 
in the key status display.

ALL: Pressing this button turns on a 
preselected set of the [BKGD], [KEY1] 
to [KEY4], and [KEY PRIOR] buttons.
Make this setting in a Setup menu.

b Transition type selection buttons
You can assign these buttons in setup to any 
transition type (see “Overall Control Panel 
Settings (Config Menu)” in Chapter 19 
(Volume 3)).
Press one of these buttons, turning it on, to 
determine the type of the next transition.
When multi-program mode is selected in 
the Setup menu (see “Settings for Switcher 
Configuration (Config Menu)” in Chapter 
20 (Volume 3)), two or more of the 
following buttons may light.
You can also assign a function to these 
buttons to select whether or not the fader 
levers are used as keyframe faders.
MIX: In a background transition, the new 

video fades in as the current video 
fades out. During the transition, the 
overall signal level is maintained at 
100%.

In a key transition, the key fades in (for 
insertion) or out (for removal).

NAM (non-additive mix): The current and 
new video signals are compared, and 
the signal with the higher luminance 
level is given priority in the output.
The current video is maintained at 
100% output for the first half of the 
transition as the new video increases 
progressively to 100%, then the current 
video is progressively reduced from 
100% to zero in the second half while 
the new video is maintained at 100%.

SUPER MIX: The current video is 
maintained at 100% output for the first 
half of the transition as the new video is 
mixed while increasing progressively 
to 100%. The current video is then 
progressively reduced from 100% to 
zero in the second half while the new 
video is maintained at 100%.

PST (preset) COLOR MIX: In the first 
transition, the current video is replaced 
by the color matte in a mix (dissolve), 
then in the second transition the color 
matte is replaced by the new video also 
in a mix (dissolve).
In place of a color matte, you can select 
any signal on the utility bus.

WIPE: The current video is replaced by the 
new video, using the wipe pattern 
selected in the Wipe menu.

DME: A wipe type of transition is carried 
out, using the DME effect selected in 
the DME Wipe menu.

FM1&2CLIP, FM3&4CLIP, 
FM5&6CLIP, FM7&8CLIP: A 
recorded clip is played back together 
with the transition. At this point, you 
can also carry out a transition (wipe or 
mix (dissolve)) simultaneously 
together with the clip.

KF (keyframe): Press this button, turning 
it on, to enable using the fader lever as 
a keyframe fader.
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c Transition execution section
Transition indicator: This comprises 

multiple LEDs, which show the 
progress of the transition.

Fader lever: Move up or down to carry out 
the transition. When the [KF] button or 
a transition type selection button to 
which the KF button function has been 
assigned is lit, you can use this as a 
keyframe fader.

Transition rate display: This shows the 
“transition rate” (the time from the 
beginning of a transition to its 
completion) set for an auto transition, 
in frames.
You can set the transition rate using the 
numeric keypad control block, Flexi 
Pad control block, or menu.

AUTO TRANS (transition) button: 
Pressing this button carries out an auto 
transition of the set transition rate 
(duration). The transition starts 
immediately, and the button lights 
amber. When the transition completes, 
the button goes off.

CUT button: Pressing this button carries 
out the transition as a cut (i.e. 
instantaneously).

d Wipe direction selection buttons
When you have selected a wipe or DME 
wipe as the transition type, press one of 
these buttons, turning it on, to select the 
wipe direction.
NORM (normal): The wipe proceeds in 

the direction from black to white as 
shown on the pattern in the lists of 
patterns see “Wipe Pattern List” (page 
444) and “DME Wipe Pattern List” 
(page 445), or in the direction of the 
arrow.
When the VTR/disk recorder/frame 
memory operation mode is enabled in 
setup, pressing this button plays the 
tape.

REV (reverse): The wipe proceeds in the 
opposite direction to that when the 
[NORM] button is pressed.
When the VTR/disk recorder/frame 
memory operation mode is enabled in 
setup, pressing this button cues the tape 
automatically to the start point.

NORM/REV (normal/reverse): The wipe 
direction alternates between normal 
and reverse every time a transition is 
executed.
When the VTR/disk recorder/frame 
memory operation mode is enabled in 
setup, pressing this button stops the 
tape.

e TRANS PVW (transition preview) 
button

When this button is lit, you can check in 
advance the video changes during the 
transition, on the preview output from the 
M/E or PGM/PST bank.
During the preview, you can use the fader 
lever, [AUTO TRANS] button, and [CUT] 
button. One of the following functions of 
this button can be selected in a Setup mode.
• When the transition completes, the 

system returns to the normal mode.
• The transition preview mode is 

maintained while this button is pressed.
• Switching is made between the transition 

preview mode and normal mode every 
time this button is pressed.

f Pattern limit buttons
PTN (pattern) LIMIT: Pressing this 

button, turning it on, enables the 
pattern limit function.
When the VTR/disk recorder/frame 
memory operation mode is enabled in 
setup, pressing this button plays the 
tape.

LIMIT SET: Use this button to set a 
pattern limit when the [PTN LIMIT] 
button is off.
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Move the fader lever to the position of 
a particular pattern size, and stop it 
there, then press this button to set the 
pattern limit range.
When the VTR/disk recorder/frame 
memory operation mode is enabled in 
setup, pressing this button stops the 
tape.

g KF (keyframe) button
When the VTR/disk recorder/frame 
memory operation mode is enabled in 
setup, pressing this button cues the tape 
automatically to the start point. When not, 
pressing this button to turn it on allows you 
to use the fader lever as a keyframe fader.

h Key status display
For each of keys 1 to 4, the corresponding 
ON indicator lights when the key is 
inserted. It also shows the priority (1 to 4) 
of each key.

i PRIOR (priority) SET button
While this button is held down, you can set 
the key priority.
The setting mode when this button is 
pressed depends on whether or not the 
[KEY PRIOR] button is lit, as follows.
• When the [KEY PRIOR] button is off, the 

current key priority is set.
• When the [KEY PRIOR] button is lit, the 

key priority after the next transition is set.
Press the [KEY PRIOR] button as required, 
to switch between these two modes.
In either mode, hold down the [PRIOR 
SET] button, and press the button ([KEY1] 
to [KEY4]) corresponding to the key you 
want to bring to the front.

The following controls are used as the 
independent key transition control block.

j Key delegation buttons
These buttons delegate this independent 
key transition control block to a desired 

keyer. Press one of the [KEY1] to [KEY4] 
buttons ([DSK1] to [DSK4] in the PGM/
PST bank), turning it on.
You can press more than one button to 
select two or more keyers.
While these buttons are held down, you can 
select a key source with the cross-point 
buttons for the key bus.
Pressing one of these buttons twice in rapid 
succession changes its state so that you can 
make cross-point selections on the 
corresponding key bus.

a) The key bus selection button [KEY3] in the cross-
point control block goes off.

b) The key bus selection button [KEY4] in the cross-
point control block goes off.

c) The key bus selection button [KEY3] in the cross-
point control block lights.

d) The key bus selection button [KEY4] in the cross-
point control block lights.

k Independent key transition type 
selection buttons

Press one of the following buttons, turning 
it on, to select the independent key 
transition type.
MIX: Faded in or out.
WIPE: Inserted or deleted with a wipe.
DME (DME wipe): Inserted or deleted 

with a DME wipe.

l Independent key transition 
execution section

KEY1 ON to KEY4 ON (DSK1 ON to 
DSK4 ON in the PGM/PST bank) 
buttons: Press the corresponding one 
of these buttons to cut key 1 to key 4 in 
or out instantaneously. When the key 

Key delegation button 
(double press)

Corresponding 
key bus

[KEY1] key 1 a)

[KEY2] key 2 b)

[KEY3] key 3 c)

[KEY4] key 4 d)
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corresponding to the button appears in 
the final program output, the button 
lights red, and otherwise lights amber.

AUTO TRANS (transition) buttons: 
These correspond to keys 1 to 4 from 
left to right; press one to carry out an 
auto transition. The transition rate for 
an independent key transition can be 
set in the numeric keypad control 
block, in the Flexi Pad control block, or 
in a menu.

m Key source name display/key 
snapshot buttons

These display the source name selected on 
the corresponding keyer. In key snapshot 
mode, press these buttons, corresponding to 
registers 1 to 4 for the selected keyer, to 
save or recall a key snapshot.

n Key snapshot setting buttons
K-SS (key snapshot): This enables key 

snapshot mode.
K-SS STORE (key snapshot store): To 

save a key snapshot, hold down this 
button, and press the key source name 
display/key snapshot button 
corresponding to the register you want 
to save.

K-MOD ENBL (key modifier enable): To 
recall key adjustment values and key 
modifier settings when recalling a key 
snapshot, press this button, turning it 
on.

K-TR ENBL (key transition enable): To 
recall independent key transition 
settings when recalling a key snapshot, 
press this button, turning it on.

Flexi Pad Control Block (Standard Type)

The Flexi Pad control block is used for 
saving and recalling wipe snapshots, DME 
wipe snapshots, and snapshots, for recalling 
effects, and shotbox content, and for 
entering the transition rate.
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a Mode selection buttons
WIPE: To save or recall a wipe snapshot, 

or recall the pattern number of a wipe 
pattern, use this in combination with 
the buttons of the memory recall 
section.

DME: To save or recall a DME wipe 
snapshot, or recall the pattern number 
of a DME wipe pattern, use this in 
combination with the buttons of the 
memory recall section.

SNAPSHOT: To save or recall a snapshot, 
use this in combination with the 
buttons of the memory recall section.

EFF (effect): To recall the master timeline 
or run an effect, use this in combination 
with the buttons in the memory recall 
section.

SHOTBOX: To recall or execute a 
shotbox, use this in combination with 
the buttons of the memory recall 
section.

MCRO (macro): To save, recall or edit a 
macro, use this in combination with the 
buttons of the memory recall section.

TRANS RATE (transition rate): To enter 
the transition rate, press this button, 
turning it on. To enter the independent 
key transition rate, hold down this 
button, and press the key delegation 
button in the independent key 
transition control block. To select 
whether the value is entered in frames 
or as a timecode value, switch the [TC] 
button in the memory recall section on 
or off.

7

WIPE

DME

SNAP
SHOT

EFF

MCRO

SHOT
BOX

UNDO

STORE
STATS

TRANS
RATE

BNAK
0

BANK
1

BANK
SEL

XPT HOLD
A B U1 U2 1 2 3 4

8 9

4 5 6

1 2 3

0 AUTO
TRAN

EFF
DISS

1 Mode selection buttons

5 XPT HOLD status display

3 Memory recall section

2 Bank selection buttons

4 UNDO button

6 Numeric display
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b Bank selection buttons
BANK0 (bank 0): Assigns the memory 

recall section to bank 0, of registers 1 to 
10.

BANK1 (bank 1): Assigns the memory 
recall section to bank 1, of registers 11 
to 20.

BANK SEL (bank selection): After 
pressing this button, press a button in 
the memory recall section to select 
banks 0 to 9.

c Memory recall section
This consists of 12 buttons with LCDs. 
These display changes, according to 
various operation modes.

d UNDO button
UNDO: After recalling a register, press this 

button to return to the state before 
recalling the register.
When contents have been saved to a 
register, hold down the [STORE 
STATS] button and press this button to 
return the register to its state before the 
save operation.

STORE STATS (store status): When a 
save or delete operation has been 
carried out on a register, this button 
lights amber. After saving to a register, 
hold down this button and press the 
relevant register button to delete the 
data in the register. Again, after a save 
operation on a register, hold down this 
button and press the [UNDO] button to 
restore the register to its state before the 
save operation.

e XPT HOLD (cross-point hold) status 
display

A bus for which cross-point hold is set 
appears as a green light.

f Numeric display
Depending on the operation mode, this 
shows the pattern number of a wipe or 

DME wipe, a bank number, a register 
number, a transition rate, and so on in up to 
four digits.
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Key Control Block

Each of the M/E banks and the PGM/PST 
bank includes four keyers (for keys 1 to 4), 
and you can delegate this control block to 

any desired keyer. In this control block, you 
can adjust and modify keys.

a Delegation buttons
Key delegation: Press one of the [KEY1] 

to [KEY4] buttons to delegate the key 
control block to the corresponding 
keyer.

M/E delegation: Press one of the [M/E 1] 
to [M/E 3], and [P/P] buttons to select 
the bank (an M/E bank or the PGM/
PST bank) to which the key control 
block is delegated.

3 Key fill/key source selection buttons

2 Key type selection buttons

1 Delegation buttons

4 Key modifier buttons

9 DME channel 
selection buttons

7 Knobs

8 Displays

qf AUTO DELEG button

qa Output destination specification 
buttons

qd TRACE button

qs OVERRIDE button

5 MORE button

6 SHOW KEY button

q; ON AIR indicators

qg RESIZER button
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TRANS: By pressing this button, you can 
check the DME channel used for DME 
wipes on the M/E or PGM/PST bank. 
Also, by pressing this button, then 
pressing one of the DME channel 
selection buttons, you can preset the 
DME channel to be used when a DME 
wipe is selected as the transition type 
for the transition.
When presetting the DME channel for 
an independent key transition, hold 
down this button, then press one of the 
[KEY1] to [KEY4] buttons, turning the 
two buttons on, beforehand.

b Key type selection buttons
Press one of these buttons, turning it on, to 
select the desired key type.
Depending on the selected key type, 
various parameters are displayed, and you 
can set the values with the knobs.
The following key types can be selected.
LUM: luminance key
LIN: linear key
CRK: chroma key
CVK: color vector key
PTN: key wipe pattern key

For details, see “Key Types” (page 197).

c Key fill/key source selection buttons
AUTO SEL (selection): Use the signal 

selected on the key fill bus, and the 
paired key source signal. The setting of 
key fill and key source pairs is carried 
out in a Setup menu.

SPLIT: To use the signal selected on the 
key fill bus as key fill, and a signal 
separate from the signal assigned in a 
pair with key fill for key source, press 
this button, turning it on. 
To select the signal on the key source 
bus, hold down this button, and press a 
button in the key 1 or key 2 row in the 
cross-point control block.

To use the signal selected on the key fill bus 
as key source (self keying), press the 
[AUTO SEL] button and [SPLIT] button at 
the same time, so that both are off.
MATTE FILL: To use a color matte from 

the internal generator as key fill, press 
this button, turning it on. You can 
adjust the color matte using the knobs.
When this button is off, the signal 
selected on the key fill bus is used as 
key fill.

d Key modifier buttons
To add an edge modifier to the key, press 
one of these buttons, turning it on.
Depending on the edge type selected, 
parameters appear in the displays, and you 
can set the values with the knobs.
For functions other than MASK, keys 3 and 
4 cannot be used.
KEY DROP: When drop border or shadow 

is selected, turning this button on 
lowers the key fill and key source 
position by four or eight scan lines as 
set in the key menu.
To select 4H or 8H, use the Key menu.
When the selected edge type is 
“normal” and soft edge is selected or 
when border, outline, or emboss is 
selected, this button lights 
automatically.

BDR (border): Apply a border of a 
uniform thickness to the whole key.

DROP BDR (drop border): Apply a 
border to two sides of the key (for 
example, below and to the right, or 
below and to the left).

SHDW (shadow): Apply a shadow to two 
sides of the key (for example, below 
and to the right, or below and to the 
left).

OUTLINE: Use the outline of the key.
EMBOS (emboss): Apply an embossing 

effect to the periphery of the key.
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• To select a “normal” as the edge type 
(that is, a plain edge), set all five of the 
above buttons off.

• When emboss is selected, you can use the 
dedicated color matte signal for the 
emboss function.

• When outline is selected, the signal 
selected on the key fill bus is used to fill 
the edge.

MASK: Press this button, turning it on, to 
enable the key mask using the mask. It 
also enables you to set the parameters 
with the knobs.

ZABTN (zabton): When this is pressed, 
turning it on, a translucent pattern is 
inserted behind the key. With the 
knobs, you can adjust the color, size, 
density, and softness parameters.

SOFT EDGE: Soften the edge of the key.

e MORE button
When there are more than four parameters, 
this button lights amber. When it is pressed, 
it changes from amber to green and the fifth 
and subsequent parameters are assigned to 
the knobs, allowing them to be adjusted.

f SHOW KEY button
While this button is held down, a key 
processed key source signal is output from 
the specified output port. You can make the 
output specification independently for each 
of edit preview and the preview of each M/
E or PGM/PST bank in a Setup menu.

g Knobs
Turn the knobs to adjust the parameter 
values.

h Displays
Each display shows the initial letters of the 
parameter name and the parameter value 
(maximum three digits including a minus 
sign for a negative value).

i DME channel selection buttons
Press one of these buttons, turning it on, to 
delegate a DME channel to the keyer. 
DME 1 and DME 2 can be assigned to one 
keyer.
A DME channel assigned to a keyer cannot 
be selected on another keyer. 
However, using the override function it is 
possible to allocate a channel already 
allocated to another keyer to the currently 
selected keyer. If DME channel allocations 
have been made in a Setup menu, these 
buttons cannot be used to make DME 
channel allocations. Using the trace 
function, it is possible to check which keyer 
a DME channel is allocated to.

j ON AIR indicators
These light red when the corresponding 
DME channels are included in the final 
program output.

k Output destination specification 
buttons

MON (DME monitor): Hold down this 
button and press the selection button 
for the DME channel you want to 
assign to the monitor output; you can 
then monitor the output signal on the 
DME monitor output.
While this button is held down, the 
DME channel selection buttons light as 
follows, allowing you to check the 
monitor assignment.
Lit amber: DME channel that can 

currently be monitored
Lit green: DME channel currently 

assigned to the monitor output

l OVERRIDE button
To select a DME channel already allocated 
to another keyer or transition to the 
currently selected keyer (or transition), hold 
down this button, and press the DME 
channel selection button.
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m TRACE button
When a DME channel is already allocated 
to another keyer or transition, hold down 
this button, and press the corresponding 
DME channel selection button, to switch to 
the state in which the keyer (or transition) to 
which the DME channel is allocated is 
currently selected.

n AUTO DELEG (auto delegation) 
button

When this button is on, the key delegation 
selection state of the key control block is 
linked to the key delegation selection state 
of the independent key transition control 
block.

o RESIZER button
Enables or disables resizer.

For details on resizer, see page 249.
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Device Control Block (Trackball)

The device control block is used for three-
dimensional transform operations using a 
DME, for wipe pattern position setting, and 

for VTR/disk recorder/frame memory clip 
operation.

a Region selection buttons
The operation mode allocated to the device 
control block depends on the selection state 
of the region selection buttons.
When the [M/E 1], [M/E 2], [M/E 3], and 

[P/P] buttons are selected: This 
enables the wipe pattern position 
setting (positioner) operation mode in 
the device control block. You can 
select multiple buttons simultaneously.

When the [USER] button is selected: This 
enables pattern position setting used 
for color backgrounds.

When the [DME 1] [DME2], [DME5] to 
[DME 8] buttons are selected: This 

enables the three-dimensional 
transform operation mode in the device 
control block.
Press a button, turning it on, to select a 
DME channel. You can select multiple 
buttons simultaneously.
The number of valid buttons depends 
on the number of DME processor 
channels installed.

When the [DEV] button is selected: This 
enables the VTR/disk recorder/frame 
memory operation mode in the device 
control block. Each button functions as 
follows.

1 Region selection buttons

3 Trackball

4 Z-ring2 Operating buttons

5 MENU button
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(From upper left to right in the above 
figure)
[M/E1] to [M/E3]: DEV1 (device 1) to 

DEV3 (device 3)
[P/P]: DEV4 (device 4)
[USER]: FM1CLIP (frame memory 

clip 1)
[Unused]: FM2CLIP (frame memory 

clip 2)
[DME1]: DEV5 (device 5)
[DME2]: DEV6 (device 6)
[Unused]: DEV7 (device 7)
[Unused]: DEV8 (device 8)
[Unused]: FM LOOP (frame memory 

loop)
[DME5] to [DME8]: DEV9 (device 9) 

to DEV12 (device 12)
To exit from this mode, press the 
[DEV] button again, turning it off.

When the [RUN CTRL] button is 
selected: This enables the effect run 
control mode in the device control 
block.

When the [RSZR CTRL] button is 
selected: This enables the resizer 
control mode.

For details on resizer, see page 249.

The functions of the operation buttons, 
trackball, and Z-ring vary with the 
operation mode as follows.

b Operation buttons

When the positioner operation mode is 
enabled
K1 CB1: Press this button to enable wipe 

pattern position setting for key 1 
(DSK1).
When the [USER] button is selected, 
pattern position setting for color 
background 1 is enabled.

K2: Press this button to enable wipe pattern 
position setting for key 2 (DSK2).

K3: Press this button to enable wipe pattern 
position setting for key 3 (DSK3).

K4: Press this button to enable wipe pattern 
position setting for key 4 (DSK4).

WIPE: Press this button to enable wipe 
pattern position setting for normal 
transitions.

Among the [K1 CB1] button, [K2] button, 
[K3] button, [K4] button and [WIPE] 
button, you can select multiple buttons.

POS: Press this button to enable pattern 
movement in the x-axis and y-axis 
directions with the trackball.
When the [USER] button is selected, 
this enables the trackball to move the 
pattern in the x-axis and y-axis 
directions, and the Z-ring to adjust the 
size of the pattern.

X, Y: These restrict the axes affected by the 
trackball and Z-ring to the x- or y-axis. 

Z: This restricts the axes affected by the 
trackball and Z-ring to the z-axis. 

CTR (center): When this button is pressed, 
the pattern position returns to the 
center. When the [USER] button is 
selected, the pattern size also returns to 
50.00.

SHIFT/CLR WORK BUFR: Press this 
button twice in rapid succession to 
reset all parameters on the target M/E 
or PGM/PST to their initial values.

When the three-dimensional transform 
operation mode is enabled
The Buttons are used for three-dimensional 
DME transformations.

For details, see “Basic Operations” in 
Chapter 11 (Volume 2).

When the VTR/disk recorder/frame 
memory operation mode is enabled
The Buttons are used for VTR control or 
playback of frame memory clips.
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For details, see “Controlling the Tape/Disk 
Transport” in Chapter 12 (Volume 2).

When the resizer control mode is enabled
LOCAL (K1): Select key 1.
GLB (K2): Select key 2.
LOC SIZE (ASP: aspect): Pressing this 

button and operating the trackball or Z-
ring changes the aspect ratio of a key to 
which the resizer function is applied to. 
When this button is held down, the 
trackball or Z-ring operation is 
switched to a finer control. (fine mode)

LOC XYZ (LOC: location): Pressing this 
button and operating the trackball or Z-
ring moves, shrinks, or magnifies a key 
to which the resizer function is applied 
to. When this button is held down, the 
trackball or Z-ring operation is 
switched to a finer control. (fine mode)

ROT (RSZE: resizer): Press this button, 
turning it on, to enable the resizer.

CLR WORK BUFR (Clear work 
buffer): Pressing this button once 
returns the two-dimensional 
transformation settings to the defaults. 
Pressing twice in rapid succession 
returns all resizer parameter values to 
the defaults.

X, Y: These restrict the axes affected by the 
trackball and Z-ring to the x- or y-axis.

Z: This restricts the axes affected by the 
trackball and Z-ring to the z-axis.

CTR (center): Pressing this button once 
changes the two-dimensional 
transformation settings to the closest 
detent values. Pressing twice in rapid 
succession returns the two-dimensional 
transformation settings to the defaults.

c Trackball
When the positioner operation mode is 
enabled
By moving this, you can move the pattern 
in the x-axis and y-axis directions.

When the three-dimensional transform 
operation mode is enabled
Move the trackball to control the x- and y-
axes in a three-dimensional transform.
When the [SRC] or [TRGT] button is held 
down, the trackball operation is switched to 
a finer control. (fine mode)
By turning the trackball, you can move in 
the x- and y-directions of the key to which 
the resizer is applied, and change the aspect 
ratio.
When the [LOC SIZE] or [LOC XYZ] 
button is held down, the trackball operation 
is switched to a finer control. (fine mode)

d Z-ring 
When the positioner operation mode is 
enabled
When the [USER] button is selected, by 
turning the ring you can adjust the size of 
the pattern.

When the three-dimensional transform 
operation mode is enabled
Turn this ring to control the z-axis in a 
three-dimensional transform.
When the [SRC] or [TRGT] button is held 
down, the Z-ring operation is switched to a 
finer control. (fine mode)

When the effect run control mode is 
enabled
By turning the Z-ring, you can run the 
keyframe effect, independent of the STOP 
NEXT KF, EFF LOOP, and similar settings 
in the keyframe control block. Turn 
clockwise to run the effect in the normal 
direction, and counterclockwise for the 
reverse direction.

When the resizer control mode is enabled 
By turning the ring, you can zoom the key 
to which the resizer is applied, and change 
the aspect ratio.
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When the [LOC SIZE] or [LOC XYZ] 
button is held down, the Z-ring operation is 
switched to a finer control. (fine mode)

When the VTR/disk recorder/frame 
memory operation mode is enabled
Turning the Z-ring controls the tape 
transport/disk drive/frame memory clip 
operations, at a speed determined by the 
operating buttons. Turn clockwise for the 
normal direction, and counterclockwise for 
the reverse direction.

e MENU button
Press this button, turning it on, to enable 
adjusting the parameters allocated to the 
knobs in the menu using the trackball and 
Z-ring.
In the case of the DME menu, the operation 
applies to the selected DME channel.
In VTR/disk recorder/frame memory 
operation mode, press this button, setting it 
to On. This makes it possible to carry out 
timeline start/stop point setting operation 
for the device selected with the device 
selection buttons.
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Device Control Block (Joystick)

All functions of the joystick type device 
control block are equivalent to the functions 
of the trackball type, except that the 

trackball and Z-ring operations are carried 
out with the joystick.

a Joystick
When the positioner operation mode is 
enabled
By moving this, you can move the pattern 
in the x-axis and y-axis directions.

When the three-dimensional transform 
operation mode is enabled
By moving this, you can carry out 
operations in the x-, y-, and z-axes.
When the following buttons are held down, 
the joystick operation is switched to a finer 
control. (fine mode)
• The button on the end of the joystick
• [SRC] button
• [TRGT] button

Depending on the settings made in the 
Setup menu, the operation speed multiple 
can be changed.

When the effect run control mode is 
enabled
By moving the joystick sideways, you can 
run the keyframe effect, independent of the 
STOP NEXT KF, EFF LOOP, and similar 
settings in the keyframe control block. 
Move to the right to run the effect in the 
normal direction, and to the left for the 
reverse direction.

Operating buttons

1 Joystick

MENU button

Region selection buttons
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When the VTR/disk recorder/frame 
memory operation mode is enabled
Moving the joystick sideways controls the 
tape transport/disk drive/frame memory 
clip operation, at a speed determined by the 
operating buttons. 

When the resizer control mode is 
enabled 
Move for operations in the x-, y-, and z-
axes. Hold down the button on the tip of the 
joystick to switch the joystick operation to 
a finer control. (fine mode)

Device Control Block (Search Dial)

Using the device control block (search 
dial), you can directly operate an XDCAM, 
disk recorder, VTR, other external device, 

frame memory clip, or shot box. The device 
control block (trackball) and device control 
block (joystick) can be used together.

a Timecode display
This shows the current time (CURRENT) 
and the start and stop point timecode values 
for the current reference device (START 
TC, STOP TC). When you press a device 
selection button, the button lights, selecting 

the assigned device as the reference device, 
and displaying its setting value.
In the case of the [SBOX] buttons, the 
display does not change. When the 
operation applies to a VTR/disk recorder, 
the displayed setting value depends on 

TIME
LINE

DEV
1

CURRENT

START TC

STOP TC

DEV
2

DEV
3

DEV
4

DEV
5

DEV
6

FM1
CLIP

FM2
CLIP

SBOX
1

SBOX
2

SBOX
3

START
TC

STOP
TC

SET
START

TC

SET
STOP

TC

SET
DUR

STB
OFF

ALL
STOP

STOP

RECPLAY FFREWCUE

DELAY

SHTL JOG VAR ENBL

1 Timecode display

2 Device selection buttons

4 DELAY button

5 Editing 
buttons

6External device 
operation buttons

7 TIMELINE button

8 STOP button

9 Search dial

3 SBOX buttons
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whether the [TIMELINE] button is on or 
off, as follows.
When the [TIMELINE] button is on: 

Displays the start and stop points of the 
last set keyframe on the timeline. When 
the keyframe number is changed and 
the last register and keyframe change, 
the display also changes. (timeline 
setting mode)

When the [TIMELINE] button is off: 
Displays the Cueup & Play (rewind 
action) start and stop points.

b Device selection buttons
These buttons are used for selecting 
assigned external devices or frame memory 
clips. Each button can only be assigned to a 
single device. Carry out the assignment in 
the Setup menu (see “Overall Control 
Panel Settings (Config Menu)” in Chapter 
19 (Volume 3)). To select an assigned 
device, press the corresponding button, 
which lights green. To select more than one 
device simultaneously, hold down the 
button for the first selection, while pressing 
the buttons for the other selections in turn. 
The second and subsequent selected 
buttons light amber. If you press another 
button without holding down the first 
selected button, the second button will be 
the reference device and light green.
DEV: Assign external devices DEV1 to 

DEV12.
FM CLIP: Assign frame memory clips 

FM1 to FM8.
Device selection buttons can be set as 
SBOX buttons or DELAY button in the 
Setup menu.

c SBOX (shotbox) buttons
Assign a shotbox saved in registers 1 to 99. 
When you press a button, the assigned 
shotbox is selected, and executed. Carry out 
the assignment in the Setup menu (see 
“Overall Control Panel Settings (Config 
Menu)” in Chapter 19 (Volume 3)).

SBOX buttons can be set as device 
selection buttons or DELAY button in the 
Setup menu.

d DELAY button
When pressed, this button lights green, the 
numeric keypad control block display 
changes to DELAY__  :  , and you can set 
the start delay time for the selected device. 
The setting range is from 00:00 to 59:29 
(depends on the video format). This button 
goes off when another timecode setting 
button ([START TC], [STOP TC], [SET 
START TC], [SET STOP TC], or [SET 
DUR]) is pressed. 
The DELAY button can be set as a device 
selection button or an SBOX button in the 
Setup menu. Carry out the assignment in 
the Setup menu (see “Overall Control 
Panel Settings (Config Menu)” in Chapter 
19 (Volume 3)).

e Editing buttons
These buttons set start and stop points. 
These operations are only valid while a 
device is selected with the device selection 
buttons.
START TC: Press this button to set the 

timecode of the start point at that time. 
The timecode of the start point is 
updated to the current time each time 
this button is pressed.
When the device the operation applies 
to is a VTR/disk recorder, the start 
point updated by the setting of the 
[TIMELINE] button is as follows.
When the [TIMELINE] button is 

On: start point of the timeline
When the [TIMELINE] button is 

Off: start point of Cueup & Play
STOP TC: Press this button to set the 

timecode of the stop point at that time. 
The timecode of the stop point is 
updated to the current time each time 
this button is pressed.
When the device the operation applies 
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to is a VTR/disk recorder, the stop 
point updated by the setting of the 
[TIMELINE] button is as follows.
When the [TIMELINE] button is 

On: stop point of the timeline
When the [TIMELINE] button is 

Off: stop point of Cueup & Play
SET START TC, SET STOP TC, SET 

DUR: When pressed, these buttons 
light green, “START TC”, “STOP TC” 
or “DUR” appears in the numeric 
keypad control block display, and you 
can enter a timecode from the numeric 
keypad. If you enter a numeric value 
and press the [ENTER] button, the 
button goes off, whereas if you press 
the [ENTER] button without entering a 
numeric value the numeric keypad 
control block display shows 
“--:--:--:--”. To exit the numeric value 
entry mode, either repeat pressing the 
same button, or press a different 
numeric keypad control block linked 
button, or a mode selection button such 
as the [EFF] and [SNAPSHOT] 
buttons in the numeric keypad control 
block. If the timecode has been set 
correctly, the entered numeric value 
appears in the timecode display.

STB (standby) OFF: When pressed, this 
button flashes amber, and the device 
selected with the device selection 
buttons exits from the standby mode.
This button cannot be used for frame 
memory clip operations.

CUE: When pressed, this button flashes 
amber together with the [ALL STOP] 
button, and the device selected with the 
device selection button is cued up to the 
start point of the material. When more 
than one device is selected, the amber 
flashing continues until the reference 
device is cued up, and when the cueing 
up is finished, this button lights green.

REW: When pressed, this button lights 
amber, and material of the device 
selected with the device selection 
buttons is rewound. To stop during the 
rewind, press the [STOP] button or 
[ALL STOP] button.

PLAY: When pressed, this button lights 
amber, and the device selected with the 
device selection buttons plays. The 
playback stops not only if the [STOP] 
button is pressed, but also if any of the 
[STB OFF], [SHTL], [JOG], [CUE], 
[REW], [PLAY], [FF], and [ALL 
STOP] buttons is pressed. When the 
[VAR] button is pressed while the 
device is playing back, the device plays 
at one times normal speed in variable 
mode.

FF: When pressed, this button lights amber, 
and the material of the device selected 
with the device selection buttons is fast 
forwarded. To stop during the fast-
forward, press the [STOP] button or 
[ALL STOP] button.

ALL STOP: When pressed, all device 
material playback and other operations 
stop. During cueing up of any of the 
devices, this button flashes amber, and 
when all cueing up operations are 
completed, it lights green.

REC: When pressed simultaneously with 
the [PLAY] button, this button lights 
red (the [PLAY] button lights amber), 
and the image from the selected device 
is recorded.
This button cannot be used for frame 
memory clip operations.

f External device operation buttons
ENBL (enable): When this is pressed, 

turning it on, the search dial [VAR], 
[JOG], and [SHTL] button operations 
are enabled.

VAR (variable): Sets the search dial to 
variable mode.

JOG: Sets the search dial to jog mode.
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SHTL (shuttle): Sets the search dial to 
shuttle mode.

g TIMELINE button
Press to switch the device selected with the 
device selection buttons to timeline setting 
mode.

h STOP button
When pressed, this lights amber, and 
operation of the device selected with the 
device selection buttons stops.

i Search dial
Use this for search and other operations on 
the material of an external device. 

For details of the method of use, see 
“Controlling Tape/Disk Transport” in 
Chapter 12 (Volume 2).

Keyframe Control Block

In the keyframe control block, you can 
carry out effect editing and execution.

STOP
NEXT

KF

NORM REV

NORM
/REV

EFF
LOOP

EDIT
ENBL

KF
DUR

DELAY

EFF
DUR

COPY PASTE

DEL

SHIFT INS
PREV

KF
NEXT

KF

MOD UNDO

CONST
DUR

KF
LOOP

GO TO
TC

AUTO
INS

PAUSE

GO TO
KF

ALL
FROM

TO

FF

RE
WIND

RUN

0 EFF LOOP button

1 EDIT ENBL button

2 Edit point 
specification 
buttons3 Editing buttons

4 Duration setting buttons

5 KF LOOP button

6 PAUSE button

7 Effect execution section

8 Effect execution direction selection 
buttons

9 STOP NEXT KF button

qa AUTO INS button
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a EDIT ENBL (edit enable) button
Press this button, turning it on, to enable 
effect editing operations with the keyframe 
control block.
When macro editing is carried out, this 
button lights red.

b Edit point specification buttons
GO TO TC (Go to timecode): Press this 

button, turning it on, to enter a numeric 
value from the numeric keypad control 
block, and move the edit point to the 
specified timecode position.

GO TO KF (Go to keyframe): Press this 
button, turning it on, to enter a numeric 
value from the numeric keypad control 
block, and move the edit point to the 
specified keyframe.
During macro editing, pressing this 
button moves the edit point to the event 
number specified by numeric entry 
with the numeric keypad control block.

PREV KF (previous keyframe): When 
this button is pressed, the edit point 
moves to the keyframe immediately 
before the current time (the position 
where the effect is currently stopped).
During macro editing, pressing this 
button moves the edit point to the event 
immediately before the current event.

NEXT KF (next keyframe): When this 
button is pressed, the edit point moves 
to the keyframe immediately after the 
current time.
During macro editing, pressing this 
button moves the edit point to the event 
immediately after the current event.

c Editing buttons
ALL: Press this button, turning it on, to 

select all keyframes (during macro 
editing, all events) in the effect.

FROM TO: Press this button, turning it on, 
to enter numeric values from the 
numeric keypad control block, and 
select a specified range of keyframes 

(during macro editing, the specified 
range of events).

INS (insert): When this button is pressed, a 
new keyframe is inserted after the 
current keyframe. Pressing this button 
while holding down the [SHIFT] 
button inserts a new keyframe before 
the current keyframe.
During macro editing, pressing this 
button registers an event after the 
current event.

MOD (modify): When this button is 
pressed, the selected keyframe is 
modified with the values of the current 
keyframe. When the edit point is 
between two keyframes, the 
immediately preceding keyframe is 
modified. You can also select multiple 
keyframes, and modify them in a single 
operation. At this time, pressing this 
button while holding down the 
[SHIFT] button modifies all selected 
keyframes with the changed values 
taken as relative values.
During macro editing, pressing this 
button amends the selected event.

DEL (delete): When this button is pressed, 
the selected keyframe is deleted. When 
the edit point is between two 
keyframes, the immediately preceding 
keyframe is deleted. During macro 
editing, pressing this button deletes the 
selected event. You can also select 
multiple keyframes or macro events, 
and delete them in a single operation.

COPY: When this button is pressed, the 
selected keyframe (during macro 
editing, macro event) is copied. You 
can also select multiple keyframes or 
macro events, and copy them in a 
single operation.

PASTE: When this button is pressed, the 
deleted or copied keyframe (during 
macro editing, macro event) is inserted 
after the current keyframe (during 
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macro editing, macro event). Pressing 
this button while holding down the 
[SHIFT] button inserts the deleted or 
copied keyframe (during macro 
editing, macro event) before the current 
keyframe (during macro editing, macro 
event).

SHIFT: Hold down this button, and press 
the [INS] button, [MOD] button, or 
[PASTE] button, to obtain the shifted 
function for the button.

UNDO: When this button is pressed, the 
last executed keyframe (during macro 
editing, macro event) insertion, 
modification, or deletion, or paste 
operation is canceled.

d Duration setting buttons
KF DUR (keyframe duration): Press this 

button, turning it on, to set the 
keyframe duration of the selected 
keyframe, by numeric value entry from 
the numeric keypad control block.

EFF DUR (effect duration): Press this 
button, turning it on, to set the effect 
duration from the numeric keypad 
control block.

DELAY: Press this button, turning it on, to 
enter a delay value from the numeric 
keypad control block.

CONST DUR (constant duration): Select 
the duration mode. When this is lit, the 
mode is constant duration mode, and 
when off, variable duration mode.

e KF LOOP (keyframe loop) button
Press this button, turning it on, to execute 
the effect the specified number of times 
through the keyframes in the specified 
range.

f PAUSE button
When this button is pressed, a pause is 
applied to the selected keyframe.
When editing a macro, press this button, 
turning it on, to include a pause event in the 

macro. The pause length can be set in the 
numeric keypad control block.

g Effect execution section
RUN: When this button is pressed, the 

effect is run from the first keyframe to 
the last keyframe. However, if a pause 
is set on a keyframe, the effect stops at 
that point. Press this button again to 
resume execution, and continue to the 
next pause point or the end of the 
effect.

Effect indicator: This comprises multiple 
LEDs, which show the progress of the 
effect.

Fader lever: Moving this up or down 
manually runs the effect.

REWIND: When this button is pressed, the 
currently recalled effect is rewound to 
the first keyframe.

FF (fast forward): When this button is 
pressed, the currently recalled effect is 
advanced to the last keyframe.

h Effect execution direction selection 
buttons

NORM (normal): When this button is lit, 
effect execution runs from the first 
keyframe to the last keyframe.

REV (reverse): When this button is lit, 
effect execution runs from the last 
keyframe to the first keyframe.

Pressing one of these buttons automatically 
turns the other off.
NORM/REV (normal/reverse): Press this 

button, turning it on, to reverse the 
direction of the effect when it reaches 
the last keyframe or first keyframe.

i STOP NEXT KF (stop next 
keyframe) button

When this button is pressed, turning it on, 
the effect execution range is from the 
current time to the next keyframe.
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j EFF LOOP (effect loop) button
When the effect reaches the last keyframe 
with this button on, it returns to the first 
keyframe and repeats.

k AUTO INS (auto insert) button
When editing a macro, press this button, 
turning it on, to enable the auto insert 
function, so that every control panel 
operation you carry out is added to the 
macro as an event.

Numeric Keypad Control Block

The numeric keypad control block is used 
for region selection, for saving and 
recalling snapshots, effects and shotboxes, 

for entering numeric values for trackball 
operation and keyframe operation, and for 
transition rate entry.

a Mode selection buttons
EFF (effect): Press to save or recall an 

effect.
SNAPSHOT: Press to save or recall a 

snapshot.

SHOTBOX: Press to save or recall a 
shotbox.

MCRO (macro): Press to save, recall or 
edit a macro.

TRANS RATE (transition rate): Press to 
set the transition rate. 

1 Mode selection buttons 5 Display

2 Region selection buttons

3 Function selection buttons

4 Numeric keypad
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Hold down this button, and press one of 
the key delegation buttons [KEY1] to 
[KEY4] in the transition control block 
to set an independent key transition 
rate.

b Region selection buttons
These select the functional block (“region”) 
of the control panel to which operations 
apply.
You can select more than one region at the 
same time.
The first button you press is taken as the 
reference region, and lights green, while the 
next pressed button lights amber.
With the exception of the [MASTER] and 
[ALL] buttons, you can change the region 
assignment to the buttons as desired in the 
Setup menu.
MASTR: Press this, turning it on, to save 

region information in a master 
snapshot register or master timeline 
register, or to recall such region 
information.

ALL: Select all regions. When any region 
is already selected, pressing this button 
makes all regions unselected.

M/E 1 to M/E 3, P/P: Select the 
corresponding regions, M/E-1, M/E-2, 
M/E-3, and PGM/PST.

USER 1 to USER 8: Select a User region.
DME1, DME2, and DME5 to DME8: 

Select a DME channel.
P-Bus: Select the P-Bus region.
GPI: Select the GPI region.
RTR: Select the router region.
DEV1 to DEV12: Select the Device 1 to 

Device 12 regions respectively.
MCRO: Select the macro region.

c Function selection buttons
UNDO: After recalling a register, press this 

button to return to the state before 
recalling the register.

STORE STATS (store status): This lights 
amber when data is stored in a register. 

After saving data to a register, hold 
down this button and press the 
[UNDO] button to return the register to 
the state before the data was saved.

TC (timecode): Press this button, turning it 
on, to switch transition rate entry to the 
timecode entry mode.

STORE: Press this button to switch to the 
mode for saving a snapshot, effect, 
shotbox or macro in a register.

RCALL (recall): Press this button to 
switch to the mode for recalling a 
snapshot, effect, shotbox or macro  
from a register.

[STORE] button or [RCALL] button 
flashes amber when one or more of the 
regions assigned to the Region selection 
buttons are not selected by the Region 
Select menu.

d Numeric keypad
In addition to the buttons for numeric input, 
this includes buttons for adding attributes to 
snapshots.
0 to 9: Used to input numeric digits.
. (period): Enters the decimal point.

When the [TRANS RATE] button is lit, 
enters “00.” When the [EFF] button, 
[SNAPSHOT] button or [SHOTBOX] 
button is lit, this is used to find an 
empty register.

+/–/ EFF DISS (effect dissolve): Invert the 
sign, negative or positive.
When the [SNAPSHOT] button is lit, 
applies the effect dissolve attribute to a 
snapshot.

CLR/AUTO TRANS (clear/auto 
transition): Clear an input value, 
returning to the previous state.
When the [SNAPSHOT] button is lit, 
applies the auto transition attribute to a 
snapshot.

TRIM/GPI ENBL (enable): After 
entering a difference value to be added 
to an existing setting, press this button 
to confirm the change.
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ENTER: Confirm an entered value. e Display
This shows the selected region name and 
entered numeric values.

Fade to Black Control Block

a FTB (fade to black) button
Press this button to fade to black the 
program output of the PGM/PST bank, at 
the set transition rate. You can set the fade 
to black transition rate in the menu.

b Preview selection buttons
Press one of these buttons to select a signal 
on the edit preview bus. Each button can be 
assigned to any preview output in setup (see 
Chapter 19 “Overall Control Panel 
Settings (Config Menu)” (Volume 3)).
PST (preset): When this button is pressed, 

the signal selected on the background B 
row of the PGM/PST bank is selected 
on the edit preview bus.

M/E 1 to M/E 3, P/P (M/E1 to M/E 3, P/P 
preview): The preview signal (M/E-1 
PVW, M/E-2 PVW, M/E-3 PVW, P/P 

PVW) of the M/E or PGM/PST bank 
corresponding to the pressed button is 
selected on the edit preview bus.

M/E1 K to M/E3 K, P/P K (M/E1 to M/E 
3, P/P key preview): The key preview 
signal (M/E-1 K-PVW, M/E-2 K-
PVW, M/E-3 K-PVW, P/P K-PVW) of 
the M/E or PGM/PST bank 
corresponding to the pressed button is 
selected on the edit preview bus.

DME V (DME monitor video): When this 
button is pressed, the DME monitor 
output video signal (DME MON V) is 
selected on the edit preview bus.

DME K (DME monitor key): When this 
button is pressed, the DME monitor 
output key signal (DME MON K) is 
selected on the edit preview bus.

AUTO PST P/P

FTB

DME
K

DME
V

M/E
3

M/E
2

M/E
1

M/E
3K

M/E
2K

M/E
IK

P/P
K

3 AUTO button 1 FTB button 2 Preview selection buttons
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c AUTO button
When this button is pressed, the M/E or 
PGM/PST bank preview signal selected on 

the edit preview bus is automatically 
switched to the program signal depending 
on the on-air status.

Auxiliary Bus Control Block (for AUX Buses)

There are also models without the selected 
source name displays and source name 
displays shown in the following figure.

All operations except those of the [DEST] 
button and [SHIFT] button are the same as 
for a model with selected source name 
displays and source name displays.
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a AUX delegation buttons
Press one of these buttons, turning it on, to 
select the bus to which to assign the cross-
point buttons in the auxiliary bus control 
block. 

For buses that can be selected, see “Bus 
Selection” (page 136).

b Selected source name displays
These show the name of the currently 
selected signal (source) on the bus 
corresponding to the delegation button.

c DEST (destination) button
Press this button, turning it on, to display 
the names of buses allocated to the 
delegation buttons in the selection source 
name displays.
In the case of a module without selected 
source name displays, this button is invalid.

d Selected bus display
This shows the name of the bus selected by 
the auxiliary bus delegation buttons.

e Cross-point buttons
The cross-points in the auxiliary bus control 
block are arranged in two rows: an upper 
row (1st row) and a lower row (2nd row), 
and are allocated to the buses selected with 
the AUX delegation buttons. The 1st row 
contains the cross-point buttons for 
unshifted buses, and the 2nd row contains 
the cross-point buttons for shifted buses.
When the DME 1V/K to 8V/K buses are 
selected with the AUX delegation buttons, 
the 1st row cross-point buttons are for the 
currently showing side of DME, and the 
2nd row are for the reverse side.
By holding down the [2ND] button and 
making an AUX delegation selection, you 
can allocate the 2nd row to a different bus 
from the 1st row.
In this case, if the 32nd button is set to be a 
[SHIFT] button (in a 32-button system), the 

cross-point buttons switch to the shifted 
allocation while the [SHIFT] button is 
enabled.

f XPT HOLD (cross-point hold) 
buttons

Press one of these buttons, turning it on, to 
enable cross-point hold.

g KEY button
While this button is held down, you can use 
the cross-point row of buttons to select key 
signals.

h 2ND button
After selecting a bus with an AUX 
delegation button, hold down this button, 
and select another AUX delegation, thus 
allocating a different bus in the 2nd row 
from the 1st row.

i Source name displays
These show the names of the source signals 
which can be selected by the cross-point 
buttons. While the [SHIFT] button is 
enabled, the shifted signal name is 
displayed. If a different bus is allocated to 
the 2nd row, while the [2ND] button is held 
down, the 2nd row signal name is 
displayed.
While the [KEY] button is held down, the 
source name of the key signal assigned to 
the cross-point buttons appears.

j SHIFT button
While this button is enabled, the shifted 
signal names appear in the source name 
display. Pressing this buttons toggles the 
source name display between the shifted 
signal names and unshifted signal names.
In the case of a module without source 
name displays, this button is invalid.
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k RTR (router) button
Press this button, turning it on, to assign the 
auxiliary bus control block to router 
control.

For details of the names and functions of 
parts for router control, see the next 
section.

l Level selection buttons
Used when the auxiliary bus control block 
is carrying out router control.
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Auxiliary Bus Control Block (for Router Control)

Press the [RTR] button, turning it on, to 
assign the auxiliary bus control block to 
router control.

a Destination selection buttons
Press a button, turning it on, to select the 
destination to which the router source is 
assigned.
The button pressed to assign a destination 
to a source selection button in the 1st row 
lights amber. When another button is 
pressed to assign a different destination to a 

source selection button in the 2nd row, it 
lights green.

b Selected source name displays
These show the source name selected for 
the destination.
If the source names and destination names 
are set in the Setup menu to “SW’er Local” 
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1 Destination selection buttons

2 Selected source name displays

3 DEST button

4 Selected destination display

5 Source selection 
button rows

6 XPT HOLD buttons

7 KEY button

qs Level selection buttons

qa RTR button

0 SHIFT button
9 Source name displays

8 2ND button

2nd

1st
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mode, then the description names appear 
here.

c DEST (destination) button
Press this button, turning it on, to display 
the names of the destinations assigned to 
the destination selection buttons in the 
selected source name displays.

d Selected destination display
This shows the name of the destination 
selected by the destination selection 
buttons. If a protected destination is 
selected, the indication “PROTECT” 
appears.

e Source selection button rows
The destination selected with a destination 
selection button is assigned to a source 
selection button. Press a source selection 
button to select a source. The 1st row of 
buttons are source selection buttons for the 
unshifted destinations, and the 2nd row are 
shifted source selection buttons. By holding 
down the [2ND] button, and selecting a 
destination, you can assign a different 
destination from the 1st row to the 2nd row. 
In the 1st row, the button to which a 
destination is assigned lights amber. If a 
different destination is assigned to a button 
in the 2nd row, the button lights green.
When the 32nd button is set as a [SHIFT] 
button (in a 32-button system), while the 
[SHIFT] button is active, these switch to the 
shifted source selection buttons. By using 
the [KEY] button, you can expand the 
source selection as follows.

f XPT HOLD (cross-point hold) 
buttons

Not used in router control mode.

g KEY button
When this button is enabled by a setting in 
the Setup menu, by holding it down during 
a source selection you can expand the 
function of the [SHIFT] button. (See 
“Cross-Point Settings (Xpt Assign Menu)” 
in Chapter 19 (Volume 3).)

h 2ND button
After selecting a destination with the 
destination selection buttons, hold down 
this button and make another destination 
selection to assign a different destination 
from the 1st row to the 2nd row.

i Source name displays
These display the names of signals 
(sources) that can be selected with the 
cross-point buttons. While the [SHIFT] 
button is active, the shifted signal names 
appear. While the [KEY] button is held 
down, the expanded signal names appear.
When a different destination is assigned to 
the 2nd row, the 2nd row signal names 

Source 
selection

[SHIFT] [KEY] Selection 
operation

1 to 31 Off Off Press the source 
selection button.

32 to 62 On Off Press the 
[SHIFT] button, 
then press the 
source selection 
button.

63 to 93 Off On Hold down the 
[KEY] button, 
and press the 
source selection 
button.

94 to 124 On On Hold down the 
[KEY] button, 
and press the 
[SHIFT] button, 
turning it on (the 
[SHIFT] button 
locks here, even 
when in Hold 
mode), then 
press the source 
selection button.

Source 
selection

[SHIFT] [KEY] Selection 
operation
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appear only while the [2ND] button is held 
down.

j SHIFT button
While this button is active, the source name 
displays show the shifted signal names. 
Press this button to toggle between the 
shifted and unshifted states.

k RTR (router) button
Press this button, turning it on, to assign the 
auxiliary bus control block to router 
control.

l Level selection buttons
To each of the four buttons, plural S-Bus 
levels are assigned in the Setup menu. Press 
a button, turning it on, to make operations 
apply to those S-Bus levels.
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Menu Control Block

a Top menu selection buttons
These select the menu appearing in the 
menu display.
It is also possible to change the assignment 
of these buttons in setup.

For details, see “Overall Control Panel 
Settings (Config Menu)” in Chapter 19 
(Volume 3).

b Menu display
This shows the menu currently in use.

c Knobs
These adjust the parameter values 
appearing in the menu.

d User preference buttons
These recall the functions or menus 
assigned to them in the Setup menu.
In the default setup, nothing is assigned to 
the [PREFS 1] to [PREFS 8] buttons.
It is also possible to change the assignment 
of these buttons in setup.

For details, see “Overall Control Panel 
Settings (Config Menu)” in Chapter 19 
(Volume 3).
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Memory Card/USB Adaptor Block

a Memory card slot
This slot accepts a PCMCIA Type II 
compliant memory card. You can use it in 
software installation, and for saving and 
reading in data, such as snapshot, keyframe, 
effect, and setup data.

b DEVICE connectors
There are three USB connectors. 
You can connect a device such as a mouse, 
keyboard, USB storage, and so on, that is 
equipped with a USB interface to any of 
these connectors.

For details on the devices that can be 
connected, consult your Sony 
representative.

1 Memory card slot 2 DEVICE connectors
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“Memory Stick”/USB Connections Block

a “Memory Stick” status indicator
Lights in red during access to a “Memory 
Stick.”

Note
Do not power the unit off or remove a 
“Memory Stick” when the “Memory Stick” 
status indicator is lit.

b “Memory Stick” slot
Insert “Memory Sticks.” You can use it in 
software installation, and for saving and 
reading data, such as snapshot, keyframe, 
effect, and setup data.

See the next item, “Memory Sticks” for 
more information about the usable 
“Memory Sticks” and their handling.

c DEVICE connectors
There are three USB connectors.
You can connect a device such as a mouse, 
keyboard, USB storage, and so on, that is 
equipped with a USB interface to any of 
these connectors.

For details on the devices that can be 
connected, consult your Sony 
representative.

About “Memory Sticks”

Usable “Memory Sticks”
This unit has been confirmed to operate 
with those of the following “Memory 
Sticks” that have a capacity of 8 GB 
(gigabytes) or less. However, operation 
with all “Memory Sticks” is not guaranteed.
• “Memory Stick”

1 “Memory Stick” status indicator

2 “Memory Stick” slot

3 DEVICE connectors
Names and Functions of Parts of the Control Panel



  C
hapter 2 

M
enus and C

ontrol P
anel
• “Memory Stick PRO”
• “Memory Stick Duo”
• “Memory Stick PRO Duo”

Notes
• When using a “Memory Stick PRO,” 

high-rate data transfer using parallel 
interface is not supported.

• A “MagicGate Memory Stick” can also 
be used, but this system does not support 
the MagicGate function.

• When using a “Memory Stick Duo,” be 
sure to use it with a “Memory Stick Duo 
Adaptor” (MSAC-M2 or equivalent). If 
you insert a “Memory Stick Duo” 
without using the adaptor, there is the 
possibility that the stick cannot be 
removed, resulting in a serious accident.

Handling “Memory Sticks”
When using “Memory Sticks,” pay 
attention to the following points.
• Do not touch the connector of the 

“Memory Stick” with anything, including 
your finger or metallic objects.

• Do not attach anything other than the 
supplied label to the “Memory Stick” 
labeling position.

• Attach the label so that it does not stick 
out beyond the labeling position.

• Carry and store the “Memory Stick” in its 
case.

• Do not strike, bend, or drop the “Memory 
Stick.”

• Do not disassemble or modify the 
“Memory Stick.”

• Do not allow the “Memory Stick” to get 
wet.

• Do not use or store the “Memory Stick” 
in a location that is:
– Extremely hot, such as in a car parked 

in the sun
– Under direct sunlight
– Very humid or subject to corrosive 

substances
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Utility/Shotbox Control Block

a Bank selection buttons
Press any of the [BANK1] to [BANK4] 
buttons to select a bank of 24 memory recall 
buttons. The selected button lights amber.

b Memory recall buttons
You can use these buttons to recall 
frequently used menus, utility functions, 
shotbox registers, or macro registers that 
you have assigned.
When a utility function is allocated to a 
button, the button lights orange (or green 
depending on the status), and the allocated 
function name appears. Pressing the button 
executes the allocated function. When the 
function constitutes a switching on/off 
operation, the button lights green; 
otherwise, it only momentarily lights green.
When a shotbox register or macro register 
recall is assigned to a button, the button 
lights orange, and the assigned register 
name appears. (If the register is empty, the 

button goes off.) In the case of a shotbox 
function, pressing the button executes the 
assigned shotbox function, and the button 
lights yellow. In the case of a macro 
register, pressing the button executes the 
assigned macro, and the button flashes 
yellow.

1
BANK

1 2 3 4

7
BANK

2

BANK
3

BANK
4

5 6

8 9 10 11 12

13 14 15 16 17 18

19 20 21 22 23 24

1 Bank selection buttons

2 Memory recall buttons
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Transition Control Block and Flexi Pad Control Block 
(Simple Type)

The simple versions of the transition 
control block and Flexi Pad control block 
shown in the following figure is designed to 
allow simplified operations than with the 
standard type. The transitions carried out 
using these simple-type control blocks are 
also referred to as “simple transitions” in 
this User’s guide.
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KEY1

NORM
/REV

REV

KEY2

LIMIT
SET

PTN
LIMIT

TAKE

WIPE

DME

SNAP
SHOT

UNDO

MIX

NAM

WIPE

DME

ON
OVER

ON
OVER

1 2

3 4

5 6

XPT HOLD
A B U1 U2 1 2 3 4

7 8

2 Key transition selection buttons

6 Key status display

1 Transition type selection buttons

3 Transition execution section

5 Pattern limit buttons

4 Wipe direction selection buttons

qa Numeric display

0 XPT HOLD status display 

7 Mode selection buttons

9 UNDO button

8 Memory recall section 

Shown above is the right-hand type transition control block (with the right-hand fader lever).
Names and Functions of Parts of the Control Panel



  C
hapter 2 

M
enus and C

ontrol P
anel
Transition Control Block and Flexi Pad Control Block (with INH 
button)

a Transition type selection buttons
You can assign these buttons in setup to any 
transition type (see “Overall Control Panel 
Settings (Config Menu)” in Chapter 19 
(Volume 3)). Press any of the following 
buttons, turning it on, to select the transition 
type.
Press one of these buttons, turning it on, to 
determine the type of the next transition for 
a background.
To select the key transition type, hold down 
the [KEY1] or [KEY2] button, and press 
one of the following buttons, turning it on.
When multi-program mode is selected in 
the Setup menu (see “Settings for Switcher 
Configuration (Config Menu)” in Chapter 
20 (Volume 3)), two or more of the 
following buttons may light.

You can also assign a function to these 
buttons to select whether or not the fader 
levers are used as key frame faders.
MIX: In a background transition, the new 

video fades in as the current video 
fades out. During the transition, the 
overall signal level is maintained at 
100%.
In a key transition, the key fades in (for 
insertion) or out (for removal).

NAM (non-additive mix): The current and 
new video signals are compared, and 
the signal with the higher luminance 
level is given priority in the output.
The current video is maintained at 
100% output for the first half of the 
transition as the new video increases 
progressively to 100%, then the current 
video is progressively reduced from 

INH

WIPE

DME

SNAP
SHOT

LIMIT
SET

PIN
LIMIT

NORM
/REV

REV

UNDO

MIX

NAM

WIPE

DME

TAKE

XPT HOLD

A B U1 U2 1 2 3 4

qs INH button

Memory recall section

UNDO button
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100% to zero in the second half while 
the new video is maintained at 100%.

WIPE: The current video is replaced by the 
new video, using the wipe pattern 
selected in the Wipe menu.

DME: This applies a wipe-like transition, 
using the DME effect selected in the 
DME Wipe menu.

FM1&2CLIP, FM3&4CLIP, 
FM5&6CLIP, FM7&8CLIP: A 
recorded clip is played back together 
with the transition. At this point, you 
can also carry out a background 
transition (wipe or mix (dissolve)) 
simultaneously together with the clip.

KF (key frame): Press this button, turning 
it on, to enable using the fader lever as 
a key frame fader.

b Key transition selection buttons
To insert or delete key 1 on the next 
transition, hold down the [KEY1] button, 
and select the type of transition using the 
transition type selection buttons. If the key 
is currently not inserted, the transition will 
insert it, and if the key is currently inserted, 
the transition will delete it. You can use the 
[KEY2] button in a similar way.
While these buttons are held down, you can 
select a key source with the cross-point 
buttons on the key bus.
Pressing one of these buttons twice in rapid 
succession changes the state of the 
corresponding key bus so that a cross-point 
can be selected.

a) The key bus switching button [KEY3] in the cross-
point control block goes off.

b) The key bus switching button [KEY4] in the cross-
point control block goes off.

c Transition execution section
Fader lever: Move this vertically to carry 

out a transition.
When the [KF] button or a transition 
type selection button to which the KF 
button function has been assigned is lit, 
you can use this as a key frame fader.
When the split fader function is 
enabled, by pressing the projection on 
the left side of the grip you can release 
the lock and separate the two halves of 
the fader lever. With the split fader 
lever, in a background mix transition, 
you can control the background A and 
B buses independently.

Transition indicator: This comprises 
multiple LEDs, which show the 
progress of the transition.

Transition rate display: This displays the 
transition rate (the time from the 
beginning of the transition to its 
completion) set for an auto transition, 
in frames.
You can set the transition rate using the 
numeric keypad control block or menu.

TAKE button: Pressing this button carries 
out an auto transition of the set 
transition rate. The transition starts 
immediately, and the button lights 
amber. When the transition completes, 
the button goes off.

d Wipe direction selection buttons

For details, see “Wipe direction selection 
buttons” (page 49).

e Pattern limit buttons
LIMIT SET: Move the fader lever to the 

position of a particular pattern size, and 
stop it there, then press this button to 
set the pattern limit range. This button 
is enabled when the [PTN LIMIT] 
button is off.

PTN (pattern) LIMIT: When a wipe or 
DME wipe is selected, pressing this 

Key delegation button 
(double press)

Corresponding 
key bus

[KEY1] key 1 a)

[KEY2] key 2 b)
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button, turning it on, enables the 
pattern limit function.

f Key status display
For each of keys 1 and 2, when the key is 
inserted, the corresponding ON indicator 
lights. The OVER indicators show the 
priority between keys 1 and 2, by lighting 
when the corresponding key is on top. For 
example, when key 1 appears over key 2 on 
the program monitor, the OVER indicator 
for key 1 lights.

The following is the Flexi Pad control 
block.

g Mode selection buttons
WIPE: When saving or recalling a wipe 

snapshot, use this in combination with 
the buttons of the memory recall 
section.

DME: When saving or recalling a DME 
wipe snapshot, use this in combination 
with the buttons of the memory recall 
section.

SNAPSHOT: When saving or recalling a 
snapshot, use this in combination with 
the buttons of the memory recall 
section.

h Memory recall section
This consists of eight buttons with LCDs, 
whose display changes according to the 
operation mode. Use these in combination 
with the mode selection buttons to save or 
recall wipe snapshots, DME wipe 
snapshots, or snapshots.

i UNDO button
After recalling a register, press this button 
to return to the state before recalling the 
register.
With a setup setting, this can be switched to 
a mode selection button for macro setting, 
and used in combination with the buttons in 

the memory recall section for recalling and 
executing a macro.

j XPT HOLD (cross-point hold) status 
display

A bus for which cross-point hold is set 
appears as a green light.

k Numeric display
Depending on the operation mode, this 
shows a wipe or DME wipe pattern number, 
or a register number in up to four digits.
In macro mode, this provides indications 
for macro editing.

l INH (inhibit) button
Pressing this button, turning it on, disables 
the buttons in the memory recall section 
and the [UNDO] button. 
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Independent Key Transition Control Block (Simple 
Type)

The left side of this control block controls 
key 3, and the right side controls key 4.
The control block for key 3 only is 
described as an example, but the operations 
on the key 4 control block are the same.

In setup you can assign any key to either 
side of this control block. For details, see 
“Assigning Keys to the Independent Key 
Transition Control Block (Simple Type)” in 
Chapter 19 (Volume 3).

a Independent key transition type 
selection buttons

Press one of the following buttons, turning 
it on, to select the independent key 
transition type.
MIX: Faded in or out.
WIPE: Inserted or deleted with a wipe.
DME: Switches the key with a DME wipe.
CUT: Inserted or deleted instantaneously.

SHIFT: This has the following functions.
• When setting is made in the Setup 

menu to allow a different transition 
type for inserting or deleting a key, it 
is possible to display and set the 
transition type after the next 
transition while this button is held 
down.

K-SS WIPE DME

SHIFT MIX CUT

KEY3
ON

TAKE

K-SS WIPE DME

SHIFT MIX CUT

KEY4
ON

TAKE

3 K-SS button

4 Key source name display/key snapshot buttons

1 Independent key transition type selection buttons

2 Independent key transition execution section
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• While this button is held down, you 
can select a key source with the 
cross-point buttons for the key bus.

• If you press this button twice in rapid 
succession, the key bus selection 
button [KEY3] in the cross-point 
control block lights, and a key 3 key 
bus cross-point can be selected.

• If you press this button, while 
holding down [TRANS RATE] 
button in the numeric keypad control 
block, you can set the independent 
key transition rate on the control 
block.

b Independent key transition 
execution section

KEY3 ON button: This inserts or deletes 
key 3 instantaneously. When key 3 is 
present in the final program output 
from the switcher, this lights red, and 
otherwise lights amber.

TAKE button: This carries out an auto 
transition on key 3.

c K-SS (key snapshot) button
This enables key snapshot mode. In key 
snapshot mode, it is possible to save and 
recall key snapshots.

d Key source name display/key 
snapshot buttons

These show the signal name of the key fill 
selected for key 3 and the transition rate on 
two buttons. In key snapshot mode, these 
correspond to registers 1 and 2 for key 3; 
press to save or recall a key snapshot.
To save a key snapshot, with the [K-SS] 
button lit amber, hold down [SHIFT] button 
and press one of the key snapshot buttons.
This saves a key snapshot in the button you 
pressed, which lights yellow.
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Downstream Key Control Block

a Key delegation buttons
Press one of the [DSK1] to [DSK4] buttons 
to delegate this control block to the 
corresponding keyer.
Using the Setup menu, it is possible to 
delegate this control block to key 1 to key 4 
of the M/E bank.
While these buttons are held down, you can 
select a key source with the cross-point 
buttons for the key bus.
Pressing one of these buttons twice in rapid 
succession changes its state so that you can 
make cross-point selections on the 
corresponding key bus.

b Independent key transition type 
selection buttons

Press one of these buttons, turning it on, to 
select the downstream key transition type.
MIX: Carry out a dissolve with the key 

selected with the key delegation 
buttons.

WIPE: Carry out a wipe with the key 
selected with the key delegation 
buttons.

DME: This switches the key selected with 
the key delegation buttons, using a 
DME wipe.

CUT: Instantaneously insert or delete the 
key selected with the key delegation 
buttons.

DSK1 DSK2 WIPEUNDO

DSK3 DSK4 SHIFT MIX

K-SS

CUT

DME

K-SS
STORE

DSK1
ON

DSK2
ON

DSK3
ON

DSK4
ON

TAKETAKETAKETAKE

1 Key delegation buttons

5 Key source name display/key snapshot
buttons

4 Key snapshot setting
buttons

3 Independent key transition execution section

2 Independent key transition type 
selection buttons
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SHIFT: When setting is made in the Setup 
menu to allow a different transition 
type for inserting or deleting a key, it is 
possible to display and set the 
transition after the next transition while 
this button is held down.

c Independent key transition 
execution section

DSK1 (downstream key 1) ON to DSK4 
ON buttons: Press these to 
instantaneously cut the downstream 
keys 1, 2, 3, and 4 in or, when the 
downstream keys are already inserted, 
cut them out. When the key 
corresponding to the button appears in 
the final program output, the button 
lights red, and otherwise lights amber.

TAKE buttons: These correspond to 
downstream keys 1, 2, 3, and 4 from 
left to right; press to execute an auto 
transition. The transition starts 
immediately, and the button lights 
amber. When the transition completes, 
the button goes off.

Fader lever: Move this to carry out a 
manual downstream key transition.

Transition indicator: This comprises 
multiple LEDs, which show the 
progress of the downstream key 
transition.

d Key snapshot setting buttons
K-SS (key snapshot): This enables key 

snapshot mode.
K-SS STORE (key snapshot store): To 

save a key snapshot, hold down this 
button, and press the key source name 
display/key snapshot button for the 
register you want to save.

UNDO (key snapshot recall undo): This 
undoes the last key snapshot recall.

e Key source name display/key 
snapshot buttons

These display the selected source name for 
each corresponding keyer. In snapshot 
mode, they correspond to registers 1 to 4 of 
the selected keyer, and pressing the button 
saves or recalls a key snapshot.
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Downstream Key/Fade-to-Black Control Block

a Key delegation buttons
Press DSK1 or DSK2, to select the keyer. 
Each button can be assigned to any key in 
setup (see Chapter 19 “Overall Control 
Panel Settings (Config Menu)” (Volume 
3)).
While these buttons are held down, you can 
select a key source with the cross-point 
buttons on the key bus.
Pressing one of these buttons twice in rapid 
succession changes its state so that you can 
make cross-point selections on the 
corresponding key bus in the PGM/PST 
bank.

a) The key bus selection button [KEY3] in the P/P 
cross-point control block goes off.

b) The key bus selection button [KEY4] in the P/P 
cross-point control block goes off.

b Independent key transition 
execution section

DSK1 ON, DSK2 ON buttons: Press these 
to cut in the corresponding downstream 
key 1 or 2. When the key is already 
inserted, pressing the button cuts it out. 
Each button lights red when the 
corresponding key is inserted in the 
program output (final output from the 

AUTO PST P/P

FTB

DME
K

DME
V

M/E
3

M/E
2

M/E
1

M/E
3K

M/E
2K

M/E
IK

P/P
K

DSK1 K-SSDSK2

DSK2
ON

DSK1
ON

AUTO
TRANS

AUTO
TRANS

1 Key delegation 
buttons

2 Independent key 
transition 
execution section

3 K-SS button

4 Key source name display/key snapshot buttons

5 FTB button

6 AUTO button

7 Preview selection buttons

Key delegation button 
(double press)

Corresponding 
key bus

[DSK1] key 1 a)

[DSK2] key 2 b)

Key delegation button 
(double press)

Corresponding 
key bus
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switcher), and lights amber at other 
times.

AUTO TRANS buttons: The left button 
applies to DSK1 and the right button to 
DSK2; press these buttons to carry out 
an auto transition. The transition 
immediately starts, and the button 
lights amber. When the transition 
completes, the button goes off.

c K-SS (key snapshot) button
Pressing this button, turning it on, enables 
the key snapshot mode. In this mode, you 
can save and recall key snapshots.

d Key source name display/key 
snapshot buttons

Each column of two buttons relates to the 
corresponding downstream key 1 or 2. The 
upper button displays the name of the key 
fill signal selected for the key, and the 
lower button shows the transition rate.
In key snapshot mode, these buttons 
correspond to registers 1 to 4 of the keyer 
selected with the key delegation buttons, 
and pressing a button recalls the key 
snapshot. To save a key snapshot, hold 
down the [STORE] button in the numeric 
keypad control block, and press the button 
for the desired register.

e FTB (fade to black) button
Press this button to fade to black the 
program output of the PGM/PST bank, at 
the set transition rate. You can set the fade 
to black transition rate in the menu.

f AUTO button
When this button is pressed, the M/E or 
PGM/PST bank preview signal selected on 
the edit preview bus is automatically 
switched to the program signal depending 
on the on-air status.

g Preview selection buttons
Press one of these buttons to select a signal 
on the edit preview bus. Each button can be 
assigned to any preview output in setup (see 
Chapter 16 “Overall Control Panel 
Settings (Config Menu)” (Volume 2)).
PST (preset): When this button is pressed, 

the signal selected on the background B 
row of the PGM/PST bank is selected 
on the edit preview bus.

M/E 1 to M/E 3, P/P (M/E1 to M/E 3, P/P 
preview): The preview signal (M/E-1 
PVW, M/E-2 PVW, M/E-3 PVW, P/P 
PVW) of the M/E or PGM/PST bank 
corresponding to the pressed button is 
selected on the edit preview bus.

M/E1 K to M/E3 K, P/P K (M/E1 to M/E 
3, P/P key preview): The key preview 
signal (M/E-1 K-PVW, M/E-2 K-
PVW, M/E-3 K-PVW, P/P K-PVW) of 
the M/E or PGM/PST bank 
corresponding to the pressed button is 
selected on the edit preview bus.

DME V (DME monitor video): When this 
button is pressed, the DME monitor 
output video signal (DME MON V) is 
selected on the edit preview bus.

DME K (DME monitor key): When this 
button is pressed, the DME monitor 
output key signal (DME MON K) is 
selected on the edit preview bus.
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Transition Control Block (Compact Type)

The compact version of the transition 
control block shown in the following figure 
has fewer buttons than the standard type. 
Independent key transition operations can 

also be controlled with the compact 
transition control block.

a Next transition selection buttons
Press these buttons, turning them on, to 
determine what the next transition will 
apply to.
BKGD: Next transition changes the 

background.

KEY1 to KEY4 (DSK1 to DSK4 in the 
PGM/PST bank): Press this button, 
turning it on, to make the next 
transition insert or remove the 
corresponding key (keys 1 to 4). If a 
key is currently inserted it will be 

KEY1
TRANS

KEY2
TRANS

KEY3
TRANS

KEY4
TRANS

BKGD KEY1 KEY2 KEY3 KEY4

KEY
PRIOR MIX

ALL
PST

COLOR
MIX

NAM

WIPE

SUPER
MIX

DME

PRIOR
SET NORM

NORM
/REV REV

TRANS
PVW

AUTO
TRANS CUT

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

7 PRIOR SET button

1 Next transition selection buttons

6 Key status display

2 Transition type selection buttons

5 TRANS PVW button

3 Transition execution section

4 Wipe direction selection buttons

8 Independent key transition 
execution section
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removed, and if it is not currently 
inserted, it will be inserted.
In the PGM/PST bank, this inserts or 
removes downstream keys 1 to 4.

KEY PRIOR (priority): When this button 
is lit, the setting of the key priority after 
the next transition is enabled. The key 
priority after the next transition appears 
in the key status display.

ALL: Pressing this button turns on a 
preselected set of the [BKGD], [KEY1] 
to [KEY4], and [KEY PRIOR] buttons.
Make this setting in a Setup menu.

b Transition type selection buttons
You can assign these buttons in setup to any 
transition type (see “Overall Control Panel 
Settings (Config Menu)” in Chapter 19 
(Volume 3)).
Press one of these buttons, turning it on, to 
determine the type of the next transition.
When multi-program mode is selected in 
the Setup menu (see “Settings for Switcher 
Configuration (Config Menu)” in Chapter 
20 (Volume 3)), two or more of the 
following buttons may light.
You can also assign a function to these 
buttons to select whether or not the fader 
levers are used as keyframe faders.
MIX: In a background transition, the new 

video fades in as the current video 
fades out. During the transition, the 
overall signal level is maintained at 
100%.
In a key transition, the key fades in (for 
insertion) or out (for removal).

NAM (non-additive mix): The current and 
new video signals are compared, and 
the signal with the higher luminance 
level is given priority in the output.
The current video is maintained at 
100% output for the first half of the 
transition as the new video increases 
progressively to 100%, then the current 
video is progressively reduced from 

100% to zero in the second half while 
the new video is maintained at 100%.

SUPER MIX: The current video is 
maintained at 100% output for the first 
half of the transition as the new video is 
mixed while increasing progressively 
to 100%. The current video is then 
progressively reduced from 100% to 
zero in the second half while the new 
video is maintained at 100%.

PST (preset) COLOR MIX: In the first 
transition, the current video is replaced 
by the color matte in a mix (dissolve), 
then in the second transition the color 
matte is replaced by the new video also 
in a mix (dissolve).

WIPE: The current video is replaced by the 
new video, using the wipe pattern 
selected in the Wipe menu.

DME: A wipe type of transition is carried 
out, using the DME effect selected in 
the DME Wipe menu.

FM1&2CLIP, FM3&4CLIP, 
FM5&6CLIP, FM7&8CLIP: A 
recorded clip is played back together 
with the transition. At this point, you 
can also carry out a transition (wipe or 
mix (dissolve)) simultaneously 
together with the clip.

KF (key frame): Press this button, turning 
it on, to enable using the fader lever as 
a key frame fader.

c Transition execution section
Transition indicator: This comprises 

multiple LEDs, which show the 
progress of the transition.

Fader lever: Move this to carry out a 
manual transition. When the [KF] 
button or a transition type selection 
button to which the KF button function 
has been assigned is lit, you can use this 
as a key frame fader.

Transition rate display: This shows the 
“transition rate” (the time from the 
beginning of a transition to its 
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completion) set for an auto transition, 
in frames.
You can set the transition rate using the 
numeric keypad control block, Flexi 
Pad control block, or menu.

AUTO TRANS (transition) button: 
Pressing this button carries out an auto 
transition of the set transition rate 
(duration). The transition starts 
immediately, and the button lights 
amber. When the transition completes, 
the button goes off.

CUT button: Pressing this button carries 
out the transition as a cut (i.e. 
instantaneously).

d Wipe direction selection buttons

For details, see “Wipe direction selection 
buttons” (page 49).

e TRANS PVW (transition preview) 
button

When this button is lit, you can check in 
advance the video changes during the 
transition, on the preview output from the 
M/E or PGM/PST bank.
During the preview, you can use the fader 
lever, [AUTO TRANS] button, and [CUT] 
button. One of the following functions of 
this button can be selected in a Setup menu.
• When the transition completes, the 

system returns to the normal mode.
• The transition preview mode is 

maintained while this button is pressed.
• Switching is made between the transition 

preview mode and normal mode every 
time this button is pressed.

f Key status display
For each of keys 1 to 4, the corresponding 
ON indicator lights when the key is 
inserted. It also shows the priority (1 to 4) 
of each key.

g PRIOR (priority) SET button
While this button is held down, you can set 
the key priority.
The setting mode when this button is 
pressed depends on whether or not the 
[KEY PRIOR] button is lit, as follows.
• When the [KEY PRIOR] button is off, the 

current key priority is set.
• When the [KEY PRIOR] button is lit, the 

key priority after the next transition is set.
Press the [KEY PRIOR] button as required, 
to switch between these two modes.
In either mode, hold down the [PRIOR 
SET] button, and press the button ([KEY1] 
to [KEY4]) corresponding to the key you 
want to bring to the front.

h Independent key transition 
execution section

KEY1 TRANS (transition) to KEY4 
TRANS (DSK1 TRANS to DSK4 
TRANS in the PGM/PST block) 
buttons: Press the corresponding one 
of these buttons to cut key 1 to key 4 in 
or out automatically at the set transition 
rate. When the key corresponding to 
the button appears in the final program 
output, the button lights red, and 
otherwise lights amber. During a 
transition, the button lights green.

CCP-6224 2M/E Control Panel

In this system, you can use the built-in 
CCP-6224 2M/E Control Panel. This panel 
has two cross-point control blocks, two 

transition control blocks (compact type), 
one device control block (track ball), and 
one Multifunction Flexi Pad control block.
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a Cross-point control block

For details of cross-point control block 
operation, see “Cross-Point Control 
Block” (page 43) and “Cross-Point 
Control Block (CCP-6224/6324) in the 
AUX Operating Mode” (page 98).

For operations in AUX control mode, see 
“Auxiliary Bus Control Block (for AUX 
Buses)” (page 72).

b Transition control block (compact 
type)

For details of operations, see “Transition 
Control Block (Compact Type)” (page 94).

c Device control block (track ball)

For details of operations, see “Device 
Control Block (Trackball)” (page 58).

d Multifunction Flexi Pad control 
block

For details of operations, see 
“Multifunction Flexi Pad Control Block” 
(page 100).

CCP-6324 3M/E Control Panel 

In this system, you can use the built-in 
CCP-6324 3M/E Control Panel. This panel 
has three cross-point control blocks, three 
transition control blocks (compact type), 
one device control block (trackball), and 
one Multifunction Flexi Pad control block.

1 Cross-point control block 4Multifunction Flexi Pad 
control block

2Transition control block 
(compact type)

3Device control block 
(track ball)
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a Cross-point control block

For details of operations, see “Cross-Point 
Control Block” (page 43) and “CCP-6224 
2M/E Control Panel” (page 96).

b Transition control block (compact 
type)

For details of operations, see “Transition 
Control Block (Compact Type)” (page 94).

c Device control block (track ball)

For details of operations, see “Device 
Control Block (Trackball)” (page 58).

d Multifunction Flexi Pad control 
block

For details of operations, see 
“Multifunction Flexi Pad Control Block” 
(page 100).

Cross-Point Control Block (CCP-6224/6324) in the AUX 
Operating Mode

On the CCP-6224/6324, when using a [24-
column] cross-point control block, if the 
[PRE MCRO] button is assigned to switch 
to AUX operating mode, by pressing this 
button you can switch the control block 
button functions as follows, and select the 
AUX bus and its source signals (AUX 
panel-less function).

1 Cross-point control block
4Multifunction Flexi Pad 

control block

2Transition control block 
(compact type)

3Device control block 
(track ball)
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a AUX control block
This selects the AUX bus and the assigned 
source signals.
This cross-point control block can be 
switched to AUX control mode with the 
[AUX CTRL] button, and the key 1 row 
used as AUX delegation buttons, and the 
key 2 row used as AUX bus cross-point 
selection buttons, with the source name 
display showing the source names or the 
bus names (AUX panel-less function). To 
use this function, the function for switching 
to AUX control mode must first be assigned 
to the [PRE MCRO] and [POST MCRO] 
buttons. 

For the method of making this assignment, 
see Chapter 19 “Control Panel Setup 
(Panel)” (Volume 3).

AUX delegation buttons: These select the 
AUX bus. When you press a button, 
turning it on, this selects the assigned 
bus as the AUX bus. You can make the 
rightmost button a [SHIFT] button, in 
which case each button can be used to 
select two buses.

For details of the buses that can be 
selected, see “Bus Selection” (page 136).

AUX cross-point buttons: These select the 
source signal to be assigned to the 
AUX bus. When you press a button, 
turning it on, this selects the assigned 
video/key source signal and assigns it 
to the bus selected with the AUX 
delegation buttons. To select a key, 
hold down the [KEY] button and press 

M/E
1

M/E
1

SHIFT

SHIFT
XPT

HOLD

XPT
HOLD

PRE
MCRO

KEY3

KEY4

POST
MCRO

XPT
HOLD

XPT
HOLD UTIL

M/E
1

M/E
1

M/E
2

M/E
2

M/E
2

M/E
2

M/E
3

M/E
3

M/E
3

M/E
3

SHIFT

SHIFT

SHIFT

MCRO
ATTCH
ENBL

1 AUX control block 4KEY button

2AUX CTRL (AUX control) button

7Source/bus name displays

AUX CTRL (AUX control) button

AUX cross-point buttons

3DEST (destination) button

6A/B bus control block

5AUX DSPLY (AUX 
display) button
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the AUX cross-point button to which 
the desired key signal is assigned. You 
can make the rightmost button a 
[SHIFT] button, in which case each 
button can be used to select two video/
key source signals.
When one of the DME 1V/K to 4V/K 
buses is selected with the AUX 
delegation buttons, this selects the 
video side currently visible on the 
DME, and if you hold down 
[repeatedly press] the AUX delegation 
button, you can also select the reverse 
side of the video.

b AUX CTRL (AUX control) button
This switches the cross-point control block 
to the AUX operating mode. However, 
using this function requires an assignment 
to have been made in the Setup menu.

For details of assigning the function for 
switching to AUX operating mode, see 
“Assigning the AUX Bus Control Mode 
Switching Function” in Chapter 19 
(Volume 3).

c DEST (destination) button
When you press this button, turning it on, 
the source name displays show the names 
of the buses assigned to the AUX 
delegation buttons.

d KEY button
When you press this button, turning it on, 
the source name displays show the names 
of the key source signals assigned to the 
AUX cross-point buttons, and they are now 
selectable.

e AUX DSPLY (AUX display) button
This switches the source name displays to 
the AUX operating mode (by default 
showing the video source signal names).

f A/B bus control block
Select the source signals for the background 
A/B buses.

g Source/bus name displays
In the AUX operating mode, these show the 
information in the following table, 
according to the states of the [AUX 
DSPLY], [DEST], and [KEY] buttons.

Multifunction Flexi Pad Control Block

You can use the Multifunction Flexi Pad 
control block for creating, saving, and 
recalling snapshots, wipe snapshots, and 
DME wipe snapshot key snapshots, effects, 
shot box recall, macro execution, transition 
rate settings, and key adjustments.

[AUX 
DSPLY]

[DEST] [KEY] Indication

Off Off Off Background A/B 
bus source signal 
names

On Off Off Video source 
signal names for 
AUX bus

On On Off Bus names for 
AUX bus

On Off On Key source signal 
names for AUX 
bus
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a Mode selection buttons
EFF (effect): Press this to carry out effect 

creation/recall/editing/execution/
deletion.

SNAPSHOT: Press this to carry out 
snapshot creation/recall/editing/
deletion.

SHOTBOX: Press this to carry out shot 
box creation/recall/editing/execution/
deletion.

MCRO (macro): Press this to carry out 
macro creation/editing/execution/
deletion.

WIPE (wipe snapshot): Press this to carry 
out wipe snapshot creation/recall/
deletion and wipe adjustments.

DME WIPE (DME wipe snapshot): Press 
this to carry out DME wipe snapshot 
creation/recall/deletion and DME wipe 
adjustments.

TRANS RATE (transition rate): Press 
this to set the transition rate.

KEY ADJ (key adjust): Press this to carry 
out key adjustments and set modifiers.

KEY SS (key snapshot): Press this to carry 
out key snapshot creation/recall/
deletion. By default, this is not 
assigned to a mode selection button, so 
before use it is necessary to assign to a 
mode selection button in the Setup 
menu.

b EDIT ENBL (edit enable) button
By pressing this, turning it on, you can 
carry out the following operations.
• Effect creation/editing
• Snapshot attribute setting
• Shot box creation/editing
• Macro creation/editing
• Wipe adjustments

7 +/-

4 CLR

1 TRIM

ENTR0

8 9

5 6

2 3

.

SHOT
BOX

SNAP
SHOT

TRANS
RATE

EDIT
ENBL

DME
WIPE

KEY
ADJ

MCRO

EFF

WIPE

DME
1

DME
2ALL

P/P
M/E

2

DEV
1

USER
4 MORE

M/E
1

1Mode selection 
buttons

2EDIT ENBL button

3Region selection 
buttons

4Alphanumeric display

5Memory recall section

6Adjustment knob displays

7Adjustment knobs
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• DME wipe adjustments

c Region selection buttons
These select the function block to which 
operations apply.
When the mode selection button selection is 
EFF/SNAPSHOT/SHOT BOX/MCRO, 
you can select multiple region selection 
buttons simultaneously. In this case, the 
first button pressed lights green as the 
reference region, and the other buttons 
pressed light amber (the buttons for the 
regions shown in the memory recall section 
are yellow).
ALL: Selects all regions. When any region 

is selected, press this button to unset 
the selection of all regions.

DME1 to DME2: Select DME channels.
M/E1, M/E2, P/P: Select the M/E-1, M/E-

2, and PGM/PST regions respectively.
USER4: Selects the USER4 region.
DEV1: Selects the device 1 region.
MORE: Displays buttons in the memory 

recall section for regions not assigned 
to a region selection button, so that they 
can be selected. By default the 
following regions are shown on the 
memory recall section buttons.

MSTR (master snapshot, master 
timeline registers), USER1 to 3, 
USER5 to 8, MCRO (macro), 
DEV2 (device 2), PBUS, GPI, 
RTR(router)

To revert the button displays in the 
memory recall section, press the 
[MORE] button once more, or press the 
[EXIT] button that appears in the 
memory recall section.
Note that except for the [ALL], 
[EXIT], and [MORE] buttons, you can 
freely change the assignment to regions 
in the Setup menu.

d Alphanumeric display
This shows the selected region name or 
register number, and entered numeric 
values.

e Memory recall section
This comprises 16 LCD buttons, each with 
a display that changes according to the 
operating mode.

f Adjustment knob displays
Each of these shows the initial letter of the 
parameter that can be adjusted with the 
knob to the right, and the setting value 
(three digit places, including the minus 
sign).

g Adjustment knobs
Use these to adjust the parameters selected 
with the memory recall section buttons.
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Basic Menu Operations

Menu Organization

Operations on the MVS-6000 switcher 
system make frequent use of menu 
operations.
This section describes the menus and their 
interrelationships.
If you display the menus in an external 
monitor, operated with a mouse, the method 
of operation is basically the same, but with 
mouse clicks in place of button presses. 
There is no difference in the menu control 
block operation described here. However, 
since the monitor has no knobs for 
adjusting the parameters in the menu 
control block, for details of operations 
corresponding to these knob operations, see 
the section below, “Operation With a 
Mouse” (page 121).

Overview
All detailed settings for basic operations 
such as transitions, keys, DME, or wipes, 
are made in menus. There are also menus 
for carrying out general system control, 
managing setting data, and initial setup.

About the Top Menu List

When the control panel is powered on, the 
top menu list appears as shown below.
You can also display this by selecting VF1 
‘Top Menu List’ after pressing the [HOME] 
button at the upper left in the top menu 
selection button area of the menu control 
block.

To display the top menu
In the same way as for the top menu 
selection buttons in the menu control block, 
press each button to display the particular 
top menu in the menu display.
The top menu list button is the same as the 
default layout of the top menu selection 
buttons. However, even if the assignment of 
the top menu selection buttons is changed, 
this does not affect the top menu list.

To shut down the menus
Press the [Shutdown] button at the lower 
right.
This operation is the same as the shut down 
operation in the top menu window.

For details, see “Shutting down the menus” 
(page 125).
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Accessing Menus

You can use any of the following methods 
to access a menu, and the initially displayed 
menu page depends on the method used.
• Pressing a top menu selection button in 

the menu control block.
This displays the page you last accessed 
in the particular menu. After initially 
powering on the system, however, the 
page of VF1 - HF1 of the particular menu 
is always selected.

• Pressing a button other than a top menu 
button twice in rapid succession (see 
page 106).
Depending on the button, this may 
display a fixed page or the page selected 
last time you accessed the menu.

• Press the menu page selection button at 
the top left of the menu display.
The top menu window appears; press the 
top menu selection button for the 
particular menu, or enter the menu 
number with the numeric keypad, and 
press the Enter button.

For details of the VF buttons and HF 
buttons, see “Interpreting the Menu 
Screen” (page 113).
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Menus accessed from a top menu selection button

Buttons Menus Function See

HOME Home Recalling menus using the top 
menu list or shortcut menu

Top menu list: page 103 
Shortcut menu: page 127

M/E 1 M/E-1 Transition, keys, and wipe 
settings for the M/E-1 bank

page 156 (transitions), page 
198 (keys), page 267 (wipes)

M/E 2 M/E-2 Transition, keys, and wipe 
settings for the M/E-2 bank

P/P PGM/PST Transition, downstream key, and 
wipe settings for the PGM/PST 
bank

FRAME 
MEM

Frame Memory Frame memory settings page 341

COLOR 
BKGD

Color Bkgd Color background settings page 390

AUX/MON Aux/Mon AUX bus settings page 406

CCR CCR Color corrector settings page 413

COPY 
SWAP

Copy/Swap Copy and swap settings page 394

MISC Misc Safe title settings page 403

STATS Status Status display page 407

DME DME DME special effect settings Chapter 11 (Volume 2)

GLB EFF Global Effect Global effect settings Chapter 11 (Volume 2)

RTR Router Destination, source and level 
selections

page 408

DEV Device Settings for external device 
operation

Chapter 12 (Volume 2)

MCRO Macro Macro register settings Chapter 16 (Volume 2)

KEY 
FRAME

Key Frame Keyframe settings Chapter 13 (Volume 2)

EFF Effect Keyframe effect register settings Chapter 13 (Volume 2)

SNAP
SHOT

Snapshot Snapshot register settings Chapter 14 (Volume 2)

SHOTBOX Shotbox Shotbox register settings Chapter 15 (Volume 2)

FILE File File settings Chapter 17 (Volume 2)

ENG 
SETUP

Engineering Setup Setup functions Chapter 18 to Chapter 24 
(Volume 3)

DIAG Diagnosis Status information display Appendix (Volume 3)
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Menus accessed by pressing a button twice
For relevant buttons other than the top 
menu selection buttons, pressing twice in 
rapid succession directly recalls a related 
menu page. The following table lists these 

buttons of each control block, together with 
the menus they recall. (XX represents the 
HF menu recalled last in the VF menu.)

Cross-point control block

Buttons Menus See

FM1 to 8 signals assigned 
buttons

Frame Memory >Still >Recall page 351

Color Bkgd1 signal assigned 
button

Color Bkgd >Color Bkgd1 page 390

CCR1 signal assigned button CCR >CCR1 >XX Chapter 19 
(Volume 3)

CCR2 signal assigned button CCR >CCR2 >XX

FMS1 Frame Memory>Still>Recall

FMS2 Frame Memory>Still>Recall

Transition control block (standard type, compact type)

Buttons Menus See

KEY1 (DSK1) a) • M/E-1, 2, 3 >Key1 >XX 
• PGM/PST >DSK1 >XX

page 204

KEY2 (DSK2) a) • M/E-1, 2, 3 >Key2 >XX 
• PGM/PST >DSK2 >XX

KEY3 (DSK3) a) • M/E-1, 2, 3 >Key3 >XX 
• PGM/PST >DSK3 >XX

KEY4 (DSK4) a) • M/E-1, 2, 3 >Key4 >XX 
• PGM/PST >DSK4 >XX

WIPE M/E-1, 2, 3, PGM/PST >Wipe >Main Pattern page 267

DME M/E-1, 2, 3, PGM/PST >DME Wipe >XX page 308

SUPER MIX M/E-1, 2, 3, PGM/PST >Misc >Transition page 157

PST COLOR MIX M/E-1, 2, 3, PGM/PST >Misc >Transition page 158

FM1&2 CLIP,
FM3&4 CLIP,
FM5&6 CLIP,
FM7&8 CLIP

M/E-1, 2, 3, PGM/PST >Misc >Clip Transition page 378

PRIOR SET M/E-1, 2, 3, PGM/PST >Misc >Key Priority page 153

KEY PRIOR M/E-1, 2, 3, PGM/PST >Misc >Next Key Priority page 154

WIPE (Independent key 
transition type selection 
button (standard type))

• M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select

page 279
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a) Including the key delegation buttons of the transition control block (standard type).

a) The menu to be recalled depends on the setup of the key assignment.

DME (Independent key 
transition type selection 
button (standard type))

• M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >DME Wipe 
Adjust >1ch Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >DME Wipe 
Adjust >1ch Pattern Select

page 318

K-SS STORE Snapshot >Key Snapshot >XX Chapter 14 
(Volume 2)

Transition control block (standard type, compact type)

Buttons Menus See

Independent key transition control block (simple type) a)

Buttons Menus See

WIPE • M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select

page 279

DME • M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >DME Wipe 
Adjust >1ch Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >DME Wipe 
Adjust >1ch Pattern Select

page 318

SHIFT • M/E-1, 2, 3 >Key1, 2, 3, 4 >XX 
• PGM/PST >DSK1, 2, 3, 4 >XX

page 204

Flexi Pad control block (standard type)

Buttons Menus See

WIPE M/E-1, 2, 3, PGM/PST >Wipe >Main Pattern page 267

DME M/E-1, 2, 3, PGM/PST >DME Wipe >XX page 308

SNAPSHOT Snapshot >Snapshot >XX Chapter 14 
(Volume 2)

EFF Effect >Effect 1-99 >XX Chapter 13 
(Volume 2)

SHOTBOX Shotbox >Register >Store/Recall Chapter 15 
(Volume 2)

MCRO Macro >Register >XX Chapter 16 
(Volume 2)
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a) The menu recalled depends on which of the M/E delegation buttons and key delegation buttons 
are selected in the key control block.

a) The menu recalled depends on which of the M/E-1 to M/E-3 banks and PGM/PST bank the 
numeric control block is delegated to.

b) When other than [MASTR] is selected with the region selection buttons.
c) When [MASTR] is selected with the region selection buttons.
d) When the [SNAPSHOT] button or [EFF] button is set to On, or lit green.

Key control block a)

Buttons Menus See

KEY1 • M/E-1, 2, 3 >Key1 >XX 
• PGM/PST >DSK1 >XX

page 204

KEY2 • M/E-1, 2, 3 > Key2 > XX 
• PGM/PST >DSK2 >XX

KEY3 • M/E-1, 2, 3 >Key3 >XX 
• PGM/PST >DSK3 >XX

KEY4 • M/E-1, 2, 3 >Key4 >XX 
• PGM/PST >DSK4 >XX

LUM • M/E-1, 2, 3 >Key1, 2, 3, 4 >Type 
• PGM/PST >DSK1, 2, 3, 4 >Type

page 205

LIN

CVK

PTN

CRK • M/E-1, 2, 3 >Key1, 2, 3, 4 >Type >Chroma Adjust 
• PGM/PST >DSK1, 2, 3, 4 >Type >Chroma Adjust

page 210

Numeric keypad control block

Buttons Menus See

EFF • Effect >Effect 1-99 >XX b) 

• Effect >Master Timeline >Store c)

Chapter 13 
(Volume 2)

SNAPSHOT • Snapshot >Snapshot >XX b) 

• Snapshot >Master Snapshot >Store c)

Chapter 14 
(Volume 2)

SHOTBOX Shotbox >Register >Store/Recall Chapter 15 
(Volume 2)

MCRO Macro >Register >XX Chapter 16 
(Volume 2)

TRANS RATE a) Misc >Transition page 166

STORE RCALL Key Frame >Region Select d) Chapter 13 
(Volume 2)
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a) The menu recalled depends on which of keyers 1 to 4 the downstream key control block is 
delegated to.

b) Recalling is possible only when the [K-SS] button is On.

Downstream key control block a)

Buttons Menus See

DSK1 • M/E-1, 2, 3 >Key1 >XX 
• PGM/PST >DSK1 >XX

page 204

DSK2 • M/E-1, 2, 3 >Key2 >XX 
• PGM/PST >DSK2 >XX

DSK3 • M/E-1, 2, 3 >Key3 >XX 
• PGM/PST >DSK3 >XX

DSK4 • M/E-1, 2, 3 >Key4 >XX 
• PGM/PST >DSK4 >XX

WIPE • M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select

page 279

DME • M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >Wipe 
Adjust >Pattern Select 

• PGM/PST >DSK1, 2, 3, 4 >Transition >DME Wipe 
Adjust >Pattern Select

page 318

K-SS STORE b) Snapshot >Key Snapshot >XX Chapter 14 
(Volume 2)

Auxiliary bus control block

Buttons Menus See

FMS1, FMS2 Frame Memory >Still >Freeze/Store page 347

FM1 to 8 signals assigned 
buttons

Frame Memory >Still >Recall page 351

Color Bkgd1 signal assigned 
button

Color Bkgd >Color Bkgd1 page 390

CCR1 signal assigned button CCR >CCR1 >XX Chapter 19 
(Volume 3)

CCR2 signal assigned button CCR >CCR2 >XX

Device control block (trackball or joystick)

Buttons Menus See

DME1, DME2, DME5 to 
DME8 a)

DME >XX Chapter 11 
(Volume 2)

DEV1 to DEV12 assigned 
buttons

• Device >DDR/VTR >Cueup & Play b) 
• Device >DDR/VTR >Timeline c)

Chapter 12 
(Volume 2)
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a) When the three-dimensional transformation operation mode is enabled.
b) When the [MENU] button is Off.
c) When the [MENU] button is On.
d) In the resizer control mode, K3 and K4 are outside the scope of double-clicks.

a) When the [TIMELINE] button is Off.
b) When the [TIMELINE] button is On.

a) When a key other than DSK1 or DSK2 is assigned, the menu for the corresponding key appears.

a) When the button is assigned to macro function in the Setup menu.

FM1CLIP to FM8CLIP 
assigned buttons

Frame Memory >Clip >Recall page 366

K1, K2 • M/E-1, 2, 3 >Key1, 2, 3, 4 >Processed Key
• PGM/PST >DSK1, 2, 3, 4 >Processed Key

page 249

Device control block (trackball or joystick)

Buttons Menus See

Device control block (search dial)

Buttons Menus See

DEV1 to DEV12 • Device >DDR/VTR >Cueup & Play a) 
• Device >DDR/VTR >Timeline b)

Chapter 12 
(Volume 2)

FM1CLIP to FM8CLIP 
assigned buttons

Frame Memory >Clip >Recall page 366

Downstream key/fade-to-black control block

Buttons Menus See

DSK1, DSK2 • PGM/PST >DSK1, 2 >XX a) page 204

Transition control block and Flexi Pad control block (simple type)

Buttons Menus See

KEY1 (DSK1) • M/E-1, 2, 3 >Key1 >XX 
• PGM/PST >DSK1 >XX

page 204

KEY2 (DSK2) • M/E-1, 2, 3 >Key2 >XX 
• PGM/PST >DSK2 >XX

WIPE • M/E-1, 2, 3 >Wipe >Main Pattern 
• PGM/PST >Wipe >Main Pattern

page 267

DME • M/E-1, 2, 3 >DME Wipe >XX
• PGM/PST >DME Wipe >XX

page 308

SNAPSHOT Snapshot >Snapshot >XX Chapter 14 
(Volume 2)

MCRO a) Macro >Register >XX Chapter 16 
(Volume 2)
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Multifunction Flexi Pad conrol block

Buttons Menus See

WIPE M/E-1, 2, 3, PGM/PST >Wipe >Main Pattern page 267

DME WIPE M/E-1, 2, 3, PGM/PST>DME Wipe>xxx a) page 308

SNAPSHOT When the [MSTR] button is On.
Snapshot>Master Snapshot>Store

Chapter 14
(Volume 2)

When the [MSTR] button is Off 
Snapshot>Snapshot>xxx a)

EFF When the [MSTR] button is On
Effect>Master Timeline>Store

Chapter 13
(Volume 2)

When the [MSTR] button is Off
Effect>Effect 1-99>xxx a)

SHOTBOX Shotbox>Register>Store/Recall Chapter 15
(Volume 2)

MCRO Macro>Register>xxx a) Chapter 16
(Volume 2)

TRANS RATE Misc>Transition page 404

KEY SS Snapshot>Key Snapshot>xxx a) Chapter 14
(Volume 2)

KEY ADJ >  KEY1 M/E1, 2, 3 >Key1 >xxx a)

PGM/PST >DSK1 >xxx a)

page 204

KEY2 M/E1, 2, 3 >Key2 >xxx a)

PGM/PST >DSK2 >xxx a)

KEY3 M/E1, 2, 3 >Key3 >xxx a)

PGM/PST >DSK3 >xxx a)

KEY4 M/E1, 2, 3 >Key4 >xxx a)

PGM/PST >DSK4 >xxx a)

LUM
LIN
WIPE PTN

M/E-1 >Key1, 2, 3, 4 >Type page 205

M/E-1 >Key1, 2, 3, 4 >Type

M/E-2 >Key1, 2, 3, 4 >Type

M/E-3 >Key1, 2, 3, 4 >Type

PGM/PST >DSK1, 2, 3, 4 >Type

CRK M/E-1 >Key1, 2, 3, 4 >Type >Chroma Adjust page 207

M/E-2 >Key1, 2, 3, 4 >Type >Chroma Adjust

M/E-3 >Key1, 2, 3, 4 >Type >Chroma Adjust

PGM/PST >DSK1, 2, 3, 4 >Type >Chroma Adjust
111Basic Menu Operations



112

   C
hapter 2 

M
enus and C

ontrol P
anel
a) “xxx” represents the last accessed page of the relevant menu.

Displaying a Menu

To display, for example, the M/E-1 >Key1 
>Type menu, use either of the following 
operations.
• Press the top menu selection button [M/E 

1], then press the VF1 ‘Key1’ button and 
the HF1 ‘Type’ button in that order.

• Press the menu page number button in the 
upper left corner of the menu screen to 
display the top menu window, then enter 
the page number of the M/E-1 >Key1 
>Type menu, which is 1111, and press 
the [Enter] button.

For details of the menu page numbers, see  
“Menu Tree” (page 454).

The M/E-1 >Key1 >Type menu appears in 
the menu display as follows.

KEY SS  KEY1 M/E1, 2, 3 >Key1 >xxx a)

PGM/PST >DSK1 >xxx a)

page 204

KEY2 M/E1, 2, 3 >Key2 >xxx a)

PGM/PST >DSK2 >xxx a)

KEY3 M/E1, 2, 3 >Key3 >xxx a)

PGM/PST >DSK3 >xxx a)

KEY4 M/E1, 2, 3 >Key4 >xxx a)

PGM/PST >DSK4 >xxx a)

Multifunction Flexi Pad conrol block

Buttons Menus See
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M/E-1 >Key1 >Type menu

Interpreting the Menu 
Screen

The menu screen consists of the following 
principal parts.
When buttons on the screen are lit or 
represented in a depressed state, this 
indicates that the corresponding item or 
function is selected (set on).

a Menu title button
This shows the title of the menu screen.
You can set different colors for the main 
menu site and subsidiary menu site (see 
page 127).

b Menu page number button
This shows the menu screen page number. 
When you press this button, the top menu 
window (see page 124) appears. You can 
enter the page number for the desired menu, 

2 Menu page number button

1 Menu title 
button

6 Function button area

7 Parameter group button

8 Knob 
parameter 
buttons3 VF buttons

4 HF buttons

9 Previous page button

5 Status area

0 Keyframe status

qa Default recall button

qs b (previous) button and B (next) 
button
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or press one of the top menu selection 
buttons in the window, to display that 
menu.
While the system is accessing the hard disk, 
the indicator lights red.

Note
When the indicator is lit, do not power off 
the switcher, or disconnect the IEEE1394 
cable 1).

1) When an external hard disk drive is connected

c VF buttons
These indicate the larger subdivisions of 
this menu.
Depending on the selected item, the menu 
screen contents including the HF button 
indications change.

d HF buttons
These indicate the items within the menu.
Depending on the selected item, the menu 
indications change.
Depending on the function, if any one is on, 
the status is shown by an orange bar, as in 
the following figure.

e Status area
This shows the status of the settings items 
controlled by the selected menu.
An orange frame appears around the 
parameter area relating to the displayed 
menu. For each of the twelve areas, 

pressing the display jumps to the related 
menu.

f Function button area
This shows the functions which can be 
operated in the currently selected menu by 
means of buttons.
Each function button corresponds to a 
function which can be set in the currently 
selected menu. Press it to enable the 
function, to display a parameter group and 
adjust the parameters with the knobs, or to 
execute the function.
These buttons are in groups by function. In 
the screen example shown on the previous 
page, the [Key Bus] and [Matte] function 
buttons constitute the <Key Fill> group.

g Parameter group button
This displays parameter group names for 
which the knobs can make adjustments, the 
current parameter setting page number, and 
the total number of the parameter setting 
pages. (Example: Color Vector 1/2)
When there are more than five parameters 
within the same parameter group, press this 
button to display the sixth and subsequent 
parameters, which can then be controlled 
by the knobs.

h Knob parameter buttons
These show the parameters currently 
controlled by the knobs and their values. 
Pressing one of these buttons displays the 
numeric keypad window (see page 122), 
and you can then enter a new value for the 
corresponding parameter with the numeric 
keypad.

i Previous page button
This shows the page number of the 
previously displayed menu screen. Press it 
to go back to that page. When the indication 
[Parent] appears, this displays the parent 
directory.

Indicator for internal hard 
disk

Indicator for frame 
memory external hard disk
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j Keyframe status
This shows the keyframe status of the 
reference region. Pressing this button 
switches the menu screen as follows.
When a menu other than the Key Frame 

menu is currently shown: The menu 
screen switches to the Key Frame 
menu.

When the Key Frame menu is currently 
shown: The menu screen switches to 
the menu that was on the screen 
immediately before the Key Frame 
menu.

In some parts of menus such as the File 
menu, this functions as a “Region selection 
area,” for selecting the region to which 
operations apply.

k Default recall button
This only appears in those menus for which 
the default recall function is available. (See 
“Menus allowing a return to default 
settings” (page 117).)
Press this button, turning it on, then press a 
VF button or knob parameter button to 
return the settings to their default values, in 
the following groupings.
• Function grouping: the functions within 

an HF menu under the VF button
• Knob parameters (parameters currently 

controlled by the knobs)

l b (previous) button and B (next) 
button

The b button returns to the previous menu. 
Press the B button to continue to the next 
menu.

Menu Operations

The method of menu operation is basically 
the same when using a mouse with an 
external monitor, but with mouse clicks in 
place of button presses. There is no 

difference in the menu control block 
operation described here.
However, since the monitor has no knobs 
for adjusting the parameters in the menu 
control block, for details of operations 
corresponding to these knob operations, see 
the section below, “Operation With a 
Mouse” (page 121).

Selecting an item

1 Press the VF button (1 to 7) for the 
desired group of items.

The HF button (1 to 7) indications 
change to show the items within the 
selected group.

2 Press the HF button for the desired 
item.

The indications in the status area and 
function button area change, and you 
can now make various changes to the 
selected item.

Selecting a function
Press the appropriate function button within 
the function button area.

Shape and color of the button
Pressing the button turns it on, and it lights, 
showing the state.

Lit pale blue: The function is enabled, and 
the parameters can currently be 
adjusted with the knobs.

Lit orange: The function is enabled.
Lit purple: Execution button. Pressing the 

button immediately executes the 
function. (Example: [Auto Start] 
button in the Chroma Adjust menu)
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Pressing a button of this type displays a 
further menu, allowing more detailed 
settings. (Example: [Chroma Adjust] 
button in the Type menu)

Setting parameters

This marking on a function button indicates 
that there are parameters which can be 
adjusted with the knobs.
Pressing this function button assigns 
parameters to the knobs.
You can set the parameter values by either 
of the following methods.
• Turn the knob (1 to 5) corresponding to 

the parameter, to adjust the value.
• Press the knob parameter buttons (1 to 5) 

corresponding to the parameter. This 
displays the numeric keypad window 
allowing you to enter the desired value.

In the description of specific setting 
procedures, the knob adjustment is 
described, as follows.

Example: When wipe pattern key is selected

When the [MENU] button in the device 
control block is lit, you can use the trackball 
and Z-ring to control the parameters.
• Move the trackball on the x-axis to 

control the parameter for knob 1 or on the 
y-axis to control the parameter for knob 
2. Moving up or to the right increases the 
parameter value, and moving down or to 
the left decreases the parameter value.

• Use the Z-ring to adjust the parameter for 
knob 3. Turning clockwise increases the 
parameter value, and turning 
counterclockwise decreases the 
parameter value.

Going back to the previous menu
To return to the last displayed menu, press 
the previous page button.

Returning to default state in function 
groupings

1 Press the [Default Recall] button, 
turning it on.

This enters the menu default recall 
mode.

2 Press the VF button you want to return 
to the default state.

This returns the settings within the 
function grouping to the default state, 
and the [Default Recall] button goes 
off.

Note
The default state of the settings depends on 
the setting of the initial status mode, set in 
the Setup menu of system setup, as follows.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

3 Density Key density 0.00 to 100.00
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User: The state when [Initial Status Define] 
is executed.

Factory: Factory default settings

Returning knob parameters to 
default state

1 Press the [Default Recall] button, 
turning it on.

This enters the menu default recall 
mode.

2 Press the knob parameter button you 
want to return to the default state.

This returns the knob parameter value 
to the default state, and the [Default 
Recall] button goes off.

Notes
• In the following table, “Menus allowing a 

return to default settings,” the default 
recall function does not apply to some 
knob parameters. 

For details, see the table, “Knob 
parameters to which default recall does 
not apply” on page 119.

• The default recall function does not 
return the horizontal (H) and vertical (V) 
position settings to their default state 
individually. Returning the horizontal 
(H) position to its default state also 
returns the vertical (V) position to its 
default state automatically, and vice 
versa.

For details, see the table, “Knob 
parameters subject to restriction on 
default recall” on page 120.

Menus allowing a return to default settings

Top menu selection button 
name

VF number 
(HF number)

Menu number Menu name

M/E1 VF1 1110-series Key1 a)

VF2 1120-series Key2 a)

VF3 1130-series Key3 a)

VF4 1140-series Key4 a)

VF5 1150-series Wipe a)

VF6 1160-series DME Wipe a)

VF7 1170-series Misc a)

M/E2 VF1 1210-series Key1 a)

VF2 1220-series Key2 a)

VF3 1230-series Key3 a)

VF4 1240-series Key4 a)

VF5 1250-series Wipe a)

VF6 1260-series DME Wipe a)

VF7 1270-series Misc a)
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M/E3 VF1 1310-series Key1 a)

VF2 1320-series Key2 a)

VF3 1330-series Key3 a)

VF4 1340-series Key4 a)

VF5 1350-series Wipe a)

VF6 1360-series DME Wipe a)

VF7 1370-series Misc a)

P/P VF1 1410-series DSK1 a)

VF2 1420-series DSK2 a)

VF3 1430-series DSK3 a)

VF4 1440-series DSK4 a)

VF5 1450-series Wipe a)

VF6 1460-series DME Wipe a)

VF7 1470-series Misc a)

COLOR BKGD VF1 2210 Color Bkgd 1 a)

VF2 2220 Color Bkgd 2 a)

CCR VF1 2410-series CCR1 a)

VF2 2420-series CCR2 a)

FRAME MEM VF1 2510-series Still b)

VF2 2520-series Clip b)

VF3 2530-series Reposition/Lock b)

VF4 2540-series File b)

VF5 2550-series Folder b)

AUX/MON VF1 2311 Aux Bus b)

Top menu selection button 
name

VF number 
(HF number)

Menu number Menu name
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a) Menu to return to the default settings for particular functions or for particular knob parameters 
(see page 119).

b) Menu to return to the default settings for particular knob parameters (see page 119).

DME VF1 4110-series Edge b)

VF2 4120-series Video Modify b)

VF3 4131 Freeze b)

VF4 4141 Non-Linear b)

VF5 4150-series Light/Trail b)

VF6 4160-series Input/Output b)

VF7 4170-series Enhanced Video 
Modify b)

GLB EFF VF1 4210-series Ch1–Ch2

VF2 4220-series Ch5–Ch8 b)

KEY FRAME (HF3) 6113 Path b)

Top menu selection button 
name

VF number 
(HF number)

Menu number Menu name

Knob parameters to which default recall does not apply

Menu number a) Menu name Button name Knob Parameter

1111 Type [Luminance] and [Linear] in 
<Key Type> group

4 Filter

[Color Vector] in <Key Type> 
group

1
2
(Parameter 
group [2/2])

Y Filter, 
C Filter

1111.1 Type >CRK Adjust [Key Active] 5 Filter

[Color Cancel] in <Color 
Cancel> group

5 Filter

1112.1 Edge >Matte [Mix Color] in <Edge Matte> 
group

5 Pattern

[Multi] 3 Invert Type

1113 Main Mask b) [Pattern] 5 Pattern

[Multi] 3 Invert Type
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a) The menu numbers shown by way of example are those for M/E-1: the same applies for M/E-2, 
M/E-3, and P/P. Also, content applying to Key1 applies equally to Key2, Key3, and Key4.

b) Does not appear for Key3 and Key4.

1116 Transition [Wipe] in <ON Transition Type> 
group

1

5 

Transition 
Rate
Pattern

[Wipe] in <OFF Transition 
Type> group

1

5 

Transition 
Rate
Pattern

[Key Blink] and [Edge Blink] in 
<Blink> group b)

1 Blink Rate

[Mix] in <Transition Type> group 1 Transition 
Type

[Wipe] in <Transition Type> 
group

1

5 

Transition 
Rate
Pattern

1116.1 Transition >
Wipe Adjust

[Multi] 3 Invert Type

[H] and [V] in <Pairing> group 1 Width

[H], [V], and [Fringe] in 
<Modulation> group

4 Shape

1154.1 Edge/Direction >
Matte Adjust

[Mix Color] in <Edge Matte> 
group

3 Pattern

[Multi] 3 Invert Type

1164 Edge/Direction [Independent Trans Rate] in 
<Pattern Limit Release> group

1 Transition 
Rate

1171 Transition [Mix], [Nam], [Super Mix], 
[Preset Color Mix], [Wipe], [DME 
Wipe], and [FTB] in <Transition 
Type> group

1 Transition 
Rate

Knob parameters to which default recall does not apply

Menu number a) Menu name Button name Knob Parameter

Knob parameters subject to restriction on default recall

Menu number Menu name Button name Knob Parameter

1111.1 a) Type >CRK Adjust [Sample Mark] in the <Auto> group 1
2

Position H
Position V

1112.1 a) Edge >Matte 
Adjust

[Position]

1113 a) Main Mask [Position]

1116.1 a) Transition >Wipe 
Adjust

[Position]

1116.3 a) Transition >DME 
Wipe Adjust

[Position] 1
2

H
V
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a) The menu numbers shown by way of example are those for M/E-1: the same applies to M/E-2, 
M/E-3, and P/P. Equally, content applying to Key1 applies equally to Key2, Key3, and Key4.

b) The menu numbers shown by way of example are those for CCR1: the same applies to CCR2.
c) The sample applies to Mask2 Adjust.

Operation With a Mouse

If you display the menus in an external 
monitor, operated with a mouse, then you 
click the mouse instead of pressing a button 
as described in the previous section, “Menu 
Operations.”
However, in the following cases there are 
special operations with a mouse.

To set parameters
To adjust the value of a knob setting 
parameter button with the mouse, you can 
use either of the following three methods.
• Position the cursor over the knob setting 

parameter button for which you want to 
adjust the value, and turn the mouse 
wheel.

• Position the cursor over the knob setting 
parameter button for which you want to 
adjust the value, then hold down the right 
mouse button, and drag the bar showing 
the setting to the desired value.

• Position the cursor over the knob setting 
parameter button for which you want to 
adjust the value, then click the left mouse 
button to open the numeric keypad 
window by whick you can input the 
desired value.

To scroll a list
Position the cursor over the list you want to 
scroll, and turn the mouse wheel.

In the setup menus you can select the 
direction of mouse wheel rotation that 
increases the setting value. And you can 

1154.1 a) Edge Direction 
>Matte Adjust

[Position] 1
2

Position H
Position V

1155 a) Main Modify [Position] in the <Position> group

1155.1 a) Main Modify 
>Multi Adjust

[Position]

2122.2 Composite 
>Pattern Adjust

[Position] 1
2

Position H
Position V

2131 Reposition [Normal]

[Black&White]

2210 Color Bkgd1 [Position]

2412.1 b) Primary CCR 
>Mask1 Adjust c)

[Position]

4116 DME >Edge 
>Wipe Crop

[Position/Size] 5 Pattern

4127 DME >Video 
Modify >Mask

[Position/Size]

Knob parameters subject to restriction on default recall

Menu number Menu name Button name Knob Parameter
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also switch the functions of the right and 
left mouse buttons.

For details, see Chapter 19 “Control Panel 
Setup (Panel)” (Volume 3).

Numeric keypad window

a Item display
This is the name of the parameter being set 
in the numeric keypad window.

b Max./min. (maximum/minimum) 
value indication

This shows the maximum and minimum 
settings of the parameter.

c Input value
This is the value being input into the 
numeric keypad window.

d Close button
This closes the numeric keypad window.

e TC (timecode) button
When the numeric keypad window is 
opened for a setting requiring a timecode 
value to be entered, this button appears in a 
depressed state.
You can enter a timecode value in the range 
that depends on the signal format (see 
“Setting the Signal Format (Format 
Menu)” in Chapter 18 (Volume 3)) as 
follows:

00:00:00:00 to 23:59:59:nn,
where nn = (number of frames per 
second) – 1.

f  – (minus) button
This toggles the sign of the entered value. 
When it is pressed, the value is negative.

g Clear button
This clears the input. It does not change the 
parameter setting.

h Trim button
After entering the difference from the 
current value, press this button to confirm 
the numeric input.

i Enter button
This confirms the entered value.
If correctly set, the numeric keypad 
window closes.
If not correctly set, the input display 
changes color.

1 Item display

2 Max./min. value indication

3 Input value

4 Close button

5 TC (timecode) 
button

6 – (minus) 
button

7 Clear button

8 Trim button

9 Enter button
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Keyboard window

Note
Except when changing source names, the 
following characters cannot be used. The 
same applies to macro file editing.

space, \, /, :, ;, , (comma), . (dot), <, >, 
*, ?, ", |

a Item display
This is the name of the parameter being set 
in the keyboard window.

b Input string
This is the character string being input in 
the keyboard window.

c Close button
This closes the keyboard window.

d BS button
This clears the character immediately 
before the cursor in the input string.

e Caps Lock button
This enables input of capital letters only.

Note
You can enter items to be displayed on the 
control panel LCD using lowercase letters, 
but these will be converted to capitals for 
display.

1 Item display 2 Input string

4 BS button

3 Close button

0 Left button

6 Shift button

5 Caps Lock button

7 Space button

8 Clear button

9 Del button

qa Right button

qs Enter button

qd Line feed
button
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MS-DOS does not distinguish case in 
filenames, and therefore you are 
recommended to enter filenames in capital 
letters.

f Shift button
This selects the characters on the shift side 
of the keys. The shift is released when you 
enter a character.

g Space button
This enters a space character.

h Clear button
This clears all of the characters in the input 
string.

i Del button
This clears the character immediately after 
the cursor in the input string.

j Left button
This moves the cursor one character to the 
left in the input string.

k Right button
This moves the cursor one character to the 
right in the input string.

l Enter button
This sets the input string as a parameter 
value, and closes the keyboard window if 
the value has been entered correctly. If the 
value has not been entered correctly, the 
display color changes.

m Line feed button
After pressing the Shift button, press this 
button to feed a line. The input string shows 
“|”.

Function of the top menu window

1 Top menu selection buttons

2 Input display

3 Numeric entry section

6 Close button

4 Clear button

5 Enter button

7 Shut down button

8 Add Favorite button
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a Top menu selection buttons
These are the same as the top menu 
selection buttons in the menu control block. 
Pressing one of these buttons closes the top 
menu window and displays the selected 
menu in the menu display.

b Input display
This shows the page number entered with 
the numeric entry section.

c Numeric entry section
Enter a page number.

d Clear button
Press this to clear the input display.

e Enter button
Pressing this button without entering a page 
number closes the top menu window with 
the current menu remaining in the menu 
display.
If you enter a page number then press this 
button, this confirms the value in the input 
display. If it is a correct page number, the 
top menu window closes, and the menu 
display shows the new menu. If it is not 
correctly set, the input display changes 
color.

f Close button
Press this to close the top menu window.

g Shut down button
Shuts down the menus.

Note 
Be sure to shut down the menus before 
powering off the control panel.

Shutting down the menus

1 In the menu screen, press the menu 
page number button to open the top 
menu window.

For details of the top menu window, see  
“Function of the top menu window” 
(page 124).

2 Press [Shut down].

A confirmation message appears.

3 Press [Yes].

This shuts down the menu system after 
a while, and the menu display changes 
to black. Now power off the system.

To restart menu operations
Power on the control panel once more.

h Add Favorite button
Pressing this button allows the currently 
displayed menu to be registered to the 
Shortcut menu.

Registering a menu to the 
Shortcut menu

1 In the Home >Favorites >Shortcut 
menu, select the desired group.

2 Display the menu you want to register, 
and then press the [Add Favorite] 
button.

The currently displayed menu is 
automatically registered to a blank 
button.

Use of the color palette window
When a parameter is assigned to the knobs 
as a combination of luminance, saturation, 

and hue, pressing a knob parameter button 
displays a color palette window.
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a Color palette buttons
Press one of these to enter the 
corresponding color in the display.
By default the following settings are 
available.
First row: white, yellow, cyan, green
Second row: magenta, red, blue, black
Third row: all black

b Operation buttons
Set: If you press any color palette button 

with this button held down, the color 
shown in the color display is assigned 
to the color palette button.

Copy: If you press a color palette button 
with this button held down, the color is 
used as the source for copying. Next 
press a different color palette button to 
copy to that button.

Swap: If you press two color palette 
buttons in sequence with this button 
held down, the two colors are swapped.

Default: If you press any color palette 
button with this button held down, the 
color palette button is set to the default 
color.

c Color display
This shows the setting color, and the 
parameters (LUM, SAT, and HUE).
By adjusting the parameters with the knobs, 
you can create any color.
If a parameter value is outside the permitted 
range for RGB (0 to 255), the indication 
“Illegal Color” appears, and this is adjusted 
to a value in range.
Cancel: Pressing this button returns to the 

state when the color palette window 
was opened.

d Numeric keypad
Use this to enter numeric values for 
parameters.

For details of use, see page 122.

1Color palette 
buttons

3Color display

4Numeric 
keypad

2Operation 
buttons
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Switching Between the 
Main Menu Site and 
Subsidiary Menu Site

For menu transitions, you can store two 
separate versions in the main and subsidiary 
menu sites.
By switching sites, and pressing the b 
button and the B button you can trace the 
history in each menu.

To switch the subsidiary menu 
site on and off
Assign [SUB MENU SITE] to a menu 
control block top menu selection button or 
user preference button. To switch to the 
subsidiary menu site, press this button, 
turning it on.

For details of the assignment operation, see 
“Assigning Functions to the Menu Control 
Block Top Menu and User Preference 
buttons” in Chapter 19 (Volume 3).

Shortcut Menu

Recalling a menu using the 
shortcut menu

1 In the Home menu, select VF2 
‘Favorites’ and HF1 ‘Shortcut.’

The following menu appears.

2 In the [Group Select] box, select the 
group.

The group buttons appear.

3 Press the button for the desired menu.

Creating a shortcut menu
Assign frequently used menus to buttons, to 
create a “Favorites” menu.

To create a menu group

1 In the Home menu, select VF2 
‘Favorites’ and HF1 ‘Shortcut.’

The following menu appears.

2 Press [Group Edit].

The following menu appears.
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3 With the cursor, select the group name 
(in this case a blank button) for the 
operation.

4 Press [Rename].

A keyboard window appears.

5 Enter a group name (maximum 24 
characters), and press Enter.

This confirms the group name.

To copy a menu group

1 In the Home >Favorites >Group Edit 
menu, press the button for the copy 
source group.

2 Press [Copy].

3 Press the button for the copy 
destination group.

4 Press [Paste].

This copies the menu group settings.

To delete menu group settings

1 In the Home >Favorites >Group Edit 
menu, select the group to be deleted.

2 Press [Clear].

A confirmation message appears.

3 Press [Yes].

This deletes the settings.

To register a menu on a button
You can register 15 buttons in one group.

1 In the Home >Favorites >Shortcut 
menu, press [Button Edit].

2 Move the cursor to the position where 
you want to display the button. To 
change the content of an already 
displayed button, press the button to 
select it.

3 Press [Page Set].

A page number input window appears.

4 Enter the page number for the menu 
you want to register.

5 Press [Rename].

A keyboard window appears.

6 Enter the button name (maximum 24 
characters).

Menu No.

Button name
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7 To change the button color, press 
[Color Set].

Button color samples appear.

8 Press the desired color.

This completes the assignment of the 
menu to the button.

9 Repeat steps 2 to 8 to complete the 
“Favorites” menu.

To copy button settings

1 In the Home >Favorites >Button Edit 
menu, press the copy source button to 
select it.

2 Press [Copy].

3 Press the copy destination button to 
select it.

4 Press [Paste].

This copies the button settings.

To delete button settings
In the Home >Favorites >Button Edit 
menu, press [Clear].
This deletes the button settings.

Note
The shortcut menu settings are handled as 
part of the control panel setup. You can 
recall and save them in the same way as 
setup data.
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Video Processing Flow

The switch from the current video stream (appearing on the corresponding 
program monitor) to a new video stream is referred to as a transition.
The following illustration shows the flow of operations for carrying out a 
transition on an M/E bank or the PGM/PST bank.
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Select next transition (page 145)

Make key settings (page 195)

Keys 1 to 4

Select new background video (page 135)

Select transition type (page 145)

Select current background video 
(page 135)

Background

Cut Mix Super 
mix

Preset color 
mix

Wipe DME wipe

Make wipe settings 
(page 267)

Make DME wipe settings
(page 308)

Preview the effect of transition (page 175)

Execute the transition (page 161)

NAM
Video Processing Flow
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Signal Selection

You carry out signal selection with the cross-point buttons in the cross-point 
control block of each M/E bank or the PGM/PST bank, and the buttons in the 
auxiliary bus control block.
The number of buttons in each cross-point row may be 16, 24, or 32, but here 
the description is of the 32-button case as an example.

Cross-point control block

M/E
1

M/E
1

SHIFT

SHIFT
XPT

HOLD

XPT
HOLD

MCRO
ENBL

KEY3

KEY4

MCRO
ASGN

XPT
HOLD

XPT
HOLD

AUTO
RUN

UTIL

M/E
1

M/E
1

M/E
2

M/E
2

M/E
2

M/E
2

M/E
3

M/E
3

M/E
3

M/E
3

SHIFT

SHIFT

SHIFT

Source name displays

Key 2 row

Key 1 row Reentry buttons

KEY4 button

KEY3 button

Cross-point buttons

Background A row

Background B row

SHIFT button

Reentry buttons

UTIL button
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Basics of Signal Selection

Each of the M/E banks, PGM/PST bank and auxiliary bus control block has 32 
cross-point buttons and three reentry buttons (four in the case of the auxiliary 
bus control block).
These buttons are identified by numbers common to all of the banks and block, 
and a signal is assigned to each number.
The basis of signal selection is to select, in a cross-point button row, the cross-
point button to which is assigned the desired signal.

Reentry buttons
To use the output of one M/E bank as background input to another bank, use 
the reentry buttons [M/E1], [M/E2], and [M/E3] (on the auxiliary bus control 
block, [M/E1], [M/E2], [M/E3], and [PGM]) in the cross-point control block 
of the destination bank.
For example, to feed the output from the M/E-1 bank as the background B input 
to M/E-2, in the M/E-2 cross-point control block, press the [M/E1] button in 
the background B row.

Bus Selection

Each row of 32 cross-point buttons is shared by multiple buses.
For example, in the M/E-1 bank, the key 1 row of buttons can be assigned either 
to the key 1 bus or to the key 3 bus. The [KEY3] button switches between these 
two assignments.
To assign a bus to the cross-point buttons in the auxiliary bus control block, 
press one of the AUX delegation buttons to select the bus. 

Note
When using the CCP-6224/6324, buses may be assigned with the cross-point 
button rows for keys 1 and 2 as the auxiliary bus control block.

The following table illustrates the correspondence between buses and cross-
point button rows, and the delegation operations.
Signal Selection
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Bank Bus name Cross-point 
button row

Delegation operation

M/E-1, 
M/E-2

Background A bus a) Background A 
row

–

Background B bus a) Background B 
row

–

Key 1 bus Key 1 row Turn off the [KEY3] button

Key 2 bus Key 2 row Turn off the [KEY4] button

Key 3 bus Key 1 row Turn on the [KEY3] button

Key 4 bus Key 2 row Turn on the [KEY4] button

PGM/PST Program bus a) Program row –

Preset bus a) Preset row –

DSK 1 bus DSK1 row Turn off the [DSK3] button

DSK 2 bus DSK2 row Turn off the [DSK4] button

DSK 3 bus DSK1 row Turn on the [DSK3] button

DSK 4 bus DSK2 row Turn on the [DSK4] button

M/E-1, 
M/E-2, 
PGM/PST

Utility bus Background A, B 
row

When [UTIL] button mode 
is Hold, hold down the 
[UTIL] button

DME external video bus Key 1 row Hold down the [UTIL] 
button
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a) Dual background bus mode (see below) can be selected.

Dual background bus mode
In this mode, the shifted signal on the background A row can be selected on the 
key 1 row, and the shifted signal on the background B row can be selected on 
the key 2 row.
To switch this mode on and off, it is necessary to assign this function to the 
[PRE MCRO] button in the cross-point control block.

For details of the assignment operation, see “Overall Control Panel Settings 
(Config Menu)” in Chapter 19 (Volume 3).

Auxiliary 
bus control 
block

AUX1 to AUX48 buses 1st row, 2nd row Turn on the appropriate 
buttons in accordance with 
the signal assignment 
made in the Setup menu.

MONITOR 1 to 
MONITOR 8 buses

Frame memory source 1 
and frame memory 
source 2 buses

DME 1 to DME 2, DME 5 
to DME 8 video buses

DME 1 to DME 2, DME 5  
to DME 8 key buses

Edit preview bus

M/E-1 UTILITY bus

M/E-2 UTILITY bus

P/P UTILITY bus

M/E-1 Key 1 fill to M/E-1 
Key 4 fill buses

M/E-1 Key 1 source to M/
E-1 Key 4 source buses

M/E-2 Key 1 fill to M/E-2 
Key 4 fill buses

M/E-2 Key 1 source to M/
E-2 Key 4 source buses

DSK 1 fill to DSK 4 fill 
buses

DSK 1 source to DSK 4 
source buses

M/E-1 external DME bus

M/E-2 external DME bus

P/P external DME bus

Bank Bus name Cross-point 
button row

Delegation operation
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Note
For the following switcher banks, dual background bus mode is not available.
• When set to “Dual M/E Assign”
• When M/E Config is set to “DSK”

AUX Panel-less Function

When using 24-column cross-point control blocks for the CCP-6224/CCP-
6324 Control Panel, you can use the key 1 and key 2 rows as the auxiliary bus 
control block. This is called the panel-less function.

Preparations
Assign the function for switching to the AUX control mode to the [PRE 
MCRO] and [POST MCRO] buttons. Hereafter this button is called the [AUX 
CTRL] button.
In the source name display you can display either the source name or the bus 
name.

For details of how to make the assignment, see Chapter 19 “Control Panel 
Setup (Panel)” (Volume 3).

Selecting the AUX bus

1 Switch the operation mode with the [AUX CTRL] button.

2 In the key 1 row, select the AUX bus for the operation.

3 In the key 2 row, select the desired signal.

Signal Assignment and Selection

Assigning signals to buttons
Each of the 32 cross-point buttons and reentry buttons has a corresponding 
button number, to which you assign a signal.
In addition to the signals input to the PRIMARY INPUTS 1 to 49 connectors 
on the rear panel of the switcher, you can also select signals generated within 
the switcher.
Each button has assigned to it a video signal and a key signal, forming a pair. 
You can set these video and key combinations in a Setup menu. 
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For details of Setup menu operations, see “Cross-Point Settings (Xpt Assign 
Menu)” in Chapter 19 (Volume 3).

Cross-point button control block button numbers

On each M/E bank and the PGM/PST bank, each cross-point button and reentry 
button has two button numbers, and you use the shift button to switch between 
these numbers.
In the case of a 32-button layout, the button numbers are as follows.

You can use the rightmost button (number 32) as a [SIDE FLAG] button. In 
this case, the shift button moves one to the left, to number 31, and the button 
numbers are offset by one.

For details of the [SIDE FLAG] button, see “Cross-Point Settings (Xpt Assign 
Menu)” in Chapter 19 (Volume 3).

Switching button numbers
The rightmost (32nd) button functions as a shift button.
(The shift button function can be disabled in a Setup menu.)
When selecting the signals of button numbers 1 to 31, press the cross-point 
button for the desired signal.
To select button numbers 32 to 62, hold down the shift button, and press the 
cross-point button for the desired signal.

M/E
1

M/E
1

SHIFT

XPT
HOLD

XPT
HOLD

MCRO
ENBL

DSK3

KSK4

MCRO
ASGN

XPT
HOLD

XPT
HOLD

AUTO
RUN

UTIL

M/E
1

M/E
1

M/E
2

M/E
2

M/E
2

M/E
2

M/E
3

M/E
3

M/E
3

M/E
3

1, 2, 3, 4, ....... ....... 29, 30, 31 121 123

32, 33, 34, 35, ....... ....... 60, 61, 62 125 127
(first button numbers)

(second button numbers)

Shift button

Shift button

Cross-point control block button numbers

Button Number when the shift 
button is not pressed

Number when the shift 
button is pressed

From the left end to the 
31st button

1 to 31 32 to 62

Reentry buttons 121 to 123 125 to 127
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Button numbers in the auxiliary bus control block

When the [2ND] button is unlit
The cross-point buttons and reentry buttons in the auxiliary bus control block 
have separate upper (1st row) and lower (2nd row) numbers.
In the case of a 32-button layout, the button numbers are as follows.

When the [2ND] button is lit
Different buses can be assigned to the 1st-row buttons and 2nd-row buttons. 
When the 32nd button is set as a shift button, the 1st-row buttons and 2nd-row 
buttons both have the following button numbers.

Auxiliary bus control block button numbers ([2ND] button lit)

Inhibiting cross-point button operations
For each cross-point button, you can temporarily inhibit operations. 

LEVEL
1

DEST

SHIFT

RTR

2ND

KEY

XPT
HOLD

XPT
HOLD

M/E
1

M/E
1

LEVEL
2

MCRO
1

M/E
2

M/E
2

LEVEL
3

MCRO
2

M/E
3

M/E
3

LEVEL
4

MCRO
3

P/P

P/P

EDIT
PVW

AUX
1

AUX
2

AUX
3

AUX
4

AUX
5

AUX
6

AUX
7

AUX
8

AUX
9

AUX
10

AUX
11

AUX
12

AUX
13

AUX
14

AUX
15

AUX
16

AUX
17

AUX
18

AUX
19

AUX
20

AUX
21

AUX
22

AUX
23

AUX
24

AUX
25

AUX
26

AUX
27

DME
UTIL1

DME
UTIL2

FM
1

FM
2

1, 2, 3, 4, ....... ....... 29, 30, 31 121 124

32, 33, 34, 35, ....... ....... 60, 61, 62 125 128

(1st row)

(2nd row)

2ND button

Auxiliary bus control block button numbers ([2ND] button unlit)

Button Button Button numbers

1st row From the left end to the 31st button 1 to 31

Reentry buttons 121 to 124

2nd row From the left end to the 31st button 32 to 62

Reentry buttons 125 to 128

Button Number when the shift 
button is not pressed

Number when the shift 
button is pressed

From the left end to the 
31st button

1 to 31 32 to 62

Reentry buttons 121 to 124 125 to 128
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Note
This setting is cleared when you reset the control panel. 

Assigning a button to the function of disabling cross-point button 
operation
You can assign the button to be used for the operation to the [PRE MCRO] 
button, in setup (See “Overall Control Panel Settings (Config Menu)” in 
Chapter 19 (Volume 3)).
You can also use the [Inhibit Set] and [Inhibit All Clear] functions, assigned to 
user preference buttons (See “Setting Button Assignments (Prefs/Utility 
Menu)” in Chapter 19 (Volume 3)).

Buses for which operations can be inhibited
This setting applies to the auxiliary bus control block (when using the CCP-
8000) and the cross-point buttons in each switcher bank. However, when using 
the CCP-6224/6324, buses may be assigned with the cross-point button rows 
for keys 1 and 2 as the auxiliary bus control block.

For example, if you make the setting for one cross-point button in a switcher 
bank, this inhibits operation of all cross-point buttons with the same number in 
the following buses. 
The corresponding name also disappears from the source name display. 
• Background A, background B
• Keys 1 to 4
• Utility
• External DME

To inhibit operation of a cross-point button
Hold down the button which “Inhibit Set” is assigned, and press the cross-point 
button whose operation you want to inhibit. 
The button you pressed flashes amber, and this makes the operation inhibited. 

Note
Even when you inhibit operation of a cross-point button, macro attachment 
settings are still possible (see “Setting and Canceling a Macro Attachment” in 
Chapter 16 (Volume 2)). 

To clear a cross-point button operation inhibit setting
Hold down the button to which “Inhibit Set” is assigned, and press the button 
whose operation is inhibited (flashing amber). 
This clears the operation inhibit setting for the button you pressed. 

To clear all operation inhibit settings
Press the button to which “Inhibit Set” is assigned and the button to which 
“Inhibit All Clear” is assigned simultaneously. 
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Selection of signals linked with the audio mixer

When you select a signal in a switcher bank background A, key 1 or key 2 row 
(of the CCP-6224/6324 control panel in AUX control mode) or AUX bus 
control block (of the CCP-8000), and the bank and signal are set to be linked 
to the audio mixer, then the program output of the audio mixer follows the 
signal selection.

For details of the setting, see “Cross-Point Settings (Xpt Assign menu)” in 
Chapter 19 (Volume 3). 

Notes
• For details of audio mixers that can be connected, contact your Sony service 

or sales representative. 
• When the signal is switched with a snapshot, keyframe, and so on, the audio 

mixer is not linked. 
• When bus fixed mode is selected in setup (see page 173), the audio mixer 

program output is linked to the bus output as the background. 

Signal Name Display

You can attach a name (source name) to each signal assigned to a cross-point 
button, with a maximum of 16 characters.

• The source name displays in the cross-point control block and auxiliary bus 
control block show the source names of the video signals assigned to 
numbers 1 to 31.

• To display the source names for numbers 32 to 62, press the [SHIFT] button 
to the right of the source name displays.

• To display the source names of the key signals assigned to buttons, hold 
down the [SPLIT] button in the key control block or the [KEY] button in the 
auxiliary bus control block.

When using the AUX panel-less function (see page 139) with the CCP-6224/
6324 Control Panel, you can use the cross-point control block as an AUX bus 
control block with the [AUX CTRL] button.
In this case, use the key 1 row as AUX delegation buttons, and the key 2 row 
as AUX bus cross-point selection buttons; the source name displays show the 
bus names and source names.

Colors of lit cross-point buttons
In a particular row of cross-point buttons, only the last pressed button is 
effective, and lights amber or red. The amber indicates the “low tally” state, 
and the red indicates the “high tally” state, to indicate whether or not the 
selected signal appears in the final output video.
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Significance of colors of lit cross-point buttons

Color State Significance

Amber Low tally Does not appear in final output video

Red High tally Appears in final output video
Signal Selection
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Transitions

Selecting the Next Transition

To execute a transition, it is first necessary to decide how the image will be 
changed as a result of the transition. This selection is carried out using the next 
transition selection buttons (see page 48) in the transition control block of each 
M/E or PGM/PST bank.

For details of operations, see “Procedure for Basic Transition Operation” 
(page 148).

Transition Types

Selecting the transition type determines the way in which the transition occurs.
Carry out the type selection with the transition type selection buttons in the 
transition control block of each M/E or PGM/PST bank.

For details of this operation, see “Procedure for Basic Transition Operation” 
(page 148).

The following are the transition types.

Mix
This is a dissolve, in which the new video progressively fades in over the 
current video, with the sum of the two video outputs maintained constant. At 
the mid-point of the transition (when the fader lever is in the center position), 
the output of each is 50%.
This transition type can also be selected for an independent key transition. In 
this case, the key either dissolves in or dissolves out similarly, with the 
progress of the transition.

NAM (non-additive mix)
In this dissolve, the current video and new video signals are compared, and the 
signal with the higher luminance level is given priority in the output. The 
current video is maintained at 100% output for the first half of the transition as 
the new video increases progressively to 100%, then the current video is 
progressively reduced from 100% to zero in the second half with the new video 
maintained at 100% output.
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Note 
This transition type is not available for an independent key transition.

Super mix
In this dissolve, the current video is maintained at 100% output for the first half 
of the transition as the new video is mixed while increasing progressively to 
100%, then the current video is progressively reduced from 100% to zero in the 
second half with the new video maintained at 100% output.

For details on super mix settings, see page 157.

Note 
This transition type is not available for an independent key transition.

Preset color mix
This is a two-stage dissolve, comprising two transitions, the first a dissolve to 
a color matte, and the second from the color matte to the new video.
In the first transition, the current video is replaced by the color matte in a mix 
(dissolve), then in the second transition the color matte is replaced by the new 
video also in a mix (dissolve). 

For details on color matte settings, see page 158.

Note 
This transition type is not available for an independent key transition.

Wipe
A wipe replaces the current video by the new video according to a 
predetermined pattern. This transition type can also be selected for an 
independent key transition.

For details, see “Wipes” (page 25) and Chapter 5 “Wipes” (page 265).

DME wipe
Using a DME effect, it is possible to obtain a transition to a new image from 
the current image, as in a wipe. You can also use this transition type as an 
independent key transition.

For details, see “DME Wipes” (page 25) and Chapter 6 “DME Wipes” (page 
297).
Transitions
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Clip transitions

Linked to a mix (dissolve) or wipe transition, a frame memory clip (movie) is 
played back. 

Cut
A cut switches instantaneously from the current video to the new video. When 
the next transition is a key transition, the key cuts in or out instantaneously.
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Procedure for Basic Transition Operation

The positions of the principal buttons used for basic transition operation are as 
follows.

Transition control block (for standard transitions)

1 In the cross-point control block, select the background video with the 
background A row of cross-point buttons.

2 Select the way in which the transition will affect the image, using the next 
transition selection buttons in the transition control block.

For an overview, see “Selecting the Next Transition” (page 145).

To change the background: Press the [BKGD] button, turning it on.
To insert or delete a key: Press one of the [KEY1] to [KEY4] buttons (or 

[DSK1] to [DSK4] buttons in the PGM/PST bank), turning it on.
To enable the key priority setting, which determines the key overlay 

order after the transition: Press the [KEY PRIOR] button, turning it 
on.

You can press more than one button at the same time.
To change the keys and background presets in Setup menus 

simultaneously: Press the [ALL] button.

To allocate a particular next transition button to the [ALL] button 
function, see “Operation Settings (Operation Menu)” in Chapter 19 
(Volume 3).

BKGD KEY1 KEY2 KEY3 KEY4

KEY
PRIOR MIX

ALL
PST

COLOR
MIX

NAM

WIPE

SUPER
MIX

DME

PRIOR
SET NORM

NORM
/REV REV

TRANS
PVW

PTN
LIMIT

LIMIT
SET KF

AUTO
TRANS CUT

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

Next transition 
selection buttons

Transition type 
selection buttons

Transition execution 
section
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3 For the transition to change the key priority, set the priority for after the 

transition.

For details of the key priority setting operation, see “Key Priority Setting” 
(page 151).

4 Select the new video used for the transition.

• In the background B row of cross-point buttons, select the new 
background video.

• When inserting a key, select the key signal, and make any required 
settings.

For details of key settings, see Chapter 4 “Keys” (page 195).

To carry out a cut transition, skip to step 7; otherwise continue to step 5.

5 Select one of the transition type selection buttons in the transition control 
block.

To carry out a dissolve to the new video: Press one of the [MIX], 
[NAM], [SUPER MIX], and [PST COLOR MIX] buttons, turning it 
on.

To carry out a wipe: Press the [WIPE] or [DME] button, turning it on.
To carry out a transition while playing back a frame memory clip: 

Press one of the buttons corresponding to the clip to be used 
(FM1&2CLIP, FM3&4CLIP, FM5&6CLIP, and FM7&8CLIP).

You can also use the Misc  >Transition menu to select a desired transition 
type for the M/E or PGM/PST bank. (See “Selecting the Transition Type 
by a Menu Operation” (page 156).)

For an overview of the transition types, see “Transition Types” (page 
145).

Note
The transition type selection buttons in the transition control block can be 
interchanged in the setup menu.

For details, see “Overall Control Panel Settings (Config Menu)” in 
Chapter 19 (Volume 3).

6 Make the required settings, according to the selected transition type.

For details of the settings, see the relevant section.

Super mix: “Super Mix Settings” (page 157)
Preset color mix: “Color Matte Settings” (page 158)
Wipe: “Basic Procedure for Wipe Settings” (page 267)
149Procedure for Basic Transition Operation
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DME Wipe: “Basic Procedure for DME Wipe Settings” (page 308)
Clip transition: “Clip Transition Operations” (page 378)
Using the transition preview function (page 175), you can check the 
transition on the preview monitor.

7 Carry out the transition in the transition execution section.

For a gradual transition such as a mix (dissolve) or wipe: Press the 
[AUTO TRANS] button, or operate the fader lever.
To execute a transition by pressing the [AUTO TRANS] button, first 
set the transition rate (specified as the duration of the transition).
 (See “Setting the Transition Rate” (page 162).)
When you have selected a wipe or DME wipe as the transition type, 
you can also set the transition range. (See “Pattern Limit” (page 167).)

For an instantaneous transition: Press the [CUT] button.

For details, see “Executing a Transition” (page 161).

Transition linked to the audio mixer
If the video signal selected in the background B row is linked to the audio mixer 
in setup, then the audio mixer sound changes with the transition. That is, 
pressing the [AUTO TRANS] button gives a cross fade, and pressing the 
[CUT] button gives an instantaneous sound switch.

For details of setup, see “Cross-Point Settings (Xpt Assign Menu)” in Chapter 
19 (Volume 3).

Notes
• The audio mixer is not linked to a snapshot or key frame transition.
• The audio mixer is not linked to a transition using the fader lever.
• If the bus-fixed mode (see page 173) is selected in the setup menu, and the 

fader lever is in the lowest position, there is a cross fade from the audio 
selected on the B row to the audio selected on the A row.

• The audio mixer is not linked to a key transition.
• In the following cases, the audio and video may be out of sync.

– When carrying out a cross fade in some DME wipes (for example, “picture 
in picture”)

– When executing a preset color mix in two-stroke mode
• For details of audio mixers that can be used, Sony service or sales 

representative.
Procedure for Basic Transition Operation
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Key Priority Setting

Selecting the key priority
If a number of keys are already inserted in the current video, you can check or 
change the key priority, that is to say, the order in which the keys are overlaid.
When a key priority ([KEY PRIOR]) is selected as the next transition, you can 
also change the key priority in the new video.

The key priority values go from 1 to 4, with a higher priority key being “in 
front” as seen on the screen.

Priority sequence on the screen

There are two ways of setting the priority: either using the [PRIOR SET] button 
in the transition control block, or using the Misc menu to access the Key 
Priority menu for the M/E or PGM/PST bank.

Note 
When the operating mode is set to multi program, the key priority setting 
cannot be made.

Setting the Key Priority in the Transition Control Block

The positions of the buttons used for the operation are as follows.

4
3

2
1
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Transition control block (standard type)

Changing the currently inserted key priority

1 If the next transition selection button [KEY PRIOR] is on, press another 
next transition selection button to turn the [KEY PRIOR] button off.

(When the [KEY PRIOR] button is on, the transition control block 
switches to the mode for changing the key priority for after the transition.)

2 Holding down the [PRIOR SET] button, press the one of the next transition 
selection buttons [KEY1] to [KEY4] ([DSK1] to [DSK4] buttons in the 
PGM/PST bank) for the key to appear on top.

The selected key now appears on top, on the program monitor.
The priority of keys other than the selected one does not change.

To change the priority of more than one key, repeat this operation as 
required.

BKGD KEY1 KEY2 KEY3 KEY4

KEY
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Next transition 
selection buttons

KEY PRIOR button

PRIOR SET button

Key 1 selected.

Key priority: 3, 1, 4, 2 Key priority: 1, 3, 4, 2
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Changing the key priority for after the transition

When executing a transition, turning on the next transition selection button 
[KEY PRIOR] causes the keys to be rearranged based on the set priority.
To set the key priority for after the transition, use the following procedure.

1 In the transition control block, hold down the [PRIOR SET] button and 
press the [KEY PRIOR] button to turn it on. Do not release the [PRIOR 
SET] button before advancing to step 2.

The [KEY PRIOR] button lights green, and it becomes possible to change 
the key priority setting for after the transition.

2 Hold down the [PRIOR SET] button, and press the one of the next 
transition selection buttons [KEY1] to [KEY4] ([DSK1] to [DSK4] 
buttons in the PGM/PST bank) for the key you want to bring to the front 
after the transition.

To set the priority to be the same as before the transition, press the [BKGD] 
button.

Note
The [BKGD] button is only effective when in the mode for changing the 
key priority for after the transition. 

When the next transition selection button [KEY PRIOR] is on, the selected 
key appears on top on the preview monitor. The priority of keys other than 
the selected one does not change.

3 To change the priority of more than one key, repeat the previous operation 
as required.

4 Execute the transition.

The keys are rearranged based on the set priority.

Setting the Key Priority by a Menu Operation

Changing the priority of the currently inserted keys

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF3 ‘Key 
Priority.’

The Key Priority menu appears.
153Key Priority Setting



154

   C
hapter 3 

S
ignal S

election and Transitions
2 For each of <Priority1>, <Priority2>, <Priority3>, and <Priority4>, select 
a key, to determine the key priority sequence.

The keys are inserted in the key priority sequence with priority 1 at the 
front.

Note
It is not possible to select the same key for two or more priority numbers.

The keys appear in the set order on the program monitor.

Changing the key priority for after the transition

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF4 ‘Next 
Key Priority.’

The Next Key Priority menu appears.

2 For each of <Priority1>, <Priority2>, <Priority3>, and <Priority4>, select 
a key, to determine the key priority sequence.

For details of the key priority sequence, see the figure shown for step 2 in 
the previous item (see page 154).

The keys appear in the set order on the preview monitor.

3 Execute the transition.

The keys are rearranged in the set order on the program monitor.

1
2

3
4

Priority 1

Priority 2

Priority 3

Priority 4
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Display of the Key Output Status and Key Priority

You can check whether keys are currently output, and the key priority setting, 
using the key status display in the transition control block of the M/E or PGM/
PST bank.
The display is above the next transition selection buttons [KEY1] to [KEY4] 
([DSK1] to [DSK4] buttons in the PGM/PST bank).

Display of the key output status
When a key is included in the output from the M/E or PGM/PST bank, the 
corresponding ON indicator lights.

Key priority display
The key priority is indicated by numerals 1 to 4 lighting.
The topmost key as seen on the program monitor is priority 1, and the keys 
underneath are numbered 2, 3, 4 away from the viewer (see page 154).
To display the key priority for after the transition, press the [KEY PRIOR] 
button in the transition control block, turning it on. For keys for which the 
priority after the transition is different from the current priority, the 
corresponding numerals 1 to 4 flash. For a key with the same priority, the 
indication remains on.
Example key status display given when the [KEY PRIOR] button is pressed:
Current key priority: 1, 2, 3, 4
Key priority after the transition: 3, 2, 1, 4
Indicators: 1, 3 (flashing), 2, 1 (flashing), 3, 4

Example key status display (showing the key priority after the transition)

BKGD KEY1 KEY2 KEY3 KEY4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

ON
1 2 3 4

Lit

Flashing Flashing

LitLit

Lit
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Selecting the Transition Type by a Menu 
Operation

You can also select the required transition type by a menu operation.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select the required transition type in the <Transition Type> group.

The parameter settings can now be adjusted with the knobs according to 
the selected transition type.

For details, see the following.
• “Super Mix Settings” (page 157)
• “Color Matte Settings” (page 158)
• “Setting the Transition Rate” (page 162)

Note
When multi-program mode is selected in the Setup menu (see “Settings for 
Switcher Configuration (Config Menu)” in Chapter 20 (Volume 3)), there 
may be cases in which two or more transition types have been selected.
Selecting the Transition Type by a Menu Operation
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Super Mix Settings

You can set the output levels of the current and new video signals at the mid-
point of the transition, in the range 0 to 100%. 

Note
This transition type is not available for an independent key transition.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select [Super Mix] in the <Transition Type> group.

3 Turn the knobs to adjust the output levels.

Knob Parameter Adjustment Setting values

2 A Gain Background A output level 0.00 to 100.00% 

3 B Gain Background B output level 0.00 to 100.00% 
157Super Mix Settings
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Color Matte Settings

You can specify the color matte by luminance, saturation, and hue values.
Also, in place of a color matte you can use an image selected on the utility bus. 

Notes
• This transition type is not available for an independent key transition.
• In the multi-program mode, you can use a preset color mix only when 

selecting the background for the next transition.

One-stroke mode and one-time mode
• You can make a setting such that a preset color mix is carried out in a single 

transition. This is called “one-stroke mode.”
When the bus fixed mode is selected with a Setup menu setting, a preset color 
mix is always carried out in the one-stroke mode.

• You can also make a setting such that when a preset color mix is completed, 
the next transition switches to the previous transition type automatically. 
This is called “one-time mode.”

When only the background is changed

Preset color mix (changing background only)

Current video Color matte New video
Color Matte Settings
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When a key is inserted

Preset color mix (transition including key)

By means of a Setup menu setting, it is possible to preserve the key state while 
carrying out the color matte mix.

When, with a key inserted, a key is selected in the next transition

Preset color mix (when set to preserve key state)

Setting the color matte

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select [Preset Color Mix] in the <Transition Type> group.

3 In the <Preset Color Mix Fill> group, select one of the following.

Flat Color: monochrome color matte
Utility Bus: signal selected on the utility bus

4 When “Flat Color” is selected, turn the knobs to adjust the color matte.

Key fades out

Key

When a key is 
selected as the next 
transition

When no key is selected

Key fades in

Key

Key state preserved
Key gradually 
removed

Knob Parameter Adjustment Setting values

2 Luminance Luminance 0.00 to 100.00
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3 Saturation Saturation 0.00 to 100.00

4 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values
Color Matte Settings
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Executing a Transition

There are two modes of executing a transition: an auto transition by button 
operation or a manual transition using the fader lever.
It is also possible to combine both methods, taking control with the fader lever 
of an auto transition which has partly completed, or complete a transition 
started with the fader lever as an auto transition.
By combining common transitions with independent key transitions, different 
transition types can be applied to the background and keys, for example 
allowing a key wipe combined with a background dissolve. 
When the audio mixer is linked in setup, you can carry out an auto transition, 
and also switch the sound with the audio mixer. (See “Transition linked to the 
audio mixer” (page 150).)

Transition Indicator Function

In each of the M/E banks and PGM/PST bank, to the left of the fader lever is a 
transition indicator composed of multiple LEDs. This indicator shows the state 
of the transition, whether auto or manual, by which LEDs are lit.

Transition indicator

Lit
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For example, in the previous illustration, it can be seen that the transition is 
more than half completed.
When the transition is completed, all of the LEDs go off.

Setting the Transition Rate

There are three ways of setting the transition rate: using the Flexi Pad control 
block, Multifunction Flexi Pad control block or numeric keypad control block 
to enter a numeric value, or using the Misc menu to access the Transition menu 
for the M/E or PGM/PST bank.
You can also display the transition rate, independent key transition rate, and 
fade-to-black transition rate for each of the M/E and PGM/PST banks, and 
change the settings. (See “Displaying a List of Transition Rates and Changing 
the Settings” (page 404).)

Note
When a clip transition is selected as the transition type, it is not possible to set 
the transition rate.

Frame input mode and timecode input mode
For numeric input of the transition rate value, there are two modes: frame input 
mode and timecode input mode. You select one of these modes using either the 
Flexi Pad control block (page 163), Multifunction Flexi Pad control block or 
the numeric keypad control block (page 164).
Frame input mode: The entered value is a number of frames.

Example: Entering 123 constitutes an entry of 123 frames
Timecode input mode: The entered value is a timecode value.

Example: Entering 123 constitutes an entry of 1 second 23 frames.

Note
Whereas you can enter a value of up to 999 in frame input mode, a value not 
smaller than 10 seconds cannot be entered in timecode input mode.

Frame display mode and timecode display mode
For the transition rate display in the transition control block, there are two 
modes: frame display mode and timecode display mode. You can select one of 
these modes in setup. (See “Operation Settings (Operation Menu)” in Chapter 
19 (Volume 3).)

Note
The setting is common to all banks of the switcher.
Executing a Transition
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Frame display mode: Values are shown as from 0 to 999 frames. In this 

display mode, a value entered in timecode input mode is converted for 
display as a number of frames.

Timecode display mode: Values are shown as timecode values, consisting of 
seconds and frames. In this display mode, a value entered in frame input 
mode is converted for display as a timecode value. If the value consists of 
four or more digits, the last digit is not shown.
Example: A value of 9 seconds 23 frames appears as “9.23” and a value 

of 10 seconds 1 frame appears as “10.0.”

Setting the transition rate in the Flexi Pad control block

Note
In the PGM/PST bank or when using a simple-type transition control block, 
you cannot use the Flexi Pad control block to set the transition rate.

1 In the M/E bank Flexi Pad control block, press the [TRANS RATE] 
button.

The memory recall section display is now ready to accept the entered 
transition rate.

Flexi Pad control block (standard type)

2 Enter the desired transition rate with the numeric keypad. 
If required, press the [TC] button to toggle the input mode (frame input or 
timecode input).
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• Enter a value of up to three digits.
• To cancel the entry, press any of the six buttons in the leftmost column 

([WIPE], [DME], ...) or the [TRANS RATE] button.

3 Press the [ENTR] button.

This confirms the entry, and the new setting appears in the transition 
control block display.

Setting the transition rate in the numeric keypad control block

Numeric keypad control block

1 In the numeric keypad control block, press the [TRANS RATE] button.

2 Press the region selection button for the M/E or PGM/PST bank for which 
you want to set the transition rate, turning it on.

The numeric keypad control block display now shows the selected region 
name and the current transition rate setting for the region.

3 With the numeric keypad, enter the transition rate.
If required, press the [TC] button to toggle the input mode (frame input or 
timecode input).

• Enter a value of up to three digits.
• To clear the entry, press the [CLR] button.
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4 Press the [ENTER] button.

This confirms the entry, and the selected region name and the set transition 
rate appear in the numeric keypad control block display.
The transition control block display of the same bank (M/E or PGM/PST) 
also shows the setting.

To enter a difference from the current value
After pressing the [+/–] button, enter the difference and press the [TRIM] 
button.
To change the sign (+ or –), press the [+/–] button.

Setting the transition rate in the Multifunction Flexi Pad control 
block

This is an example when setting the M/E1 block background transition rate.

1 In the Multifunction Flexi Pad control block, press the [TRANS RATE] 
button.

The button displays in the memory recall section change as shown in the 
following illustration, and the Multifunction Flexi Pad control block 
switches to the transition rate setting mode.

2 In the region selection buttons, select the switcher bank.

3 Press the [TRANS SEL] button in the memory recall section.

The button displays in the memory recall section change as shown in the 
following illustration, and you can select the type of transition for which 
to set the rate.
165Executing a Transition
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4 Press the [KEY1] button.

You can now set the M/E-1 block background transition rate.

5 Watching the alphanumeric display, enter the transition rate you want to 
set with the memory recall section button.

If required, press the [TC] button to switch the input mode (frame count 
input or timecode input).
• Enter a value of up to three digits.
• To cancel the input, press any of the mode selection buttons.

6 Press the [ENTR] button.

Setting the transition rate by a menu operation

1 In the switcher bank, select first VF7 ‘Misc’, then HF1 ‘Transition.’

The Transition menu appears.

2 Select any transition type in the <Transition Type> group.

3 Turn the knob to set the transition rate.

Displaying the transition rates in a menu and changing the 
settings

For each of the M/E and PGM/PST banks, you can display the transition rate, 
independent key transition rate and fade-to-black transition rate, and change 
the settings.

Knob Parameter Adjustment Setting values

1 Transition Rate Transition Rate 0 to 999 (frame count)
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For more details, see “Displaying a List of Transition Rates and Changing the 
Settings” (page 404).

Pattern Limit

When a wipe or DME wipe pattern is selected for the transition, you can 
specify the range of movement of the wipe pattern through the course of the 
transition, for each bank independently.
When the pattern limit function is enabled, carrying out a transition results in 
the following effect for example settings.
• When the limit value is set to 50%, the effect at the end of the transition is 

the same as when the fader lever is at the center position in the normal case 
(with the pattern limit function disabled); the wipe pattern does not complete.

• When the limit value is set to 0%, the wipe effect is completely disabled, and 
carrying out the transition produces no change in the image.

• When the limit value is set to the maximum 100%, the image changes in 
exactly the same way as when the pattern limit function is off, but when the 
transition is completed, the cross-point selections on the background A and 
B buses do not interchange.

There are two ways of setting a pattern limit: either by operating the fader lever 
to save the fader position, or by using the Wipe menu or DME Wipe menu to 
access the Edge/Direction menu for the M/E or PGM/PST bank.

Notes
• A pattern limit only applies when a wipe or DME wipe is selected as the 

transition type.
• A pattern limit cannot be applied to an independent key transition (see page 

177).
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Transition control block (standard type)

Setting the pattern limit with the fader lever

1 Move the fader lever to the position corresponding to a particular pattern 
size.

• First make sure that the [PTN LIMIT] button is off.
• To check the pattern size on the preview monitor, first press the [TRANS 

PVW] button, to select the transition preview mode (see page 175).

2 Press the [LIMIT SET] button.

This sets the current fader lever position as the pattern limit.

Setting the pattern limit by a menu operation

1 When a wipe is selected as the transition type, in the M/E or PGM/PST 
menu, select first VF5 ‘Wipe,’ then HF4 ‘Edge/Direction.’

When a DME wipe is selected as the transition type, in the M/E or PGM/
PST menu, select first VF6 ‘DME Wipe,’ then HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 Press the [Pattern Limit] button, turning it on.
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3 Turn the knobs to adjust the following parameters.

a)  0.00%: Executing the transition does not change the video output at all.
b) 100.00%: The transition is the same as when no pattern limit is set, but the cross-point 

button selections of the background A and B buses do not interchange when the transition 
completes.

Executing a pattern limit transition

1 Press the [PTN LIMIT] button, turning it on.

The button you pressed lights amber.

2 Carry out the transition.

The transition progresses as far as the set pattern limit. Even if the 
transition completes, the cross-point button assignments of the background 
A and B buses do not interchange.

3 Carry out the transition once again.

The status before the previous transition is restored.

To cancel the pattern limit
To cancel the pattern limit after completion of step 3 in the previous procedure, 
press the [PTN LIMIT] button, turning it off.
If after carrying out step 2 in the previous procedure, the pattern limit has been 
reached, carry out the following procedure.

1 Press the [PTN LIMIT] button.

The button you pressed lights green.

2 Carry out the transition.

The [PTN LIMIT] button goes off, and the pattern limit state is released.
Depending on the way in which the transition was executed, the action will 
be as follows.
• When you press the [CUT] button, the pattern limit is immediately 

released, and the image switches instantaneously.
• When you press the [AUTO TRANS] button, until the state of the next 

transition, the transition is carried out over the duration given by the 
transition rate.

• When you move the fader lever, the transition is carried out from the 
pattern limit state to the state before the pattern limit transition was 

Knob Parameter Adjustment Setting values

1 Pattern Limit Pattern limit 0.00 a) to 100.00% b)
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carried out.
Moving the fader lever even a little synchronizes the fader lever position 
with the transition state, and you can move the fader lever either in the 
forward direction or in the reverse direction.

Depending on the Setup settings, the transition may be executed at the 
instant you press the [PTN LIMIT] button, and the button goes off. In this 
case, execution continues for the time specified by the dedicated transition 
rate in the menu setting, as far as the state of the next transition.

For details of the setting, see “Settings Relating to Keys, Wipes, Frame 
Memory and Color Correction (Key/Wipe/FM/CCR Menu)” in Chapter 20 
(Volume 3).

To set the transition rate when the pattern limit is released

1 In the <Pattern Limit Release> group of the Edge/Direction menu, select 
one of the following.

Auto Trans Rate: Use the transition rate set in the transition rate control 
block

Independ Trans Rate: Independent transition rate

2 If you selected “Independ Trans Rate” in step 1, adjust the following 
parameter.

Executing an Auto Transition

The following two modes can be used for auto transition.

Cut
A cut switches instantaneously from the current video to the new video. When 
the next transition is a key transition, the key cuts in or out instantaneously.

Auto transition
The transition from the current video to the new video is carried out 
automatically at a constant rate, using the transition effect selected as the 
transition type.
You can set the transition rate in advance. (See “Setting the Transition Rate” 
(page 162).)

Knob Parameter Adjustment Setting values

1 Transition Rate Independent transition rate 0 to 999 (frames)
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Transition control block (standard type)

To execute a transition on the M/E or PGM/PST bank by a button operation, 
use the following procedure in the transition control block.

To carry out an instantaneous cut transition: Press the [CUT] button.
To carry out a gradual transition: Press the [AUTO TRANS] button.

This executes the transition at the preset transition rate (see page 162).
While the transition is executing, the [AUTO TRANS] button lights 
amber. When it completes the button goes off.

To complete a partially executed transition instantaneously: Press the 
[CUT] button.
The [AUTO TRANS] button goes off.

Executing a Transition With the Fader Lever (Manual 
Transition)

Using the fader lever, you can manually control the progress of the transition. 
Moving the fader lever from one end of its travel to the other completes the 
transition.

To execute a manual transition with the transition control block fader lever, use 
the following procedure.

To carry out the transition completely: Move the lever over the full range of 
its travel.
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To pause a partly executed transition: Stop moving the fader lever.
To resume a paused transition: Resume moving the fader lever.

Combinations of Auto and Manual Transitions

Using the [AUTO TRANS] button, the [CUT] button, and the fader lever, use 
the following procedures.

Moving the fader lever during an auto transition
During an auto transition started by pressing the [AUTO TRANS] button, 
operating the fader lever immediately enables the fader lever, and the [AUTO 
TRANS] button goes off. Thereafter, the fader lever controls the progress of 
the transition.

Executing an auto transition after partly moving the fader lever
• Press the [CUT] button to instantaneously complete the transition.
• Press the [AUTO TRANS] button to complete the rest of the transition at the 

preset transition rate.
If the transition rate is set to 100 frames, and the fader lever has moved 
through 1/4 of the transition, then the remaining 3/4 of the transition is carried 
out in 100 frames.

Non-Sync State

If the fader lever is in an intermediate position when a transition is completed 
as an auto transition, then the lever position no longer agrees with the transition 
state. This is termed a non-sync state.
In a non-sync state, two lit LEDs indicate the position from which a normal 
transition can be carried out. This is either at one end position or both end 
positions of the fader lever travel.
Moving the fader lever toward the position of the lit LEDs does not carry out a 
transition, but when the fader lever reaches the end position the non-sync state 
is released, and it is now possible to carry out the next transition.
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• If the fader lever is moved in the direction away from the lit LEDs, this 
carries out the next transition, over the remaining part of the fader lever 
travel.

• Even in a non-sync state, you can carry out an auto transition by pressing the 
[AUTO TRANS] button. During the auto transition, the indicators show the 
transition progress in the usual way, but when the transition completes, they 
once again indicate the non-sync state.

Fader Lever Operation in Bus Fixed Mode

Flip-flop mode and bus fixed mode
The following describes the difference between flip-flop mode and bus fixed 
mode, taking an M/E bank as an example; the functionality is the same, 
however, on the PGM/PST bank.
Normally, when a background transition is carried out on an M/E bank, the 
signals selected on the A and B rows of cross-point buttons are interchanged at 
the end of the transition. That is to say, except during a transition, the 
background output is always from the background A bus. This is called “flip-
flop mode.”
The alternative is known as “bus fixed mode,” in which there is no bus 
interchange. In this mode, when the fader lever is at the top of its travel the 
output from the A bus is always 100%, and when the fader lever is at the bottom 
of its travel the output from the B bus is 100%.

Manual transition completed as auto 
transition when moving the fader 
lever upward: Top two LEDs light.

Manual transition completed as 
auto transition when moving the 
fader lever downward: Bottom two 
LEDs light.

Once the fader lever is moved 
to this position, the non-sync 
state ends, and the next 
transition (direction shown by 
the arrow) is possible.
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Flip-flop mode and bus fixed mode

In the bus fixed mode there is a fixed relationship between the position of the 
fader lever and the signal output on each bus. Depending on the direction of the 
transition, the fader lever must therefore always be moved in a particular 
direction, as shown in the following table. This does not affect an auto 
transition, which is executed regardless of the fader lever direction.

Fader lever operating direction in bus fixed mode

• When a transition applies to a combination of more than one of the 
background and keys 1, 2, 3, and 4, then the transition for all of these must 
be in the same direction complying with the above table.

• If as a result of an auto transition, for example, the fader lever position does 
not agree with the signal output, this is a non-sync state (see page 172) and 
LEDs light at both end positions of the fader lever travel. Moving the fader 
lever does not carry out a transition, but when the fader lever reaches the end 
position the non-sync state is released, and it is now possible to carry out the 
next transition. If the fader lever is moved in the direction away from the lit 
LEDs, this carries out the next transition, over the remaining part of the fader 
lever travel. 

A

B

BLACK

BLACK

A

B

BLACK

BLACK

A

B

BLACK

BLACK

Buttons lit

Fader 
lever

Flip-flop mode

Bus fixed mode

Next transition Transition direction Fader lever movement

Background A t B Downward

B t A Upward

Keys 1, 2, 3, and 4 On t Off (deletion) Downward

Off t On (insertion) Upward
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Transition Preview

With the preview output of the M/E banks and PGM/PST bank, you can check 
the effect of a transition in advance. To carry out a transition preview, press the 
[TRANS PVW] button in the transition control block.

Note
In multi-program mode or bus fixed mode (page 173), it is not possible to carry 
out a transition preview.

Carrying out a transition preview

1 In the M/E or PGM/PST bank transition control block, press the [TRANS 
PVW] button.

The [TRANS PVW] button lights green, and the switcher is now in the 
transition preview mode. At this point, the preview output is the same as 
the program output before the [TRANS PVW] button was pressed.

2 Operate the fader lever, or press the [AUTO TRANS] button or [CUT] 
button.

On the preview monitor, you can check the effect of the transition.

To terminate a transition preview
There are three modes for a transition preview. To terminate a transition 
preview, carry out the operation which depends on the mode, and press the 
[TRANS PVW] button, turning it off.
Lock: Toggling the [TRANS PVW] button on and off switches between the 

transition preview mode and the normal mode.
Hold: The preview mode obtains only while the [TRANS PVW] button is held 

down.
One Time: Each time a transition ends, it reverts to the normal mode.
Set the transition preview mode in the following combinations. 

For details, see Chapter 19 “Control Panel Setup (Panel)” (Volume 3).

Transition Preview 
mode

Switcher setup
(Transition menu)
<Transition Preview> group

Panel setup
(Operation >Custom Button 
menu)
<Trans Pvw> group

Lock Normal Lock

Hold Normal Hold
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Notes
• During a transition, whether executed with the [AUTO TRANS] button or 

the fader lever, it is not possible to press the [TRANS PVW] button.
• In bus fixed mode (see page 173), transition previews are not available.
• When using the simple-type transition control block (see page 189), 

transition previews are not available.

One Time One Time –

Transition Preview 
mode

Switcher setup
(Transition menu)
<Transition Preview> group

Panel setup
(Operation >Custom Button 
menu)
<Trans Pvw> group
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Independent Key Transitions

What is an independent key transition?
In addition to common transitions, it is possible to carry out independent 
transitions on the keyers of the M/E banks and PGM/PST bank. These are 
called “independent key transitions.”
By carrying out an independent key transition in combination with a common 
transition, different transition types can be used for the background and keys. 
It is also possible to use different transition types for key insertion and key 
deletion by means of a Setup menu setting.

For details of this operation, see “Basic Independent Key Transition 
Operations” (page 180).

Combining other transitions with independent key transitions
When you set a common transition and a key independent transition for the 
same key, you can apply two different effects such as a wipe and mix (dissolve) 
(see page 145) to the key simultaneously.
When carrying out such a combination of transitions simultaneously on a key 
as auto transitions (see page 170), the result depends on the timing of pressing 
the respective [AUTO TRANS] buttons.

Simultaneous execution
If the [AUTO TRANS] buttons for the two transitions are pressed 
simultaneously, the following is the result.
Note that in both cases the common transition is a wipe and the independent 
key transition is a mix (dissolve).
Deleting a key with simultaneous transitions: With the key inserted, it is 

deleted simultaneously with the two transitions.
177Independent Key Transitions
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When the common transition completes, even if the independent key 
transition is still not completed, the two end simultaneously.

Deleting a key with simultaneous transitions

Inserting a key with simultaneous transitions: With the key not inserted, it 
is inserted simultaneously with the two transitions. If the common 
transition or independent key transition ends first, the other continues to 
completion.

Inserting a key with simultaneous transitions

Time offset execution
If the [AUTO TRANS] buttons for the two transitions are pressed with a time 
offset, the following is the result.
Note that in both cases the common transition is a wipe and the independent 
key transition is a mix (dissolve).
Time offset execution with the key inserted: With the key inserted, it is 

deleted with the two transitions acting with a time offset.
Whichever button is pressed first, when the common transition completes, 
even if the independent key transition is still not completed, the two end 
simultaneously.

Wipe and mix 
(dissolve) are 
carried out 
simultaneously.

The key is deleted, 
even if the 
independent key 
transition has not 
completed.

Wipe and mix 
(dissolve) are 
carried out 
simultaneously.

The transitions 
continue until both 
are completed.
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Example: When the independent key transition [AUTO TRANS] button 
is pressed later

Time offset execution with the key inserted

Time offset execution with the key not inserted: With the key not inserted, 
it is inserted with the transition whose [AUTO TRANS] button is pressed 
first.
Since the key is then in the inserted state, with the transition whose [AUTO 
TRANS] button is pressed later, the key is deleted. When the key is 
completely deleted, both transitions complete.

Time offset execution with the key not inserted

Common transition 
(wipe) start

Independent key 
transition (mix) start

The key is deleted, 
even if the 
independent key 
transition has not 
completed.

Common transition 
(wipe) start

Independent key 
transition (mix) 
start

The transition 
completes with the 
key deleted.

Example 1: When the independent key transition [AUTO TRANS] 
button is pressed later

Common 
transition (wipe) 
start

Independent 
key transition 
(mix) start

The transition 
completes with the 
key deleted.

Example 2: When the common transition [AUTO TRANS] button is 
pressed later
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Basic Independent Key Transition Operations

Independent key transition control block (standard type)

To set independent transitions for the keyers on the M/E or PGM/PST bank, 
use the independent key transition control block.

1 Select one or more of the delegation buttons [KEY1] to [KEY4] ([DSK1] 
to [DSK4] in the PGM/PST bank), turning them on.

You can press more than one button at the same time.

2 Select the transition type.

To fade a key in or out: Press the [MIX] button, turning it on.
To insert or delete a key using a dedicated wipe pattern: Press the 

[WIPE] button, turning it on.
To insert or delete a key using a dedicated DME wipe pattern: Press 

the [DME] button, turning it on.

If, in the Setup menus, you set insertion and deletion as independent 
modes, make the settings for the next transition in the independent key 
transition control block.
Separate settings are required both when inserting a key and when deleting 
it. For example, with the key not inserted, if you select the transition type 
and carry out a transition, this will be the setting when inserting a key.

KEY1 KEY2 KEY3 KEY4
K-MOD
EMBL K-SS

K-TR
ENBL

K-SS
STOREMIX WIPE DME

KEY1
ON

AUTO
TRANS

KEY2
ON

AUTO
TRANS

KEY3
ON

AUTO
TRANS

KEY4
ON

AUTO
TRANS

Independent key transition type 
selection buttons

Independent key transition
execution section

Key delegation buttons

Key source name display/key 
snapshot buttons
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You can also use the Transition menu to select a desired independent key 
transition type for each key (see the next section).

For details of the wipe settings, see “Wipe Settings for Independent Key 
Transitions” (page 279). For details of DME wipe settings, see “DME 
Wipe Settings for Independent Key Transitions” (page 318).

3 Execute the transition.

To insert or delete the key gradually with a mix or wipe transition: 
Press the [AUTO TRANS] button.

For details of the transition rate, see “Setting the Independent Key 
Transition Rate” (page 183).
For details of operation together with a common transition, see 
“Combining other transitions with independent key transitions” (page 
177).

To cut the key in or out instantaneously: Press the [KEY ON] button on 
the keyer.

Notes
• In an independent key transition, the pattern limit function is not 

available.
• When the following DME effects are set, the effects may be applied 

during wipe transitions. If the effects are not necessary, cancel the 
settings.
– Trail
– Motion Decay
– Wind
When the Keyframe Strobe effect is set, operating keyframes do the 
same effect. Cancel the unnecessary settings.
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Independent key transition operations when using the CCP-6224/
6324 Control Panel

Transition control block (compact type)

To carry out an independent key transition, press the corresponding button 
in the independent key transition execution section of the transition control 
block.
The color of the button shows the status as follows.
Lit green: transition in progress.
Lit amber: key inserted.
Lit red: key inserted into final program output.
Off: no key inserted.

For details of setting the transition rate, see “Setting the transition rate in 
the Flexi Pad control block” (page 163).

Setting the Independent Key Transition Type by a Menu 
Operation

You can also select the required independent key transition type by a menu 
operation.

1 In the M/E or PGM/PST menu, select first the desired one from VF1 
‘Key1’ to VF4 ‘Key4,’ then HF6 ‘Transition.’

The Transition menu for the selected appears.

2 Select the required transition type in the <Transition Type> group.
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If, in the Setup menus, you set insertion/deletion as independent modes, 
make the settings for insertion in the <On Transition Type> group, and the 
settings for deletion in the <Off Transition Type> group.

Setting the Independent Key Transition Rate

There are two ways of setting the transition rate: using the Flexi Pad control 
block, Multifunction Flexi Pad control block or numeric keypad control block 
to enter a numeric value, or using the Key menu to access the Transition menu 
for the M/E or PGM/PST bank.
You can also display the transition rate, independent key transition rate, and 
fade-to-black transition rate for each of the M/E and PGM/PST banks, and 
change the settings. (See “Displaying a List of Transition Rates and Changing 
the Settings” (page 404).)
When the setup selection is for separate transition rates for inserting or deleting 
a key, you can set both rates independently. For example, with the system in 
the state with the key not inserted, the transition rate setting applies to key 
insertion.

Setting the independent key transition rate in the Flexi Pad 
control block

Note
In the PGM/PST bank or when using a simple-type transition control block, 
you cannot use the Flexi Pad control block to set the transition rate.

1 In the Flexi Pad control block of the M/E bank, hold down the [TRANS 
RATE] button, and in the independent key transition control block, press 
the delegation button [KEY1] to [KEY4] for the key for which you want 
to set the transition rate.

The memory recall section display is now ready to accept the entered 
independent key transition rate.

2 Enter the desired transition rate with the numeric keypad.

• Enter a value of up to three digits.
• To cancel the entry, press any of the six buttons in the leftmost column 

([WIPE], [DME], ...) or the [TRANS RATE] button.

For details of frame input mode and timecode input mode, see page 162.

3 Press the [ENTR] button.
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Setting the independent key transition rate in the numeric 
keypad control block

Note
You cannot use the numeric keypad control block to set the transition rate for 
a simple transition.

1 In the numeric keypad control block, hold down the [TRANS RATE] 
button, and in the independent key transition control block, press the 
delegation button [KEY1] to [KEY4] ([DSK1] to [DSK4] in the PGM/PST 
bank) for the key for which you want to set the transition rate.

The numeric keypad control block changes to the mode for inputting the 
independent key transition rate, and its display now shows the 
corresponding region name and the current transition rate set for the 
region.

2 With the numeric keypad, enter the transition rate.

• Enter a value of up to three digits.
• To clear the entry value, press the [CLR] button.

For details of frame input mode and timecode input mode, see page 162.

3 Press the [ENTER] button.

This confirms the entry, and the selected region name and the set transition 
rate appear in the numeric keypad control block display.

To enter a difference from the current value
After pressing the [+/–] button, enter the difference and press the [TRIM] 
button.
To change the sign (+ or –), press the [+/–] button.

Setting the independent key transition rate in the Multifunction 
Flexi Pad control block

For example, to set the independent key transition rate for M/E-1 key1, carry 
out the following procedures.

1 In the Multifunction Flexi Pad control block, press the [TRANS RATE] 
button.

The Multifunction Flexi Pad control block switches to the transition rate 
setting mode.

2 In the region selection buttons, select the switcher bank.
Independent Key Transitions
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3 Press the [TRANS SEL] button in the memory recall section.

You can select the type of transition for which to set the rate.

4 Press the [KEY1] button.

This enables setting of the independent key transition rate for M/E-1 key1.

5 Watching the alphanumeric display, enter the transition rate you want to 
set with the memory recall section button.

If required, press the [TC] button to switch the input mode (frame count 
input or timecode input).
• Enter a value of up to three digits.
• To cancel the input, press any of the mode selection buttons.

6 Press the [ENTR] button.

Setting the independent key transition rate by a menu operation

1 In the M/E or PGM/PST menu, select first the desired one from VF1 
‘Key1’ to VF4 ‘Key4,’ then HF6 ‘Transition.’

The Transition menu for the selected key appears.

2 Select any transition type in the <Transition Type> group.

If, in the Setup menus, you set insertion/deletion as independent modes, 
make the settings for insertion in the <On Transition Type> group, and the 
settings for deletion in the <Off Transition Type> group.

3 Turn the knob to set the transition rate.

Independent key transition rate display
To check the set independent key transition rate, press the key source name 
display/key snapshot button above the corresponding delegation button when 
the [K-SS] button is off.

Knob Parameter Adjustment Setting values

1 Transition Rate Transition rate 0 to 999 (frame count)
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Displaying the independent key transition rates in a menu and 
changing the settings

For each of the M/E and PGM/PST banks, you can also display the transition 
rate, independent key transition rate and fade-to-black transition rate, and 
change the settings.

For more details, see “Displaying a List of Transition Rates and Changing the 
Settings” (page 404).
Independent Key Transitions
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Fade to Black

The PGM/PST bank provides a fade-to-black function, controlled with the 
[FTB] button in the fade to black control block. 

Note
In multi-program mode, it is possible to carry out a fade-to-black on a number 
of programs simultaneously.
You can also make a Setup menu setting such that a fade-to-black does not 
apply to particular programs.

For details of the setting, see “Settings Relating to Video Switching (Transition 
Menu)” in Chapter 20 (Volume 3).

Fade to Black Operation

Fade to black control block

Carrying out a fade to black
To carry out a fade to black, press the [FTB] button in the fade to black control 
block.
The fade to black is carried out with the transition rate set for the program 
output of the PGM/PST bank.
During the transition, the [FTB] button lights amber. When the transition 
completes (the video is completely black), the button lit color changes to red.

AUTO PST P/P

FTB

DME
K

DME
V

M/E
3

M/E
2

M/E
1

M/E
3K

M/E
2K

M/E
IK

P/P
K

FTB button
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Setting the Fade to Black Transition Rate

Setting the fade to black transition rate

1 In the PGM/PST menu, select first VF7 ‘Misc,’ then HF1 ‘Transition.’

The Transition menu appears.

2 Select [FTB].

3 Turn the knob to set the fade to black transition rate.

Displaying the transition rates in a menu and changing the 
settings

You can also display the transition rate, independent key transition rate, and 
fade-to-black transition rate for each of the M/E and PGM/PST banks, and 
change the settings.

For more details, see “Displaying a List of Transition Rates and Changing the 
Settings” (page 404).

Knob Parameter Adjustment Setting values

1 Transition Rate Transition rate 0 to 999 (frame count)
Fade to Black
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Simple Transition

The “simple transitions” refer to the transitions carried out using the simple-
type transition control block (or simple-type independent key transition control 
block).

Basic Operations for Simple Transitions

Transition control block (simple right-hand type)

Note
The simple transition control block cannot be installed in the CCP-6224/6324 
Control Panel.

KEY1

NORM
/REV

REV

KEY2

LIMIT
SET

PTN
LIMIT

TAKE

MIX

NAM

WIPE

DME

ON
OVER

ON
OVER

Key status display

Key transition selection buttons

Transition type selection buttons

Transition execution section
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Carrying out a transition using a simple-type transition control 
block

1 With the background A row of cross-point buttons in the cross-point 
control block, select the background video.

2 Using one of the following methods, select the way in which the transition 
will affect the image.

Use a combination of the transition type selection buttons ([MIX], [NAM], 
[WIPE] and [DME]) and the next transition selection buttons ([KEY1] and 
[KEY2]).

For an overview of the mix, NAM, wipe, and DME wipe transition types, 
see “Transition Types” (page 145). 

To change the background only: Press one of the [MIX], [NAM], 
[WIPE], and [DME] buttons.
The [KEY1] and [KEY2]buttons go off, and the system changes to the 
background transition mode.

To insert or delete key 1: Hold down the [KEY1] button and press one of 
the [MIX], [NAM], [WIPE], and [DME] buttons.

To insert or delete key 2: Hold down the [KEY2] button and press one of 
the [MIX], [NAM], [WIPE], and [DME] buttons.

To insert or delete key 1 and key 2 simultaneously: Hold down the 
[KEY1] and [KEY2] buttons, and press one of the [MIX], [NAM], 
[WIPE], and [DME] buttons.

To use a super mix or preset color mix: Select [Super Mix] or [Preset 
Color Mix] in the Misc >Transition menu for the M/E or PGM/PST 
bank.

To set the key priority, use the Misc >Key Priority menu for the M/E or 
PGM/PST bank. For details, see “Setting the Key Priority by a Menu 
Operation” (page 153).

Note
The transition type selection buttons ([MIX], [NAM], [WIPE], and 
[DME]) can be assigned to other transition types in setup.

For details, see “Overall Control Panel Settings (Config Menu)” in 
Chapter 19 (Volume 3).

3 Select the new background for after the transition.

• Select the background video with the background B row of cross-point 
buttons.
Simple Transition
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• To insert a key, select the key signal, and make various settings as 

required.

For details of key settings, see Chapter 4 “Keys” (page 195).

4 Depending on the transition type selected in step 2, make the required 
settings.

For details of the settings, see the following sections:

Super mix: “Super Mix Settings” (page 157)
Preset color mix: “Color Matte Settings” (page 158)
Wipe: “Basic Procedure for Wipe Settings” (page 267)
DME Wipe: “Basic Procedure for DME Wipe Settings” (page 308)
Clip transition: “Clip Transition Operations” (page 378)

5 Carry out the transition in the transition execution section.

For a gradual transition such as a mix or wipe: Press the [TAKE] 
button, or operate the fader lever.

See “Setting the Transition Rate” (page 162) and “Pattern Limit” (page 
167) as required.

Display of the Key Output Status and Key Priority

You can check the output status of keys 1 and 2 and the key priority setting, in 
the key status display in the transition control block.
The key status display includes two ON indicators corresponding to keys 1 and 
2.

Display of the key output status
When the key is inserted in the output from the M/E or PGM/PST bank, the 
indication “ON” lights, and when it is not inserted, the indication goes off.

Key priority display
The key lying in front on the program monitor has an indication “OVER” lit.

To set the key priority, use the Misc >Key Priority menu for the M/E or PGM/
PST bank. For details, see “Setting the Key Priority by a Menu Operation” 
(page 153).
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Split Fader

What does “split fader” mean?
The term “split fader” refers to the function of carrying out a transition with the 
fader lever split into left and right halves, so that the background A and 
background B buses can be manipulated separately.
To use the split fader, the following conditions must be met.
• The fader lever is in bus fixed mode. (See “Settings Relating to Video 

Switching (Transition Menu)” in Chapter 20 (Volume 3).)
• The necessary settings have been made in a Setup menu to enable the split 

fader (See “Settings Relating to Video Switching (Transition Menu)” in 
Chapter 20 (Volume 3).)

• A background is selected for the next transition.
• For the transition type, [MIX] or [NAM] is selected.

Split fader operation
The two halves of the split fader lever correspond to the buses as follows.
Right fader lever: Background A bus
Left fader lever: Background B bus
The relationship between the positions of the two fader levers and the image 
output in a mix is as follows.

• When the transition type is NAM, the outputs of the A bus and B bus in the 
above table are the outputs subjected to NAM.

• The transition indicators always show the progress of the background A bus.
• The operation of the left lever and that of the right lever can be swapped. (See 

“Operation Settings (Operation Menu)” in Chapter 19 (Volume 3).)

Independent Key Transitions With a Simple Transition 
Module

You carry out independent key transition operations using the independent key 
transition control block (simple type). This controls only keys 3 and 4. 
However, each key button can be assigned to any key in setup (see “Overall 
Control Panel Settings (Config Menu)” in Chapter 19 (Volume 3)).

Left lever position Right lever 
position

A bus output B bus output

Top Top 100% 0%

Bottom Top 100% 100%

Top Bottom 0% 0%

Bottom Bottom 0% 100%

Center Center 50% 50%
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Independent key transition control block (simple type)

Carrying out a transition using a simple-type independent key 
transition control block

1 Select the transition type for key 3 or key 4 using the independent key 
transition type selection buttons.

To fade a key in or out: Press the [MIX] button, turning it on.
To insert or delete a key using a dedicated wipe pattern: Press the 

[WIPE] button, turning it on.
To insert or delete a key using a dedicated DME wipe pattern: Press 

the [DME] button, turning it on.

For details of wipe settings, see “Wipe Settings for Independent Key 
Transitions” (page 279). For details of DME wipe settings, see “DME 
Wipe Settings for Independent Key Transitions” (page 318).

To cut the key instantaneously in or out: Press the [CUT] button, turning 
it on.

K-SS WIPE DME

SHIFT MIX CUT

KEY3
ON

TAKE

K-SS WIPE DME

SHIFT MIX CUT

KEY4
ON

TAKE

Key 3 control block Key 4 control block

Independent key transition type 
selection buttons

Independent key transition 
execution section

The functions of the key 3 control block and key 4 control block are the same.
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If, in the Setup menus, you set insertion and deletion as independent 
modes, make the settings for the next transition in the independent key 
transition control block.
Separate settings are required both when inserting a key and when deleting 
it. For example, with the key not inserted, if you select the transition type 
and carry out a transition, this will be the setting when inserting a key.

2 Carry out the transition in the independent key transition execution 
section.

To insert or delete the key gradually with a mix or wipe transition: 
Press the [TAKE] button.

To set the independent key transition rate using a simple-type transition 
control block, use the key 3 and key 4 Transition menus. For details, see 
“Setting the Independent Key Transition Rate” (page 183).

To cut the key in or out instantaneously: Press the [KEY 3 ON] button 
or [KEY 4 ON] button.

Note
In an independent key transition, the pattern limit function is not available.
Simple Transition
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Overview

A key is an effect in which a part of the background image is replaced by an 
image or superimposed text. The signal determining how the background is cut 
out is termed “key source,” and the signal that replaces the cut-out part is 
termed “key fill.”
 The system component responsible for processing a key is referred to as a 
keyer.

Note
There are some restrictions on the functions that can be used with key 3 and 
key 4, compared to key 1 and key 2.

Key Types

The key type indicates the manner in which the key source signal is used to cut 
out the background. In each bank, you can use the following key types. You 
can select the key type using the key type selection buttons in the key control 
block or Multi function Flexi Pad control block, or by a setting in the Type 
menu for the keyer. (See “Key Type Setting” (page 205).)

Luminance key
The background is cut out according to the luminance (Y) of the key source 
signal, and at the same time the key fill signal is cut out and then added to the 
background signal.

Linear key
This is a type of luminance key, but there is a reduced variability in gain, 
allowing more precise adjustment.

Color vector key
The key signal is created from a combination of the luminance and 
chrominance components of the key source signal. When perfect keying is not 
possible with a luminance key, this allows a key signal to be created even if the 
luminance level is low, provided that the colors have high saturation.
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Clean mode
In a luminance key, linear key or color vector key, you can enable the clean 
mode. When the clean mode is on, the key source does not affect the key fill, 
which is added unchanged to the background. This improves the keyed image 
quality, but means that the part of the key fill signal which is not to be inserted 
must be completely black, or it will color the background. You set the clean 
mode with the Type menu of the respective keyer. (See “Setting the key type in 
a menu” (page 205).)
Note that in the following situations, the clean mode goes off, and cannot be 
turned on.
• When the key type is a pattern key
• When key inversion is on
• When the key fill is a matte
• When the key edge is an outline
• When the key edge is normal with soft edge being on
• When fine key is on
• When the key positioner is on

Chroma key
A key signal based on a particular color is used to cut out the background, and 
the key fill is then inserted. The inserted signal is also referred to as the 
foreground, and the composite image is called a chroma key image.

For details of chroma key composition, see “Chroma Key Composition” (page 
207). For details of video adjustment operations and the adjustment items, see 
“Chroma Key Adjustments” (page 208).

Foreground Background

Chroma key image
Overview
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Key wipe pattern key
This uses the wipe pattern selected for an independent key transition as the key 
source.

Note on wipe pattern modifiers
In a key wipe pattern key, you can apply various modifications, depending on 
the pattern used, and the modifiers in common with a wipe.
However, modifiers which relate to the wipe direction and edge are not 
reflected.

Key Modifiers

Edge modifiers

Note
For key 3 and key 4, it is not possible to use edge modifiers.

You can apply borders and other effects to the edge of the key. (See “Key Edge 
Modifications” (pages 216 and 234).)

Name Effect Image

Normal This is the state with no key edge modifiers 
applied.

Border This applies a uniform width border to the 
edge of the key. You can adjust the border 
width and density. You can also enable the 
separate edge function, and adjust the top, 
bottom, left, and right border widths 
separately.
199Overview



200

   C
hapter 4 

K
eys
Edge type and key fill/key source position

Note
For key 3 and key 4, it is not possible to set key drop to On.

Drop 
border 

This applies a border below and to the right 
for example, of the key. You can adjust the 
border width, position, and density.

Shadow This applies a shadow below and to the right 
for example, of the key. You can adjust the 
shadow width, position, and density.

Outline This uses the outline of the original key as 
the key. You can adjust the width and 
density of the outline. You can also enable 
the separate edge function, and adjust the 
top, bottom, left, and right outline widths 
separately.

Emboss This applies an embossing effect to the 
outline of the key. You can adjust the width 
and position of the embossing, and the 
density. You can adjust the density 
separately for key fill and key edge. When 
embossing is on, the Fine Key and zabton 
functions go off.

–

Soft 
edge

This softens the edge of the key. –

Zabton This inserts a translucent pattern behind a 
key. You can adjust the pattern size, 
softness, density and color.

–

Name Effect Image
Overview
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The key edge modification function has two modes: a mode (“key drop ON 
mode”) in which the key fill/key source position moves downward, and a mode 
(“key drop OFF mode”) in which it does not move downward.
Key drop ON mode: The key fill/key source position moves downward by 

eight scan lines or four scan lines. When a drop border or shadow is 
selected, it is possible to apply a border to the top edge of the key.

Key drop OFF mode: The key fill/key source position does not move. When 
a drop border or shadow is selected, it is not possible to apply a border to 
the top edge of the key.

In the key drop ON mode, a menu setting selects between the mode (“4H 
mode”) in which the key fill/key source position is lowered by four scan lines, 
and the mode (“8H mode”) in which the key fill/key source position is lowered 
by eight scan lines.
When Fine Key is on, the edge width is forced to the range 0.00 to 4.00.

Note that in the following situations, the key drop mode is forcibly turned on.
• When the edge type is border, outline, or emboss
• When the edge type is normal with soft edge being on
• When Fine Key is on

To fix key fill / key source in key drop off mode
In the Edge menu, switch frame delay mode on (see page 220).
Regardless of the fine key and edge type settings, key fill and key source are 
fixed in key drop off mode. In this mode key image has a one-frame delay. 

Notes
• This function uses the resizer, and therefore the normal effect of the setting 

is not obtained while using DME wipe or other effect that uses the resizer. 
• This function cannot be used for key 3 or key 4.

Edge fill
When a border, drop border, or shadow modifier is selected, you can select a 
signal to fill these edge effects.
The edge fill is the signal from the dedicated color matte generator.
In the case of an outline, there is no edge fill signal selection, because the key 
fill signal fills the outline, and the rest of the image remains as the background.
For the emboss effect, in place of the edge fill signal, the emboss fill matte 1 
and emboss fill matte 2 signals are used.

Masks
A mask is used to inhibit the effect of a key over a part of the image. This 
allows parts of the background which would otherwise be keyed to be 
protected, or to correct the key if it is not of the desired shape.
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For details of masking operations, see “Masks” (pages 223 and 238).

Key mask and background mask
There are two types of mask: a key mask and a background mask.
Key mask: This masks out a part of the key, which will result in the 

background appearing.
Background mask: This masks out a part of the background, which will result 

in the key fill appearing.

Main mask: This uses the signal from the dedicated box generator provided 
on each keyer, or the signal from the dedicated pattern generator as the 
mask source.
When the box generator is selected, a rectangular mask is formed.
When the pattern generator is selected, you can select the pattern and apply 
modifiers.

Key Memory

The key memory function allows the keyer settings on each cross-point button 
to be automatically stored, so that the next time the same cross-point button is 
selected these settings are recalled automatically.
There are two modes for key memory: simple mode and full mode. 
The parameters stored in each mode are as follows.
Simple mode: key type, clean mode (including the plane setting for chroma 

keying), key position, key inversion, and adjustment values for the 
particular key type (Clip, Gain, Density, Filter, etc. This includes color 
vector key, key wipe pattern key, and chroma key. However, in the case of 
a chroma key, it excludes color cancel, Y balance, foreground CCR, 
window, and shadow.)

Full mode: All settings except transition (the same parameters as simple mode, 
Fine Key, key modifiers, mask settings, chroma key detailed settings, and 
so on)

Key mask

Masked area (box)

Background mask
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For the settings for these modes, see “Settings Relating to Keys, Wipes, Frame 
Memory and Color Correction (Key/Wipe/FM/CCR Menu)” in Chapter 20 
(Volume 3).

Key Default

With a simple operation you can return the key adjustment values to their 
defaults.
The adjustment values which can be returned to their default values are as 
follows.
• Adjustment values for the particular key type (Clip, Gain, Density, Filter, 

etc.)
In the case of chroma keying, all adjustment values return to their default 
values.

• Key position
• Key inversion
• Clean mode

For details, see “Returning the key adjustment values to their defaults” (page 
240).
For the menu operation to return the key adjustment values to their defaults, 
see “Returning to default state in function groupings” (page 116).
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Key Setting Operations Using Menus

There are two ways of making key settings: either using menus, or using the 
key control block or the Multifunction Flexi Pad control block.
This section describes basic procedures for making key settings using the 
menus, taking the M/E-1 >Key1 menu as an example.
Operations in the Key menus are the same for all banks (M/E-1 to M/E-3 and 
PGM/PST).

For details of the method of using the key control block, see “Key Setting 
Operations With the Key Control Block” (page 230).

Key Setting Menus

The key setting menus for each bank (M/E-1 to M/E-3 and PGM/PST) are as 
follows.

Accessing a key setting menu
For example, to access the M/E-1 >Key1 menu, carry out any of the following 
procedures.
• In the menu control block, select the top menu selection button [M/E 1], then 

press VF1 ‘Key1.’
• In the M/E-1 bank transition control block, press the KEY1 next transition 

selection button twice in rapid succession.
• In the M/E-1 bank independent key transition control block, press the key 

delegation button [KEY1] twice in rapid succession.
• In the key control block, press the M/E delegation button [M/E1], then press 

the key delegation button [KEY1] twice in rapid succession.
Any of the above operations displays the M/E1 >Key1 menu.
Note that you can access the DSK menus by pressing the button for the 
corresponding key in the downstream key control block twice in rapid 
succession.

Bank Keys set Menus

M/E-1 Keys 1 to 4 M/E-1 >Key1 to 4

M/E-2 Keys 1 to 4 M/E-2 >Key1 to 4

PGM/PST Downstream keys 1 to 4 PGM/PST >DSK1 to 4
Key Setting Operations Using Menus
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Key Type Setting

Setting the key type in a menu

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’

The Type menu appears.

2 In the <Key Type> group, select the key type.

Luminance: luminance key
Linear: linear key
Chroma: chroma key
Color Vector: color vector key
Key Wipe Pattern: key wipe pattern key

For the selected key type, you can now set the parameters.

For an overview of the key types, see “Key Types” (page 197). 

3 Carry out the following settings as required, depending on the key type 
selected in step 2.

To enable clean mode (see page 198) for a luminance key, linear key or 
color vector key: Select [Clean Mode] so that it is set on.
When clean mode is enabled, key fill is added to the background 
without cutting out with key source.

When chroma key is selected: Select [Chroma Adjust] to access the 
Chroma Adjust menu (see page 210), and make the required settings.

When a key wipe pattern key is selected: In the M/E-1 >Key1 >
Transition >Wipe Adjust menu (see page 279), carry out pattern 
selection and modifier setting, then return to the M/E-1 >Key1 >Type 
menu.

Note
For a wipe pattern selected for a key wipe pattern key, the [Edge] and 
[Direction] modifier settings are not available.

4 Set the parameters.

• When a luminance key or linear key is selected

Knob Parameter Adjustment Setting values

1 Clip Reference level for generating the 
key signal

+109.59 to –7.31

2 Gain Key sensitivity –100.00 to +100.00
205Key Setting Operations Using Menus



206

   C
hapter 4 

K
eys
a) Setting this value to 1, produces the “through” state in which no filter is applied. The larger 
the value, the more strongly the filter applies.

• When a chroma key is selected

• When a color vector key is selected

• When a key wipe pattern key is selected

5 Make the following settings as required.

To invert the black and white sense of the key source: Press [Key 
Invert], turning it on.

To adjust the horizontal position or key source width for a luminance 
key, linear key, or chroma key: Press [Key Position], turning it on, 
and set the parameters.

3 Density Key density 0.00 to 100.00

4 Filter Filter coefficient 1 to 9 a)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

3 Density Key density 0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Y Clip Reference level for creating 
luminance signal

+109.59 to –7.31

2 Y Gain Luminance signal sensitivity –100.00 to +100.00

3 C Clip Reference level for creating 
chrominance signal

100.00 to 0.00

4 C Gain Chrominance signal sensitivity –100.00 to +100.00

5 Density Key density 0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Y Filter Luminance signal filter coefficient 1 to 9

2 C Filter Chrominance signal filter 
coefficient

1 to 9

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of edge softness 0.00 to 100.00

3 Density Key density 0.00 to 100.00
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To set the key priority: Press [Key Priority] or select VF7 ‘Misc’ and 
HF3 ‘Key Priority’ to access the Key Priority menu.

For details, see “Setting the Key Priority by a Menu Operation” (page 
153).

Chroma Key Composition

Normal mix and additive mix
In creating a chroma key image, either a normal mix or an additive mix can be 
used. To select which, use the Type >Chroma Adjust menu for the keyer.
Normal mix: The foreground is cut out with the key signal, and then combined 

with the background, which has also been cut out with the key signal.
Additive mix: The background, which has been cut out with the key signal, is 

combined with the unshaped foreground. This is effective for a natural-
looking composite when the scene includes glass or other translucent 
objects.

Plane function
In an additive mix, the foreground is not shaped by the key signal, and 
variations in the (blue) background appear in the composite image. To prevent 
this, it is possible to set a particular luminance level for the background, and 
any parts below this level are cut forcibly.

Composing an image by chroma keying
There are two types of composition for chroma keying: normal mix, and 
additive mix.

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’

2 Select [Chroma] in the <Key Type> group.

It becomes possible to adjust the key density (see page 206).

3 Select [Chroma Adjust].

The Chroma Adjust menu appears.

Knob Parameter Adjustment Setting values

1 H Phase Key horizontal position –4.00 to +4.00

2 Left Key left edge position –4.00 to +4.00

3 Right Key right edge position –4.00 to +4.00
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4 Carry out auto chroma key adjustments. 
Also carry out manual adjustments if necessary to obtain an optimum 
chroma key image.

For the adjustment procedures, see page 208.

5 In the <Mix Mode> group, select [Normal Mix] or [Additive Mix] 
depending on the desired type of chroma key composition.

When using an additive mix for chroma keying, the (typically blue) 
background parts of the foreground video must be converted to black. For this, 
use the color cancel function (see page 211).

Using the plane function
In an additive mix, since no key is applied to the foreground, any variations in 
the (typically blue) background may appear in the composite image. To avoid 
this, a particular luminance level can be set for the (blue) background, and 
regions of lower luminance forcibly cut.

1 In the Chroma Adjust menu, set [Plane] on.

2 Adjust the following parameter.

Chroma Key Adjustments

Methods of adjusting the composite obtained from chroma keying include 
automatic adjustment with the auto chroma key function, and manual 
adjustment carrying out the necessary processing separately. The optimum 
results will be obtained by first carrying out adjustments with the auto chroma 
key function, then making any fine adjustments as required.
The following manual adjustments are possible.

Key active
When this function is off, only the foreground is output and you can make 
adjustments of color cancel (see the next paragraph).

Color cancel
If the foreground image includes shades of the background color, turn this 
function on to remove the color from the foreground image.

Knob Parameter Adjustment Setting values

1 Luminance Luminance level 0.00 to 100.00
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Chroma key window
You can adjust the range over which the key signal is determined as matching 
the specified hue. When this adjustment is off the default ranges are used.

Chroma keying generates a key signal based on a particular color (reference 
color) in the foreground (typically a plain blue background), and the “window” 
refers to the range of colors which are regarded as matching this specified 
reference color to create the key signal.
As seen on a vectorscope (that is, in the hue-saturation color space), the range 
for this matching corresponds to a truncated sector. This range is specified by 
two parameters: the “Angle” parameter, which determines the range of the hue 
parameter, and the “Crop” parameter, which determines the degree of 
truncation (see the following figure).

Window adjustment

Y balance
In normal chroma keying, the key signal is based on the chrominance 
component only, and all elements of the foreground with the same hue are 
replaced by the background. Using the Y balance function, you can specify a 
luminance level range within which the key is active, and replace the specified 
part by the background.
You can use the Y balance function independently on the key signal for the 
composition and the key signal for the color cancel function. When applied to 
the key signal for the composition, this produces the foreground with the color 
cancel effect applied. This can therefore be used to provide an impression of 
smoke, for example.

Reference color 
specified by Hue 
setting

Range of colors creating the key signal 
(to be replaced by background signal)

Range of colors remaining 
as foreground

a) The Crop and Angle values do not change even if 
you use the auto chroma key function.

Angle a)

Crop a)
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When the Y balance function is applied to the color cancel key, the relevant 
part is output in its original color without canceling, and therefore it is possible 
to combine colors which are the same color as the background (i.e. typically 
blue) in the foreground.

Video signal adjustment
You can vary the foreground signal gain, or change the hue. There are separate 
adjustments for the gain of the overall video signal, and Y and C components.

Making auto chroma key adjustments
Auto chroma key is an automatic adjustment function which allows you to 
specify a part of the foreground video (for example, the blue background color) 
and use it as a reference for creating the chroma key image.

1 In the M/E-1 >Key1 menu, select HF1 ‘Type,’ then select [Chroma] in the 
<Key Type> group.

2 Select [Chroma Adjust].

The Chroma Adjust menu appears.

3 Select [Sample Mark] in the <Auto> group.

The foreground video only appears on the monitor, with a white box-
shaped sample selector.

4 Adjust the position and size of the sample selector, to specify the color to 
be used as the basis of chroma keying (typically a blue background).

a) The setting ranges depend on the signal format, screen aspect ratio, and size settings.

5 Select [Auto Start] in the <Auto> group.

This executes an auto chroma key based on the color specified by the 
sample selector, and displays the composite image on the monitor.

Making key active adjustments
When the key active function is on, the composite image is output to the 
monitor, and you can watch the monitor while manually adjusting the keying. 

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –100.00 to +100.00 a)

2 Position V Vertical position –100.00 to +100.00 a)

3 Size Size 1.00 to 100.00
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When the key active function is off, only the foreground image appears. Set 
this off when manually adjusting color cancel (see the next section).

1 In the Chroma Adjust menu, set [Key Active] on.

2 Adjust the following parameters.

Making color cancel adjustments
If the background color is leaking into the foreground video, turning the color 
cancel function on allows you to eliminate this leakage.

1 In the Chroma Adjust menu, turn [Key Active] off.

Only the foreground image appears on the monitor.

2 In the <Color Cancel> group, set [Color Cancel] on.

3 Adjust the following parameters.

4 Set [Key Active] on.

The chroma key composite image now appears in the monitor.

Making key signal adjustments for color cancel
When the color cancel function is set on, you can adjust the key signal for color 
cancel.

1 In the <Color Cancel> group of the Chroma Adjust menu, set [Color 
Cancel] on.

Knob Parameter Adjustment Setting values

1 Clip Chroma key reference level 0.00 to 100.00

2 Gain Key gain –100.00 to +100.00

3 Hue Hue 359.99 to 0.00

4 Density Density 0.00 to 100.00

5 Filter Filter coefficient 1 to 9

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

5 Filter Filter coefficient 1 to 9
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2 In the <Color Cancel> group, set [Cancel Key] on.

The cancel key is now on, and you can now adjust the key signal for color 
cancel.

3 Make the following settings, as required, in the <Color Cancel> group.

• When setting [Key Position] on and adjusting the color cancel key 
edge position

• When setting [Window] on and adjusting the detection range of the 
color cancel key

For details of the crop and angle parameters, see “Chroma key window” 
(page 209).

• When setting [Y Balance] on and adjusting the ratio in which Y 
balance is added to the color cancel key

Adjusting the window
Setting the window function on allows you to adjust the detection range used 
to determine the key signal. When this function is off, the default range is used 
for the key.

For an overview of the window, see “Chroma key window” (page 209).

Knob Parameter Adjustment Setting values

1 Clip Color cancel key reference level 0.00 to 100.00

2 Gain Color cancel key gain –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 H Phase Move left and right edges of the 
color cancel key simultaneously

Left edge position 
value shown

2 Left Move left edge of the color cancel 
key

–3.00 to +3.00

3 Right Move right edge of the color 
cancel key

–3.00 to +3.00

Knob Parameter Adjustment Setting values

1 Crop Crop value 100.00 to 0.00

2 Angle Angle value 180.00 to 0.00

Knob Parameter Adjustment Setting values

1 Mixture Ratio of Y balance key 0.00 to 100.00
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After making sure that the values of Clip, Gain, and Hue are adjusted 
appropriately, use the following procedure to make the window adjustment.

1 In the Chroma Adjust menu, set [Window] on.

2 Adjust the following parameters.

Adjusting the Y balance
Setting the Y balance on allows you to specify that, even if the hue is the same, 
only portions of a particular luminance will be replaced by the background.

For an overview of the Y balance, see “Y balance” (page 209).

1 In the Chroma Adjust menu, set [Y Balance] on.

2 Adjust the following parameters.

Adjusting the video signal
You can change the gain of the foreground signal, or vary the Hue. There are 
separate adjustments for the gain of the whole video signal, or Y and C 
individually.

1 In the Chroma Adjust menu, set [FRGD CCR] on.

2 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Crop Crop value 100.00 to 0.00

2 Angle Angle value 180.00 to 0.00

Knob Parameter Adjustment Setting values

1 Clip Luminance range 0.00 to 100.00

2 Gain Key gain –100.00 to +100.00

3 Luminance Luminance 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Video Gain Overall gain of video signal –100.00 to +100.00

2 Y Gain Y signal gain –100.00 to +100.00

3 C Gain C signal gain –100.00 to +100.00

4 Hue Hue offset amount –180.00 to +180.00
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Selecting Key Fill and Key Source

Selecting key fill and key source
To select key fill and key source for key 1 on the M/E-1 bank, use the following 
procedure.

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’

The Type menu appears.

2 In the <Key Fill> group, select either of the following for use as key fill.

Key Bus: signal selected on the key 1 fill bus
Matte: signal from the dedicated color matte generator

3 If you selected [Key Bus] in step 2, select the key fill signal on the key 1 
row in the cross-point control block.

To select key fill for key 3 or key 4 in the cross-point control block, press 
the [KEY3] button or [KEY4] button to the right of the key bus buttons, 
turning it on, to allocate the key 1 row or key 2 row to the key 3 fill or key 
4 fill, then press the desired cross-point button.
For the CCP-6224/6324 Control Panel, it is necessary to set the [AUX 
CTRL] button to Off in order to exit the AUX panel-less function (see page 
139).

4 If you selected [Matte] in step 2, in the same Type menu, press the [Matte 
Adjust] button to display the Matte Adjust menu, then adjust the single-
color or two-color combination color matte. Select whether to use a single-
color matte or a two-color combination in the <Fill Matte> group.

Flat Color: Adjust color 1 with the following parameters.

Mix Color: Carry out a color mix. Adjust color 1 and color 2, and select a 
mix pattern (see the next section).

5 In the <Key Source> group, specify the key source selection mode.

Self: The key fill bus signal is automatically selected as the key source.
When the key type is selected as chroma key, select [Self].

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Auto Select: The signal allocated, being paired with the key fill bus signal, 
to a cross-point button is automatically selected as the key source. The 
setting of key fill and key source pairs is carried out in the Setup menu. 
(See “Cross-Point Settings (Xpt Assign Menu)” in Chapter 19 
(Volume 3).)

Split: You can select a key source signal independently of the key source 
automatically selected in Auto Select mode.

6 When [Split] was selected in step 5, hold down the [SPLIT] button in the 
key control block or the Multifunction Flexi Pad Control block, then in the 
cross-point control block key 1 row, select the key source signal. 
Alternatively, hold down the key delegation button in the transition control 
block and press a cross-point button in the key 1 row to select the key 
source signal.

Notes
• In the above-stated key 1 row operation, you can only select a key signal 

assigned to a cross-point button. For the method of selecting a video 
signal, see “To select a video signal assigned to a cross-point button” 
below.

• When [Split] is selected, the key memory function (see page 202) is 
disabled.

To select a video signal assigned to a cross-point button
By selecting the key source bus with an auxiliary bus control block AUX 
delegation button, and pressing the cross-point button, it is possible to select 
the video signal assigned to the cross-point button.
(If you press the cross-point button with holding down [KEY], the key signal 
assigned to the cross-point button.)

Note
In the above operation, the following settings must have been made.
• Assigning the key source bus to an AUX delegation button

For details, see “Auxiliary Bus Control Block Settings (Aux Assign Menu)” 
in Chapter 19 (Volume 3).

• Setting the [KEY] button operating mode

For details, see “Operation Settings (Operation Menu)” in Chapter 19 
(Volume 3).
215Key Setting Operations Using Menus



216

   C
hapter 4 

K
eys
Carrying out a color mix for key fill
When [Matte] is selected for key fill, you can combine color 1 and color 2. For 
the combination, you can use not only a key wipe generator pattern for key 
edge color mix.

1 In the <Key Fill> group of the Type menu, select [Matte] and press [Matte 
Adjust].

The Matte Adjust menu appears.

2 Select [Mix Color] in the <Fill Matte> group.

3 Adjust the following parameters.

You can change this pattern by pressing [Pattern Select] to open the menu 
for key wipe pattern selection (Pattern Select menu), and make 
adjustments by pressing [Pattern Adjust] to open the menu for pattern 
adjustment (Wipe Adjust menu).

4 In the Type menu, adjust color 1 and color 2.

To adjust color 1, select [Color1], and to adjust color 2, select [Color2], 
then adjust the following parameters.

5 To interchange color 1 and color 2, press the [Color Invert] button, turning 
it on.

Key Edge Modifications

Note
For key 3 and key 4, it is not possible to use edge modifiers.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Softness of the edge of the 
pattern

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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To modify the key edge of key 1 on the M/E-1 bank, use the following 
procedure.

1 In the M/E-1 >Key1 menu, select HF2 ‘Edge.’

The Edge menu appears.

2 Select the edge type in the <Edge> group.

For an overview of the key edge modifications, see “Edge modifiers” 
(page 199).

Normal: unadorned edge
Border: edge with border applied
Drop Border: edge with drop border applied
Shadow: edge with shadow applied
Outline: edge used as outline
Emboss: embossing effect applied to edge

If you select [Normal], skip to step 7.

3 Set the border width and other parameters.

When border or outline is selected: The setting parameters depend on 
the key type and whether the separate edge function is enabled or not. 
To enable the separate edge function, press [Separate Edge], setting it 
on.

• Separate edge off

a) In the “4H mode” and when [Fine Key] (page 219) is on, the setting value range is 0.00 
to 4.00.

b) When a wipe pattern key or key wipe pattern key is selected as the key type

• Separate edge on
The left, right, top, and bottom border or outline widths can be adjusted 
independently. The separate edge function is only valid when a 
luminance key, linear key, or chroma key is selected as the key type.

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00 a)

(0.00 to 100.00) b)

3 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Top Top edge width 0.00 to 8.00 a)

2 Left Left edge width 0.00 to 8.00 a)
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a) In the “4H mode” and when [Fine Key] (page 219) is on, the setting value range is 0.00 
to 4.00.

When drop border or shadow is selected: The setting parameter values 
depend on the on/off setting of key drop and the selection of 4H mode/
8H mode (see page 200).

• “Key drop OFF” mode 

• “Key drop ON” mode

a) In the “4H mode” and when [Fine Key] (page 219) is on, the setting value range is 0.00 
to 4.00.

When emboss is selected:

a) The Density adjustment only affects the key edge. This can be adjusted separately from 
Key Density, and if Key Density is set to 0.00, the embossed edge effect only can be 
applied.

To make edge fill adjustments, carry out the settings in step 6.

4 Press [Edge Matte], and adjust the color parameters for the edge fill signal.

3 Right Right edge width 0.00 to 8.00 a)

4 Bottom Bottom edge width 0.00 to 8.00 a)

5 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00

2 Position Position 359.99 to 180.00

3 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00 a)

2 Position Position 359.99 to 0.00

3 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 4.00

2 Position Position 359.99 to 0.00

3 Density a) Density 0.00 to 100.00
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When the edge type is outline, in place of the edge fill signal, the selected 
key fill signal fills the outline, and elsewhere remains as the background.
Press [Matte Adjust] to display the Matte Adjust menu, and carry out the 
color matte adjustment for a single color or two-color combination. Select 
whether to use a single color or two-color combination for the color matte 
in the <Edge Matte> group.

For color mix operations, see “Carrying out a color mix for the key edge 
fill matte” (page 220).

5 When emboss is selected for the edge type, adjust the color in the <Emboss 
Fill> group.

To adjust matte 1 press [Matte1], and to adjust matte 2 press [Matte2], then 
adjust the following parameters.

6 To make the edge soft, press [Soft Edge] to set it on, and adjust the 
softness.

For a normal edge, when [Soft Edge] is enabled, [Key Drop] is kept on.

7 To make separate fine adjustments to the positions of the left, right, top, 
and bottom of the source edge, press [Fine Key], to set it on, and adjust the 
following parameters.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Top Key top edge position –2.00 to +2.00

2 Left Key left edge position –2.00 to +2.00

3 Right Key right edge position –2.00 to +2.00
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Note
In the emboss function it is not possible to set [Fine Key] on.

• When the edge type is normal, drop border or shadow, enabling the [Fine 
Key] function keeps [Key Drop] on.

• When applying a border to the key edge, enabling the [Fine Key] 
function halves the border width setting range.

To fix key fill and key source in key drop off mode

1 In the Edge menu, press [Key Delay Mode].

The Key Delay Mode menu appears.

2 Press [Frame Delay], setting it to On.

Note
This function uses the resizer, and therefore the expected result of the 
setting may not be obtained if conditions do not allow the resizer to be 
used.

Carrying out a color mix for the key edge fill matte
When you select ‘Matte’ for the edge fill of a border, drop border, or shadow, 
you can create a combination of color 1 and color 2 using a wipe pattern 
generated by the dedicated pattern generator.

1 In the Edge menu, select [Matte Adjust].

The edge fill Matte Adjust menu appears.

2 In the <Edge Matte> group, select [Mix Color], turning it on.

3 Adjust the following parameters.

4 Bottom Key bottom edge position –2.00 to +2.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 H Phase Key horizontal position Left edge position 
value shown

2 V Phase Key vertical position Top edge position 
value shown
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a) The patterns are the same as wipes. (For details, see “Wipe Pattern List” in (page 444).)

To select the pattern, display the Mix Pattern Select menu by pressing 
[Mix Pattern] in the edge fill Matte Adjust menu. After selecting one of the 
patterns (standard wipe patterns 1 to 24) displayed in the Mix Pattern 
Select menu, you can adjust the following parameters.

4 Adjust color 1 and color 2.

To adjust color 1 press [Color 1], and to adjust color 2 press [Color 2], 
turning it on respectively, and adjust the following parameters.

5 If required, set the pattern modifiers.

• When turning [Position] on and setting the pattern position

a) See page 273.

• When turning [Multi] on and replicating the pattern

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Softness of pattern edge 0.00 to 100.00

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Softness of pattern edge 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)
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a) See page 277.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 276.

• When turning [Angle] on in the <Rotation> group and inclining the 
pattern

a) See page 274.

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a constant speed

a) See page 275.

6 To interchange color 1 and color 2, press [Color Invert], turning it on.

Applying the zabton effects

Notes
• For key 3 and key 4, the zabton effect is not available.
• For key 1 or key 2, it is not possible to have zabton and [Fine Key] on 

simultaneously.

1 In the Edge menu, press [Zabton], turning it on.

2 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Pattern edge softness 0.00 to 100.00

3 Density Density 0.00 to 100.00
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Note
If in the pattern selection described below you select “Mask Pattern,” and 
“Box” for the mask, the “Size” parameter here cannot be adjusted. Set 
“Size” in the Main Mask menu.

3 To adjust the pattern and color, press [Zabton Adjust].

The Zabton Adjust menu appears.

4 In the <Zabton Pattern> group, select the pattern.

Key Wipe: Use a key wipe.
You can change this pattern by pressing [Pattern Select] to open the 
menu for key wipe pattern selection (Pattern Select menu), and make 
adjustments by pressing [Pattern Adjust] to open the menu for pattern 
adjustment (Wipe Adjust menu).

Key Edge Pattern: Use a color mixing pattern for key edge.
You can change this pattern by pressing [Pattern Select] to open the 
menu for edge color mix dedicated wipe pattern selection (Mix Pattern 
Select menu), and make adjustments by pressing [Pattern Adjust] to 
open the menu for pattern adjustment (Matte Adjust menu).

Mask Pattern: Use the main mask Box or Pattern.
You can also press [Pattern Select], and in the corresponding pattern 
adjustment menu, change the pattern.

5 To adjust the color, press [Zabton Color] and adjust the following 
parameters.

Masks

The mask function can be used to mask off unneeded parts of a key or 
background, or to remove defects. 

Knob  Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

4 Density Density 0.00 to 100.00
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Using the mask
For example, to use the main mask for key 1 on the M/E-1 bank, use the 
following procedure.

1 In the M/E-1 >Key1 menu, select HF3 ‘Main Mask.’

The Main Mask menu appears.

2 In the <Mask Type> group, select the mask type.

Key Mask: Masks a part of a key.
Bkgd Mask: Masks a part of a background.

3 In the <Mask Source> group, select the mask source.

Box: signal from the dedicated box generator
Pattern: signal from the dedicated pattern generator

4 Set the mask source parameters.

• When a box is selected

• When a pattern is selected

a) The pattern is the same as a wipe. (See “Wipe Pattern List” in Appendix (Volume 1) (page 
444).)

To select the pattern, display the Mask Ptn Select menu by pressing the 
[Mask Ptn Select] button in the Main Mask menu. 
After selecting one of the patterns (wipe patterns 1 to 24) displayed in the 
Mask Ptn Select menu, you can adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Top Top position –100.00 to +100.00

2 Left Left position –100.00 to +100.00

3 Right Right position –100.00 to +100.00

4 Bottom Bottom position –100.00 to +100.00

5 Soft Box softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

5 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00
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5 To invert the black and white sense of the mask source, press the [Mask 
Invert] button, turning it on.

6 When a pattern is selected as the mask source, set the pattern modifiers as 
required.

• When turning [Position] on and setting the pattern position

a) See page 273.

• When turning [Multi] on and replicating the pattern

a) See page 277.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 276.

• When turning [Angle] on in the <Rotation> group and setting the 
angle of the pattern rotation

a) See page 274.

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Pattern angle –100.00 to +100.00 a)
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• When turning [Speed] on in the <Rotation> group and setting the 
rate of pattern rotation

a) See page 275.

Applying a DME Effect to a Key

Note 
A maximum of two DMEs (including DME wipes) can be used simultaneously 
on a single M/E bank.

Assigning a DME to a key

1 In the M/E-1 >Key1 menu, select HF5 ‘Processed Key.’

The Processed Key menu appears.

2 In the <DME Select> group, select the DME channel (DME1, DME2) to 
be used.

The lit colors of [DME1] and [DME2] indicate the DME assignment.
Lit green: Shows the DME assigned to the currently selected key.
Lit amber: Shows the DME assigned to a key other than the currently 

selected key.
Off: DME is not assigned.

To select a DME being used by another keyer
Press [Override], turning it on, then select the DME channel.
The later selection is valid, and the button lights green.

You can check the DME operating status in the Status menu (see page 407).

Assigning a DME output signal as a monitor signal

Notes
• You can select the DME output signal on the AUX bus or edit preview bus.
• Carrying out independent key transitions with DME assigned keys applies 

the transition effect for the DME output.

1 In the Processed Key menu, press [Monitor].

Knob Parameter Adjustment Setting values

1 Speed Rate of pattern rotation –100.00 to +100.00 a)
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The Monitor menu appears.

2 Press [Monitor Set], turning it on.

3 In the <DME Select> group, select the DME channel (DME1, DME2) to 
be used.

This assigns the selected DME output to DME MON V and DME MON K.
The colors with which [DME1] and [DME2] are lit show the key 
assignment status.
Lit green: DME currently being monitored
Lit amber: DME that can be monitored
Off: Unassigned DME

Key Modify Clear

A simple button operation or a menu operation returns the key settings to the 
initial status settings.
Press [Default Recall] at the lower left of the menu display, turning it on, then 
press the corresponding VF button (VF1 to VF4) to return the key settings to 
their initial status.

For details of the initial status, see “Selecting the State After Powering On 
(Start Up Menu)” in Chapter 18 (Volume 3).
For the menu operation to return the key state to that set in initial status, see 
“Returning to default state in function groupings” (page 116).

Blink Function

Note
For key 3 and key 4, the following “edge blink” function is not available.

With the blink function, you can obtain the following effects.
Key blink: The key is alternately inserted and deleted at regular intervals. You 

can set the period of blinking, and the proportion of each cycle for which 
the key is inserted.

Edge blink: The key fill and key edge fill signals are interchanged at regular 
intervals. You can set the period of blinking, and the proportion of each 
cycle for which the original state holds.

The blink settings are in the Transition menu for each key. 
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Using the blink function
For example, to make the required settings for key 1 on the M/E-1 bank, use 
the following procedure.

1 In the M/E-1 >Key1 menu, select HF6 ‘Transition.’

The Transition menu appears.

2 In the <Blink> group, select [Key Blink] or [Edge Blink] to set it on.

3 Set the blink parameters.

• When key blink is selected

• When edge blink is selected

Video Processing

You can adjust the luminance and hue of the selected key fill signal.
For example, to apply video processing to the signal selected on the M/E-1 
bank key 1 fill bus, use the following procedure.

1 In the M/E-1 >Key1 menu, select HF7 ‘Video Process.’

The Video Process menu appears.

2 Press [Video Process], turning it on.

3 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Blink Rate Length of blink cycle 1 to 100

2 Duty Proportion of cycle for which key 
inserted

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Blink Rate Length of blink cycle 1 to 100

2 Duty Proportion of cycle for which 
original state holds

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Video Gain Video gain –200.00 to +200.00

2 Y Gain Luminance gain –200.00 to +200.00
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To return adjustment values to their defaults
Press [Unity].

3 C Gain Chrominance gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Luminance black level –7.31 to +109.59

Knob Parameter Adjustment Setting values
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Key Setting Operations With the Key 
Control Block

This section describes the basic procedures for key settings using the key 
control block.

Key control block

Operations in the Key Control Block

Parameter adjustment with the knobs
When the button for a function requiring parameter settings is pressed (that is, 
on), you can set the parameters with the four knobs. If there are more than four 
values to be assigned to the knobs, the [MORE] button lights amber. At this 
point, press the [MORE] button, which turns green, to assign the fifth and 
subsequent parameters to the knobs, so that the parameter settings can be made.

DME
1

DME
2

DME
3

DME
4

M/E
1

M/E
2

M/E
3

RE
SIZERP/P

KEY1 KEY2 KEY3 KEY4 TRANS

LUM LIN CRK CVK PTN

AUTO
SEL SPLIT

MATTE
FILL

KEY
DROP

SOFT
EDGE

BDR
DROP
BDR SHDW EMBOS

OUT
LINE

SHOW
KEY

MAIN
MASK

SUB
MASK ZABTN MORE

MON
FM

FEED

OVER
RIDE TRACE

PROC
KEY

AUTO
DELEG

DME
5

DME
6

DME
7

DME
8

M/E delegation buttons

Key type selection buttons

Key fill/key source selection buttons

Knobs

Key delegation buttons

Displays

Edge type selection buttons

MORE button
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Selecting the bank and keyer
To make key settings, first select the bank (from M/E-1 to M/E-3 and PGM/
PST) and keyer, then assign them to the key control block.
For example, to set key 1 on M/E-1 with the key control block, use the 
following procedure.

1 Using the M/E delegation buttons in the key control block, press the [M/
E1] button, setting it on.

2 Using the key delegation buttons in the key control block, press the 
[KEY1] button, setting it on.

This assigns the key control block to M/E-1 key 1.

Selecting the key type
To select the key type, press one of the key type selection buttons in the key 
control block.
[LUM] button: luminance key
[LIN] button: linear key
[CRK] button: chroma key
[CVK] button: color vector key
[PTN] button: key wipe pattern key

When using a wipe pattern key as the key type, in the <Key Type> group 
of the Type menu for the keyer, select [Wipe Pattern] and make the 
settings.

For an overview of the key types, see “Key Types” (page 197).

The button you pressed lights green, and you can now adjust the parameters 
with the knobs. The display beside each knob shows the first letter of the 
parameter name and the three-digit setting value.

• When the [LUM] or [LIN] button is lit green

Knob Parameter Adjustment Setting values

1 Clip Reference level for generating the 
key signal

+109 to –7

2 Gain Key sensitivity –100 (shown as –00) 
to +100

3 Density Key density 0 to 100

4 Filter Filter coefficient 1 to 9
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• When the [CRK] button is lit green

• When [Key Active] is off, only the parameters Hue and Density are 
displayed.

• When both [Key Active] and [Color Cancel] are off, only the parameter 
Density is displayed.

• When the [CVK] button is lit green

• When the [PTN] button is lit green

Selecting key fill
Select whether to use a color matte as key fill, or the signal on the key fill bus.

Knob Parameter Adjustment Setting values

1 Clip Chroma key reference level 0 to 100

2 Gain Key sensitivity –100 (shown as –00) 
to +100

3 Hue Hue 0 to 359

4 Density Key density 0 to 100

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Y Clip Reference level for Y signal +109  to –7

2 Y Gain Y signal sensitivity –100 (shown as –00) 
to +100

3 C Clip Reference level for chrominance 
signal

100 to 0

4 C Gain Chrominance signal sensitivity –100 (shown as –00) 
to +100

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Y Filter Y signal filter coefficient 1 to 9

2 C Filter Chrominance signal filter coefficient 1 to 9

4 Density Key density 0 to 100

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100

3 Density Key density 0 to 100
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When using a color matte: Press the [MATTE FILL] button, setting it on. The 
button lights green, and you can now set the parameters with the knobs.

When [Mix Color] is selected in the key fill Matte Adjust menu, you can 
further adjust color 2.

When [Mix Color] is on, and the [MORE] button is lit amber

When [Mix Color] is on, and the [MORE] button is lit green

When using the key fill bus signal: Press the [MATTE FILL] button, turning 
it off. 
To select the key fill signal, use the key 1 or key 2 bus buttons in the cross-
point control block.
To select the key fill signal for key 3 or key 4 in the cross-point control 
block, press the [KEY3] button or [KEY4] button to the right of the key 
bus buttons, turning it on, to allocate the key 1 bus row or key 2 bus row 
to the key 3 fill bus or key 4 fill bus, then press the desired cross-point 
button.
For the CCP-6224/6324 Control Panel, it is necessary to set the [AUX 
CTRL] button to Off in order to exit the AUX panel-less function (see page 
139).

Selecting key source
• To use the key source paired with the key fill signal selected on the key fill 

bus, press the [AUTO SEL] button, turning it on. The pairing of the cross-

Knob Parameter Adjustment Setting values

1 Luminance Color 1 luminance 0 to 100

2 Saturation Color 1 saturation 0 to 100

3 Hue Color 1 hue 359 to 0

Knob Parameter Adjustment Setting values

1 Luminance Color 1 luminance 0 to 100

2 Saturation Color 1 saturation 0 to 100

3 Hue Color 1 hue 359 to 0

4 Size Pattern size 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Color 2 luminance 0 to 100

2 Saturation Color 2 saturation 0 to 100

3 Hue Color 2 hue 359 to 0

4 Soft Edge softness 0 to 100
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point buttons for key fill and key source is carried out in the Setup menu. (See 
“Cross-Point Settings (Xpt Assign Menu)” in Chapter 19 (Volume 3).)

• To select key source independently of the key fill signal selected on the key 
fill bus and paired with key source, hold down the [SPLIT] button, turning it 
on, then press the desired Key 1 or Key 2 button in the cross-point control 
block.

• To use as key source the same signal as the key fill signal selected on the key 
fill bus, select the SELF mode by pressing the [AUTO SEL] button and 
[SPLIT] button simultaneously so that both are off. When chroma key is 
selected as the key type, select the SELF mode.

Key Edge Modifications

Note
For key 3 and key 4, it is not possible to use edge modifiers. It is also not 
possible to set [Fine Key] to On.

To apply a modification to the key edge, press one of the edge type selection 
buttons in the key control block.

[BDR] button: border
[DROP BDR] button: drop border
[SHDW] button: shadow
[OUTLINE] button: outline
[EMBOS] button: emboss

For an overview of the edge modifications, see “Edge modifiers” (page 199).

The pressed button lights green, and you can now adjust the parameters with 
the knobs. The display beside each knob shows the first letter of the parameter 
name and the three-digit setting value.

Setting the border parameters
When the [BDR] button is lit green, the parameter settings depend on the key 
type and whether the separate edge function is active. To activate the separate 
edge function, press [Separate Edge], setting it on, in the Edge menu for the 
key.

• Separate edge off

Knob Parameter Adjustment Setting values

1 Width Border width 0 to 8 a)

(0 to 100) b)
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a) In the “4H mode” and when [Fine Key] (page 219) is on, the setting value range is 0 to 4.
b) When a wipe pattern key or key wipe pattern key is selected as the key type

• Separate edge on
The border width settings can be made independently for left, right, top, and 
bottom sides. The separate edge function is only available when luminance 
key, linear key, or chroma key is selected as the key type.

a) In the “4H mode” and when [Fine Key] (page 219) is on, the setting value range is 0 to 4.

To adjust the edge fill color
When [BDR] is selected, the [MORE] button lights amber. Pressing the 
[MORE] button to turn it green then allows you to adjust the edge fill color 
parameters with the knobs.

Setting the drop border or shadow parameters
When the [DROP BDR] or [SHDW] button is lit green, the parameter settings 
differ between the “key drop OFF” and “key drop ON” modes (see page 200) 
as shown below. Switching between these two modes is made by turning the 
[KEY DROP] button on or off.

• “Key drop OFF” mode

a) In the “4H mode” and when [Fine Key] (page 219) is on, the setting value range is 0 to 4.

4 Density Border density 0 to 100

Knob Parameter Adjustment Setting values

1 Top Top edge width 0 to 8 a)

2 Left Left edge width 0 to 8 a)

3 Right Right edge width 0 to 8 a)

4 Bottom Bottom edge width 0 to 8 a)

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Width Width 0 to 8 a)

2 Position Position 359 to 180

4 Density Density 0 to 100
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• “Key drop ON” mode

a) In the “4H mode” and when [Fine Key] (page 219) is on, the setting value range is 0 to 4.

To adjust the edge fill color
When [DROP BDR] or [SHDW] is selected, the [MORE] button lights amber. 
Pressing the [MORE] button to turn it green then allows you to adjust the edge 
fill color parameters with the knobs.

Setting the outline parameters
When the [OUTLINE] button is lit green, the parameter settings depend on the 
key type and whether the separate edge function is active. To activate the 
separate edge function, press [Separate Edge], setting it on, in the Edge menu 
for the key.

• Separate edge off

a) In the “4H mode” and when [Fine Key] (page 219) is on, the setting value range is 0 to 4.
b) When a wipe pattern key or key wipe pattern key is selected as the key type

• Separate edge on
The outline width settings can be made independently for left, right, top, and 
bottom sides. The separate edge function is only available when luminance 
key, linear key, or chroma key is selected as the key type.

Knob Parameter Adjustment Setting values

1 Width Width 0 to 8 a)

2 Position Position 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Width Outline width 0 to 8 a)

(0 to 100) b)

4 Density Outline density 0 to 100

Knob Parameter Adjustment Setting values

1 Top Top edge width 0 to 8 a)

2 Left Left edge width 0 to 8 a)
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a) In the “4H mode” and when [Fine Key] (page 219) is on, the setting value range is 0 to 4.

When [Outline] is selected with separate edge on, the [MORE] button lights 
amber. Pressing the [MORE] button to turn it green then allows you to adjust 
the key fill density parameter with a knob.

Setting the embossing parameters
When the [EMBOS] button is lit green, adjust the following parameters.

Selecting a normal edge
When all five edge type selection buttons are off, a normal edge is selected. If 
one of the buttons is lit, press it, turning it off. 

Softening the edge
Press the [SOFT EDGE] button, turning it on. The button lights green, and you 
can now adjust the softness with the knob.

• For a normal edge, when [SOFT EDGE] is enabled, “Key Drop” mode turns 
on.

• When a luminance key or linear key is selected as the key type, and clean 
mode is enabled, enabling [SOFT EDGE] ends the clean mode.

Applying the zabton effects

Notes
• For key 3 and key 4, the zabton effect is not available.

3 Right Right edge width 0 to 8 a)

4 Bottom Bottom edge width 0 to 8 a)

Knob Parameter Adjustment Setting values

4 Density Outline density 0 to 100

Knob Parameter Adjustment Setting values

Knob Parameter Setting values

1 Width 0 to 4

2 Position 359 to 0

4 Density 0 to 100

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0 to 100
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• For key 1 or key 2, it is not possible to have zabton and [Fine Key] on 
simultaneously.

When the [ZABTN] button is lit green, adjust the following parameters.

Press the [MORE] button lit amber, changing it to green, then adjust the 
following parameters.

Masks

Using the mask
In the key control block, press the [MASK] button, turning it on. 
The parameter settings depend on the mask source selected as [Box] or 
[Pattern] in the <Mask Source> group of the Main Mask menu for the key.

• When box is selected

When box is selected and the [MORE] button is lit amber, there are more 
settings. Press the [MORE] button, so that it changes from amber to green to 
make the extra setting.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Pattern edge softness 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Top Top position –100 (shown as –00) to +100

2 Left Left position –100 (shown as –00) to +100

3 Right Right position –100 (shown as –00) to +100

4 Bottom Bottom position –100 (shown as –00) to +100

Knob Parameter Adjustment Setting values

1 Soft Box softness 0 to 100
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• When pattern is selected

a) The pattern is the same as a wipe. (See “Wipe Pattern List” (page 444).)

Applying a DME Effect to a Key

Note
For one M/E bank, DME effects (including DME wipes) can be used in two 
places.

Assigning a DME to a key

1 In the key control block, press the delegation buttons [M/E1] and [KEY1].

2 Using the DME channel selection buttons, select the DME channel 
(DME1, DME2) for applying the effect.

The lit colors of the [DME1] and [DME2] buttons indicate the DME 
assignment.
Lit green: Shows the DME assigned to the currently selected key.
Lit amber: Shows the DME assigned to a key other than the currently 

selected key.
Off: DME is not assigned.

To select a DME being used by another keyer
Press [Override], turning it on, then select the DME channel.
The later selection is valid, and the button lights green.

Using two DME channels on a single keyer

1 Select DME1 and DME2 with the DME channel selection buttons.

2 To select the second video signal, hold down the [UTIL] button in the 
cross-point control block, and select the signal in the Key1 row (DME 
external video bus).

You can check the DME operating status in the Status menu (see page 407).

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100

3 Pattern Pattern number 1 to 24 a)
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Assigning the DME output signal to a monitor signal

1 Holding down the output destination specification button [MON] in the 
key control block, use the DME channel selection buttons to select the 
DME channel (DME1 or DME2) you want to use.

The selected DME output is assigned to DME MON V and DME MON K.

2 To check the DME assignment status, hold down just the [MON] button.

While it is held down, the lit color of the [DME1] and [DME2] buttons 
shows the key assignment status.
Lit green: Shows the DME currently being monitored.
Lit amber: Shows a DME which can be monitored.
Off: DME is not assigned.

Other Key Setting Operations

Using the show key function
While the [SHOW KEY] button is held down, the key-processed key source 
signal appears on the specified output. (Show key mode)
Even when the [SHOW KEY] button is released, for a preset time the show key 
mode is maintained. You can specify the output to which the show key function 
is applied and set the time for which the show key mode is maintained after 
releasing the button in a Setup menu.

For details see “Settings Relating to Keys, Wipes, Frame Memory and Color 
Correction (Key/Wipe/FM/CCR Menu)” in Chapter 20 (Volume 3).

Using the auto delegation function
To couple the selection in the key delegation buttons of the independent key 
transition control block so that the key control block delegation selection is 
automatically switched, in the key control block press the [AUTO DELEG] 
button, turning it on.

Returning the key adjustment values to their defaults
Holding down a key type button ([LUM], [LIN], [CRK], [CVK], or [PTN]) 
recalls the key default values (page 203).
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Key modify clear
When an M/E delegation button is held down, holding down a key delegation 
button together returns the key settings to the initial status settings.

For details of the initial status, see “Selecting the State After Powering On 
(Start Up Menu)” in Chapter 18 (Volume 3).
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Key Adjustment Operations With the 
Multifunction Flexi Pad Control Block

This section describes basic key adjustment operations when using the 
Multifunction Flexi Pad control block.

Selecting the switcher bank and keyer
Before carrying out key adjustment, first select the key adjust mode, then select 
the switcher bank and keyer.
For example, to adjust key 1 on M/E-1, proceed as follows.

1 In the Multifunction Flexi Pad control block mode selection buttons press 
[KEYADJ].

2 Press the [M/E1] region selection button.

3 In the memory recall section, press the [KEY1] button.

EDIT ENBL button

Mode selection buttons

Alphanumeric display

Adjustment knobs

Adjustment knob displays

Memory recall section

Region selection buttons
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The button displays in the memory recall section now appear as shown in 
the following illustration.
Pressing the [PAGE 1/3] >[PAGE 2/3] buttons further changes the display 
as follows, then pressing [PAGE 3/3] returns to the original display shown 
in the illustration.
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With these buttons in the memory recall section, you can carry out the 
following key adjustment.
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Selecting the key type
[LUM] button: Selects a luminance key.
[LIN] button: Selects a linear key.
[CRK] button: Selects a chroma key.
[WIPE PTN] button: Selects a key wipe pattern key.
Adjust the parameters for each type with the adjustment knobs. For details of 
the parameters, see the following sections.
Luminance key: “When the [LUM] or [LIN] button is lit green” (page 231)
Linear key: “When the [LUM] or [LIN] button is lit green” (page 231)
Chroma key: “When the [CRK] button is lit green” (page 232)
Key wipe pattern key: “When the [PTN] button is lit green” (page 232)

Selecting the key source
[AUTO SEL] button: The signal assigned as a pair with the key fill bus signal 

for the key row button in the cross-point control block is automatically 
selected.

[SPLT] button: Select a different signal manually. To make the selection, hold 
down this button, and press the button assigned to the signal you want as 
key source in the cross-point control block.

You can also use the same signal as the key fill selected on the key fill bus as 
key source (SELF). Press the [AUTO SEL] button and [SPLT] button 
simultaneously so that both are off, to select the SELF mode.

Setting auto chroma key
[SMPL MARK] button: Toggles the sample mark display on and off. When 

on, the monitor screen shows the foreground video and a white box sample 
mark.

[AUTO STRT] button: Automatically adjusts the chroma key. When the 
[SMPL MARK] button is off, pressing this does not carry out automatic 
chroma key adjustment.

You can adjust the display position and size of the sample mark with the 
adjustment knobs.

For details of these parameters, see “Making auto chroma key adjustments” 
(page 210).

Setting the show key function
[SHOW KEY] button: When this is pressed, the key source signal to which 

key processing has been applied is output from the specified output port 
(show key mode).

For details, see “Using the show key function” (page 240).
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Setting the resizer function
[RE SIZR] button: Enables and disables the resizer function.
The parameters that can be adjusted with the adjustment knobs are on two 

pages; to access the second page, press the [KNOB 1/2] button. For details 
of the parameters, see “Menu operations for key shrinking, magnification 
and movement” (page 249).
If you press this button at the same time as any of the [KEY1] to [KEY4] 
buttons, you can switch the trackball and joystick to the resizer setting 
mode.

Inverting the sense of the key source
[KEY INV] button: When this is set to On, the sense of the key source is 

inverted.

Selecting the key fill signal
[FILL MAT] button: When this is On, the signal generated by the dedicated 

color matte generator is selected, and when it is Off, the signal selected on 
the key 1 fill bus is selected.

For parameters that can be adjusted with the adjustment knobs, see “Selecting 
key fill and key source” (page 214).

Selecting the mask source
[MASK] button: Selects the mask source (box generated by dedicated 

generator or pattern) to be selected in the Main Mask menu for each M/E 
bank.

The parameters that can be adjusted with the adjustment knobs are different for 
a box or a pattern.
The box parameters are on two pages; to access the second page, press the 
[KNOB1/2] button.

For details, see step 4 in “Using the mask” (page 224).

Applying modifiers to the key edge
[BDR] button: Applies a border to the edge.
[DROP BDR] button: Applies a drop border to the edge.
[SHDW] button: Applies a shadow to the edge.

For parameters that can be adjusted with the adjustment knobs, see “Key Edge 
Modifications” (page 216).
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Setting the degree of edge softening
[SOFT EDGE] button: Softens the key edge.

For parameters that can be adjusted with the adjustment knobs, see step 7 in 
“Key Edge Modications” (page 219).

Using a DME currently used on another keyer
[OVER RIDE] button: When one DME channel is in use, by holding down 

this button and pressing a DME channel button ([DME1] or [DME2]), you 
can forcibly select this channel. The button for the selected DME channel 
lights green.

Recalling the keyer using the DME channel
[TRCE] button: Holding down this button, press the selection button for the 

DME channel already assigned to another keyer or transition, to switch the 
keyer or transition to which the DME channel is assigned to the currently 
selected state.

Monitoring DME output
[DME MON] button: Holding down this button and pressing the selection 

button for a DME channel ([DME1] or [DME2]) allows you to monitor the 
signal for this channel as a reentry signal to DME MON V/K. However, it 
is first necessary to assign this channel on the DME to the delegation 
(keyer or transition) to be monitored.

Selecting the DME channel
[DME1], [DME2] buttons: Press one of these to select the corresponding 

DME channel. The number of valid buttons depends on the number of 
DME channels in use.

Returning the key adjustment values to their defaults
Holding down a key type button ([LUM], [LIN], [CRK], [CVK], or [PTN])
recalls the key default values.

Key modify clear
When the [KEY ADJ] button is held down, holding down the region selection 
button for the selected region together returns all the key settings of the region 
to the initial status settings.
When the [KEY ADJ] button is held down, holding down the button for the 
selected key together returns the key settings to the initial status settings.
247Key Adjustment Operations With the Multifunction Flexi Pad Control Block



248

   C
hapter 4 

K
eys
For details of the initial status, see “Selecting the State After Powering On 
(Start Up Menu)” in Chapter 18 (Volume 3).
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Resizer

Resizer allows you to apply DME-like effects such as image shrinking, 
magnification and movement, as well as change of the aspect ratio, to the 
processed key.
The following functions are available.
• Two-dimensional transformations of keys
• Resizer interpolation settings
• Resizer crop/border settings
• Resizer effect settings

(mosaic, defocus)

Notes
• For key 3 and key 4, the resizer cannot be used.
• The image of the key manipulated by resizer has a one-frame delay.
• Some effects of resizer are different from what you would expect of DME 

effects.

Restrictions on the use of effects
There are restrictions on combined use of resizer effects themselves and that 
with DME wipes.

Relation between resizer and other effects
You cannot apply DME effects to a key for which the resizer function is 
enabled. When one of the three functions – resizer, DME wipe and DME 
effects – is enabled, the other two are disabled.

Two-Dimensional Transformations of Keys

Note
When the screen aspect ratio is 4:3 in HD format, when the resizer is used to 
shrink a video image, this is applied to the 16:9 screen including the added 
video on the left and right sides. Use the crop function as required to extract the 
4:3 image.

Menu operations for key shrinking, magnification and movement
For example, to shrink, magnify or move key1 of the M/E-1 bank, use the 
following procedure.
249Resizer



250

   C
hapter 4 

K
eys
1 In the M/E-1 >Key1 >Processed Key menu, press [Resizer], turning it on.

2 Adjust the following parameters with the knobs.

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Location X Move key 
horizontally

HD –99.9999 to 
+99.9999

SD 4:3 –33.3333 to 
+33.3333

SD 16:9 –24.9999 to 
+24.9999

2 Location Y Move key vertically HD –99.9999 to 
+99.9999

SD 4:3 –33.3333 to 
+33.3333

SD 16:9 –24.9999 to 
+24.9999

3 Size Magnify or shrink 
key

0.0000 to 10.0000

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Aspect X Change aspect 
ratio horizontally 

0.0000 to 99.9999

2 Aspect Y Change aspect 
ratio vertically 

0.0000 to 99.9999

3 Aspect Ratio Change aspect 
ratio horizontally 
and vertically at a 
time

0.0000 to 2.0000
Resizer
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Key control block operations for key shrinking, magnification 
and movement

1 Use the delegation buttons to select the key to which you want to apply a 
resizer function.

2 Press the [RESIZER] button, turning it on.

3 Adjust the following parameters with the knobs.
(To switch between displaying parameter group 1/2 and 2/2, press the 
[MORE] button.)

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 X Move key 
horizontally

HD –99 to +99

SD 4:3 –33 to +33

SD 16:9 –24 to +24

2 Y Move key vertically HD –99 to +99

SD 4:3 –33 to +33

SD 16:9 –24 to +24
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KEY1 KEY2 KEY3 KEY4 TRANS
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FILL

KEY
DROP
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BDR
DROP
BDR SHDW EMBOS
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SHOW
KEY ZABTNMASK MORE
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OVER
RIDE TRACE
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DELEG

Delegation buttons

RESIZER button

MORE button

Knobs
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Device control block operations for key shrinking, magnification 
and movement

1 Press the [RSZR CTRL] button, turning it on.

3 S Magnify or shrink 
key

0.0 to 10

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 X Change aspect 
ratio horizontally 

0.0 to 99

2 Y Change aspect 
ratio vertically 

0.0 to 99

3 R Change aspect 
ratio horizontally 
and vertically at a 
time

0.0 to 2.0

Parameter group [1/2]

Knob Parameter Adjustment Setting values
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Trackball

ASP button

LOC button
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2 Press the delegation button to select the key.

3 Press the [RSZR] button, turning it on.

4 • To change the aspect ratio, turn on the [LOC SIZE(ASP)].
• To shrink, magnify, or move the key, turn on the [LOC XYZ(LOC)].

Hold these buttons down while carrying out the operation of step 5 to 
enable fine adjustment (fine mode).

5 Use the trackball and joystick for the operation.

For details of parameters, see step 3 of “Key control block operations for key 
shrinking, magnification and movement” (page 251).

Entering parameters
This operation is the same as DME three-dimensional parameter input.

For details, see “Entering Three-Dimensional Parameter Values” in Chapter 
11 (Volume 2).

Resetting parameters
This operation is the same as DME three-dimensional parameter resetting.

For details, see “Entering Three-Dimensional Parameter Values” in Chapter 
11 (Volume 2).

Clearing resizer effects

To clear three-dimensional transform parameters only and set the 
initial state
In the device control block, press the [CLR WORK BUFR] button in the 
operation buttons.

To clear all resizer parameters, and set the initial state
In the device control block, press the [CLR WORK BUFR] button in the 
operation buttons, twice in rapid succession.
For the initial state, you can select either the factory default settings or user 
settings.

For details of how to make this selection, see “Selecting the State After 
Powering On (Start Up Menu)” in Chapter 18 (Volume 3).
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Resizer Interpolation Settings

For example, to make the interpolation settings for key 1 of the M/E-1 bank, 
use the following procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press [Resizer], turning it on.

This enables the resizer function.

2 Press [Resizer Process].

The Resizer Process menu appears.

3 In the <Video Field/Frame Mode> and other groups, make the 
interpolation settings.

Note

These settings are the same as those for input video signals. For details, 
see “Interpolation Settings” in Chapter 11 (Volume 2).
However, the following points are different.
• The signal formats allowing interpolation processing are: 480i/59.94, 

576i/50, 1080i/59.94, 1080i/50, and 1080i/60.
• It is not possible to set [Interpolation Mode].

Resizer Crop/Border Settings

Making a crop setting for a key for which resizer is on
For example, to make the crop settings for key 1 of the M/E-1 bank, use the 
following procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press [Resizer], turning it on.

This enables the resizer function.

2 Press [Border/Crop].

The Border/Crop menu appears.

3 Press [Crop], turning it on.

This enables the adjustment of crop.
Resizer
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4 Set the parameters.

These settings are the same as those for crop of DME. For details, see 
“Crop Settings” in Chapter 11 (Volume 2).

Note
If defocus is enabled, and in the <Defocus Mode> group you select Video/Key, 
then the crop is disabled. If mosaic is enabled crop is disabled.

Applying a border to a key for which resizer is on
For example, to add the border for key 1 of the M/E-1 bank, use the following 
procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press [Resizer], turning it on.

This enables the resizer function.

2 Press [Border/Crop].

The Border/Crop menu appears.

3 Press [Border], turning it on.

This enables the adjustment of crop.

4 Set the parameters.

The valid ranges of the parameter values depend on the combination of 
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system, 
as follows.

• SD format

• HD format

Knob Parameter Adjustment Setting Values

1 H Simultaneously adjust width of left 
and right borders

0.00 to 4.00

2 V Simultaneously adjust width of top 
and bottom borders

0.00 to 3.00 (4:3) 
0.00 to 2.25 (16:9)

3 All Simultaneously adjust width of all 
four borders

Value of H shown

5 Density Density of the borders 0.00 to 100.00

Knob Parameter Adjustment Setting Values

1 H Simultaneously adjust width of left 
and right borders

0.00 to 12.00 (4:3) 
0.00 to 16.00 (16:9)
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To apply color to a border

1 In the <Border Mode> group of the Border/Crop menu, press [Flat Color].

2 Adjust the following parameters.

To soften the inner edge of a border

1 In the Border/Crop menu, press [Border Soft].

2 Adjust the following parameters.

To apply a beveled light edge

1 In the <Border Mode> group of the Border/Crop menu, press [Beveled 
Light Edge].

2 Adjust the following parameters.

3 Press [Border Soft].

2 V Simultaneously adjust width of top 
and bottom borders

0.00 to 9.00

3 All Simultaneously adjust width of all 
four borders

Value of H shown

5 Density Density of the borders 0.00 to 100.00

Knob Parameter Adjustment Setting Values

Knob Parameter Adjustment Setting Values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting Values

1 Inner Soft Border inner softness 0.00 to 100.00

Knob Parameter Adjustment Setting Values

1 Top Top edge –100.00 to +100.00

2 Left Left edge –100.00 to +100.00

3 Right Right edge –100.00 to +100.00

4 Bottom Bottom edge –100.00 to +100.00

5 All Four edges Value of Left shown
Resizer
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4 Adjust the following parameters.

To apply a beveled color edge

1 In the <Border Mode> group of the Border/Crop menu, press [Beveled 
Color Edge].

2 In the <Color Adjust> group, select the edges for adjustment among the 
[Top], [Left], [Right], and [Bottom] edges. To select all the four edges, 
press [All].

3 Set the color parameters.

For details, see “To apply color to a border” (page 256)

4 Press [Border Soft].

5 Adjust the following parameters.

Applying Resizer Effects

For example, to apply effects to key 1 of the M/E-1 bank, use the following 
procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press [Resizer], turning it on.

This enables the resizer function.

2 Press [Enhanced Effect].

The Enhanced Effect menu appears.

Knob Parameter Adjustment Setting Values

1 Inner Soft Border inner softness 0.00 to 100.00

2 Bound Soft Border boundary softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Inner Soft Border inner softness 0.00 to 100.00

2 Bound Soft Border boundary softness 0.00 to 100.00
257Resizer
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Applying a mosaic

1 In the M/E-1 >Key1 >Processed Key >Enhanced Effect menu, press 
[Mosaic], turning it on.

2 Set the parameters.

 This operation is the same as the DME mosaic setting. For more details, 
see “Mosaic Settings” in Chapter 11 (Volume 2).

3 Set the parameters.

Defocusing

1 In the M/E-1 >Key1 >Processed Key >Enhanced Effect menu, press 
[Defocus], turning it on.

2 Set the parameters.

This operation is the same as the defocusing setting when using the DME 
with the DME dedicated interface. 
For more details, see “Defocus Settings” in Chapter 11 (Volume 2).

Knob Parameter Adjustment Setting values

1 H Horizontal defocusing 0.00 to 100.00

2 V Vertical defocusing 0.00 to 100.00

3 All Horizontal and vertical defocusing H value shown
Resizer
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Key Snapshots

Key settings other than the key on/off status and the key priority can all be 
instantaneously saved in a dedicated register, for recall when required. A key 
snapshot comprises three values: a cross-point button number, key memory full 
mode, and independent key transition, and can be called in any combination.
There are four key snapshot registers for each keyer.

Key Snapshot Operations

Key snapshot operations are carried out in the independent key transition 
control block downstream key control block or Multifunction Flexi Pad control 
block. Each keyer is provided with four dedicated key snapshot registers.

Independent key transition control block (standard type)

Saving a key snapshot
For example, the following procedure saves the state of the M/E-1 key 1 
settings.

1 In the M/E-1 independent key transition control block, press the key 
delegation button [KEY1], turning it on.

2 Press the [K-SS] button, turning it on. 

KEY1 KEY2 KEY3 KEY4
K-MOD
EMBL K-SS

K-TR
ENBL

K-SS
STOREMIX WIPE DME

PTN
LIMIT

LIMIT
SET KF

DSK1
ON

AUTO
TRANS

DSK2
ON

AUTO
TRANS

DSK3
ON

AUTO
TRANS

DSK4
ON

AUTO
TRANS

Key source name display/key snapshot buttons

Key delegation buttons

Key snapshot setting 
buttons
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The system switches to key snapshot mode, and the key source name 
display/key snapshot buttons show the status of registers 1 to 4 for key 1.
Off: Nothing is saved in the register.
Lit orange: Settings are saved in the register.
For a register holding a snapshot, the register name is shown as up to eight 
characters.

3 Hold down the [K-SS STORE] button, and press the key source name 
display/key snapshot button corresponding to the register in which you 
want to save the snapshot.

The key source name display/key snapshot button which you pressed lights 
yellow.

Note
If you save a key snapshot in a register for which the button is lit orange or 
yellow, the existing contents of the register are overwritten.

Recalling a key snapshot
For example, the following procedure recalls the state of the M/E-1 key 1 
settings.

1 In the M/E-1 independent key transition control block, press the key 
delegation button [KEY1], turning it on.

2 Press the [K-SS] button, turning it on.

3 Set the following buttons on or off, depending on the information you want 
to recall.
(These buttons are not provided in the downstream key control block.)

[K-MOD ENBL] button: When this is on, the key settings and key 
modifiers are recalled. When this is off, they are not recalled.

[K-TR ENBL] button: When this is on, the independent key transition 
settings are recalled. When this is off, they are not recalled.

If both buttons are off, the key memory function is enabled and only the 
saved selection of key fill and key source signals is recalled.

4 Press the key source name display/key snapshot button corresponding to 
the register you want to recall.

The button you pressed lights yellow, and this recalls the key snapshot.

To cancel a recall carried out in the downstream key control block, press 
the [UNDO] button in the downstream key control block.
Key Snapshots
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Key snapshot operation on the Multifunction Flexi Pad control 
block

By default, the [KEY SS] key snapshot mode selection button does not appear 
in the Multifunction Flexi Pad control block. To carry out key snapshot saving 
and recall in this control block, it is first necessary in the Engineering Setup 
>Panel >Config >Link/ProgramButton >Multi Function >Mode Sel Assign 
menu to assign the Key Snapshot mode to a mode selection button.

To save a key snapshot
For example, to save a key snapshot for key 1 of M/E-1, select M/E1 and key1, 
then use the following procedure.

1 Press the [K SS] button.

The button displays in the memory recall section change as shown in the 
following illustration.

2 In the memory recall section, hold down the [STOR] button, and press the 
button (any of [1] to [4]) for the register in which you want to save the key 
snapshot.

To recall a key snapshot
For example, to recall a key snapshot for M/E1 key 1 saved in register 1, with 
the M/E1 region and key 1 selected, proceed as follows.

1 Press the [KEY SS] button.

2 According to the information you want to recall, set the following buttons 
On/Off.

[MOD ENBL] button: Recall the key adjustment values and key modifier 
settings.
261Key Snapshots
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[TRNS ENBL] button: Recall independent key transition settings.
If both are Off, then key memory is enabled, and just the saved key fill 
and key source signal selections are recalled.

3 Press button [1] for the register you want to recall.

The [1] button lights yellow, and the key snapshot is recalled.
To cancel the recall operation, press the [UNDO] button.

To delete a key snapshot
For example, to delete a key snapshot for M/E1 key 1 saved in register 1, with 
the M/E1 and key 1 region selected, proceed as follows.

1 Press the [KEY SS] button.

2 Holding down the [DEL] button, press the button [1] for the register in 
which is saved the key snapshot you want to delete.

To carry out an auto transition execution during key snapshot 
operation
Press the [AUTO TRNS] button.

Instant key insertion/removal
Press the [KEY ON] button.
To remove the key, while the key is inserted press the [KEY ON] button.

Key Snapshot Operations Using a Simple Transition 
Module

When using a simple transition module, the key snapshots hold the settings for 
key 3 and key 4. However, each key control block can be assigned to any key 
in setup (see Chapter 19 “Overall Control Panel Settings (Config Menu)” 
(Volume 3)).
You can carry out key snapshot operations in the independent key transition 
control block (simple type) and Flexi Pad control block (simple type).
There are two dedicated key snapshot registers for each of keys 3 and 4.
Key Snapshots
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Independent key transition control block (simple type)

Saving a key snapshot
For example, to save the settings of M/E-1 key 3, use the following procedure.

1 In the M/E-1 independent key transition control block, press the [K-SS] 
button in the key 3 control block, turning it on.

This switches to key snapshot mode, and the key source name display/key 
snapshot button shows the state of registers 1 and 2 for key 3.
Off: Nothing is saved in the register.
Lit orange: Settings are saved in the register.
For a register holding a snapshot, the register name is shown as up to eight 
characters.

2 In the Flexi Pad control block, hold down the [SNAPSHOT] button and 
press the key source name display/key snapshot button corresponding to 
the register in which you want to save the snapshot.

The key source name display/key snapshot button which you pressed lights 
yellow.

Note
If you save a key snapshot in a register for which the button is lit orange or 
yellow, the existing contents of the register are overwritten.

K-SS WIPE DME

SHIFT MIX CUT

KEY3
ON

TAKE

K-SS WIPE DME

SHIFT MIX CUT

KEY4
ON

TAKE

The functions of the key 3 control block and key 4 control block are the same.

K-SS button

Key 3 control block Key 4 control block

Key source name display/key 
snapshot buttons
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Recalling a key snapshot
For example, the following procedure recalls the state of the M/E-1 key 3 
settings.

1 In the M/E-1 independent key transition control block, press the [K-SS] 
button in the key 3 control block, turning it on.

2 Press the key source name display/key snapshot button corresponding to 
the register you want to recall.

The button you pressed lights yellow, and this recalls the key settings 
(excluding the key insertion state (on/off) and key priority).
Key Snapshots
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Overview

A wipe is a transition from the current video stream to a new video stream, 
using a wipe pattern. 
Changing the background by means of a wipe is referred to as a “background 
wipe,” and inserting or deleting a key with a wipe is termed a “key wipe.”
There are two types of wipe: those that can be selected in a common transition,
and those that can be selected in an independent key transition.

For details of independent key transitions, see page 177.
Overview
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Basic Procedure for Wipe Settings

You carry out wipe setting operations principally using the Wipe menu for each 
of the M/E-1 to M/E-3 and PGM/PST banks.
This section describes the basic procedures for wipe settings, taking the M/E-
1 >Wipe menu as an example.

For details of independent key transition wipe settings, see “Wipe Settings for 
Independent Key Transitions” (page 279).

Wipe Settings Menu

Accessing the wipe settings menu
To access the M/E-1 >Wipe menu, use either of the following operations.
• In the menu control block, select the top menu selection button [M/E 1], and 

press VF5 ‘Wipe.’
• In the transition control block of the M/E-1 bank, press the transition type 

selection button [WIPE] twice in rapid succession.
Any of the above operations displays the M/E-1 >Wipe menu.

Wipe Pattern Selection

Selecting a wipe pattern by a menu operation

1 In the M/E-1 >Wipe menu, select HF1 ‘Main Pattern.’

The Main Pattern menu appears.

See “Wipe Pattern List” (page 444).

2 Press the button to select the desired pattern.

The patterns appear on the screen.
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Setting Wipe Modifiers

You can apply various modifiers to the wipe pattern: setting the wipe direction, 
pattern position, and so on.

Specifying the wipe direction (Direction)
You can specify the direction of the wipe: the regular direction is referred to as 
“normal,” and the other direction as “reverse.” You can also select alternating 
directions each time the transition is completed (normal/reverse mode).

To specify the wipe direction in a menu

1 In the M/E-1 >Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Direction> group, specify the wipe direction.

Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal

To specify the wipe direction with a button in the transition control 
block
In the transition control block of each of the M/E-1 to M/E-3 and PGM/PST 
banks, press the following direction selection buttons.
NORM: Normal
NORM/REV: Normal/reverse
REV: Reverse

Normal Reverse
Basic Procedure for Wipe Settings
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Modifying the wipe pattern edge (Edge)
You can apply a border to the pattern, soften the edges, or soften the applied 
border.

Border: You can adjust the border width.
Soft: You can adjust the edge softness.
Soft border: You can adjust the border width, and the softness of the inner and 

outer edges of the border.
When a border or soft border is selected, the signal filling the border is called 
edge fill. For the edge fill, you can use a matte generated by the dedicated color 
matte generator, or the signal selected on the utility bus. A matte can be color 
1 or color 2, or a combination of the two colors (a “color mix”).

1 In the M/E-1 >Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Edge> group, select the edge type.

Border: border
Soft: soft edge
Soft Border: soft border

3 Set the parameters according to the selection in step 2.

• When border is selected

• When soft edge is selected

Border Soft Soft border

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00
269Basic Procedure for Wipe Settings
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• When soft border is selected

4 When you selected border or soft border, select the edge fill signal in the 
<Edge Fill> group.

Utility Bus: signal selected on the utility bus
Matte: signal from the dedicated color matte generator

5 Depending on the operation in step 4, carry out the following operation.

When ‘Utility Bus’ is selected: Hold down the [UTIL] button in the cross-
point control block, and select the signal in the background A bus.
While the [UTIL] button is held down, the background A bus changes 
to the utility bus.

Note
To enable the [UTIL] button, its operation mode must be set to [Hold] 
beforehand. (See “Operation Settings (Operation Menu)” in Chapter 
19 (Volume 3).)

When ‘Matte’ is selected: In the same Edge/Direction menu, press [Matte 
Adjust] to display the Matte Adjust menu, then adjust the single-color 
or two-color combination color matte. Select whether to use a single-
color matte or a two-color combination in the <Edge Matte> group.
Flat Color: Adjust color 1 with the following parameters.

When you select [Mix Color] for a two-color combination, see the next 
paragraph.

Carrying out a color mix for the edge fill matte
When you selected [Matte] for the border or soft border edge fill, you can 
combine color 1 and color 2.
For the combination, you can use not only a normal wipe generator pattern, but 
also the dedicated color mix pattern.

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

2 Inner Soft Border inner softness 0.00 to 100.00

3 Outer Soft Border outer softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
Basic Procedure for Wipe Settings
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1 In the <Edge Fill> group of the Edge/Direction menu, select [Matte], and 
press [Matte Adjust].

The Matte Adjust menu appears.

2 In the <Edge Matte> group, select [Mix Color], turning it on.

3 In the <Mix Pattern> group, make one of the following selections.

Wipe: Use the wipe pattern selected for the transition.
Pattern: Use the dedicated pattern.

4 Depending on the selection in step 3, set the following parameters.

• When Wipe is selected

• When Pattern is selected

a) The patterns are the same as for a wipe. See “Wipe Pattern List” (page 444).

If you selected Pattern, you can also carry out the pattern selection by 
pressing the [Mix Ptn Select] button in the Matte Adjust menu, to display 
the Mix Ptn Select menu. Select any pattern appearing in the Mix Ptn 
Select menu (wipe patterns 1 to 24) by pressing the appropriate button, and 
you can then adjust the following parameters.

5 If you selected Pattern in step 4, if required, the following modifiers can 
be added. After selecting a wipe mix, skip to step 6.

• When turning [Position] on and setting the pattern position

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)
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a) See page 273.

• When turning [Multi] on and using replications of the same pattern

a) See page 277.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 276.

• When turning [Angle] on in the <Rotation> group and slanting the 
pattern

a) See page 274.

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a constant rate

a) See page 275.

6 To adjust color 1, set [Color 1] on, and to adjust color 2 set [Color 2] on, 
then adjust the parameters.

2 Position V Vertical position –200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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7 To interchange color 1 and color 2, press the [Color Invert] button, turning 
it on.

Setting the wipe position (Positioner)
When you turn on this function, you can move the wipe pattern to any position.

• The parameter H Position controls the horizontal position of the pattern.
A negative value moves the pattern to the left, and a positive value moves the 
pattern to the right.

• The parameter V Position controls the vertical position of the pattern. 
A negative value moves the pattern down, and a positive value moves the 
pattern up.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Position> group, press [Position], turning it on, and set the pattern 
position.

To return the pattern position to the center of the screen
In the <Position> group, press [Center].

To move the pattern from its current position to the center through 
the course of a transition
In the <Position> group, press [Auto Center], turning it on.

To set the wipe position using the trackball or joystick
You can also set the wipe position using the trackball or joystick in the device 
control block. 

Positioner onPositioner off

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00

2 Position V Vertical position –200.00 to +200.00
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1 In the device control block, press the [M/E1], [M/E2], [M/E3], or [P/P] 
button, turning it on.

The buttons in the device control block are assigned to the wipe position 
setting as follows.

Table 1: Buttons and assigned settings

Table 2: Buttons assigned to functions

2 Press the [WIPE] button, turning it on.

3 Press the [POS] button, turning Position on.

4 Move the trackball or joystick, to set the wipe position. By pressing the [X] 
button, turning it on, you can restrict movement to the horizontal direction, 
and by pressing the [Y] button, turning it on, you can restrict movement to 
the vertical direction. 

Rotating the wipe pattern (Rotation)
You can rotate the pattern. There are three rotation modes, as follows.

Angle
This carries out a wipe with the pattern in a fixed angle.

The parameter Angle determines the angle of pattern rotation. 

Button name Setting

Wipe Wipe position for common transition.

Button name Function

POS Toggle Position on or off.

X, Y Fix the operating direction.

CTR Return the pattern position to the center of the screen.

Angle off Angle on
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A value of –100.00 of the parameter Angle corresponds to one whole turn 
counterclockwise; a value of +100.00 corresponds to one whole turn 
clockwise.
With a value of 0.00 there is no rotation.

Speed
Through the course of the transition the wipe pattern rotates at a fixed specified 
speed.

The parameter Speed determines the speed of pattern rotation. 
A value of –100.00 of the parameter Speed corresponds to one turn per second 
counterclockwise; a value of +100.00 corresponds to one turn per second 
clockwise. With a value of 0.00 the pattern is stationary.

Magnitude
Through the course of the transition the wipe pattern rotates through the 
specified angle. 

The parameter Angle determines an angle of pattern inclination at the 
beginning of the transition.
• A value of –100.00 corresponds to the angle rotated one whole turn 

counterclockwise.
• A value of +100.00 corresponds to the angle rotated one whole turn 

clockwise.
• With a value of 0.00 the pattern is stationary.
The parameter Magnitude determines an angle of pattern rotation through the 
course of the transition.
• A value of –200.00 corresponds to a rotation of two turns counterclockwise.
• A value of +200.00 corresponds to a rotation of two turns clockwise.
• With a value of 0.00 the pattern is stationary.
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1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Rotation> group, select the rotation type.

Angle: Incline the pattern through a fixed angle.
Speed: Rotate at a fixed rate.
Magnitude: Rotate through a particular angle during the course of the 

transition.

3 According to the selection in step 2, set the following parameters.

• When Angle is selected

• When Speed is selected

• When Magnitude is selected

Setting the wipe pattern aspect ratio (Aspect ratio)
You can freely change the aspect ratio of the pattern.

A negative value of the parameter Aspect stretches the pattern vertically; a 
positive value stretches the pattern horizontally.

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation at start of 
transition

–100.00 to +100.00

2 Magnitude Angle of rotation through course 
of transition

–200.00 to +200.00

Aspect off Aspect on
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1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press [Aspect], turning it on.

3 Set the following parameter.

Setting the wipe pattern replication (Multi)
The same pattern can be repeated horizontally and vertically or both, up to 63 
times. You can also change the orientation of alternate copies, or change the 
position.

• The parameter H Multi determines the number of pattern replications 
horizontally, and the parameter V Multi determines the number of pattern 
replications vertically.

You can use the “Invert Type” parameter to select from the following four 
types of replication patterns.

1: All replications in the same orientation
2: Even-numbered rows staggered
3: Even-numbered columns and rows inverted
4: Even-numbered columns and rows inverted, and even-numbered rows 

staggered

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00

“Multi” off “Multi” on

1 2 3 4
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1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press the [Multi] button, turning it on.

3 Set the following parameters.

Wipe Modify Clear

Press [Default Recall] at the lower left of the menu display, turning it on, then 
press VF5 ‘Wipe’ to return the wipe settings to their initial status.

For details of the menu operation to return the wipe state to that set in initial 
status, see “Returning to default state in function groupings” (page 116).

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4
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Wipe Settings for Independent Key 
Transitions

You carry out independent key transition wipe setting operations using the 
Wipe Adjust menu for each keyer.

For an overview of independent key transitions, see “What is an independent 
key transition?” (page 177).

This section describes the independent key transition wipe settings, taking the 
M/E-1 >Key1 >Transition >Wipe Adjust menu as an example.

Basic Procedure for Independent Key Transition Wipe 
Settings

Accessing the independent key transition wipe settings menu
As an example, to access the M/E-1 >Key1 >Transition >Wipe Adjust menu, 
carry out either of the following operations.
• In the menu control block, select the top menu selection button [M/E 1] and 

select VF1 ‘Key1’ and HF6 ‘Transition’ to display the Transition menu for 
key 1, then press [Wipe Adjust].

• In the independent key transition control block of the M/E-1 bank, press the 
key delegation button [KEY1], then press the independent key transition type 
selection button [WIPE] twice in rapid succession.

Carrying out the above operation displays the M/E-1 >Key1 >Transition 
>Wipe Adjust menu (which will be referred to below as simply the Key1 Wipe 
Adjust menu).

Selecting the independent key transition wipe pattern
You select the independent key wipe pattern from the list of patterns displayed 
in the menu.

Note 
In an independent key transition, you can only use the patterns 1 to 24.

To select a wipe pattern for independent key1 on the M/E-1 bank, use the 
following procedure.
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1 In the Key1 Wipe Adjust menu, select [Pattern Select].

The Pattern Select menu appears.

2 Press the button for the desired pattern.

Setting Independent Key Transition Wipe Modifiers

Available modifiers
You can use the following modifiers with an independent key transition wipe.
Note that the available modifiers may depend on the pattern you are using.
• Direction
• Edge
• Positioner
• Rotation
• Aspect ratio
• Pattern replication

Setting the wipe direction (Direction)
In the <Direction> group of the Key1 Wipe Adjust menu, make any of the 
following selections.
Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal

Softening the wipe pattern edge (Soft edge)

1 Press [Soft] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameter.

Setting the wipe position (Positioner)
There are two methods of setting the wipe position: using the device control 
block, or in a menu.

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00
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To set the wipe position using the trackball or joystick
You can also set the wipe position using the trackball or joystick in the device 
control block.

1 In the device control block, press the [M/E1], [M/E2], [M/E3], or [P/P] 
button, turning it on.

The buttons in the device control block are assigned to the wipe position 
setting as follows.

Table 1: Buttons and assigned settings

Table 2: Buttons assigned to functions

2 Press one of the buttons in Table 1 above, to select the wipe position to 
which the operation applies. Multiple selection is possible.

3 Press the [POS] button, turning Position on.

4 Move the trackball or joystick, to set the wipe position. By pressing the [X] 
button, turning it on, you can restrict movement to the horizontal direction, 
and by pressing the [Y] button, turning it on, you can restrict movement to 
the vertical direction. 

To set the wipe position by a menu operation

1 Press [Position] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameters.

Button name Setting

K1 CB1 Wipe position for independent key 1 transition

K2 Wipe position for independent key 2 transition

K3 Wipe position for independent key 3 transition

K4 Wipe position for independent key 4 transition

Button name Function

POS Toggle Position on or off.

X, Y Fix the operating direction.

CTR Return the pattern position to the center of the screen.

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)
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a) See page 273.

To move the pattern from its current position to the center through 
the course of a transition
Press [Auto Center] in the <Position> group, turning it on.

Rotating the wipe pattern (Rotation)

1 In the <Rotation> group of the Key1 Wipe Adjust menu, select the rotation 
type.

Angle: Incline the pattern through a fixed angle.
Speed: Rotate at a speed rate.
Magnitude: Rotate the pattern through a fixed angle during the course of 

the transition.

2 According to the selection in step 1, set the following parameters.

• When Angle is selected

a) See page 274.

• When Speed is selected

a) See page 275.

• When Magnitude is selected

a) See page 275.

Setting the wipe pattern aspect ratio (Aspect ratio)

1 Press [Aspect] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameter.

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation at start of 
transition

–100.00 to +100.00 a)

2 Magnitude Angle of rotation through course 
of transition

–200.00 to +200.00 a)
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a) See page 276.

Replicating the wipe pattern (Multi)

1 Press [Multi] in the Key1 Wipe Adjust menu, turning it on.

2 Set the following parameters.

a) See page 277.

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)
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Wipe Snapshots

You can snapshot and save a wipe pattern together with the current settings of 
its modifiers and pattern limit in a dedicated register for recall when required.
There are 10 wipe snapshot registers on each M/E bank and the PGM/PST 
bank. 
Use the Flexi Pad control block, the Multifunction Flexi Pad block in each 
switcher bank or the Menu control block to save and recall wipe snapshots. 
For simple transitions (see page 189), there are eight wipe snapshot registers 
on each M/E bank and the PGM/PST bank.

Wipe Snapshot Operations With the Flexi Pad

Flexi Pad control block (standard type)

7

WIPE

DME

SNAP
SHOT

EFF

MCRO

SHOT
BOX

UNDO

STORE
STATS

TRANS
RATE

BNAK
0

BANK
1

BANK
SEL

XPT HOLD
A B U1 U2 1 2 3 4

8 9

4 5 6

1 2 3

0 ENTR
PTN
NQ

WIPE button STORE STATS button

UNDO button

Numeric display

Memory recall buttons
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Flexi Pad control block (simple type)

Selecting a wipe pattern in the Flexi Pad control block
To select a pattern with a standard type Flexi Pad control block, use the 
following procedure. (It is not possible to select a wipe pattern with a simple 
type Flexi Pad control block.)

1 In the M/E-1 Flexi Pad control block, press the [WIPE] button.

This switches the Flexi Pad control block to wipe snapshot mode.

2 In the memory recall section, press the [PTN NO] button.

This switches the Flexi Pad control block to wipe pattern number recall 
mode.

3 Use the buttons in the memory recall section to enter the pattern number 
consisting of up to three digits, and press the [ENTR] button.

WIPE

DME

SNAP
SHOT

UNDO

1 2

3 4

5 6

XPT HOLD
A B U1 U2 1 2 3 4

7 8

WIPE button

Numeric display

UNDO button

Memory recall buttons
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The entry is confirmed, and now the numeric display shows the pattern 
number.

For the pattern numbers, see “Wipe Pattern List” (page 444).

Saving a wipe snapshot

1 Make the wipe settings that you want to save.

Make any modifier settings required.

For details, see “Setting Wipe Modifiers” (page 268).

2 In the Flexi Pad control block, hold down the [WIPE] button, and press the 
memory recall button corresponding to the register in which you want to 
save.

Note
If you press a button which is lit orange or yellow, the existing contents of 
the register are overwritten.

The pattern appears on the button you pressed, which lights yellow.
The numeric display shows the number of the corresponding pattern.
It is also possible to display the register name using a Setup menu (see 
“Operation Settings (Operation Menu)” in Chapter 19 (Volume 3)).

Meaning of the state of buttons
Off: Nothing is saved in the register.
Lit orange: Settings are saved in the register.
Lit yellow: The most recently recalled register.

Canceling the saving of a wipe snapshot
To cancel the saving of a wipe snapshot immediately after performing it, hold 
down the [STORE STATS] button, and press the [UNDO] button. The 
[STORE STATS] button changes from amber to green.

Note
On a simple type Flexi Pad control block, it is not possible to cancel the saving 
of a wipe snapshot.

Recalling a wipe snapshot

1 In the Flexi Pad control block, press the [WIPE] button.
Wipe Snapshots
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This switches the Flexi Pad control block to the wipe snapshot mode.

2 Press the memory recall button for the register from which you want to 
recall the wipe snapshot.

The button lights, and the saved wipe snapshot is recalled. At this point, 
the numeric display shows the pattern number or register name.

Canceling the recall of a wipe snapshot
To cancel the recall of a wipe snapshot, press the [UNDO] button.

Deleting a wipe snapshot
When the [WIPE] button is lit in the Flexi Pad control block, hold down the 
[STORE STATS] button and press the memory recall button for the register in 
which you want to delete the wipe snapshot.
The indication of the memory recall button reverts from the wipe pattern or 
register name to the register number.

Note
In a simple type Flexi Pad control block, it is not possible to delete a wipe 
snapshot.

Wipe Snapshot Operations With the Menus

Menus used
As an example, when operating on M/E-1, select M/E-1 >Wipe >Wipe 
Snapshot.
The Wipe Snapshot menu appears.
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Button displays
In setup you can select whether the memory recall buttons show the pattern 
number or register name.

See “Operation Settings (Operation Menu)” in Chapter 19 (Volume 3).

Saving a wipe snapshot from the menu

1 Set up the wipe you want to save.

2 In the Wipe Snapshot menu, press [Store], lighting it amber.

3 Press the memory recall button for the register in which you want to save.

Note
If you press a button which is already lit, this overwrites the contents of the 
register.

Recalling a wipe snapshot from the menu
In the Wipe Snapshot menu, press the memory recall button for the wipe 
snapshot you want to recall.
This recalls the wipe snapshot, and the button you pressed lights amber.
In the upper left is shown the currently recalled register name or number.

Note
The Flexi Pad and menu settings are linked.

Memory recall buttons
Wipe Snapshots
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A setting in setup determines whether register names or pattern numbers 
appear.

Deleting a wipe snapshot from the menu

1 In the Wipe Snapshot menu, press [Delete].

2 Press the memory recall button for the wipe snapshot you want to delete.

This deletes the wipe snapshot.
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Wipe Pattern Operations in the 
Multifunction Flexi Pad Control Block

Recalling a Wipe Snapshot

You can recall a wipe snapshot in the Multifunction Flexi Pad control block.
To recall a wipe snapshot, use the operations shown in the following 
illustration.

1 In the Multifunction Flexi Pad control block, press the [WIPE] button.

This sets the Multifunction Flexi Pad control block to wipe snapshot mode, 
and the button indications appear as follows.

You can change the indications for buttons [0] to [9] in the memory recall 
section to pattern images, using the Engineering Setup >Panel >Operation 
>Flexi Pad Mode menu.

2 Select the region for the wipe snapshot to be recalled with the region 
selection buttons.
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3 Press the numeric button (lit orange) in the memory recall section 
corresponding to the register in which the desired wipe snapshot is stored.

The button you pressed lights yellow, and this recalls the saved wipe 
snapshot.
At this point the numeric display shows the register name or pattern 
number for the pattern.

Selecting the Wipe Pattern

1 Press the [WIPE] button, and select the region with the region selection 
buttons.

2 Press the [PTN NO.] button in the memory recall section.

The [PTN No.] button lights green.

3 With the buttons in the memory recall section, enter the pattern number of 
up to three digits, and press the [ENTR] button.

This confirms the input, and the pattern number appears in the 
alphanumeric display.
The [PTN NO.] button lights orange, and the system returns to wipe 
snapshot mode.

For pattern numbers, see “Wipe Pattern List” (page 444).

Editing the Wipe Pattern

By pressing the [EDIT ENBL] button to switch the memory recall section to 
editing mode as shown in the following illustration, you can edit the selected 
wipe pattern with the following buttons.
To exit from the editing mode, press the [EDIT ENBL] button once more, or 
press the [EXIT] button.
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Wipe pattern edge setting buttons
BDR (border): Applies a border to the wipe pattern.
SOFT BDR (soft border): Softens the applied border.
SOFT (soft edge): Softens the edge.
EDGE MAT (edge matte): Selects whether to fill the edge with a color matte, 

or insert an image from the utility bus. By default a color matte is selected.

You can adjust the parameters selected with these buttons using the control 
knobs, when the button is lit green.

• When border is selected

• When soft border is selected

EXIT

BDR

POS

NORM

SOFT

CNTR

REV

SHOT
BOX

SNAP
SHOT

TRANS
RATE

EDIT
ENBL

DME
WIPE

KEY
ADJ

MCRO

EFF

WIPE

DME
1

DME
2ALL

P/P
M/E

2

DEV
1

USER
4 MORE

M/E
1

NORM
/REV

SOFT
BDR

KNOB
1/2

EDGE
MAT

LIMT
SET

PTN
LIMT

H 0

V 0

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 W Border width 0 to 100

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 L Luminance 0 to 100

2 S Saturation 0 to 100

3 H Hue 359 to 0

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 W Border width 0 to 100

2 I Degree of softening of 
inside of border

0 to 100
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• When soft edge is selected

• When edge matte is selected

Buttons for positioning the wipe pattern
POS (position): Adjusts the position of the wipe pattern.
CNTR (center): Returns the wipe pattern position to the center.

When you press the [POS] button, the alphanumeric display first shows the 
name of the parameter, “H” or “V,” and then the value of the parameter.
When the [POS] button is lit green, you can adjust the position of the wipe 
pattern with the control knobs.

Buttons for setting the wipe direction
NORM (normal): Sets wipe to normal (forward) direction.
NORM/REV (normal/reverse): Sets the wipe direction to alternate between 

normal and reverse for each transition.
REV (reverse): Sets wipe to reverse direction to normal.

3 O Degree of softening of 
outside of border

0 to100

Parameter group [1/2]

Knob Parameter Adjustment Setting values

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 L Luminance 0 to 100

2 S Saturation 0 to 100

3 H Hue 359 to 0

Knob Parameter Adjustment Setting values

1 S Degree of softening of 
edge

0 to 100

Knob Parameter Adjustment Setting values

1 L Luminance 0 to 100

2 S Saturation 0 to 100

3 H Hue 359 to 0

Knob Parameter Adjustment Setting values

1 H Horizontal position –200 to +200

2 V Vertical position –200 to +200
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Buttons for setting the wipe pattern limit
PTN LIMT (pattern limit): Enables the following settings for the pattern 

limit using the control knobs.
LIMT SET (limit set): If you change the pattern size with the fader lever then 

press this button, this sets the current size as the pattern limit.

a) At 0%, executing the transition has no effect at all.
b) At 100%, the transition can be executed with the same effect as with no pattern limit set, but 

when the transition completes, background buses A and B are not interchanged.

Other buttons
EXIT: Exits the editing mode, and returns the memory recall section to wipe 

snapshot mode.
KNOB 1/2: When the control knob adjustments are on two pages, this switches 

between parameter group [1/2] and parameter group [2/2].

Wipe modify clear
Press [Default Recall] at the lower left of the menu display, turning it on, then 
press VF5 ‘Wipe’ to return the wipe settings to their initial status.

For details of menu operations, see “Menu Operations” (page 115).

Saving, Canceling, and Deleting Edited Wipe Patterns

Saving the edited wipe pattern as a snapshot
Holding down the [WIPE] button, press the button in the memory recall section 
for the register in which you want to save.
The button you pressed lights yellow.
Buttons for registers in which wipe snapshots are already saved light orange.

Canceling a saved wipe snapshot

To cancel a wipe snapshot
Immediately after saving, hold down the [STOR STAT] button and press the 
[UNDO] button.
At other times, hold down the [STOR STAT] button, and press the button for 
the register in which the wipe snapshot you want to cancel is saved.

Knob Parameter Adjustment Setting values

1 P Pattern limit range 0 a) to +100 b) (%)
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Buttons for registers in which wipe snapshots are already saved light orange.

Canceling recall of a wipe snapshot
To cancel the operation of recalling a wipe snapshot, press the [UNDO] button.

Deleting the date of a saved wipe snapshot
Holding down the [DEL] button, press the button for the register in which the 
wipe snapshot you want to delete is saved.
The register button you pressed goes off.
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Overview

A DME wipe is a wipe transition that uses a DME effect to change from one 
video image to the next.
There are two types of DME wipe: those which can be selected for a normal 
transition, and those which can be selected for an independent key transition.

For details of independent key transitions, see page 177.

A DME wipe is only possible when using the resizer or a switcher with 
incorporated DME.

Types of DME Wipe Pattern

The patterns used for a DME wipe fall into two broad classes.
Preset patterns: predetermined fixed patterns
User programmable DME patterns: patterns which you can create using 

keyframe effects

DME wipe execution mode and pattern numbers that can be used
There are three DME wipe execution modes, depending on the number of 
DME channels available: one-channel mode and two-channel mode. The 
pattern numbers that can be used in these modes are as follows.

DME wipe pattern groups
The patterns used in DME wipes fall into the following groups.

For each group (excluding user programmable DMEs), for schematic patterns 
and numbers, see “DME Wipe Pattern List” in Appendix (Volume 1) (page 
445). The black part of the pattern represents the old video, and the white part 
the new video, with the wipe taking place in the direction of the arrow.

Slide: The new video slides in over the old video.
(Pattern numbers: 1001 to 1008 (one-channel mode), 2601 to 2608 (two-
channel mode))

Execution mode Preset pattern numbers 
that can be used

User programmable DME pattern 
numbers that can be used

One-channel mode 1000 series 1901 to 1999

Two-channel mode 2000 series 2901 to 2999
Overview
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Squeeze: The new video appears squeezed over the old video, and 

progressively expands to cover it.
(Pattern numbers: 1021 to 1031 (one-channel mode), 2621 to 2628 (two-
channel mode))

Door: The new video moves like a door closing, and progressively covers the 
old video.
(Pattern numbers: 1041 to 1048 (one-channel mode))

Flip tumble: The old video rotates about an axis and is replaced by the new 
video. During the transition, the signal from the utility 2 bus of the M/E 
bank appears as the background.
(Pattern numbers: 1101 to 1104, 1109, 1110, 1121, 1122, 1124, 1131 to 
1133, 1135 (one-channel mode))

Frame in-out: Completed in two transitions. In the first transition, the new 
video appears, then on the second transition the new video goes out and the 
old video returns.
(Pattern numbers: 1201 to 1208, 1221 to 1224 (one-channel mode), 2851 
to 2854, 2861 to 2864 (two-channel mode))

Picture-in-picture: The one-channel mode and two-channel mode differ as 
follows.
In one-channel mode, this completes in two transitions. In the first 
transition, the old video shrinks, and the new video appears behind it.
In the second transition, the old video expands again until it is its original 
size.
(Pattern number: 1251 (one-channel mode))
In two-channel mode, in the first half of the transition, the old video 
shrinks, and the new video appears. In the second half of the transition, the 
new video expands, and the old video disappears. You can move the 
pattern from the current position by a relative amount. During the 
transition, the signal from the utility 2 bus of the M/E bank appears as the 
background.
(Pattern numbers: 2651 and 2652 (two-channel mode))

2D trans: The new video appears over the old video, while undergoing 
expansion, two-dimensional rotation and translation.
(Pattern numbers: 1051 to 1058, 1061 to 1064, 1068 (one-channel mode))

3D trans: In one-channel mode, the new video appears over the old video, 
while undergoing expansion, three-dimensional rotation and translation.
(Pattern numbers: 1071, 1072, 1074, 1076, 1077, 1088, 1091 to 1094 (one-
channel mode))
In two-channel mode, the old video changes to the new video while both 
undergo expansion, three-dimensional rotation and translation.
(Pattern numbers: 2631 to 2634, 2642, 2644 (two-channel mode))

Mosaic: In the first half of the transition, a mosaic is gradually applied to the 
old video, then at the 50% point the inner image changes to the new video. 
In the second half, the mosaic effect on the new video is gradually reduced, 
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returning to the original image at 100%.
(Pattern number: 1701 (one-channel mode))

Defocus: In the first half of the transition, the old video is gradually defocused, 
then at the 50% point the inner image changes to the new video. In the 
second half, the defocusing effect on the new video is gradually reduced, 
returning to the original image at 100%.
(Pattern number: 1702 (one-channel mode))

Brick: A brick such that the side surface is visible slides in over the old video, 
then rotates so that the new video can be seen.
(Pattern numbers: 2801 to 2804, 2811 to 2814 (two-channel mode))

User programmable DME: Using a DME keyframe effect created with a 
keyframe operation, this executes a DME wipe.
Pattern numbers: 1901 to 1999 (one-channel mode), 2901 to 2999 (two-
channel mode)

For details of creating keyframe effects, see “Creating User 
Programmable DME Patterns” (page 326).

In an independent key transition, you can use the following patterns. It is not 
possible to use two-channel mode patterns.

User programmable DME in transition mode
For the transition mode set when creating a keyframe effect for a user 
programmable DME pattern, the following can be used.
• Single: single transition mode
• Flip tumble (Flip Tumble): flip tumble transition mode
• Dual: dual transition mode
• Picture-in-picture (PinP): one-channel and two-channel picture-in-picture 

transition mode
• Compress: a type of picture-in-picture, in which the new image is the 

background, and the currently visible image shrinks, and then expands to its 
original size. (See example in the next item.)

• Frame in-out (Frame I/O): frame in-out transition mode. When the first 
transition completes, if you move the position of the image, you can move it 
both horizontally and vertically.

• Frame in-out H (Frame I/O H): a type of frame in-out mode, which is 
specified when creating a transition effect in the horizontal direction.
The image movement is reflected at both the transition start point and end 
point. (See page 302.)
The operation is carried out according to DME wipe patterns 1202, 1203, or 
1204.

Execution mode DME wipe patterns that can be used

One-channel mode Slide, squeeze, door, 2D trans, 3D trans, frame in-out, and user 
programmable DME
Overview
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• Frame in-out V (Frame I/O V): a type of frame in-out mode, which is 

specified when creating a transition effect in the vertical direction.
The image movement is reflected at both the transition start point and end 
point. (See page 303.)

Transition mode “Compress”
The change in the image when the transition mode is set to “Compress” is as 
follows, in comparison to the case of “Picture-in-picture.”
• Example of the image change in the transition mode “Picture-in-

picture” (one-channel mode)

• Example of the image change in the transition mode “Compress”

Transition mode “frame in-out”
In this mode, when the first transition has completed, you can move the image 
with the positioner in both horizontal and vertical directions, but the image 
position at the transition start point and end point does not change.
The description is of an example of creating an effect such as the following.

Second strokeFirst stroke

First stroke Second stroke
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At the first transition completion point, if you move the image with the 
positioner, the transition appears as in the following figure.

Transition mode “frame in-out H”
This mode is specified when creating a transition effect in the horizontal 
direction.
In this mode, when the first transition has completed, you can move the image 
with the positioner in both horizontal and vertical directions. The image at the 
transition start point and end point also moves.
The description is of an example of creating an effect such as the following.

Transition start Transition end
First transition 
completion point

Image created 
by interpolation

Background B

Background A

Effect execution

State before 
modification

Image created 
by interpolation

Background B

Background A

Transition start Transition end
First transition 
completion point

Effect execution
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At the first transition completion point, if you move the image with the 
positioner, the transition appears as in the following figure.

Transition mode “frame in-out V”
This mode is specified when creating a transition effect in the vertical 
direction.
In this mode, in the state at completion of the first transition, you can move the 
image with the positioner in both horizontal and vertical directions. The image 
at the transition start point and end point also moves.
The description is of an example of creating an effect such as the following.

Transition start Transition end
First transition 
completion point

Image created 
by interpolation

Background B

Background A

Effect execution

State before 
modification

Image created 
by interpolation

Background B

Background A

Transition start Transition end
First transition 
completion point

Effect execution
303Overview



304

   C
hapter 6 

D
M

E
 W

ipes
At the first transition completion point, if you move the image with the 
positioner, the transition appears as in the following figure.

Transition start Transition end
First transition 
completion point

Image created 
by interpolation

Background B

Background AEffect execution

State before 
modification

Image created 
by interpolation

Background B

Background A

Transition start Transition end
First transition 
completion point

Effect execution
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Signals forming part of the background for a DME wipe

For a two-channel mode brick, frame in-out, and so on, the part of the pattern 
shown in gray (see page 449) is filled with the signal selected on the DME 
external video bus.

DME Wipe Pattern Variation and Modifiers

You can modify the selected DME wipe pattern in the same way as an ordinary 
wipe pattern, as follows.

For the setting operations, see “Setting DME Wipe Modifiers” (page 310).

Direction: You can set the DME wipe direction to normal, reverse, or 
alternating normal/reverse (see page 310), except for a key transition, 
which is always in normal/reverse mode. However, a key transition can 
only be specified when the following patterns are selected, and when other 
patterns are selected, this is fixed, as normal/reverse.
Patterns: 1204, 1207, 1221 to 1224

Edge: You can apply a border or soft border (see page 310). 
In the case of those user programmable DME patterns for keys in which an 
edge has already been applied to the effect, the behavior is as follows.
• When the DME wipe edge setting is on, only part of the edge applied in 

the effect is enabled, and that portion can be adjusted (page 310).
• When the DME wipe edge setting is off, the edge applied in the effect is 

enabled as is.
Positioner: You can move the DME wipe pattern or center of the effect to an 

arbitrary position. Using the position select function, you can also 
instantaneously move the pattern.
• 1031

When this pattern number is selected, with the progress of the transition 
the pattern center automatically moves initially from the set position 
toward the center of the screen (see page 311). In other words, the effect 
obtained is the same as in a normal wipe with the positioner set to 
“AUTO CENTER”.

• 1201 to 1208, 1221 to 1224, 1251
When these pattern numbers are selected, you can set the pattern position 
when the first transition completes.

• 2651, 2652
When these pattern numbers are selected, you can move the pattern for 
each channel, or with values relative to the current position the two 
channels simultaneously.

• 2801 to 2804, 2811 to 2814
When the these pattern numbers are selected, you can set the vertical 
position as the brick slides in.
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• 2851 to 2854, 2861 to 2864
When these pattern numbers are selected, you can set the pattern position 
for each channel setting when the first transition completes.

Pattern limit: You can restrict the range of the transition as desired. However, 
this is not available for a DME wipe in the independent key transition 
control block. 

For more details, see “Pattern Limit” (page 167).

Size: This can only be used when one of the following pattern numbers is 
selected.
• 1201 to 1208, 1221 to 1224, 1251
• 2651, 2652, 2851 to 2854, 2861 to 2864 

You can set the size of the image.
Crop: You can crop the image. It is also possible in 16:9 mode to crop both 

sides, to convert the image to a 4:3 aspect ratio. For the execution of a 
DME wipe crop transition, you can select from the following three 
possibilities.
• Cut
• Last 5%
• Linear
When [Last 5%] is selected, you can set the [Release Transition] as 
follows. 
• Last 30%
• Last 5%
• Off

Note
When pattern numbers 1701 and 1702 are selected, crop cannot be used.

Relation Between DME Wipes and Other Effects

The relations between DME wipes and other effects are as follows.

Relation to ordinary wipes
• DME wipes do not use the wipe generator built into the switcher. Therefore, 

during the execution of a DME wipe, you can still use a pattern produced by 
the wipe generator as the source for a pattern key or mask.

• A DME wipe pattern cannot be used as the source for a pattern key or mask.
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Relation to processed keys

When using the DME for a processed key, if you select a DME wipe, an 
available DME is automatically allocated to the DME wipe. If all of the DME 
channels are in use, then it is not possible to select a DME wipe.
If in a Setup menu a setting has been made for DME allocation, that Setup 
menu setting takes precedence (see “Setting the assignments of DME channels 
to use on the individual M/E banks” in Chapter 20 (Volume 3).

Relation to resizer
It is not possible to select a DME wipe for a key having the resizer enabled.

Number of DME wipes that can be used simultaneously on a 
single M/E bank

DME wipes can be used in five places, including the four independent key 
transitions. 
It is not possible to use two or more of these places simultaneously.
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Basic Procedure for DME Wipe Settings

You carry out DME wipe setting operations principally using the DME Wipe 
menu for each bank.
This section describes the basic procedures for DME wipe settings, taking the 
M/E-1 >DME Wipe menu as an example.

For details of independent key transition DME wipe settings, see “DME Wipe 
Settings for Independent Key Transitions” (page 318).

DME Wipe Settings Menu

Accessing the DME Wipe menu
To access the M/E-1 >DME Wipe menu, use either of the following operations.
• In the menu control block, select the top menu selection button [M/E 1], and 

press VF6 ‘DME Wipe.’
• In the transition control block of the M/E-1 bank, press the transition type 

selection button [DME] twice in rapid succession.
Either of the above operations displays the M/E-1 >DME Wipe menu.

DME Wipe Pattern Selection

Selecting a DME wipe pattern by a menu operation

1 In the M/E-1 >DME Wipe menu, select HF1 ‘1ch’ for one-channel mode 
and select HF2 ‘2ch’ for two-channel mode.

2 Select the DME wipe pattern group with one of the following buttons.

• Slide/Squeeze: slide and squeeze
• Door: door
• Frame I/O: frame in-out
• 2D Trans/3D Trans: 2D trans and 3D trans
• Mosaic/Defocus: mosaic and defocus
• Brick: brick
Basic Procedure for DME Wipe Settings
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• User Program: user programmable DME

For details of DME wipe patterns, see “Types of DME Wipe Pattern” 
(page 298) and “DME Wipe Pattern List” (page 445).

The patterns from the selected pattern group appear on the screen.

3 Press the button to select the desired pattern.

Note
For a key transition, the picture-in-picture cannot be used.

Adjusting DME wipe pattern parameters
Of the DME wipe patterns, the following have parameters that can be adjusted.

When Brick (for two channels) is selected (pattern numbers 2801 
to 2804, 2811 to 2814)

a) The horizontal center position of the video pasted on Side V. At –100.00 the center is at the left 
edge of the screen, and at +100.00 the center is at the right edge of the screen.

b) The vertical center position of the video pasted on Side V. At –100.00 the center is at the bottom 
edge of the screen, and at +100.00 the center is at the top edge of the screen.

When Frame in-out (for two channels) is selected
• Pattern numbers 2851 to 2854

• Pattern numbers 2861 to 2864

Knob Parameter Adjustment Setting values

1 Side V Size X Horizontal magnification 0.01 to 8.00

2 Side V Size Y Vertical magnification 0.01 to 8.00

3 Height Height of brick 0.01 to 100.00

4 Center X Horizontal center position –100.00 to +100.00 a)

5 Center Y Vertical center position –100.00 to +100.00 b)

Knob Parameter Adjustment Setting values

5 Delay Timing for video selected on 
a utility bus to appear on the 
screen

–100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Rot X Rotation about the Y axis 
(horizontal direction)

–100.00 to +100.00

2 Rot Y Rotation about the X axis 
(vertical direction)

–100.00 to +100.00

3 Rot Z Rotation about the Z axis –100.00 to +100.00
309Basic Procedure for DME Wipe Settings
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Setting DME Wipe Modifiers

You can apply various modifiers to the DME wipe pattern: setting the DME 
wipe direction, pattern position, and so on.

For an overview of the DME wipe modifiers, see “DME Wipe Pattern 
Variation and Modifiers” (page 305).

Specifying the DME wipe direction (Direction)
You can specify the DME wipe direction (normal/reverse).

To specify the DME wipe direction in a menu

1 In the M/E-1 >DME Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Direction>group, specify the DME wipe direction.

Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal

To specify the DME wipe direction with a button in the transition 
control block
In the transition control block of each of the M/E-1 to M/E-3 and PGM/PST 
banks, press the following direction selection buttons.
NORM: Normal
NORM/REV: Normal/Reverse
REV: Reverse

Modifying the DME wipe pattern edge

1 In the M/E-1 >DME Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

5 Delay Timing for video selected on 
a utility bus to appear on the 
screen

–100.00 to +100.00

Knob Parameter Adjustment Setting values
Basic Procedure for DME Wipe Settings
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For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time.

3 In the <Edge> group, select the edge type.

Border: border
Soft Border: soft border

4 Set the parameters according to the selection in step 3.

• When border is selected

• When soft border is selected

Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

Setting the DME wipe position (Positioner)

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the DME wipe pattern is in one-channel mode or 
two-channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

3 Luminance Luminance 0.00 to 100.00

4 Saturation Saturation 0.00 to 100.00

5 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

2 Inner Soft Border inner softness 0.00 to 100.00

3 Luminance Luminance 0.00 to 100.00

4 Saturation Saturation 0.00 to 100.00

5 Hue Hue 359.99 to 0.00
311Basic Procedure for DME Wipe Settings
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For a pattern in two-channel mode: from the <Ch Select> group, select 
the corresponding channel. You can select more than one channel at 
the same time.

3 In the <Position> group, press [Position], turning it on.

4 Set the following parameters.

Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

To return the DME wipe pattern position to the center of the screen
In the <Position> group, press [Center].

Displaying and moving the position of the DME wipe pattern 
(position select)

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.
In the <Position Select> group, the one of the [Top Left], [Top Right], 
[Bottom Left], and [Bottom Right] buttons that is on indicates the current 
display position of the DME wipe pattern.

2 In the <Position> group, press [Position], turning it on.

3 Depending on whether the DME wipe pattern is in one-channel mode or 
two-channel mode, proceed as follows.

In one-channel mode: press [1st Ch], turning it on.
In two-channel mode: from the <Ch Select> group, select the 

corresponding channel. You can select more than one channel at the 
same time.

4 To move the position of the DME wipe pattern, press the button where you 
want to move to, turning it on.

Knob Parameter Adjustment Setting values

1 H Horizontal position –200.00 to +200.00

2 V Vertical position –200.00 to +200.00
Basic Procedure for DME Wipe Settings
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The DME wipe pattern displayed on the screen moves to the position of 
the specified button.

Setting relative positions to move the DME wipe pattern
In two-channel mode, use the following procedure. 

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 In the <Ch Select> group, select the target channels.

3 Press [Position] in the <Position> group, turning it on.

4 Set the following parameters.

For details of the method of DME wipe pattern selection, see “DME Wipe 
Pattern Selection” (page 308).

Setting the DME wipe pattern size (Size)

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time.

3 Press [Size], turning it on.

4 Set the following parameters.

Knob Parameter Adjustment Setting values

4 Relative H Relative movement in the 
horizontal direction

–400.00 to +400.00

5 Relative V Relative movement in the vertical 
direction

–400.00 to +400.00

Knob Parameter Adjustment Setting values

1 Size Set size of effect 0.00 to 200.00 a)
313Basic Procedure for DME Wipe Settings
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a) The effect size when [Size] is off is taken as 100.00%.

Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

Adjusting the DME wipe pattern cropping

Note
When pattern numbers 1701 and 1702 are selected, crop cannot be used.

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.
For a pattern in two-channel mode: from the <Ch Select> group, select 

the corresponding channel. You can select more than one channel at 
the same time. Some patterns need no selection which is fixed in the 
<Ch Select> group.

3 In the <Crop Mode> group, press [Crop], turning it on.

4 Set the following parameters.

Display indications when multiple channels are selected at the same 
time
The indications on the knobs show the settings of the lowest-numbered 
channel. When you turn the knobs to adjust the settings, this changes the 
settings on the other channels by the same amount.

In 16:9 mode, to crop to 4:3 aspect ratio
In the <Crop Mode> group, press [4:3], turning it on.

Knob Parameter Adjustment Setting values

1 Top Crop the top of the image –100.00 to +100.00

2 Left Crop the left of the image –100.00 to +100.00

3 Right Crop the right of the image –100.00 to +100.00

4 Bottom Crop the bottom of the image –100.00 to +100.00
Basic Procedure for DME Wipe Settings
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To set the action when a DME wipe crop transition is executed

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: in the <Ch Select> group, press [1st 
Ch], turning it on.

For a pattern in two-channel mode: from the <Ch Select> group, select 
the corresponding channels. You can select more than one channel at 
the same time.

3 In the <Crop Mode> group, press [Crop] or [4:3 Crop] (to crop from 16:9 
to 4:3 aspect ratio), turning it on.

4 In the <Crop Mode> group, press [Remove From Begin].

The Remove From Begin menu appears.

5 In the <Crop Transition> group, select the execution mode for the DME 
wipe crop transition.

Cut: Cut mode. The cropping does not change during the transition, but at 
the end point of the transition the cropping is removed (enlarges).

Last 5%: The cropping is maintained for the first 95% of the transition, 
and is progressively removed during the last 5% of the transition 
(enlarges).

Linear: The cropping is removed linearly through the whole course of the 
transition (enlarges).
315Basic Procedure for DME Wipe Settings
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Setting the timing of transition completion
When the execution mode for a DME wipe crop transition is set to [Last 5%], 
you can select the timing of transition completion from 70% ([Last 30%]), 95% 
([Last 5%]), and 100% ([Off]).

1 In the M/E 1 >DME Wipe menu, select HF5 ‘Modify’.

The Modify menu appears.

2 In the <Crop Mode> group select [Remove From Begin].

The Remove From Begin menu appears.

3 In the <Release Transition> group, select the timing of transition 
completion.

Last 30%: The transition completes at the end of 70% of the transition 
execution time. The transition has a dead zone from 70% to 95% of the 
transition time.

Last 5%: The transition completes at the end of 95% of the transition 
execution time. When the transition completes, the cropping is 
removed during the last 5%.

Off: The transition completes at the end of the transition execution time. 
During the last 5% of the transition, the transition and cropping 
removal proceed together.

0
100 (%)
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t

(%)
100

0
100 (%)95

y

t

(%)
100

95

0
100 (%)

[Cut] [Last 5%] [Linear]

y
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Transition
Cropping

Transition
Cropping

Transition
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t: transition execution time
y: change in transition and cropping amount
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DME Wipe Modify Clear

Press [Default Recall] at the lower left of the menu display, turning it on, then 
press VF6 ‘DME Wipe’ to return the DME wipe settings to their initial status.

For details of the menu operation to return the DME wipe state to that set in 
initial status, see “Returning to default state in function groupings” (page 
116).
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DME Wipe Settings for Independent Key 
Transitions

You carry out independent key transition DME wipe setting operations using 
the DME Wipe Adjust menu for each keyer.

For an overview of independent key transitions, see page 177.

This section describes the independent key transition DME wipe settings, 
taking the M/E-1 >Key1 >Transition >DME Wipe Adjust menu as an example.

Basic Procedure for Independent Key Transition DME 
Wipe Settings

Accessing the independent key transition DME wipe settings 
menu

As an example, to access the M/E-1 >Key1 >Transition >DME Wipe Adjust 
menu, carry out the following operation.
• In the menu control block, select the top menu selection button [M/E 1], and 

select VF1 ‘Key1’ and HF6 ‘Transition’ to display the Transition menu for 
key 1. Next, press [DME Wipe Adjust].

• Press the key delegation button [Key1] in the independent key transition 
control block of the M/E-1 bank, then press the independent key transition 
type [DME] twice in quick succession.

Carrying out the above operation displays the M/E-1 >Key1 >Transition 
>DME Wipe Adjust menu (which will be referred to below as simply the Key1 
DME Wipe Adjust menu).

Selecting the independent key transition DME wipe pattern
You select the independent key DME wipe pattern from the list of patterns 
displayed in the menu.

To select a DME wipe pattern for independent key1 on the M/E-1 bank, use the 
following procedure.

1 In the <Pattern Select> group of the Key1 DME Wipe Adjust menu, press 
[1ch].

The Pattern Select menu appears.
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2 Select the DME wipe pattern group with one of the following buttons.

• Slide/Squeeze: slide and squeeze
• Door: door
• Frame I/O: frame in-out
• 2D Trans/3D Trans: 2D trans and 3D trans
• User Program: user programmable DME

For details of DME wipe patterns, see “Types of DME Wipe Pattern” 
(page 298) and “DME Wipe Pattern List” (page 445).

The patterns from the selected pattern group appear on the screen.

3 Press the button to select the desired pattern.

Setting Independent Key Transition DME Wipe 
Modifiers

You can add modifiers such as pattern position and size for an independent key 
transition DME wipe.

For introductory information, see “Setting the DME wipe position 
(Positioner)” (page 311) and “Setting the DME wipe pattern size (Size)” (page 
313).

Setting the DME wipe position (Positioner)
For applicable pattern numbers, see page 305.

1 In the <Position> group of the Key1 DME Wipe Adjust menu, press 
[Position], turning it on.

2 Set the following parameters.

To return the DME wipe pattern position to the center of the screen
In the <Position> group, press [Center].

Setting the DME wipe pattern size (Size)
For applicable pattern numbers, see page 306.

Knob Parameter Adjustment Setting values

1 H Horizontal position –200.00 to +200.00

2 V Vertical position –200.00 to +200.00
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1 In the Key 1 DME Wipe Adjust menu, press [Size], turning it on.

2 Set the following parameter.

a) The effect size when [Size] is off is taken as 100.00%.

Cropping a key DME wipe

1 In the <Crop Mode> group of the Key1 DME Wipe Adjust menu, press 
[Crop], turning it on.

2 Set the following parameters.

To crop to 4:3 in 16:9 mode
In the <Crop Mode> group, press [4:3 Crop], turning it on.

To set the operation for DME wipe crop transition execution

1 In the <Crop Mode> group of the Key1 DME Wipe Adjust menu, press 
[Crop], turning it on.

2 In the <Crop Mode> group, press [Crop] or [4:3 Crop] (to crop to 4:3 in 
16:9 mode), turning it on.

3 In the <Crop Mode> group, press [Remove From Begin].

The Remove From Begin menu appears.

For subsequent operations, see step 5 of “To set the action when a DME 
wipe crop transition is executed” (page 315).

To set the timing of transition completion

1 In the <Crop Mode> group of the Key1 DME Wipe Adjust menu, press 
[Crop], turning it on.

Knob Parameter Adjustment Setting values

1 Size Set size of effect 0.00 to 200.00 a)

Knob Parameter Adjustment Setting values

1 Top Cropping of the top of the image –100.00 to +100.00

2 Left Cropping of the left of the image –100.00 to +100.00

3 Right Cropping of the right of the image –100.00 to +100.00

4 Bottom Cropping of the bottom of the 
image

–100.00 to +100.00
DME Wipe Settings for Independent Key Transitions



  C
hapter 6 

D
M

E
 W

ipes

2 In the <Crop Mode> group, press [Remove From Begin].

For subsequent operations, see “Setting the timing of transition 
completion” (page 316).

Applying a border to a key DME wipe
In the <Edge> group of the Key1 DME Wipe Adjust menu, press [Border], 
turning it on.

For subsequent operations, use the same process as in step 4 of “Modifying the 
DME wipe pattern edge” (page 310).
321DME Wipe Settings for Independent Key Transitions



322

   C
hapter 6 

D
M

E
 W

ipes
Resizer DME Wipe Setting 

A DME wipe is only possible when using the resizer or a switcher with 
incorporated DME.

Notes
• It is not possible to use a resizer DME wipe for key 3 or key 4.
• When the screen aspect ratio is 4:3 in HD format, when the resizer DME 

wipe is used to shrink a video image, this is applied to the 16:9 screen 
including the added video on the left and right sides. Use the crop function 
as required to extract the 4:3 image.

DME wipe patterns available for resizer DME wipe
You can use the following patterns of the DME wipe pattern one-channel mode 
that can be used in a resizer DME wipe. (7000-series numbers)
• Slide (pattern numbers: 7001 to 7008)
• Squeeze (pattern numbers: 7021 to 7031)
• frame in-out (pattern numbers: 7201 to 7208, 7221 to 7224)

Relation between DME wipes and other effects
The following relations hold between a resizer DME wipe and other effects.

Relation to processed keys
It is not possible to select a resizer DME wipe for a key with processed key 
enabled.

Relation to resizer
It is not possible to use a resizer DME wipe for a key with resizer enabled.

Making resizer DME wipe settings

1 In the <Pattern Select> group of the Key1 DME Wipe Adjust menu, press 
[1ch].

The 1ch Pattern Select menu appears.

2 Select [Resizer Slide/Squeeze] or [Resizer Frame I/O].

The patterns of the selected group appear.

The wipe patterns that can be used for a resizer DME wipe are as follows.
• Slide (pattern numbers: 7001 to 7008)
Resizer DME Wipe Setting
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• Squeeze (pattern numbers: 7021 to 7031)
• Frame in-out (pattern numbers: 7201 to 7208, 7221 to 7224)

3 Press the desired pattern to select it.

For more about resizer DME wipe modifiers, see “Setting Independent 
Key Transition DME Wipe Modifiers” (page 319).
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DME Wipe Snapshots

You can snapshot and save a DME wipe pattern together with the current 
settings of its modifiers and pattern limit in a dedicated register for recall when 
required.
There are 10 DME wipe snapshot registers for each of the M/E and P/P banks. 
To save and recall these registers, use the Flexi Pad control block, the 
Multifunction Flexi Pad block in each switcher bank or the Menu control 
block.
In the case of a simple transition system, there are eight DME wipe snapshot 
registers for each switcher bank.

DME Wipe Snapshot Operations With the Flexi Pad

To carry out DME wipe snapshot operations, use the Flexi Pad control block.
You can save, recall and delete DME wipe snapshots using the procedures 
similar to the procedures for wipe snapshot operations. In DME wipe snapshot 
operations, use the [DME] button instead of the [WIPE] button used in wipe 
snapshot operations. 

Selecting a DME wipe pattern in the Flexi Pad control block
In the standard type Flexi Pad control block, enter a four-digit pattern number, 
using the [DME] button.

For details, see “Flexi Pad Control Block (Standard Type)” (page 51).

Note
You cannot select a DME wipe pattern in the simple type Flexi Pad control 
block.
• A button in the memory recall section in which a DME wipe snapshot is 

saved shows the pattern, and lights yellow.
For a user-programmable DME, the register number (see page 326) appears.
Depending on the setting of the Setup menu (see “Operation Settings 
(Operation Menu)” in Chapter 19 (Volume 3)), you can also display a 
register name.

• In a simple type Flexi Pad control block, it is not possible to delete a DME 
wipe snapshot.

For details of the operating procedures, see “Wipe Snapshots” (page 284).
DME Wipe Snapshots
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DME Snapshot Operations With the Menus

In the same way as for wipe snapshots, you can save, recall, and delete DME 
snapshots.

For details of the operating procedures, see “Wipe Snapshot Operations With 
the Menus” (page 287).
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Creating User Programmable DME Patterns

With a user programmable DME, you can use DME effects created through the 
use of keyframes for a transition on the switcher system.
Note the following points when creating a keyframe effect for use as a user 
programmable DME pattern.

Register numbers and pattern numbers
When saving a keyframe effect as a user programmable DME pattern, specify 
the register number that corresponds to the pattern number as shown in the 
following table.

For details of registers and keyframe effects, see Chapter 13 “Keyframe 
Effects” (Volume 2), respectively.

Keyframe effects in the global channel
When the effect with the same number as the reference channel is present on 
the DME global (GLBL) channel, executing the user programmable DME will 
also execute the effect on the global channel simultaneously.
When executing a user programmable DME, take note of whether the effect is 
present on the global channel.

User Programmable DME Transition Mode

To create a user programmable DME, it is necessary to set the transition mode 
(the way in which the effect moves). To set the transition mode, use the Key 
Frame >DME User PGM menu.

For details of the operating procedures, see “Transition Mode Settings for 
User Programmable DME” in Chapter 13 (Volume 2).

Execution mode Register number Pattern number

One-channel mode 101 to 199 1901 to 1999

Two-channel mode 201 to 299 2901 to 2999
Creating User Programmable DME Patterns
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The following transition modes are available.

a) Transition according to DME wipe patterns 1202, 1203, or 1204
b) Transition according to DME wipe pattern 1201
c) Transition according to DME wipe pattern 1251

For details, see “Overview” (page 298).

Note
For the following group of effects available in two-channel mode, no user 
programmable DME wipe patterns can be created.

Frame in-out, Brick

Notes on creating keyframe effects
When creating a keyframe effect to be used as a user programmable DME 
pattern, note the following, depending on the transition mode used.

Notes on single transition mode (one-channel mode)
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• Create the last keyframe to be a full-size image.
• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 

select [Single].

Notes on flip tumble (one-channel mode)
• Create the first keyframe image at full size. In the <Back> group of the DME 

>Input/Output >Video/Key menu, depending on the direction of the rotation 
you want during the transition, press [H Invert] or [V Invert], turning it on.

• Create the last keyframe with the image inverted so the back side is visible, 
and with the size at full size.

Channels Transition mode Effect group

One-channel mode Single transition mode Slide, Squeeze, Door, Flip 
tumble, Frame in-out, 2D 
trans, 3D trans

Flip Tumble Flip Tumble, Mosaic, Defocus

Frame in-out Frame in-out

Frame in-out H a) Frame in-out

Frame in-out V Frame in-out

Picture-in-picture b) Picture-in-picture

Compress c) Picture-in-picture

Two-channel mode Dual transition mode Slide, Squeeze, 3D Trans

Two-channel picture-in-picture Picture-in-picture
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• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [Flip Tumble].

Notes on frame in-out (one-channel mode)
Create a minimum of three keyframes.
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• Create the first transition to end such that the image can be seen within the 

screen. At this point, press the [PAUSE] button in the keyframe control 
block, turning it on, to set a pause for the keyframe.

• Either create the last keyframe image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [FRAME I/O].

Notes on Frame in-out H (one-channel mode)
Create a minimum of three keyframe points.
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• As the state after completion of the first transition, move the image 

horizontally to make it visible within the screen. At this time, press the 
[PAUSE] button in the keyframe control block, turning it on, to set a pause 
for the keyframe.

• For the last keyframe move the image horizontally to place it outside the 
screen area or set the image size to zero, so that the image is not visible 
within the screen.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [FRAME I/O H].

Notes on frame in-out V (one-channel mode)
Create a minimum of three keyframe points.
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
• As the state after completion of the first transition, move the image vertically 

to make it visible within the screen. At this time, press the [PAUSE] button 
in the keyframe control block, turning it on, to set a pause for the keyframe.

• For the last keyframe move the image vertically to place it outside the screen 
area or set the image size to zero, so that the image is not visible within the 
screen.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [FRAME I/O V].

Notes on picture-in-picture (one-channel mode)
Create a minimum of three keyframes.
• Either create the first keyframe image outside the screen area, or set the 

image size to zero so that it cannot be seen within the screen.
Creating User Programmable DME Patterns
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• Create the first transition to end such that the image can be seen within the 

screen. At this point, press the [PAUSE] button in the keyframe control 
block, turning it on, to set a pause for the keyframe.

• Either create the last keyframe image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [P In P].

Notes on compress (one-channel mode)
Create a minimum of three keyframe points.
• Create the first keyframe with the image at full size.
• In the state at completion of the first transition, create the image to be visible 

within the screen. At this time, press the [PAUSE] button in the keyframe 
control block, turning it on, to set a pause for the keyframe.

• For the last keyframe, once again set the image size to full size.
• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 

select [Compress].

Notes on dual transition mode (two-channel mode)
• Create the first keyframe for each channel as follows.

Channel 1: create the image full-size.
Channel 2: either create the image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.

• Create the last keyframe for each channel as follows.
Channel 1: either create the image outside the screen area, or set the image 
size to zero so that it cannot be seen within the screen.
Channel 2: create the image full-size.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [Dual].

Notes on picture-in-picture (two-channel mode)
Create a minimum of three keyframes.
• Create the first keyframe for each channel as follows.

Channel 1: create the image full-size.
Channel 2: since the priority is low, it will not be visible on the screen, so 
no particular restrictions apply.
In the Global Effect >Ch1 to Ch2 >Combiner menu, when setting the priority 
of channel 1 and channel 2, set the channel 1 priority higher.

• In the intermediate part of the transition, create the two images so that both 
are visible within the screen. In the Global Effect >Ch1 to Ch2 >Combiner 
menu, when setting the priority of channel 1 and channel 2, set the channel 2 
priority higher.

It is recommended to make the priority settings at a keyframe point at which 
the two images are not overlapping.
329Creating User Programmable DME Patterns



330

   C
hapter 6 

D
M

E
 W

ipes
• During the course of a transition, there is a “dead zone” corresponding to the 
intermediate point of the whole effect (see following figure), during which 
the image does not change. Therefore, it is necessary to create the effect so 
that the image in the intermediate part of the transition is the keyframe for 
the mid-point of the whole effect. The range of this “dead zone” corresponds 
to the central one-third of the range of the transition indicator. This also 
applies to an auto transition. 

• Create the last keyframe for each channel as follows.
Channel 1: since the priority is low, it will not be visible on the screen, so 
no particular restrictions apply.
Channel 2: create the image full-size.

• In the <Transition Mode> group of the Key Frame >DME User PGM menu, 
select [P In P].

A B C

Keyframe effect

First keyframe Last keyframe 

Mid-point of effect

Change in image through transition

Image at point C 
appears

Image at point B 
appears 
(dead zone)

Image at point A 
appears

Transition indicator
Fader lever
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DME Wipe Pattern Operations in the 
Multifunction Flexi Pad Control Block

Recalling a DME Wipe Snapshot

The operation of recalling a DME wipe snapshot in the Multifunction Flexi Pad 
control block is the same as the operation of recalling a wipe snapshot, except 
for pressing the [DME WIPE] button to select DME wipe snapshot mode.

See “Recalling a Wipe Snapshot” (page 290).

You can change the indications for buttons [0] to [9] in the memory recall 
section to pattern images, using the Engineering Setup >Panel >Operation 
>Flexi Pad Mode menu.

Selecting the DME Wipe Pattern

The operation of selecting the DME wipe pattern in the Multifunction Flexi 
Pad control block is the same as the operation of selecting a wipe pattern, 
except for pressing the [DME WIPE] button to select DME wipe snapshot 
mode.

See “Selecting the wipe pattern” (page 291).

Note, however, that the pattern numbers for DME wipe patterns have four 
digits.
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For pattern numbers, see “DME Wipe Pattern List” (page 445).

Editing the DME Wipe Pattern

By pressing the [EDIT ENBL] button to switch the memory recall section to 
editing mode as shown in the following illustration, you can edit the selected 
DME wipe pattern with the following buttons.
To exit from the editing mode, press the [EDIT ENBL] button once more, or 
press the [EXIT] button.

Note that the operation of the following buttons is the same as when editing a 
wipe pattern.

• [EXIT] button
• [PTN LIMT], [LIMT SET] buttons
• [NORM], [NORM/REV], [REV] buttons
• [KNOB 1/2] button

For the method of operation of these buttons, see “Editing the Wipe Pattern” 
(page 291).

Channel selection buttons
1ST CH (channel 1): Selects channel 1.
2ND CH (channel 2): Selects channel 2.
You can also select two channels by pressing the buttons simultaneously.

DME wipe pattern edge setting buttons
BDR (border): Applies a border to the DME wipe pattern.
SOFT BDR (soft border): Softens the applied border.
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You can adjust the parameters selected with these buttons using the control 
knobs, when the button is lit green.

• When border is selected

• When soft border is selected

Buttons for positioning the DME wipe pattern
POS (position): Adjusts the position of the DME wipe pattern.
CNTR (center): Returns the DME wipe pattern position to the center.

When you press the [POS] button, the alphanumeric display first shows the 
name of the parameter, “H” or “V,” and then the value of the parameter.
When the [POS] button is lit green, you can adjust the position of the pattern 
with the control knobs.

Knob Parameter Adjustment Setting values

1 W Border width 0 to 100

2 L Luminance 0 to 100

3 S Saturation 0 to 100

4 H Hue 0 to 359

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 W Border width 0 to 100

2 I Degree of softening of 
inside of border

0 to 100

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 L Luminance 0 to 100

2 S Saturation 0 to 100

3 H Hue 0 to 359

Knob Parameter Adjustment Setting values

1 H Horizontal position –200 to +200

2 V Vertical position –200 to +200

3 H (R) Relative horizontal 
movement

–400 to +400

4 V (R) Relative vertical movement –400 to +400
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Buttons for setting DME wipe pattern cropping
CROP: Adjusts the DME wipe pattern cropping.
4:3 CROP: Crops a 16:9 image to 4:3.

When the [CROP] button is lit green, you can set the cropping ratio of the DME 
wipe pattern, with the control knobs.

Button for specifying effect size
SIZE: Specifies the effect size. When the [SIZE] button is lit green, you can 

specify the effect size, with the control knobs.

a) The effect size when [Size] is off is taken as 100.00.

DME wipe modify clear
With the [DME WIPE] button held down, pressing and holding down the 
region selection button for the selected region returns the DME wipe settings 
to their initial status.

For details of the initial status, see “Selecting the State After Powering On 
(Start Up Menu)” in Chapter 18 (Volume 3).

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Cropping ratio of the image 
from left and right sides

–100 to +100

2 V Cropping ratio of the image 
from top and bottom sides

–100 to +100

3 A Cropping ratio of the image 
from all four sides

–100 to +100

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 T Cropping ratio of the image 
from the top

–100 to +100

2 L Cropping ratio of the image 
from the left

–100 to +100

3 R Cropping ratio of the image 
from the right

–100 to +100

4 B Cropping ratio of the image 
from the bottom

–100 to +100

Knob Parameter Adjustment Setting values

1 S Effect sizes 0 to 200 a)
DME Wipe Pattern Operations in the Multifunction Flexi Pad Control Block
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Saving, Canceling, and Deleting DME Wipe Snapshots

The operations of saving, canceling, and deleting a DME wipe pattern snapshot 
you have created are the same as the operations of saving, canceling, and 
deleting a wipe snapshot.

For the operations for wipe snapshots, see “Saving, Canceling, and Deleting 
Edited Wipe Patterns” (page 294).
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Overview

Frame memory is a function whereby a frame of input video can be frozen and 
written to memory, for further use as material for editing. 
You can also play recorded frame memory clips (movies).

Frame capacity
The maximum number of images that can be written to memory is as follows.
(Without ancillary data)

(With ancillary data)

SD system: 
(Without ancillary data)

(With ancillary data)

For details of operating procedures, see “Still Image Operations” (page 341).

Types of image and terminology used
The following types of image are handled in frame memory.

Video format Memory capacity

1080i/50 Approx. 1000 frames

1080i/59.94

720P/50 Approx. 2300 frames

720P/59.94

Video format Memory capacity

1080i/50 Approx. 700 frames

1080i/59.94 Approx. 800 frames

720P/50 Approx. 1400 frames

720P/59.94 Approx. 1700 frames

Video format Memory capacity

480i/59.94 Approx. 5600 frames

576i/50 Approx. 4800 frames

Video format Memory capacity

480i/59.94 Approx. 4700 frames

576i/50 Approx. 3900 frames
Overview
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Freeze image: An input image that has been frozen, but not saved to memory.
Still image: A freeze frame that has been saved to memory as a file. Each file 

(still file) holds just one still image.
Frame memory clip: A clip consists of a sequence of still images, which 

appears as a movie on playback. In this manual this is also referred to 
simply as a “clip.” The files (still files) constituting clips are referred to as 
a “clip file.”

When the above distinctions are not being made, an image is simply referred 
to as an “image.”

Use of frame memory
There are eight frame memory channels, FM1 to FM8, and each channel 
independently allows a freeze image to be saved or recalled.
By allocating FM1 to FM8 to cross-point buttons you can use the still image 
output or clip output from each channel as input material.

Correspondence between input and output
There are two buses for capturing frame memory material: the frame memory 
source 1 bus and the frame memory source 2 bus.
These input buses are used by allocation to one of the pairs of output, FM1&2, 
FM3&4, FM5&6, and FM7&8. You can freeze a frame in each channel 
separately, or freeze in the two channels simultaneously.
The source buses allocated to FM1 to FM8 are as follows.

Pair mode
By enabling the pair mode, you can link FM1 and FM2, FM3 and FM4, FM5 
and FM6, and FM7 and FM8. For example, when a freeze or image processing 
is carried out on FM1, the same operation is carried out on FM2. The same 
applies to the other pairs. When a pair of images are captured in pair mode, the 
image frozen in FM1 (3, 5, or 7) is referred to as the main file and the other 
frozen in FM2 (4, 6, or 8) is referred to as the sub file. 

Input Frame memory source bus 1 Frame memory source bus 2

Output FM1 FM2

FM3 FM4

FM5 FM6

FM7 FM8
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Pair files and single files
A file that can be recalled in pair mode is termed a “pair file.” A pair file can 
be created by setting pair mode and capturing an image, or by using the 
coupling function (see page 381) to combine two single files.
A file other than a pair file is termed a “single file.” A single file can be created 
by switching off pair mode and capturing an image, or by using the separation 
function (see page 382) to split a pair file.

Operation modes
The frame memory has the following operation mode. 
V/K mode: When the pair mode is active, the key signal is automatically 

selected on frame memory source bus 2. This is convenient for handling 
the video and key signals together in frame memory. For example, when 
you select a video signal on frame memory source bus 1, the key signal 
assigned to it is automatically selected on frame memory source bus 2. You 
can also use the signal automatically selected on frame memory source bus 
2 as a key signal when processing keyframe memory 1.

To change the pair mode or operation mode, use the Frame Memory menu.

Frame memory folders
Still images and clips can be managed in a maximum of twelve groups.
Such a group is called a “frame memory folder.” Folders can be added or 
deleted, and can be given a name of up to 8 characters.

Notes
• When the system is powered off, the folder names are deleted. The folder 

names need to be saved on media.
• The following names cannot be used for folders. 

Flash1, Flash2
CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2, COM3, 
COM4, COM5, COM6, COM7, COM8, COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, LPT9

A folder named “Default” is provided, and this folder cannot be renamed or 
deleted.

• Still images and clips in different frame memory folders cannot have the 
same name.
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Still Image Operations

The frame memory functions provides the following still image file functions.
• Freezing an input image
• Saving a still image
• Recalling a still image
• Processing an image
• Image output
• Continuously capturing images (record)
• Recalling a continuous sequence of images (animation)

For an overview of frame memory concepts, see “Overview” (page 338).

Note
During playback of a frame memory clip of the pair assigned to either of the 
target FM selection buttons (see page 368), frame memory operations may not 
be performed properly. Carry out frame memory operations after stopping clip 
playback.

Preparations

Allocating the frame memory outputs (FM1 to FM8) to cross-
point buttons

To output a frame memory image to a monitor, for example, the output signal 
from the frame memory (FM1 to FM8) must be allocated to a cross-point 
button. Carry out this allocation in the Setup menu.

Accessing the Frame Memory menu
Most frame memory operations are carried out using the Frame Memory menu.
To access the Frame Memory menu, use either of the following procedures.
• In the menu control block, select the top menu selection button [FRAME 

MEM].
• Press the cross-point button to which the frame memory output is allocated 

twice in rapid succession.
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Interpreting the Frame Memory Menu

The menu screen consists of the following principal parts.
The frame memory selection area display is the same for all except the Pattern 
Adjust/Pattern Select/File (excluding Pair Recombination menu)/Folder/
External HDD menus.

Frame Memory menu

a Auto store status display
Depending on the setup settings, this appears when the auto store function is 
enabled.

2 Display of available image capacity

4 Pair selection button

6 File selection area

3Target FM 
selection buttons

5 Pair button

1 Auto store status display

Frame memory 
selection area

7Frame 
memory 
folder 
selection 
area

8Direct 
Recall 
button
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b Display of available image capacity
This shows the remaining number of frames. When no more frames can be 
stored, in pair mode “1” or “0” appears in red, and in single mode “0” appears 
in red.

c Target FM selection buttons

Press one of these to select which of the selected outputs (FM1 and FM2 in the 
example shown) the operation applies to.
The following information appears on the button.

Status display
File name (e.g. image001) and thumbnail: when a file is output
Black: when a black signal is output
Through: when the input image is output
Freeze: when a freeze is output
Composite: when a composite image is processed
Record: when continuously capturing images (record)

Still/duration display
When a still image is selected, “Still” is shown. When a clip is selected, a 
duration indication such as “00:00:10” is shown.

Reposition/Lock status display
This shows “R” when the reposition function (see page 358) is on, and shows 
“L” when the lock function (see page 359) is on.

Status display

Still/duration display Reposition/Lock status display

The border color shows the status as follows:
Blue: selected as the reference channel
Amber: selected, but not the reference channel
Black: not selected

Ancillary data-attached clip display
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Ancillary data-attached clip display
For an ancillary data attached clip, an “A” appears.

d Pair selection button
Select the pair to be displayed in the target FM selection buttons.
(in the following figure, the pair of FM1 and FM2 is selected.)

The following information appears on the button.

Status display
For a pair, shows the status for the reference.
Thumbnail: when a file is output
Black: when a black signal is output
Through: when the input image is output
Freeze: when a freeze is output
Compos: when a composite image is processed
Record: when continuously capturing images (record) 

e Pair button
Press this button, turning it on, to enable pair mode.

f File selection area 
You can select from the displayed still image files or clip files.

The border color shows the status as follows:
Blue: selected as the reference channel
Amber: selected, but not the reference channel
Black: not selected

Status display
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Thumbnail indications
Still image files and clip files: Still image files are displayed as gray buttons 

and clip files are displayed as yellow buttons.
Single files and pair files: Single files are displayed with shadow and pair files 

are displayed with no shadow.
Selected file: Pale blue border. When more than one file is selected, only the 

first is pale blue, and the remainders are amber. If the pair file was selected, 
each press switches the front and the back.

File information detail display
For the selected file, this shows the file name, “P” if a pair file, “A” if an 
ancillary data attached clip, and the duration.

g Frame memory folder selection area
Select the frame memory folder to be displayed.

h Direct Recall button
Toggle on and off the direct recall mode in which pressing a thumbnail 
immediately recalls the file.

Selecting an Input Image

For the input image to frame memory, you can use either the signal selected on 
one of the two frame memory source buses or a dedicated color matte signal.

Selected file.
When a pair file is selected each press switches the front and the back.

File information detail display
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When using the signal on frame memory source bus 1 or 2 for the input image, 
select the signal as described below.

For the method of using a color matte signal, see “Freezing an image and 
writing it to memory” (page 347).

Selecting the signal on a frame memory source bus
As an example, to select a signal on frame memory source bus 1, use the 
following procedure.

1 In the auxiliary bus control block, press the AUX delegation button to 
which frame memory source bus 1 is allocated, turning it on.

 For allocation of buses to the AUX delegation buttons, see “Assigning a 
Bus to an AUX Delegation Button” in Chapter 19 (Volume 3).

On a CCP-6224/6324 control panel, you switch the cross-point control 
block for use as an AUX bus control block. For details of the switching, 
refer to the Setup menu (“Auxiliary Bus Control Block Settings (Aux 
Assign Menu)” in Chapter 19 (Volume 3)).

2 In the auxiliary bus control block cross-point buttons, select the signal to 
be used for the input image.

Selecting Outputs and Target Frame Memory

Selecting outputs (FM) and target frame memory
The following description applies to the case of settings for FM1&2, but the 
procedures are similar for the other cases.

1 In the Frame Memory menu, press one of VF1 to VF4, and select the 
required HF menu.

The current status of frame memory appears. (See page 342).

2 From the pair selection buttons, press the buttons corresponding to FM1 
and FM2.

This assigns the signals to FM1 and FM2.
To the right of the target FM selection buttons, the FM1 and FM2 output 
status appears (see page 343).

3 If required, press [Pair], to select the FM operation mode (pair mode).
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On: Operate on FM1(3, 5, 7) and FM2(4, 6, 8) as a pair.
Off: Operate on FM1(3, 5, 7) and FM2(4, 6, 8) individually.

For more details, see “Pair mode” (page 339).

Note
In the Pair Recombination menu, the [Pair] operation is not possible.

4 Press the target FM selection button [FM1] or [FM2] (see page 343) to 
select the FM operations apply to.

When [Pair] is On: Whichever of FM1 and FM2 you press, the pair is 
selected.

When [Pair] is Off: One of the targets must be selected. However, in the 
Clip >Play menu you can also select both FM1 and FM2.

Selecting a frame memory folder
Press a button in the frame memory folder selection area (see page 345).
By pressing [More] to switch the display, you can select from a maximum of 
12 folders.
Thumbnails of the files within the selected folder appear.

Capturing and Saving an Input Image

As the input material for the frame memory, you can use the signal selected on 
the frame memory source bus. For this signal you can use video processing 
(video levels or hue value adjustment) or masking.

Allocating a frame memory source bus signal to one of FM1 to FM8, then 
carrying out a freeze captures a still image in the corresponding frame memory 
output image, and saves it in temporary memory.
For a freeze, an image can be captured either as video frame (a “frame freeze”) 
or a video field (“field freeze”).

Note
When the system is powered off, any freeze images written to temporary 
memory are lost.

Freezing an image and writing it to memory
To freeze the signal selected as input material, and write it to memory, use the 
following procedure.
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1 In the Frame Memory menu, select VF1 ‘Still’ and HF2 ‘Freeze/Store.’

The Freeze/Store menu appears.

2 Select the target frame memory.

For the procedure, see “Selecting outputs (FM) and target frame 
memory” (page 346).

3 To enable V/K mode, press [V/K Mode] turning it on.

4 Press a button in the frame memory folder selection area, to select the 
folder to hold the freeze image.

For details of the selection method, see page 347.

Note
The folder selected here is the destination folder for writing the freeze 
image.
It is not possible to change the selection of this folder after the following 
step 5.

An orange bar appears on the selection button for the destination folder.

5 Press [Freeze Enable], turning it on.

The signals of frame memory source buses 1 and 2 are assigned to the pair 
of FMs selected in step 2, a freeze is now possible.

6 If necessary, make the video process settings (see page 350) or mask 
settings (see page 350) for application to the selected signal.

7 In the state in which you want to freeze, press one of the following in the 
<Freeze> group, to write the freeze image to temporary memory.

Frame: Freeze one frame.
Field: Freeze one field.
Off: Release the freeze, and delete the recorded freeze image.

After carrying out the freeze, to return to the state immediately before the 
freeze, press [Undo] in the <Freeze> group.

Notes
• All freeze images written to temporary memory are lost when the system 

is powered off.
• If you change the frame memory to use as in step 2 before saving the 

freeze images written to temporary memory, all the freeze images in 
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temporary memory are lost, unless the auto store function has been 
enabled in setup. With the auto store function enabled, the freeze images 
written to temporary memory are saved automatically when the frame 
memory selection is changed.

• For the following signal formats, a field freeze is not possible.
720P/50, 720P/59.94

Saving a freeze image (Store)
You can save an image in temporary memory which has been placed with the 
freeze function as a file in memory. You can save a single image in a single file 
and apply a name of up to eight characters to the file.

Note
When the system is powered off, all the files saved in memory are erased.

To save a captured still image in a file, use the following procedure in the Still 
>Freeze/Store menu.

1 Press [Store].

The keyboard window (see page 123) appears.

2 In the keyboard window, enter the file name (maximum 8 characters).

Note
The following names cannot be used:

CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2,
COM3, COM4, COM5, COM6, COM7, COM8, COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8,
LPT9

3 In the keyboard window, press the [Enter] button.

This saves the still image file in memory.

The destination folder is the folder selected in step 4 of “Freezing an image 
and writing it to memory.”
If the entered folder name already exists, a message to confirm overwriting 
appears.

When the system is powered off, the file saved in memory is erased.

To carry out a freeze and store simultaneously (Freeze and Store)
Press [Freeze & Store], turning it on.
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In this state, if you press [Frame] or [Field], this carries out a freeze, and 
simultaneously stores in a still image file.

Setting video processing
To set video processing for the signal selected on a frame memory source bus, 
use the following procedure in the Still >Freeze/Store menu.

1 In the <Video Process> group, press [Video Process], turning it on.

2 Use the knobs to adjust the following parameters.

To return the settings to the default values, press [Unity] in the <Video 
Process> group.

Note
When a pair setting is active, it is coupled to the video process on/off 
setting, but the above parameter settings are only valid for frame memory 
source bus 1. The pair setting cannot be used to set the frame memory 
source bus 2. If you want to set video process for frame memory source bus 
1 only with the pair setting when old settings for frame memory source bus 
2 remain, return the frame memory source bus 2 settings to their default 
values. When setting video process for the frame memory source bus 2, 
disable the pair setting.

Setting a mask
Masks can be set separately for frame memory source buses 1 and 2. To apply 
a mask to the signal selected on frame memory source bus 1, for example, use 
the following procedure in the Still >Freeze/Store menu.

1 Press [Box Mask] turning it on.

2 Use the knobs to adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Video Gain Overall gain of the video signal –200.00 to +200.00

2 Y Gain Y signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Y signal black level –7.31 to +109.59

Knob Parameter Adjustment Setting values

1 Top Top position –100.00 to +100.00
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3 To link the masks on frame memory source buses 1 and 2, press [Mask 
Link], turning it on.

Recalling Still Images

You can recall an image file saved in memory, and allocate to any of the FM1 
to FM8 outputs.

Recalling a still image
To recall a still image file saved in memory using the thumbnails, and assign it 
to an FM output, use the following procedure.

1 In the Frame Memory menu, select VF1 ‘Still’ and HF1 ‘Recall.’

The Recall menu appears.
• When [Pair] is on, only pair files (pairs of main file and sub file) are 

displayed.

• When [Pair] is off, both single files and pair files appear.

2 Left Left position –100.00 to +100.00

3 Right Right position –100.00 to +100.00

4 Bottom Bottom position –100.00 to +100.00

Knob Parameter Adjustment Setting values

Main file

Sub file
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2 In the frame memory selection area, select the FM to be assigned. (See 
page 346.)

3 If [Direct Recall] is on, press and turn it off.

4 Select the desired folder in the folder selection area.
By pressing [More] to switch the display, you can select from a maximum 
of 12 folders.

Thumbnails of the files within the selected folder appear.

5 Using the arrow keys or turning the knob, scroll the file thumbnail display.

6 Press the thumbnail of the clip you want to recall.

7 Press [Recall].

This recalls the still image file, which is assigned to the FM you selected 
in step 2.

To recall in direct recall mode
Direct recall means that pressing a thumbnail immediately recalls the file.
In this mode, only the front thumbnail file is recalled.

1 In step 7 above, instead of pressing [Recall], press [Direct Recall].

2 Press the thumbnail for the file you want to recall.

This immediately recalls the file.

Knob Parameter Adjustment Setting values

1 Scroll Thumbnail display 
scrolling

1 and upwards

Single file
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To display the subsidiary file in front
With the direct recall mode on, press [Sub Display], turning it on.

Image Processing

You can combine the background image (a still image file allocated to any of 
FM1 to FM8, a freeze image written to temporary memory, or a black signal) 
and the input signal.
The following types of processing are available.
Pattern key: Using the signal from a dedicated pattern generator, you can cut 

out the background image and insert the signal selected on the frame 
memory source bus or a color matte signal. You can adjust the size and 
position of the pattern, and add modifiers.

External key: When processing an image in FM1 (3, 5, 7), you can use the 
signal selected on the frame memory source bus 2 to cut out the 
background image, and fill with the signal selected on the frame memory 
source bus 1, or a color matte signal.
When processing an image in FM2 (4, 6, 8), you can use the signal selected 
on the frame memory source bus 2 to cut out the background image, and 
fill with a color matte signal (always white).

Note
An external key can only be used when the pair mode is enabled (see page 
339).

MIX: Mix the background image with the signal selected on the frame memory 
source bus or color matte signal. The mix ratio can be set.

NAM: Non-additive mix the background image with the signal selected on the 
frame memory source bus or color matte signal.

Combining the background image and input signal

1 In the Frame Memory menu, select VF1 ‘Still’ and HF3 ‘Composite.’

The Composite menu appears.

2 In the frame memory selection area, select the FM to be assigned. (See 
page 346.)

3 To select V/K mode, press [V/K Mode], turning it on.
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4 Press a button in the frame memory folder selection area, to select the 
folder to hold the freeze image.

For details of the selection method, see page 347.

Note
The folder selected here is the destination folder for writing the freeze 
image.
It is not possible to change the selection of this folder after the following 
step 5.

An orange bar appears on the selection button for the destination folder.

5 Press [Edit Enable], turning it on.

The signals of frame memory source buses 1 and 2 are assigned to the pair 
of FMs selected in step 2, and the combining of the background signal (the 
signal providing the background for combination) and the input signal (the 
signal providing the foreground for combination) is now possible.

Note
The input signal is lowered by one line, but when you apply a freeze, the 
freeze image is returned to the correct position.

6 To use a color matte signal for the input signal, press [Frgd Color], turning 
it on.
Even when pair mode is enabled, you can make separate settings for each 
FM.

7 Turn the knobs to adjust the following parameters.

8 If you turned [Frgd Color] off in step 6, if required press [Input Adjust] to 
display the Input Adjust menu, and make the video process (see page 350) 
and mask (see page 350) settings for the input signal.

9 To set the background signal to black, press [Bkgd Black], turning it on.

Notes
• When the background signal is originally black, [Bkgd Black] remains 

on. 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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• When the background signal is a freeze image (an image frozen, but not 

saved), turning [Bkgd Black] on erases the unsaved freeze image and, as 
a result, [Bkgd Black] remains on. 

10In the <Type> group, set the type of combination (see page 356).

11In the state in which you want to freeze, press one of the following in the 
<Freeze> group, to write the freeze image to temporary memory.

Frame: Freeze one frame.
Field: Freeze one field.
Off: Release the freeze, and delete the recorded freeze image.

After carrying out the freeze, to return to the state immediately before the 
freeze, press [Undo] in the <Freeze> group.

Notes
• All freeze images written to temporary memory are lost when the system 

is powered off.
• If you change the frame memory to use as in step 2 before saving the 

freeze images written to temporary memory, all the freeze images in 
temporary memory are lost, unless the auto store function has been 
enabled in setup. With the auto store function enabled, the freeze images 
written to temporary memory are saved automatically when the frame 
memory selection is changed.

• For the following signal formats, a field freeze is not possible.
720P/50, 720P/59.94

Saving a processed freeze image
To save a processed freeze image as a file, in the Still >Composite menu use 
the following procedure.

1 Press [Store].

The keyboard window appears.

2 In the keyboard window, enter the file name (maximum eight characters).

3 In the keyboard window press [Enter].

This saves the freeze image as a still image file in memory.
The destination folder is the folder selected in step 4 of “Combining the 
background image and input signal” (page 353).
If the entered folder name already exists, a message to confirm overwriting 
appears.
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Selecting the way in which images are combined
To select the way in which the background image and input signal are 
combined (see page 353), use the following procedure.

1 In the <Type> group of the Still >Composite menu, select one of the 
following methods of combination.

• Pattern Key: pattern key
• Ext Key: external key

(This can only be selected when the pair mode is enabled. The signal 
selected on the frame memory source 2 bus is used as the key signal.)

• Mix: mix
• Nam: non-additive mix
If none of the above is selected, image combination is not carried out.

2 Depending on the selection in step 1, set the following parameters.

• When [Pattern Key] is selected

a) The patterns are the same as for a wipe. See “Wipe Pattern List” in Appendix (Volume 1) 
(page 444).

• When [Ext Key] is selected

• When [Mix] is selected

3 When you selected a pattern key, press [Pattern Adjust].

The Pattern Adjust menu appears. In the menu, set the pattern modifiers as 
required.

• When turning [Position] on and setting the pattern position

Knob Parameter Adjustment Setting values

1 Size Size of pattern 0.00 to 100.00

2 Soft Edge softness of pattern 0.00 to 100.00

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Clip Reference level for key 
signal generation

+109.59 to –7.31

2 Gain Key sensitivity –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Mix Rate Mix proportion 0.00 to 100.00
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a) See page 273.

• When turning [Multi] on and replicating the pattern

a) See page 277.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 276.

• When turning [Rotation Angle] on and inclining the pattern

a) See page 274.

To select the pattern, display the Pattern Select menu by pressing [Pattern 
Select] in the Pattern Adjust menu. You can change the pattern selected in 
step 2 here. After selecting one of the patterns (wipe patterns 1 to 24) 
displayed in the Pattern Select menu, you can adjust the following 
parameters.

4 When you selected a pattern key or external key, if required press [Key 
Invert] in the Still >Composite menu to invert the key.

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –100.00 to +100.00 a)

2 Position V Vertical position –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of 
pattern horizontally

1 to 63

2 V Multi Number of repetitions of 
pattern vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00
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Image Output

There are two functions related to image output: the reposition function for 
moving the output image, and the lock function for fixing the output image.

Moving the output image (reposition function)
For up to two channels of FM1 to FM8 (one from FM1, FM3, FM5 and FM7 
and the other from FM2, FM4, FM6 and FM8), you can move the output image 
with respect to the screen. The area of the screen around the image that has 
been moved is filled with black. There are two ways of carrying out this 
repositioning.
Normal mode: Movement in the horizontal direction is in two-pixel 

increments.
Black and white mode: Movement in the horizontal direction is in one-pixel 

increments, and for each pixel moved the color is inverted.

Note
It is not possible to save an image moved with the reposition function directly 
to frame memory.

1 In the Frame Memory menu, select VF3 ‘Reposition/Lock’ and HF1 
‘Reposition.’

The Reposition menu appears. In this menu, you can also enable the V/K 
mode (see page 348).

2 In the frame memory selection area, select the FM output (see page 346).

3 In the <Reposition> group, select the movement mode.

Normal: Move in normal mode.
Black&White: Move in black & white mode.

4 With the knobs, adjust the parameters to move the image.

a) See page 273.

The surroundings of the moved image on the screen are filled with black.

Knob Parameter Adjustment Setting values

1 Position H Move in horizontal direction –200.00 to +200.00 a)

2 Position V Move in vertical direction –200.00 to +200.00 a)
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5 To return the image moved by the reposition function to the center 

position, in the <Reposition> group press [Center].

Fixing the output image selection (lock function)
For the output of each of FM1 to FM8, this fixes the image at the current 
output. When this lock is enabled, even if the output is recalled in a snapshot 
or keyframe, the images output to FM1 to FM8 are preserved.

1 In the Frame Memory menu, select VF3 ‘Reposition/Lock’ and HF2 
‘Lock.’

The Lock menu appears.

2 In the frame memory selection area, select the FM output. (See page 346.)

3 Press [Lock], turning it on.

This fixes the currently selected frame memory output image.
To release the lock, set [Lock] to off.

Continuously Capturing Still Images (Record)

You can continuously capture (freeze) a sequence of input video frames and 
store the sequence of the still images over a specified time interval.
The name of each image recorded in this way consists of a first character string 
followed by a second string.
First character string: A common part of name assigned to all the still images 

captured in one record operation. This string includes a maximum of four 
characters, which can be specified using a menu before carrying out the 
capture. The first string is automatically used as the clip name when the 
images are treated as a frame memory clip. 

Second character string: A four-digit number (0000 or greater), which is 
incremented each time a still image is captured.

Note 
When using the record function to continuously capture frames, it is not 
possible to use the mask function.

Continuously freezing input images and writing to memory

1 In the Frame Memory menu, select VF1 ‘Still’ and HF4 ‘Animation 
Record.’
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The Animation Record menu appears.

2 Select the desired frame memory.

For details of the operating procedures, see “Selecting outputs (FM) and 
target frame memory” (page 346).

3 To use V/K mode, press [V/K Mode], turning it on.

4 Press a button in the frame memory folder selection area, to select the 
folder to hold the freeze image.

For details of the selection method, see page 347.

Note
The folder selected here is the destination folder for writing the freeze 
image.
It is not possible to change the selection of this folder after the following 
step 5.

An orange bar appears on the selection button for the destination folder.

5 Press [Record Enable], turning it on.

The signals of frame memory source buses 1 and 2 are assigned to the pair 
of FMs selected in step 2, the recording function is now possible.

6 Input the file name if required.

Pressing [File Name] displays the keyboard window and you can enter the 
first character string (up to four characters) of the file name.

7 Set the recording time if required.

Pressing [Duration] displays the numeric keypad window, in which you 
can enter the recording time in the form of timecode.
If you set the recording time to zero, this uses all frame memory in which 
storing is possible for recording.

8 If required, set video processing for the selected signal.

For details of the operating procedures, see “Setting video processing” 
(page 350).

9 Press [Record], to start recording.

When the recording time is set, recording stops once the time has elapsed.
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10Press [Stop] to stop recording.

Even if the recording time is set, you can still stop recording before the set 
time has elapsed.

Recalling a Continuous Sequence of Still Images 
(Animation)

You can use a continuous sequence of images captured with the record function 
as keyframes to create an effect. By executing this effect you can recall the 
continuous sequence (animation).

Notes 
• For example, to create an effect using FM1, FM1 must be assigned to a user 

region. 
• To execute the effect, you must assign the user region to which FM1 is 

assigned to a region selection button in the numeric keypad control block and 
the Multifunction Flexi Pad control block. (For details of assigning to region 
selection buttons, see Chapter 19 “Control Panel Setup (Panel)” (Volume 
3).)

In the Frame Memory menu, effect creation follows the image file names. Of 
the eight characters in the file names, if files have the same characters except 
for  the last three characters they are treated as an image file group, and the 
effect is created with the last three (numeric) characters in sequence.

Note 
When creating the effect in pair mode (see page 339), the files used must be 
main files and sub files with the same last three (numeric) characters in the file 
name.

To recall a continuous sequence of still images, create an effect in the user 
region with the still image files as a keyframe, and run the created effect.

Note
With the 720P format, you can continuously recall images using the frame 
memory in units of two frames only.

Creating an effect with still image files as a keyframe

1 In the Frame Memory menu, select VF1 ‘Still’ and HF5 ‘Create Key 
Frame.’
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The Create Key Frame menu appears.
• A thumbnail appears for each group of files having the same characters, 

except for the last three characters, in the file name.
• When [Pair] is on, only pair files (each pair comprising a main file and 

a sub file) appear.
• When [Pair] is off, both single files and pair files all appear.

2 In the frame memory selection area, select the frame memory to be 
assigned.

This creates the effect in the user region to which the selected frame 
memory is assigned.

For details of the operating procedures, see “Selecting outputs (FM) and 
target frame memory” (page 346).

3 Select the desired folder in the folder selection area.
By pressing [More] to switch the display, you can select from a maximum 
of 12 folders.

Thumbnails of the files within the selected folder appear.

4 Turn the knob to select the register number in the user region.

Note
To search for an empty register in the user region, use the numeric keypad 
control block or the Multifunction Flexi Pad control block (see step 3 of 
“Recalling a Register” in Chapter 13 (Volume 2)).

5 Use the arrow keys or turn the knobs to scroll the thumbnail display of the 
files.

6 Select the thumbnail of the files to be used for the keyframe.

7 If necessary, turn the knob to check the animation effect in the thumbnail 
display.

Knob Parameter Adjustment Setting values

5 Register Effect register number 1 to 99

Knob Parameter Adjustment Setting values

1 Scroll Thumbnail display 
scrolling

1 and upwards
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8 Using the region selection buttons in the numeric keypad control block or 
the Multifunction Flexi Pad control block, select one of the regions (User1 
to User8) to which the frame memory output signals have been assigned.

9 Carry out either of the following.

• To clear the effect register selected in step 4, and create a new effect: 
press [Create Key Frame].

• To add to the end of the effect register selected in step 4, press [Append 
Key Frame].

A confirmation message for creating the effect appears.
If there is an inappropriate condition for creating the effect, an error 
message appears.

For details of error messages, see “Error Messages” in the Appendix 
(Volume 3).

10Press [OK].

This creates the effect in the selected user region register.

To cancel creating the effect
Press [Cancel].

Notes
• The effect is built with the selected files, in increasing order of the last three 

characters of the file name. If you do not want to include some of these files 
in the effect, first delete or rename them.

• A maximum of 99 keyframes can be included in a single effect.

Recalling a sequence of still images
Run the effect created by the foregoing procedure.
The procedure for doing this is the same as for any other effect.

For details, see “Executing Effects” in Chapter 13 (Volume 2).

Knob Parameter Adjustment Setting values

3 Viewer Animate thumbnail display 
of files

00:00:00 and upwards
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Frame Memory Clip Function

What is a “frame memory clip”?
Movies can be read into frame memory, and recalled and played back. A movie 
held in frame memory is called a “frame memory clip.”
A frame memory clip can be named using up to four characters. (For details of 
frame memory clip names, see “Continuously Capturing Still Images 
(Record)” (page 359).)

Ancillary data
In a frame memory clip, in addition to the video image, you can also record and 
play back ancillary data which can be used as embedded audio. 
To record the ancillary data, in the Setup menu the frame memory saving mode 
must be set to “save with ancillary data” (see “Saving a Frame Memory Clip 
With Ancillary Data” in Chapter 18 (Volume 3)). 

Notes
• With this setting, the saving mode for still images also changes to “save with 

ancillary data,” but when playing back a still image the ancillary data is never 
played. 

• When you change the saving mode, the frame memory is initialized, and any 
existing recorded frame memory data is lost.

Note on transferring ancillary data
Ancillary data is recorded when the frame memory saving mode is set to “save 
with ancillary data,” and can be saved to an external storage device such as a 
hard disk or memory card, and recalled. However, the ancillary data can only 
be saved or recalled; 
• When the frame memory saving mode is set to “save with ancillary data. 
• When ancillary data is present in the saved or recalled frame memory file.
• When the system signal format is the same as the signal format in the file.

When the frame memory saving mode is set to “save with ancillary data,” the 
following ancillary data status information is added to a frame memory clip. 
• Disable(d):

In this state the ancillary data is not played. This is the status when the 
[Ancillary Enable] button in the Frame Memory >Clip menu is set to Off. 

• Enable(d):
In this state, ancillary data is present, and can be played back. This is the 
status when the [Ancillary Enable] button in the Frame Memory >Clip menu 
is set to On. This is the status after a clip recording operation. 
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This status information is saved in a file, and is followed when the file is 
recalled. 

Frame memory clip settings
For frame memory clips, you can make the following settings using a menu or 
device control block (trackball/search dial/joystick).
• Start point 
• Stop point 
• Loop On/Off
The above settings can be saved in a snapshot register as snapshot attributes, 
and recalled.
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Frame Memory Clip Operations

For an overview of frame memory clip concepts, see “Frame Memory Clip 
Function” (page 364).

Note
During playback of a frame memory clip of the pair assigned to either of the 
target FM selection buttons (see page 368), frame memory operations may not 
be performed properly. Carry out frame memory operations after stopping clip 
playback.

Preparations for Operation

The preparations for using a frame memory clip (hereafter, a “clip”) are the 
same as for a still image operation. See “Preparations” (page 341) and 
“Selecting Outputs and Target Frame Memory” (page 346).

Recalling Clips

Recalling a clip
You can recall a clip from each of frame memories 1 to 8.

1 In the Frame Memory menu, select VF2 ‘Clip’ and HF1 ‘Recall.’

The Recall menu appears. (See following figure)
• When [Pair] is set to On, only pair files (sets of main file and sub file) 

are shown.
• When [Pair] is set to Off, both of single files and pair files are shown.
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2 In the frame memory selection area, select an assigned target FM. (See 
page 346)

3 If [Direct Recall] is on, press the button, turning it off.

4 In the folder selection area, select the desired folder.

By pressing [More] to switch the displays, you can select from a maximum 
of 12 folders.
Thumbnails of the files within the selected folder appear.

5 Using the arrow keys or turning the knob, scroll the file thumbnail display.

6 Press the thumbnail of the clip you want to recall.

7 Press [Recall].

Knob Parameter Adjustment Setting values

1 Scroll Thumbnail display 
scrolling

1 and upwards

Target selection buttons

Pair selection buttons

Clip file selection area

Frame memory 
selection area

Frame memory folder 
selection area

Direct Recall button
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This recalls the clip file, which is assigned to the FM you selected in step 2.
In pair mode, if a clip is selected, the main file is output to FM1, and the 
sub file to FM2. In single mode, when only one of FM1 and FM2 is 
selected, the front file on the thumbnail is output.

To recall in direct recall mode
Direct recall means that pressing a thumbnail immediately recalls the file.
In this mode, only the front thumbnail file is recalled.

1 In step 7 above, instead of pressing [Recall], press [Direct Recall].

2 Press the thumbnail for the file you want to recall.

This immediately recalls the file.

To display the subsidiary file in front
With the direct recall mode on, press [Sub Display], turning it on.

Clip Playback

You can play a recalled clip by a menu operation or by using the device control 
block.

Note
With a pair file recalled, it is possible to set [Pair] to Off and carry out a single 
file operation, but if you then set [Pair] to On again, the output of frame 
memory may be black. In such cases it is necessary to recall the pair file once 
more.

Playing a clip using the menu

1 In the Frame Memory menu, select VF2 ‘Clip’ and HF2 ‘Play.’

The Play menu appears. The status of the clip shown in the current target 
FM selection buttons appears here.
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2 When [Pair] is Off, press a target FM selection button to select the target.

3 To set loop playback, press [Loop], turning it on.

4 To start playback, press [Play]. During playback, to stop, press [Stop].

To cue up
Press [Cue].

To play the image at the beginning of the clip (Clip Begin)
Press [Rewind].

To play the image at the end of the clip (Clip End)
Press  [FF].

Playback start point 
(pale blue bar)

Current position 
(red bar)

Playback end point 
(yellow bar)

Status buttons
These show the timecode values for 
the start point, current position, and 
end point.
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To specify the playback start point
To set the current position as the playback start point, in the <Start TC> group, 
press [Set]. To set a different position, press the [Start] status button, and enter 
a timecode value from the numeric keypad window.

To specify the playback stop point
Start playback, and at the desired position press the [STOP] button to stop 
playback, then in the <Stop TC> group, press [Set]. To set to any position, 
press the [Stop] status button, and enter a timecode value from the numeric 
keypad window.

To change the current position
To change the current position, press the [Current] status button, and enter a 
timecode value from the numeric keypad window.

Using the device control block (search dial) to play back clips

Note
A frame memory clip must first be recalled with a menu operation.

1 With the device selection buttons, select the frame memory clip to be 
played (FM1 CLIP to FM8 CLIP).

If the pair mode is on, both main and subsidiary FMs light.

2 Press the [PLAY] button, turning it on.

To stop playback, press [STOP] or any of the [SHTL], [JOG], [CUE], 
[REW], [FF], and [ALL STOP] buttons.

For details of the buttons in the device control block (search dial), see 
“Device Control Block (Search Dial)” (page 63) in Chapter 2.

To specify the playback start point
To make the current position the playback start point, press the [START TC] 
button. To set a different position, press the [SET START TC] button, then 
enter the timecode from the numeric keypad control block.

To specify the duration
Press the [SET DUR] button, and enter a timecode from the numeric keypad 
control block. If the playback start point is already set, this automatically sets 
the playback stop point. If the playback stop point is already set, this 
automatically sets the playback start point. (The duration setting is not 
displayed in the device control block.)
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To specify the playback stop point
Start playback, and at the desired position press the [STOP] button to stop 
playback, then press the [STOP TC] button. To set to any position, press the 
[SET STOP TC] button, and enter a timecode from the numeric keypad control 
block.

To carry out the variable speed playback
Use the search dial.

For details on using the search dial, see “Controlling the Tape/Disk 
Transport” in Chapter 12 (Volume 2).

To apply a loop to a frame memory clip
Press the [LOOP] button.

Using the device control block (trackball) or device control block 
(joystick) to play back clips

Carry out the following operation with the device control block (trackball) or 
device control block (joystick).

Note
A frame memory clip must first be recalled with a menu operation.

1 Press the [DEV] button in the region selection buttons, and select the frame 
memory clip for playback (FM1 CLIP to FM8 CLIP).

If the pair mode is on, both main and subsidiary FMs light.

2 Press the [PLAY] button, turning it on.

To stop playback, press [STOP] or any of the [SHTL], [JOG], [CUE], 
[REW], [FF], and [ALL STOP] buttons.

For details of the buttons in the device control block (trackball) or device 
control block (joystick), see “Device Control Block (Trackball)” (page 58) in 
Chapter 2.

For details of the playback start point, stop point, and duration settings, see the 
previous item, “Using the device control block (search dial) to play back clips” 
(page 370).

To carry out the variable speed playback
Press any of the [SHTL], [JOG], and [VAR] buttons, then turn the Z-ring or 
move the joystick. The image changes in the forward direction when you turn 
the Z-ring clockwise, and in the reverse direction when you turn it 
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counterclockwise. Move the joystick to the right for the forward direction and 
to the left for the reverse direction.
When you pressed the [JOG] button: Playback is at a speed corresponding 

to the turning speed of the Z-ring or the movement speed of the joystick.
When you pressed the [SHTL] button: Playback is at a speed corresponding 

to the rotation angle of the Z-ring or amount of movement of the joystick.
When you pressed the [VAR] button: Playback is at a speed corresponding 

to the rotation angle of the Z-ring or amount of movement of the joystick, 
in the range –1 to +3 times normal speed.

Clip Creation

You save a movie as a clip.

Note
If the number of frame memory clips exceed 100 single files (50 pair files), an 
error appears.

Using the menu to record clips

1 In the Frame Memory menu, select VF2 ‘Clip’ and HF3 ‘Record.’

The Record menu appears.
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2 With [Pair] off, press the operation target selection button, to select the 
operation target.

3 In the folder selection area, select the folder containing the clip to be 
recorded.

4 Press [Record Enable], turning it on.

5 To set the clip name, press [Name].

A keyboard window appears.

6 Enter the clip name, and press Enter.

7 To start recording, press [Record Start].

8 To end recording, press [Record Stop].

To set the clip duration

1 Press [Clip Duration].

A numeric keypad window appears.

Frame memory 
selection area

Operation target 
selection buttons

Pair selection 
buttons

Folder selection 
area
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2 Enter a timecode value or number of frames, and press Enter.

This confirms the clip duration.

Creating and Handling Frame Memory Folders

You can create, rename, and delete frame memory folders.

Creating a new folder

1 In the Frame Memory menu, select VF5 ‘Folder.’

The Folder menu appears. The status area shows a list of the current folder 
settings.

2 Select [New].

A keyboard window appears.

3 Enter the folder name, and press Enter.

This confirms the folder name.

Changing the folder name

1 In the Frame Memory >Folder menu, select the folder with the arrow keys 
or by turning the knobs.

2 Press [Rename].

A keyboard window appears.

3 Enter the new folder name, and press Enter.

Note
The following names cannot be used for folders:

Default, Flash1, Flash2
CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2,
COM3, COM4, COM5, COM6, COM7, COM8, COM9

Knob Parameter Adjustment Setting values

1 No. Folder selection 1 to 12

2 Num Number of files to select 
consecutively from selected file

1 to 12
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LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8,
LPT9

This changes the folder name.

Deleting a folder

1 In the Frame Memory >Folder menu, select the folder with the arrow keys 
or by turning the knobs.

To select all folders, select [All].

2 Press [Delete].

A confirmation message appears.

3 To carry out the deletion select [Yes], and to cancel the deletion select 
[No].

Note
It is not possible to delete the default folder (named “Default”).

Clip Output

As for still image operation, you can use the reposition and lock functions.

For details of the operation, see “Image Output” (page 358).

Recording and Playback of Ancillary Data

Preparations
To record ancillary data, it is first necessary in the Setup menu to select “save 
with ancillary data” as the frame memory saving mode (see “Saving a Frame 
Memory Clip With Ancillary Data” in Chapter 18 (Volume 3)).

Knob Parameter Adjustment Setting values

1 No. Folder selection 1 to 12

2 Num Number of files to select 
consecutively from selected file

1 to 12
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Recording ancillary data
To record ancillary data in a frame memory clip, use the Frame Memory >Clip 
>Record menu. 

For details of the operating sequence, see “Clip Creation” (page 372).

To check ancillary data during recording
If the ancillary data to be recorded is embedded audio, by first setting the signal 
output to through mode, you can listen while recording.

For the method of setting the signal output to through mode, see “Signal 
Output Settings (Output Menu)” in Chapter 20 (Volume 3).

Note 
For [Freeze Enable] or [Record Enable], in the <Record Enable> group, 
pressing [Clip] or [Ext Clip] to turn them on or off may result in noise. Also, 
with these buttons in the On state, selecting the signal on the frame memory 
source bus may result in noise.

Playing back ancillary data
You can play ancillary data recorded in a frame memory clip by normal 
playback or an auto transition of the clip transition.
To play the ancillary data, you must use the following procedure to enable 
playback of the ancillary data. For the subsequent playback operation, see 
“Clip Playback” (page 368).

Notes
• After recording a frame memory clip, the ancillary data state is enabled for 

playback.
• To play back the clip, set the signal output to through mode. For the method 

of setting through mode, see “Signal Output Settings (Output Menu)” in 
Chapter 20 (Volume 3).

• When the reposition function is on, ancillary data cannot be played back.
• Switching reposition function between on and off may cause noise.
• Only the AUX bus and edit preview bus can output ancillary data.
• For loop playback of clips in the following video formats, the loop playback 

range must be at least 5 frames, and set to a multiple of 5 frames.
– 480/59.94i
– 720/59.94P
– 1080/59.94i

• Recalling operations of still images or clips can cause noise.
• Carrying out file operations on a frame memory clip may result in the 

ancillary data being discontinuous, or in noise occurring. However, if the 
first or last frame of the clip is deleted, noise will not occur.

• The audio sampling frequency is always 48 kHz.
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• In the case of 480i or 59.94, noise may occur at the beginning of playing back 

a clip. This can be avoided by making the first nine or more frames of the clip 
soundless.

• When you play back the recorded embedded audio, depending on the device 
to be used, noises are produced at the playback start point and end point. For 
details of devices that are used for playback, contact your Sony service or 
sales representative.

1 In the Frame Memory menu, select VF2 “Clip”, HF5 “Ancillary Enable.”

2 Select the frame memory folder and file to be played back.

3 Set the [Ancillary Enable] button to On.
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Clip Transition Operations

A frame memory clip (movie) is played back, linked to a transition using a mix 
(dissolve) or wipe.

The following restrictions apply to the use of a clip transition.
• Key frame capture is not possible.
• It is not possible to apply a pattern limit.
• Transitions executed in two strokes, such as a preset color mix with the 

stroke mode set to Normal, or a DME wipe with a picture-in-picture pattern, 
will not execute correctly.

• It is not possible to vary the transition rate of a clip transition.
• Transition preview cannot be used.
• No instantaneous state of a clip transition can be saved as a snapshot.
• When recalling a snapshot including a clip transition during executing 

another clip transition, the follow-on transition does not operate properly. Be 
sure to complete the transition before recalling a snapshot.

Note
When a clip transition is selected as the transition type, if one of the wipe 
direction selection buttons in the transition control block is lit, it indicates the 
direction of clip playback.

Setting a clip transition
The following example describes the case of a clip transition using FM 1&2 
Clip on the M/E-1 bank.

Note
To use a clip transition effectively, the image from the frame memory clip 
being played back during the clip transition should be seen in the M/E-1 
program output. For example, inserting a key using frame memory output 1 and 
frame memory output 2.

1 Display the M/E-1 >Misc >Transition menu, and in the <Transition Type> 
group select “FM1&2 Clip.”

2 Press [Clip Transition].

The Clip Transition menu appears.
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3 Press the [Clip] button.

The Clip menu appears, and the status area shows a list of clips.

4 Select the clip to use in the clip transition.

5 Return to the Clip Transition menu, and in the <BKGD Transition Type> 
group, select the background transition type.

Note
For details of the background transition selected here, see the various 
adjustments in the M/E-1 >Misc >Transition menu.

6 In the <Select> group, press [BKGD Transition].

7 Use either of the following methods to set the background transition start 
point independently of the clip playback timing.

• Move the fader lever to the desired position, and in the <BKGD 
Transition Set Timing> group press [Start].

Clip display area

Background transition display area Clip transition display area
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• Turn knob 1 to set the number of frames. (The left end of the reference 
axis (see following figure) is the position of frame 0.)

8 Using either of the following methods, set the end point of the background 
transition.

• Move the fader lever to the desired position, and in the <BKGD 
Transition Set Timing> group press [Stop].

• Turn knob 2 to set the number of frames.

9 If Wipe or DME Wipe is selected in the <BKGD Transition Type> group, 
in the <BKGD Transition Direction> group, select the background 
transition direction.

10In the <Select> group, press [FM 1&2 Clip].

11Using either of the following methods, set the start point of the clip.

• Move the fader lever to the desired start point, and in the <Clip 
Transition SetTiming> group press [Start].

• Turn knob 1 to set the number of frames. (The left end of the reference 
axis (see following figure) is the position of frame 0.)

Note
It is not possible to set the end point.

12In the <Clip Transition Direction> group, select the playback direction of 
the clip.

To reset the start point and end point
Press [Timing Reset].
The background transition start point and end point, and the clip start point are 
all reset.

Position of frame 0 Reference axis
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Image Data Management

You can carry out the following operations on the files in which images are 
saved.
• Pair file processing
• Move
• Delete
• Rename

Note
During playback of a frame memory clip of the pair assigned to either of the 
target FM selection buttons (see page 368), frame memory operations may not 
be performed properly. Carry out frame memory operations after stopping clip 
playback.

Pair File Processing

You can create a pair file from two single files. In the reverse direction, you 
can split a pair file into two single files.
Couple: You can create a pair file from two single still image files or clip files.
Separate: You can also separate a pair file into two single still image files or 

clip files.

Creating a pair file from two single files

Note
Carrying out the following operation automatically switches [Pair] to On.

The following description applies to the case of FM1&2, but the procedures are 
similar for the other cases.

1 In the Frame Memory >Still >Recall menu or Frame Memory >Clip 
>Recall menu, recall the two single files you want to convert to a pair file, 
to FM1 and FM2.

2 In the Frame Memory menu, select VF4 ‘File’ and HF1 ‘Pair 
Recombination.’

The Pair Recombination menu appears.
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3 Press [Couple].

This converts the files output to FM1 and FM2 to a pair.

Splitting a pair file into two single files

Note
Carrying out the following operation automatically switches [Pair] to Off.

The following description applies to the case of FM1and FM2, but the 
procedures are similar for the other cases.

1 In the Frame Memory >Still >Recall menu or Frame Memory >Clip 
>Recall menu, recall the pair file.

2 Select the folder in which the file to be moved is stored.

3 In the Frame Memory menu, select VF4 ‘File’ and HF1 ‘Pair 
Recombination.’

The Pair Recombination menu appears.

4 Press [Separate].

The FM1 and FM2 pair file is split into separate single files.

Moving Files

1 In the Frame Memory menu, select VF4 ‘File’ and HF5 ‘Move.’

The Move menu appears. The status area shows files to be moved in the 
upper area, and destination files in the lower area.

2 Select the folder which contains the file to be moved.

3 Using any of the following methods, select the file to be moved.

• Press the arrow keys to scroll the display.
• Press directly on the thumbnail in the status area.
• Turn the knobs.

Knob Parameter Adjustment Setting values

1 No File selection 1 and upwards

2 Num Selection of number of files in 
sequence

1 and upwards
Image Data Management
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4 Select the destination folder and file.

5 Press [Move].

6 To confirm the move press [Yes], and to cancel press [No].

Deleting Files

1 In the Frame Memory menu, select VF4 ‘File’ and HF5 ‘Delete.’

The Delete menu appears. In the status area, whether pair mode is on or 
off, all of the saved files appear as thumbnails.

2 Select the folder which contains the file to be deleted.

3 Using either of the following methods, select the file to be deleted. If 
necessary, press the arrow keys to scroll the display.

• Press directly on the thumbnail in the status area.
• Turn the knobs.

• To delete all files, press [Select All], turning it on.
• When a clip thumbnail is selected, the still image files making up the clip 

are also selected for deletion.

4 If necessary, turn the knob to check the contents of the frame memory clip 
through the thumbnail display.

5 Press [Delete].

A message for confirming the deletion appears.

6 To confirm the deletion press [Yes], and to cancel press [No].

Knob Parameter Adjustment Setting values

1 No File selection 1 and upwards

2 Num Selection of number of files in 
sequence

1 and upwards

Knob Parameter Adjustment Setting values

3 Viewer For a movie, the current frame 
position. For a still image, no effect.

00:00:00 and 
upwards
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Renaming Files

1 In the Frame Memory menu, select VF4 ‘File’ and HF6 ‘Rename’

The Rename menu appears. In the status area, whether pair mode is on or 
off, all of the saved files appear as thumbnails.

2 Using either of the following methods, select the file to be renamed. If 
necessary, press the arrow keys to scroll the display.

• Press directly on the thumbnail in the status area.
• Turn the knobs.

3 If necessary, turn the knob check the contents of the frame memory clip 
through the thumbnail display.

4 Press [Rename].

A keyboard window appears.

5 Enter the new name, then press [Enter] in the keyboard window.

Note
The following names cannot be used:

CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2, COM3, 
COM4, COM5, COM6, COM7, COM8, COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, LPT9

This renames the file.

Knob Parameter Adjustment Setting values

1 No File selection 1 and upwards

Knob Parameter Adjustment Setting values

3 Viewer For a movie, the current frame 
position. For a still image, no 
effect.

00:00:00 and 
upwards
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External Hard Disk Drive Access

You can connect a hard disk drive to the IEEE1394 port of the switcher 
processor, to carry out the following operations.

Format: Format the hard disk.
Backup: Batch saving of files from frame memory to the hard disk.
Restore: Restoring frame memory from files saved on the hard disk.

Since image data saved in memory is lost when the system is powered off, 
using an external hard disk drive allows required data to be preserved.

Notes
• Only one hard disk drive can be connected to a single switcher processor.
• While the hard disk is being accessed, frame memory operations are not 

possible.
• During playback of a frame memory clip of the pair assigned to either of the 

target FM selection buttons (see page 368), frame memory operations may 
not be performed properly. Carry out frame memory operations after 
stopping clip playback.

Consult your Sony service representative or sales representative about the 
hard disk drives that can be connected.

Hard Disk Formatting

When you connect a hard disk drive for the first time, it is necessary to format 
the hard disk. This partitions the disk, creating five logical drives (FMHDD1 
to FMHDD5).

1 In the Frame Memory menu, select VF6 ‘External HDD’ and HF1 
‘Format.’

The Format menu appears.

To get the hard disk drive information
In the button area press [Refresh Status].
The Model Name item shows the product information for the hard disk 
drive.

2 Press [Format].
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A popup window for confirming formatting appears.

Note
Carrying out formatting erases any existing data on the hard disk.

3 Press [Yes].

This starts the hard disk formatting. A progress bar and numerical 
indication appear to show the progress of the operation.
When the operation is completed, a popup window reading “Success!!” 
appears.

4 Press [OK].

Saving Files

You can save all of the files from frame memory to the external hard disk drive.

Note
Before carrying out this operation for the first time, it is necessary to format the 
hard disk (see previous item, “Hard Disk Formatting”).

1  In the Frame Memory menu, select VF6 ‘External HDD’ and HF2 
‘Backup/Restore.’

The Backup/Restore menu appears.
If in Dual Simul mode, select the switcher to operate.

To get the hard disk drive information
Press [Refresh Status].
The Model Name item shows the product information for the hard disk 
drive, and the names of directories within the logical drives.

2 Using any of the following methods, select a logical drive (FMHDD1 to 
FMHDD5).

• Press directly on the list to select.
• Press a button in the <Partition> group.
• Turn the knob.

3 Press [Backup].

Knob Parameter Adjustment Setting values

1 Partition Logical drive selection 1 to 5
External Hard Disk Drive Access



  C
hapter 7 

F
ram

e M
em

ory

A popup window for confirming file saving appears.

Note
When you save the files, all of the saved files in the logical drive is erased 
immediately before the saving operations.

4 Press [Yes].

This starts the file saving operation. If there is no directory in the logical 
drive, a directory is automatically created, and the files are saved within it. 
A progress bar and numerical indication appear to show the progress of the 
operation.
When the operation is completed, a popup window reading “Completed.” 
appears.

5 Press [OK].

To rename a directory
Select a directory in the list, and in the button area press [Rename].
In the keyboard window that appears, enter the new directory name, and press 
[Enter]. The name of a directory is limited to eight characters.

Note
The following names cannot be used:

CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2, COM3, 
COM4, COM5, COM6, COM7, COM8, COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, LPT9

Recalling Files

You can recall all of the saved files on the hard disk drive into frame memory.

1 Carry out steps 1 and 2 of the procedure “Saving Files” (page 386).

Note
It is not possible to select a directory (logical drive) on which files are not 
saved.

2 Press [Restore].

A popup window for confirming file recall appears.
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Note
When you recall the files, any existing data in frame memory is lost 
immediately before the recalling operations.

3 Press [Yes].

This starts the file recall operation. A progress bar and numerical 
indication appear to show the progress of the operation.
When the operation is completed, a popup window reading “Completed.” 
appears.

4 Press [OK].
External Hard Disk Drive Access
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Color Background

The dedicated generators generate color signals, and you can use these as color 
backgrounds in video effects. You use the color signals by assigning them to 
cross-point buttons.

Color combinations (“color mix”)
The color generators can output the result of combining two colors, which are 
color 1 and color 2.
Using a pattern from a dedicated pattern generator, color 1 and color 2 can be 
combined in the boundary region, forming a color gradation. This is referred to 
in the menu system as “color mix.”
You can also apply modifiers to the selected pattern.
When the “color mix” function is not used, the result is a flat color, and color 
1 is always output.

You carry out color background settings in the Color Bkgd menu. This section 
describes the settings menu for color background 1 as an example.

Color Background Settings Menu

Accessing the Color Bkgd1 menu
Use either of the following operations.
• In the menu control block, select the top menu selection button [COLOR 

BKGD], and press VF1 ‘Color Bkgd1.’
• Press a cross-point button assigned to color background 1 twice in rapid 

succession.
The above operation displays the Color Bkgd1 menu.

Basic Color Background Setting Operations

Making a single-color matte (Flat Color)
If you are not using the “color mix” function to combine two colors, use the 
following procedure.

1 In the <Matte> group of the Color Bkgd 1 menu, press [Flat Color], turning 
it on.
Color Background
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You can now adjust color 1.

2 Set the following parameters.

Making a color combination (color mix)
To combine color 1 and color 2, use the following procedure.

1 In the <Matte> group of the Color Bkgd1 menu, press [Mix Color], turning 
it on.

2 Set the following parameters as required.

a) The patterns are the same as for a standard wipe. See “Wipe Pattern List” (page 444).

You can also carry out the pattern selection by pressing the [Mix Ptn 
Select] button, to display the Mix Ptn Select menu. Select any pattern 
appearing in the Mix Ptn Select menu (standard wipe patterns 1 to 24), and 
you can then adjust the following parameters.

3 To adjust color 1, set [Color 1] on, and to adjust color 2 set [Color 2] on, 
then adjust the parameters.

4 If required, set the pattern modifiers.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of softening of edge 0.00 to 100.00

5 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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• When turning [Position] on and setting the pattern position

a) See page 273.

• When turning [Multi] on and using replications of the same pattern 

a) See page 277.

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See page 276.

• When turning [Pairing] on and making a wipe pattern like a 
Venetian blind

• When turning [Angle] on in the <Rotation> group and slanting the 
pattern

a) See page 274.

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a constant rate

a) See page 275.

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Width Width of the slits 1 to 128 (integer)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)
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• When selecting H (horizontal) or V (vertical) in the <Modulation> 
group and applying waviness to the pattern
(The modulation is always a sine wave.)

5 To interchange color 1 and color 2, press the [Color Invert] button, turning 
it on.

Knob Parameter Adjustment Setting values

1 Amplitude Amplitude of modulation 0.00 to 100.00

2 Frequency Frequency of modulation 0.00 to 100.00

3 Speed Speed of waves –100.00 to +100.00
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Copy and Swap

You can copy and swap the settings among the M/E-1 to M/E-3, and PGM/PST 
banks or between keyers.
The following settings can be copied or swapped.
• Overall settings for the M/E-1 to M/E-3, and PGM/PST banks
• Keyer settings
• Wipe settings in a transition control block
• Wipe settings in an independent key transition control block
• DME wipe settings in a transition control block
• DME wipe settings in an independent key transition control block
• Matte data (color 1, color 2, and how to compose them)
• Color settings
• DME channel settings
• Format converter input settings (copy only)
• Format converter output settings (copy only)

You can carry out copy operations with a simple button operation. Swap 
operations, and copy operations on DME data can only be done with a menu 
operation.

M/E copy and M/E swap
You can copy and swap the overall bank settings among the M/E-1 to M/E-3, 
and PGM/PST banks.

Note
If a DME is being used on the source M/E bank, then if for example there are 
insufficient DME channels, it may not be possible to select the DME.
There are no such restrictions on a swap.

Keyer copy and keyer swap
You can carry out copy and swap operations among the 16 keyers listed in the 
following table.

Target bank Target data

M/E-1
M/E-2
M/E-3
PGM/PST

Bank settings excluding the following data items:
• Setup data
• Flexi Pad settings
• Snapshots
• Keyframe effects
• Key snapshots
• Key memory
Copy and Swap
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Note
If a DME is being used on the source keyer for a copy or either keyer for a 
swap, then if for example there are insufficient DME channels, or the limit on 
using DME channels within an M/E bank is exceeded, it may not be possible 
to select the DME.

Wipe copy and wipe swap
You can copy and swap the wipe settings among the banks listed in the 
following table.

Wipe copy and wipe swap in the independent key transition 
control block

You can copy and swap the wipe settings among the 16 keyers listed in the 
following table.

DME wipe copy and DME wipe swap
You can copy and swap the DME wipe settings among the banks listed in the 
following table.

Target bank Target keyer Target data

M/E-1
M/E-2
M/E-3

Keys 1 to 4 Key settings excluding the following data 
items:
• Setup data
• Key snapshots
• Key memoryPGM/PST Downstream keys 1 to 4

Target bank Target data

M/E-1
M/E-2
M/E-3
PGM/PST

Wipe settings.
It is not, however, possible to carry out copy or swap involving 
independent key transition wipe settings.

Target bank Target keyer Target data

M/E-1
M/E-2
M/E-3

Keys 1 to 4 Wipe settings in the independent key 
transition control block.

PGM/PST Downstream keys 1 to 4

Target bank Target data

M/E-1
M/E-2
M/E-3
PGM/PST

DME wipe settings.
It is not, however, possible to carry out copy or swap involving 
independent key transition DME wipe settings.
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DME wipe copy and DME wipe swap in the independent key 
transition control block

You can copy and swap the DME wipe settings among the 16 keyers listed in 
the following table.

Matte data copy and swap
You can copy or swap the matte data among the color generators listed in the 
following table.

Color data copy and swap
You can copy or swap the color data among the color generators listed in the 
following table.

Target bank Target keyer Target data

M/E-1
M/E-2
M/E-3

Keys 1 to 4 DME wipe settings in the independent 
key transition control block.

PGM/PST Downstream keys 1 to 4

Target bank Target keyer and data

M/E-1
M/E-2
M/E-3
PGM/PST

• Keys 1 to 2
• Downstream keys 1 to 2

• Matte data for key fill
• Matte data for key edge fill

• Keys 3 to 4
• Downstream keys 3 to 4

• Matte data for key fill

Matte data for wipe border edge

Color background • Matte data for color background 1
• Matte data for color background 2

Target bank Target keyer and data

M/E-1
M/E-2
M/E-3
PGM/PST

• Keys 1 to 2
• Downstream keys 1 to 2

• Colors 1 and 2 for key fill
• Colors 1 and 2 for key edge fill
• “Zabton” color data

• Keys 3 to 4
• Downstream keys 3 to 4

• Colors 1 and 2 for key fill

Matte data for wipe border edge

Color data for preset color mix

Color background • Colors 1 and 2 for color background 1

Frame memory • FM1 color
• FM2 color
Copy and Swap
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DME channel copy and swap
You can copy and swap the channel data among DME channels 1 to 2 or DME 
channels 5 to 8.
It is not possible to copy or swap the channel data between DME channels 1 
and 2 and DME channels 5 to 8.

Copying format converter data
You can copy data from one format converter input to another or from one 
output to another.

DME ch1 , ch2
DME ch4 to ch8

• Background
• Border
• Sepia
• Light
• Shade
• Drop shadow
• Trail

Target bank Target keyer and data
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Copy and Swap Operations

Copy and Swap Menu Operations

Accessing the Copy/Swap menu
In the menu operation section top menu selection buttons, press the [Copy/
Swap] button, then press VF1 ‘Copy/Swap.’ The Copy/Swap menu appears.
Here a copy/swap operation on wipe data is described by way of example, 
using the Copy/Swap >Wipe menu, but the same general procedure applies to 
all of the following menus.
• M/E: Copying and swapping M/E data
• Key: Copying and swapping key data
• Wipe: Copying and swapping wipe data
• DME Wipe: Copying and swapping DME wipe data
• Matte: Copying and swapping matte data
• Color: Copying and swapping color data
• DME: Copying and swapping data by DME channels
• Format Converter: Copying format converter data

For details, see “Settings Relating to Signal Inputs (Input Menu)” in Chapter 
20 (Volume 3).

For an overview of the concepts involved, see “Copy and Swap” (page 394). 
For details of color corrector copy and swap, see Chapter 9 “Color 
Corrector” (page 413).

Copying and swapping wipe data
As an example, to copy or swap wipe data, use the following procedure.

1 In the Copy/Swap menu, select HF3 ‘Wipe.’

The Copy/Swap >Wipe menu appears.
The status area shows lists for the copy/swap source on the left, and the 
copy/swap destination on the right.

2 In the <Data Select> group, select either of the following.

Wipe: The operation applies to wipes in the transition control block.
Key Wipe: The operation applies to wipes in the independent key 

transition control block.
Copy and Swap Operations
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3 Using any of the following methods, select the data to be copied or 
swapped.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs to make the setting.

a) Transition control block wipe data
b) Independent key transition control block wipe data

For details of the data affected, see “Copy and Swap” (page 394).

4 To copy, press [Copy], and to swap, press [Swap].

This carries out the copy or swap.

To undo a copy or swap 
Press [Undo], to return to the state before the copy or swap was carried out.

Copy by Button Operation

You can carry out the following copy operations by a simple button operation.
• M/E copy
• Keyer copy
• Wipe copy
• DME wipe copy

Note
On the CCP-6224/6324, it is not possible to carry out a copy by button 
operation.

Basic button operation
The basic button operation is to hold down the copy source button, then press 
the destination button.
You can undo the last operation using [Undo] in the menu (see page 399).

Knob Parameter Adjustment Setting values

1 Left No Select data for copy/
swap source

1 to 4 a)

1 to 16 b)

2 Right No Select data for copy/
swap destination

1 to 4 a)

1 to 16 b)
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M/E copy button operation
In the Flexi Pad control block of each M/E bank, use the [SNAPSHOT] button.

To copy from M/E-1 to M/E-2
In the M/E-1 Flexi Pad control block, hold down the [SNAPSHOT] button, 
then press the [SNAPSHOT] button in the M/E-2 Flexi Pad control block.

Keyer copy button operation
To specify the copy source, use the key delegation buttons in the key control 
block, and to specify the copy destination, use the key delegation buttons in the 
independent key transition control block.

To copy from M/E-1 key 1 to M/E-2 key 2
In the key control block M/E delegation buttons, press [M/E1], turning it on, 
then hold down the [KEY1] button, and in the M/E-2 independent key 
transition control block, press the [KEY2] button.

Wipe copy button operation
Use the [WIPE] button in the Flexi Pad control block of each M/E bank.

To copy the M/E-1 wipe to the M/E-2 wipe
In the M/E-1 Flexi Pad control block, hold down the [WIPE] button, then press 
the [WIPE] button in the M/E-2 Flexi Pad control block.

DME wipe copy button operation
Use the [DME] button in the Flexi Pad control block of each M/E bank.

To copy the M/E-1 DME wipe to the M/E-2 DME wipe
In the M/E-1 Flexi Pad control block, hold down the [DME] button, then press 
the [DME] button in the M/E-2 Flexi Pad control block.
Copy and Swap Operations
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Misc Menu Operations

In the Misc menu, you can carry out the following operations.
• Enabling and disabling operation from an external device, System Manager, 

or an editing keyboard.
• Enabling and disabling side flags on the background bus of each of the M/E-

1 to M/E-3 and PGM/PST banks.

For the side flag function, see “Side Flags” (page 434).

• Switching the safe title function on or off for each switcher output.
• Displaying the transition rate, independent key transition rate, and fade-to-

black transition rate for each of the M/E and PGM/PST banks, and changing 
the settings.

Port Settings for Control From an External Device

Enabling or disabling control from an external device

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears with the status area 
showing the settings of the following ports.
• Switcher Remote 1 to Remote 2 ports (RS-422A, D-sub 9-pin)
• Switcher GPI port (parallel, 25-pin) 
• DME1/DME2 Editor ports (RS-422A, D-sub 9-pin)
• DME1/DME2 GPI ports (parallel, 25-pin)

2 In the <Switcher> or <DME> group, press on the name of the port for 
which you want to disable control from an external device, turning it off. 
To re-enable control for the port, press on its name once more.

Note
For the AUX bus operation from the Remote1 to Remote2 ports of the 
switcher, the setting (Enable/Disable/Manual) in the Setup menu takes 
precedence. Only when the setting is “Manual,” the settings made in the 
Port Enable menu apply.

For details, see “Interfacing With External Devices (Device Interface 
Menu)” in Chapter 19 (Volume 3).
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DME override

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears.

2 In the <DME Override> group, select the DME override mode.

DME Override: When a switcher snapshot or effect using a DME is 
recalled, forcibly select the DME that was used when saving.

On Air Protect: The operation is the same as the DME override function, 
except that a DME being used by an M/E bank or P/P bank that is on 
air will not be forcibly selected.

Note
If effects using the same DME channel are selected simultaneously in two 
or more regions, the DME is selected with the order of precedence P/P >M/
E1 >M/E2 >M/E3.

Enabling or disabling control from System Manager
By installing the BZPS-8000 System Management Software (System 
Manager), you can use a computer connected on a network for management of 
some switcher data and control operations.
To enable or disable this function, use the following procedure.

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears.

2 Press [System Manager].

Each time you press the button toggles between enable and disable.

Editing Keyboard Settings

Note 
The following operations are only possible when a license for the BZS-8050 
Editing Control Software is activated. For details of license registration, see 
“Installation and Device Setup (Install/Unit Config Menu)” in Chapter 18 
(Volume 3).
Misc Menu Operations
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Enabling or disabling control from the editing keyboard

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF2 ‘Plug-In Editor.’

The Misc >Enable >Plug-In Editor menu appears.

2 In the <Control From Plug-In Editor> group, press [Editor Enable].

Each time you press the button toggles between enable and disable.

To enable control of the preview bus only
When control from the editing keyboard is disabled (when [Editor Enable] is 
set to Disable), to enable control of the preview bus only, press [PVW Bus 
Enable] in the <Control From Plug-In Editor> group.

Safe Title Settings

Switching the safe title function on or off

1 In the menu control block, press the top menu selection button [MISC] and 
select VF2 ‘Safe Title.’

The Misc >Safe Title menu appears.

2 Using any of the following methods, select the signal to which the settings 
apply.

• Directly press the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob to make the setting.

Notes
• It is not possible to change the setting for the output for which the safe 

title is set off in a Setup menu.
• The safe title function cannot be used for output signals for which 

through mode is set to Enable in a Setup menu.

For more information about the Setup menu settings referred to above, see 
“Signal Input Settings (Input Menu)” and “Signal Output Settings (Output 
Menu)” in Chapter 20 (Volume 3).

Knob Parameter Adjustment Setting values

1 Output Signal to which the settings 
apply

1 to 48
403Misc Menu Operations
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3 Press [Safe Title] to set it on or off.

Displaying a List of Transition Rates and Changing the 
Settings

In the Transition menu, for each bank you can display a list of the M/E (or 
PGM/PST) transition rates and independent key (or DSK) transition rates, and 
change the settings.
These settings are linked to the other transition rate setting operations.
You can also display and set the fade-to-black transition rate.

Displaying the Transition menu
In the menu control block, press the top menu selection button [MISC], then 
select VF3 ‘Transition.’
The Misc >Transition menu appears.

About the Transition menu display
The display of the independent key transition rate in the Misc >Transition 
menu depends on the selection in the <Key Transition> group of the 
Engineering Setup >Switcher >Transition menu for each of the M/E and PGM/
PST banks.

When [Same] (On direction and Off direction settings the same) is selected 
in the <Key Transition> group: Only “Key” (or “DSK” in the PGM/PST 
bank) appears.

When [Independ] (On direction and Off direction settings independent) is 
selected in the <Key Transition> group: “Key(On)” and “Key(Off)” 
each appear. In the case of the PGM/PST bank, “DSK(On)” and 
“DSK(Off)” appear.

For more details, see “Settings Relating to Video Switching (Transition 
Menu)” in Chapter 20 (Volume 3).

Setting the transition rate in the Transition menu
For example, to make the settings for the M/E-1 bank, use the following 
procedure.

To set the M/E transition rate

1 In the <M/E-1 Transition Rate> group of the Misc >Transition menu, press 
[Transition].
Misc Menu Operations
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2 Turn the knob to set the number of frames.

Note 
When a clip transition is selected as the transition type, it is not possible to 
change the transition rate in this menu.

To set the independent key transition rate

1 In the <M/E-1 Transition Rate> group of the Misc >Transition menu, press 
[Key]. 
To set the key On direction or Off direction independently, press Key(On) 
or Key(Off).

2 Turn the knobs to set the number of frames.

To set the fade-to-black transition rate in the Transition menu

1 In the Misc >Transition menu, press [FTB].

2 Turn the knob to set the number of frames.

Knob Parameter Adjustment Setting values

1 Transition Rate Transition rate 0 to 999 (frames)

Knob Parameter Adjustment Setting values

1 Key1 Trans Rate Key 1 transition rate 0 to 999 (frames)

2 Key2 Trans Rate Key 2 transition rate 0 to 999 (frames)

3 Key3 Trans Rate Key 3 transition rate 0 to 999 (frames)

4 Key4 Trans Rate Key 4 transition rate 0 to 999 (frames)

Knob Parameter Adjustment Setting values

1 Transition Rate Transition rate 0 to 999 (frames)
405Misc Menu Operations
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AUX Menu Operations

AUX Bus Settings

Making video process settings for an AUX bus
Make the settings as follows.

1 In the Aux/Mon >Aux Bus menu, using any of the following methods, 
select the AUX bus to which the settings apply.

• Directly press the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knob to make the setting.

2 Press [Video Process], turning it on.

3 Adjust the following parameters.

To return adjustment values to their defaults
Press [Unity].

Knob Parameter Adjustment Setting values

1 AUX Bus AUX bus selection 1 to 48

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain –200.00 to +200.00

2 Y Gain Luminance signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Black level –7.31 to +109.59
AUX Menu Operations
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Status Menu

The Status menu shows the following information.
• Operating status of the DME

Viewing the DME operating status
To view the DME operating status, press the top menu selection button 
[STATS] in the menu control block.
This selects VF1 ‘DME Status’ and the Status menu appears.

For each DME channel, you can see how the DME is being used in the 
corresponding operation block.
The display background color also indicates the following differences in the 
way in which a DME is being used.
Blue: The DME is currently being used in other than the final program output.
Red: The DME is currently being used in the final program output.

DME status display
407Status Menu
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Router Control Menu Operations

Using the Router >Router Control >Router Control menu, you can carry out 
router switching operations.

Checking the List of Inputs for Each Destination

You can check the list of signals currently input for each destination.

1 In the menu control block, press the top menu selection button [RTR], then 
select VF1 ‘Router Control’ and HF1 ‘Router Control.’

2 The following menu appears, and the left side of the status area shows a 
list for destination assignments.

If in the Assign >RTR Mode Setting menu, [Inhibit] is set to On for a 
destination, the corresponding line appears in gray. Also, if [PROT] (protect) 
is set to ON for a source, using a BKSR3xxx or R1xxx series Router remote 
control, a padlock icon appears.
The right side of the status area shows the level assignment status to the Level 
1 to Level 4 buttons.

Selecting the level
In the Level Button No group at the lower right in the above illustration, press 
the selected level for switching.
Router Control Menu Operations
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Switching the Source for Each Destination

You can switch the source for each destination with a menu operation.

For the assignment of destinations and sources to buttons, use the Setup 
>Panel >Aux Assign >RTR Mode Setting menu.  For details, refer to “Using 
the Auxiliary Bus Control Block for Router Control” in Chapter 19 (Volume 3).

1 Press [Change Xpt].

The Router >Router Control >Router Control >Change Xpt menu appears.
Destination Select buttons appear in groups of 16.
Source Select buttons appear by group (maximum 24 buttons).

2 Press one of the Destination Select buttons, to select the destination for 
which you want to switch the source.

To change the group
Press one of the [1-16], [17-32], [33-48], and [49-64] buttons.

3 Press one of the Source Select buttons, to select the source you want to 
switch.

To change the group
Press one of the [1-24], [25-48], ... [97-120], and [121-128] buttons.
409Router Control Menu Operations
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Video Process

The term “video process” is applied to adjustments to the luminance and hue 
of the input video signal.
There are two types of adjustment, depending on the application:
• Adjustment of an individual primary input signal
• Image effects on a particular bus

Note
These types of adjustment may be carried out independently. However, since 
they are implemented by the same hardware, if the same signal is subjected to 
processing twice, there may be limitations on the range of effects obtained in 
the final result.

Video Process Adjustments of a Primary Input Signal

For each of primary inputs 1 to 49, you can switch video process adjustments 
on or off, and can adjust the parameters (Video Gain, Y Gain, C Gain, Hue 
Delay, and Black Level) in the Setup menu. The adjustments do not, however, 
apply to the output video on the MON (monitor) bus.

For details of the settings, see “Signal Input Settings” in Chapter 20 (Volume 
3).

Video Process Adjustments on a Particular Bus

Buses to which the adjustments apply
For each of the following buses, you can switch video process adjustments on 
or off, and adjust the parameters.
• Following buses in the M/E-1 to M/E-3, and PGM/PST banks

– Key fill buses for keys 1 to 4
– Background A and background B buses
– Utility bus

• Frame memory source 1 and frame memory source 2 buses
• Aux 1 to 48 buses
These settings also apply to keyframes and snapshots.
Video Process
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Making the adjustments
Adjust VIDEO GAIN, Y GAIN, BLACK LEVEL, C GAIN, and HUE DELAY 
in the following menus.

Video Process Memory

When using video process adjustments for an image effect on a bus, this 
function saves the final values for each pair number for the signals. The video 
process on/off setting is not saved.
When you change the adjustments the values are automatically saved, and 
these last values are recalled when the pair number is selected.
In other words, by switching video process memory on, regardless of the video 
process information for each bus, you can carry out video process adjustments 
for each input signal.
The parameters saved are as follows.

VIDEO GAIN, Y GAIN, BLACK LEVEL, C GAIN, HUE DELAY

Switch the video process memory on or off in the Setup menu.

For details of setting operations, see “Settings Relating to Keys, Wipes, Frame 
Memory and Color Correction (Key/Wipe/FM/CCR Menu)” in Chapter 20 
(Volume 3).

Applicable bus Menu used for operation See page

M/E-1 to M/E-3 
banks

Key fill buses for keys 
1 to 4

M/E-1 to M/E-3 menus page 228

Background A and B 
buses

Video Process menu page 412

Utility bus

PGM/PST bank Key fill buses for 
DSK1 to DSK4

PGM/PST menu page 228

Background A and B 
buses

Video Process menu page 412

Utility bus

Frame memory source 1 and 2 buses Frame Memory menu page 350

Aux 1 to 48 buses AUX/MON menu page 406
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Video Process Settings

This section describes operations on the M/E-1 to M/E-3, and PGM/PST 
background A and B buses, and utility buse.
For these operations, use the Misc >Video Process menu in the respective 
operating bank.

For video process settings on other buses, see the following.

• Settings for a particular input signal: “Signal input settings” in Chapter 20 
(Volume 3)

• Key fill bus settings: “Video Processing” (page 228)
• Settings for frame memory source buses 1 and 2: “Setting video processing” 

(page 350)
• Settings for Aux 1 to 48 buses: “Making video process settings for an AUX 

bus” (page 406)
• Overview of video process: “Video Process” (page 410)

This section describes an example on the background A bus of the M/E-1 bank. 
For the background B bus or utility bus, make the adjustment with a similar 
procedure.

Making video process settings for each bus

1 In the menu control block, press the top menu selection button [M/E1] and 
select VF7 ‘Misc’ and HF2 ‘Video Process.’

2 In the <Bkgd-A> group, press [Video Process], turning it on.

3 Adjust the following parameters.

To return the parameter settings to the defaults
Press [Unity] in the <Bkgd-A> group.

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain –200.00 to +200.00

2 Y Gain Luminance signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Black level –7.31 to +109.59
Video Process Settings
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Preparations

The color corrector enables video signal color correction (black balance/white 
balance adjustment, gamma correction, knee correction, etc.).

Note
To use the color corrector BZS-6420 Color Corrector Software and MKS-
8442G Frame Memory Board required. To use the software, you are required 
to input an install key.

For the method of inputting an install key, see “Installation and Device Setup 
(Install/Unit Config Menu)” in Chapter 18 (Volume 3).

Note on using a format other than 720P
• When using the color corrector on a 2M/E and simple P/P system
It is not possible to use an M/E reentry signal in an overlaid manner on the key 
bus or utility bus.

Example : When M/E-1 is selected on the M/E-2 background A bus (or 
background B bus, key bus, utility bus), it is not possible to select M/
E-2 on the PGM/PST key bus.

Note on using 720P format
The following restrictions apply depending on the system configuration.

• When using the color corrector on a 2M/E and simple P/P system 
M/E reentry signals cannot be selected on the key bus and utility 1 bus. For 
example, you cannot select M/E-1 on the M/E-2 key bus or utility 1 bus.

• When not using the color corrector
It is not possible to use an M/E reentry signal in an overlaid manner on the key 
bus or utility 1 bus.

Example : When M/E-1 is selected on the M/E-2 background A bus (or 
background B bus, key bus, utility bus), it is not possible to select M/
E-2 on the PGM/PST key bus.

Assigning the color corrector input buses to AUX delegation 
buttons

There are two inputs for capturing material to the color corrector: the CCR1 
bus and the CCR2 bus.

For details of the input assignment operation, see “Auxiliary Bus Control 
Block Settings (Aux Assign Menu)” in Chapter 19 (Volume 3).
Preparations
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Selecting the color correction input signal

After assigning CCR1 and CCR2 to AUX buses, use the following procedure.

1 Press the AUX delegation buttons assigned to CCR1 (or CCR2).

2 In the cross-point button row, select the signal to which you want to apply 
color correction.

Note
The signals you can select on the CCR1 and CCR2 buses are limited to the 
primary inputs and frame memory outputs (FM1 to FM8). However you 
can make all the internal signals of the switcher selectable by a setting in 
the Setup menu.

For details, see “Selecting the Bank to Make the Settings” in Chapter 20 
(Volume 3).

Selecting the color corrector output signal
By assigning the signal output from the color corrector to a cross-point button, 
you can make that signal available on that button.

For details of the assignment process, see “Cross-Point Settings (Xpt Assign 
Menu)” in Chapter 19 (Volume 3).

Accessing the CCR menu
For color correction operations, use the CCR menu.
To access the CCR menu, in the menu control block, press the top menu 
selection button [CCR].
The following description uses CCR1 as an example. To apply color correction 
to CCR2, replace VF1 ‘CCR1’ by VF2 ‘CCR2,’ and follow the same 
procedure.
415Preparations
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Overall Color Corrector Operations

Enabling Color Corrector

To enable the functions of color corrector 1, for example, use the following 
procedure.

1 In the CCR menu, press VF1 ‘CCR1’ and any HF.

2 In the <CCR> group, press [CCR], turning it on.

This enables the functions of color corrector 1.

Returning all color corrector settings to their defaults

1 In the <CCR> group, press [Unity].

A confirmation message appears.

2 Press [Yes].

This returns all color corrector settings to their defaults, whether [CCR] is 
on or off.

Copy and Swap Operations

Copying color corrector data

1 In the CCR menu, press VF3 ‘Copy/Swap.’

The Copy/Swap menu appears.
The status area shows a copy source list on the left and a copy destination 
list on the right.

2 Using any of the following methods, select the copy source data and copy 
destination data.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.
Overall Color Corrector Operations
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3 Press [Copy].

This carries out the copy.

Swapping color corrector data
Refer to the procedure described in the previous item “Copying color corrector 
data.” In step 3, press [Swap] instead of [Copy].

To undo copy or swap 
In the Copy/Swap menu, press [Undo].
The state before carrying out the copy or swap is restored.

Knob Parameter Adjustment Setting values

1 Left No Select copy source data 1 or 2

2 Right No Select copy destination 
data

1 or 2
417Overall Color Corrector Operations
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Color Corrector Functions

This section describes the color corrector functions.
For each of the following operations, it is possible to copy or swap data 
between two color correctors (CCR1 and CCR2).

Input Video Processing Operations

Carry out the following corrections to a YUV signal before conversion to an 
RGB signal.
• Overall gain adjustment of the video signal
• Gain adjustment of the Y signal
• Gain adjustment of the C signal
• Hue delay
• Black level adjustment

To apply input video processing effects, use the following procedure.

1 In the CCR menu, press VF1 ‘CCR1’ and HF1 ‘Input Process.’

The Input Process menu appears.

2 In the <Input Process> group, press [Input Process], turning it on.

3 Adjust the following parameters.

To return the parameters to their default settings
Press [Unity] in the <Input Process> group.

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain –200.00 to +200.00

2 Y Gain Y signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Black level –116.90 to +116.90
Color Corrector Functions
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Carry out the following corrections to each of the R, G, and B signals.
Black balance adjustment: setting the output level for a 0% level input signal.
White balance adjustment: setting the output level for a 100% level input 

signal.
Gamma correction: adjusting the curvature of the gamma curve.
Knee correction: adjusting the position of the maximum point of the gamma 

curve.

It is also possible to mask part of the region to be corrected.

Applying primary color correction

1 In the CCR menu, press VF1 ‘CCR1’ and HF2 ‘Primary CCR.’

The Primary CCR menu appears.

2 In the <Primary CCR> group, press [Primary CCR], turning it on.

3 In the <Primary CCR Adjust> group, select the setting item.

Black: black balance adjustment
White: white balance adjustment
Gamma: gamma correction
Knee: knee correction

Output level

Black balance adjustment

White balance adjustment

Input level

Unadjusted signal

Input level

Output level

Knee correction

Gamma 
correction

Adjusted signal
419Color Corrector Functions
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4 Depending on the selection in step 3, adjust the following parameters.

• When Black or Gamma is selected

• When White is selected

• When Knee is selected

To return the parameters to their default settings
In the <Primary CCR> group, press [Unity].

Masking a part of the primary color correction
Here the procedure for mask 1 operation is described by way of example. You 
can carry out mask 2 operation in a similar way.

1 In the <Primary Mask> group of the Primary CCR menu, press [Mask1], 
turning it on.

2 Press [Mask1 Adjust].

The Mask1 Adjust menu appears.

3 In the <Mask Source> group, select the mask source.

Box: signal from dedicated box generator
Pattern: signal from dedicated pattern generator

Knob Parameter Adjustment Setting values

1 Red Red signal adjustment –100.00 to +100.00

2 Green Green signal adjustment –100.00 to +100.00

3 Blue Blue signal adjustment –100.00 to +100.00

4 All Simultaneous RGB adjustment Red value is shown

Knob Parameter Adjustment Setting values

1 Red Red signal adjustment 0.00 to 200.00

2 Green Green signal adjustment 0.00 to 200.00

3 Blue Blue signal adjustment 0.00 to 200.00

4 All Simultaneous RGB adjustment Red value is shown

Knob Parameter Adjustment Setting values

1 Red Red signal adjustment 20.00 to 75.00

2 Green Green signal gain 20.00 to 75.00

3 Blue Blue signal gain 20.00 to 75.00

4 All Simultaneous RGB adjustment Red value is shown
Color Corrector Functions
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4 Depending on the selection in step 3, adjust the following parameters.

• When Box is selected

• When Pattern is selected

For the pattern selection, you can also press [Mask Ptn Select] in the 
Mask1 Adjust menu, then use the Mask Ptn Select menu.
Press any of the displayed patterns (1 to 24) to select it, then you can adjust 
the following parameters.

5 When selecting the pattern as a mask source, set the pattern modifiers as 
required.

• When turning [Position] on and setting the pattern position

a) See “Setting the wipe position (Positioner)” (page 273).

• When turning [Multi] on and replicating the same pattern

Knob Parameter Adjustment Setting values

1 Top Top position –100.00 to +100.00

2 Left Left position –100.00 to +100.00

3 Right Right position –100.00 to +100.00

4 Bottom Bottom position –100.00 to +100.00

5 Soft Degree of softness of box 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of softness of pattern 
edge

0.00 to 100.00

5 Pattern Pattern number 1 to 24

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of softness of pattern 
edge

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –200.00 to +200.00 a)

2 Position V Vertical position –200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of repetitions of pattern 
horizontally

1 to 63
421Color Corrector Functions
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a) See “Setting the wipe pattern replication (Multi)” (page 277).

• When turning [Aspect] on and setting the aspect ratio of the pattern

a) See “Setting the wipe pattern aspect ratio (Aspect ratio)” (page 276).

• When turning the [Angle] on in the <Rotation> group and slanting 
the pattern

a) See “Angle” (page 274).

• When turning [Speed] on in the <Rotation> group and rotating the 
pattern at a fixed rate

a) See “Speed” (page 275).

6 To invert the mask source, return to the Primary CCR menu and press 
[Mask Invert], turning it on.

Note
The mask function is common to the primary color correction, secondary color 
correction luminance processing, and spot color adjustment functions. For 
example, if in primary color correction you set mask 1 to a box, then in 
secondary color correction set mask 1 to a pattern, this also changes the setting 
in primary color correction to the pattern.

Secondary Color Correction Operations

For the six colors R (red), G (green), B (blue), Y (yellow), C (cyan), and M 
(magenta), adjust the luminance and saturation, and also the hue within a range 
of ±30 degrees of the center value for each color.

2 V Multi Number of repetitions of pattern 
vertically

1 to 63

3 Invert Type Replication layout 1 to 4 a)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Aspect aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern rotation –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of pattern –100.00 to +100.00 a)
Color Corrector Functions



  C
hapter 9 

C
olor C

orrector

You can mask a part of the region to be corrected.

Applying secondary color correction

1 In the CCR menu, select VF1 ‘CCR1’ and HF3 ‘Secondary CCR.’

The Secondary CCR menu appears.

2 In the <Secondary CCR> group, press [Secondary CCR], turning it on.

3 In the <Secondary CCR Adjust> group, select the color for which you 
want to make the setting.

4 Adjust the following parameters.

To return the parameter settings to their default values
In the <Secondary CCR> group press [Unity].

Masking a part of the secondary color correction
In the <Secondary Mask> group, press [Mask1] or [Mask2], turning it on, then 
carry out the same operation as described under “Masking a part of the primary 
color correction” (page 420).

RGB Clip Operations

For each of the R, G, and B signals, you can make dark clip and white clip 
adjustments.

Making RGB clip adjustments

1 In the CCR menu, press VF1 ‘CCR1’ and HF4 ‘RGB Clip.’

The RGB Clip menu appears.

2 In the <RGB Clip> group, press [RGB Clip], turning it on.

Knob Parameter Adjustment Setting values

1 Luminance Luminance –100.00 to +100.00

2 Saturation Saturation 0.00 to 200.00

3 Hue Delay Hue delay –180.00 to +180.00
423Color Corrector Functions
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3 In the <RGB Clip Adjust> group, select the item you want to adjust.

Dark: dark clip adjustment
White: white clip adjustment

4 Adjust the following parameters.

a) When Dark is selected
b) When White is selected

To return the parameters to their default settings
In the <RGB Clip> group, press [Unity].

Luminance Processing Operations

After converting a signal to which RGB color correction has been applied to a 
YUV signal, divide the luminance levels into three regions, referred to as Dark, 
Middle, and Bright, and apply video signal adjustments to these regions.

There are three modes for luminance processing, as follows.
Tint mode: adding a specified color to the original video signal.
Color Modify mode: adjusting the original video signal.
Y Modify mode: adjusting the output levels of the input luminance signal.

• White balance adjustment: setting the output level for an input 
luminance signal at the 100% level.

• Black balance adjustment: setting the output level for an input 
luminance signal at the 0% level.

Knob Parameter Adjustment Setting values

1 Red Red signal adjustment –50.00 to +149.99 a)

–49.99 to +150.00 b)

2 Green Green signal adjustment –50.00 to +149.99 a)

–49.99 to +150.00 b)

3 Blue Blue signal adjustment –50.00 to +149.99 a)

–49.99 to +150.00 b)

4 All Simultaneous RGB adjustment Red value is shown

Under Dark point Middle/Dark point Bright/Middle point Over Bright point

Dark Middle Bright

Input signal 
luminance level
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• Y lift correction: adjusting the curvature of the curve.
• Y dark correction: adjusting the position of the maximum point of the 

curve.

It is also possible to mask part of the region to be corrected.

Applying luminance processing

1 In the CCR menu, press VF1 ‘CCR1’ and HF5 ‘Luminance Process.’

The Luminance Process menu appears.

2 In the <Luminance Process> group, press [Luminance Process], turning it 
on.

3 In the <Mode> group, specify the adjustment mode.

Tint: add a specified color to the original video signal.
Color Modify: adjust the original video signal.
Y Modify: adjust the output levels of the input luminance signal.

When tint mode or color modify mode is selected, skip to step 4.
When Y modify mode is selected, adjust the following parameters.

Output signal 
luminance level

Black balance adjustment

White balance adjustment

Input signal 
luminance 
level

Unadjusted signal

Input signal 
luminance 
level

Output signal luminance level

Y Dark

Adjusted signal

Y Lift

Knob Parameter Adjustment Setting values

1 White White balance adjustment 0.00 to 200.00

2 Black Black balance adjustment –100.00 to +100.00
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4 In the <Bound> group, make the settings for the three regions (Dark, 
Middle, and Bright).

• [Level] parameters: set the boundaries of the three regions.

• [Soft] parameters: set the degree of boundary softness of the three 
regions.

5 In the <Luminance Process Adjust> group, press [Dark], [Mid], or 
[Bright], and adjust the following parameters for the three regions.

• In tint mode

• In color modify mode

3 Y Lift Curvature of curve –100.00 to +100.00

4 Y Dark Position of maximum point of 
curve

–7.31 to +109.59

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Over B Level Luminance level of the Over 
Bright point

50.00 to 150.00

2 Mid B Level Luminance level of the Bright/
Middle point

10.00 to 120.00

3 Dark Mid 
Level

Luminance level of the Middle/
Dark point

–20.00 to +90.00

4 Under D 
Level

Luminance level of the Under 
Dark point

–50.00 to +50.00

Knob Parameter Adjustment Setting values

1 Over B Soft Degree of softness at Over Bright 
point

15.00 to 70.00

2 Mid B Soft Degree of softness at Bright/
Middle point

15.00 to 42.50

3 Dark Mid 
Soft

Degree of softness at Middle/Dark 
point

15.00 to 42.50

4 Under D Soft Degree of softness at Under Dark 
point

15.00 to 70.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance –100.00 to +100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
Color Corrector Functions
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To return the parameters to their default settings
In the <Luminance Process> group, press [Unity].

Masking a part of luminance processing
In the <Luminance Mask> group, press [Mask1] or [Mask2], turning it on, then 
carry out the same procedure as in “Masking a part of the primary color 
correction” (page 420).

Spot Color Adjustment

You can change the color of a specified color region to a different color, 
without affecting other regions. You can also mask part of such a region.
Then for the region other than the region whose color you have changed, you 
can make the following corrections.
• Video signal overall gain adjustment
• Y signal gain adjustment
• Y signal offset adjustment
• C signal gain adjustment
• C signal hue adjustment

Adjusting the color of the specified region (key)

1 In the CCR menu, press VF1 ‘CCR1’ and HF6 ‘Spot CCR/Output.’

The Spot CCR/Output menu appears.

2 In the <Spot CCR> group, press [Spot CCR], turning it on.

3 In the <Auto> group, press [Sample Mark], turning it on.

Note
When [Sample Mark] is on, the effects of color adjustment outside the 
region of spot color adjustment (see page 429) and output video processing 
(see page 429) are temporarily disabled.
Turning [Sample Mark] off restores the former state.

Knob Parameter Adjustment Setting values

1 Luminance Luminance –100.00 to +100.00

2 C Gain Chrominance signal gain 0.00 to 200.00

3 Hue Delay Hue delay –180.00 to +180.00
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4 Adjust the parameters so that the color you want to change is included 
within the sample mark.

5 In the <Auto> group, press [Auto Start], to adjust the key automatically.

Note
This automatic adjustment does not carry out key gain adjustment. If 
required, adjust the key gain as shown in step 6.

6 Press [Key Adjust], and adjust the following parameters.

7 Press [Window], turning it on, to adjust the key detection range for spot 
color adjustment.

8 In the <Spot CCR> group, press [Spot CCR] to display the parameters, and 
adjust the replacement color.

.

To return the parameters to their default settings
In the <Spot CCR> group, press [Unity].

Knob Parameter Adjustment Setting values

1 Position H Horizontal position –100.00 to +100.00

2 Position V Vertical position –100.00 to +100.00

3 Size Size 1.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance –7.31 to +109.59

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

4 Gain Key gain –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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Masking a part of the spot color adjustment

In the <Spot CCR Mask> group, press [Mask1] or [Mask2], turning it on, then 
carry out the same procedure as in “Masking a part of the primary color 
correction” (page 420).

Adjusting the color outside the spot color adjustment region

1 In the Spot CCR/Output menu, press [Outer Out Proc] in the <Outer Out 
Proc> group, turning it on.

2 Adjust the following parameters.

To return the parameters to their default settings
In the <Outer Out Proc> group, press [Unity].

Output Video Processing Operations

Carry out the following corrections are available on the YUV signal.
• Video signal overall gain adjustment
• Y signal gain adjustment
• Y signal offset adjustment
• C signal gain adjustment
• C signal hue adjustment

Applying output video processing effects

1 In the CCR menu, press VF1 ‘CCR1’ and HF6 ‘Spot CCR/Output.’

The Spot CCR/Output menu appears.

2 In the <Output Process> group, press [Output Process], turning it on.

3 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain –200.00 to +200.00

2 Y Gain Y signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Black level –116.90 to +116.90
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To return the parameters to their default settings
In the <Output Process> group, press [Unity].

YUV Clip Operations

For each of the luminance and color difference signals, the following 
processing is available.
White clip: setting the maximum level of the luminance signal.
Dark clip: setting the minimum level of the luminance signal.
Positive clip: setting the maximum amplitude in the positive direction of the 

color difference signal.
Negative clip: setting the maximum amplitude in the negative direction of the 

color difference signal.

Applying YUV clip processing

1 In the CCR menu, press VF1 ‘CCR1’ and HF7 ‘YUV Clip.’

The YUV Clip menu appears.

2 In the <YUV Clip> group, press [YUV Clip], turning it on.

3 In the <YUV Clip Adjust> group, select the target for adjustment.

Luminance: settings for the luminance signal.
Chroma: settings for the color difference signal.

4 Depending on the selection in step 3, adjust the following parameters.

• When Luminance is selected

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain –200.00 to +200.00

2 Y Gain Y signal gain –200.00 to +200.00

3 C Gain Chrominance signal gain –200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black Level Black level –116.90 to +116.90

Knob Parameter Adjustment Setting values

1 White Clip White clip adjustment –6.85 to +109.13

2 Dark Clip Dark clip adjustment –6.85 to +109.13
Color Corrector Functions
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• When Chroma is selected

To return the parameters to their default settings
In the <YUV Clip> group, press [Unity].

Knob Parameter Adjustment Setting values

1 U Posi Clip Positive clip adjustment for U 
signal

–113.39 to +113.39

2 U Nega Clip Negative clip adjustment for U 
signal

–113.39 to +113.39

3 V Posi Clip Positive clip adjustment for V 
signal

–113.39 to +113.39

4 V Nega Clip Negative clip adjustment for V 
signal

–113.39 to +113.39
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Side Flags

Overview

The term “side flags” refers to the areas to left and right of an image with aspect 
ratio 4:3 embedded within a 16:9 frame, when these areas are filled with a 
separate image selected from the utility bus. 
You can adjust the width of the side flag area.

Side Flag Settings

Input source aspect ratio, auto side flags, and auto crop settings

Aspect ratio 4:3 setting
Set the input signal to aspect ratio 4:3. If set to 16:9, the side flags are disabled.

Auto side flag setting
This function automatically applies side flags when a 4:3 signal is selected in 
the cross-point control block.

Auto crop setting
When carrying out a DME wipe, this function automatically crops the image 
during transition to 4:3.

Adjusting the width of the side flag area
You can set the left and right sides separately.

For the operation for the above setting, see “Settings for Switcher 
Configuration (Config Menu)” in Chapter 20 (Volume 3).

Enabling and disabling side flags with a menu operation
You can enable or disable side flags for the backgrounds (A and B) of each of 
the M/E and PGM/PST banks. 
As an example, to enable side flags for background B row on the M/E-1 bank, 
use the following procedure.

1 In the menu control block, press the top menu selection button [MISC], 
then select VF1 ‘Enable’ and HF3 ‘Side Flags.’
Side Flags
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The Misc >Enable >Side Flags menu appears.
The status area shows the buttons for Bkgd A and Bkgd B for each of the 
M/E-1 to M/E-3, and PGM/PST (P/P) banks.

2 In the <M/E-1 Side Flags> group, press [Bkgd B].

Each time you press the button toggles between Enable and Disable.

To display a menu for the aspect ratio 4:3, auto side flags, and auto 
crop settings
In the Misc >Enable >Side Flags menu, press [Setup >SWER >Side Flags].

To display a menu for assigning the side flags on/off function to a 
cross-point button
In the Misc >Enable >Side Flags menu, press [Side Flags Button Assign].

Enabling and disabling side flags with a button operation
For example, to enable side flags for the background B row of the M/E-1 bank, 
use the following procedure.

1 First, in the Setup menu assign the rightmost cross-point button to the 
[SIDE FLAG] button.

For details of the assignment operation, see “Cross-Point Settings (Xpt 
Assign Menu)” in Chapter 19 (Volume 3).

2 Press the [SIDE FLAG] button at the right end of the background B row of 
the M/E-1 bank.

The button you pressed lights amber, and this enables the side flags.

Notes 
• The operations of enabling or disabling the side flags by menu operation 

and by control panel button operation are linked.
• When the auto side flags are on, selecting a 4:3 video material 

automatically lights the [SIDE FLAG] button, but if you press this 
button, turning it off, the side flags are temporarily disabled.
However, when you select a different 4:3 video material, the [SIDE 
FLAG] button automatically lights once again, enabling the side flags.

Creating an image with side flags
For example, to create an image with side flags in the background B row of the 
M/E-1 bank, use the following procedure.
435Side Flags
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1 In the M/E-1 bank cross-point control block, hold down the [UTIL] button, 
and in the background A row select the signal (utility bus signal) you want 
to insert in the side flag areas.

2 In the background B row, press the cross-point button corresponding to the 
4:3 video material.

At this point, if auto side flags are on, this automatically adds side flags to 
the 4:3 video material. (See “Settings for Switcher Configuration (Config 
Menu)” in Chapter 20 (Volume 3).)

3 Use either of the following methods to turn the side flags on.

• Use the Misc >Enable >Side Flags menu. (See page 434)
• Use a cross-point button operation. (See previous item.)

This adds side flags to the 4:3 video material.

Wipe Action on Images With Side Flags

When a wipe is carried out on an image with side flags, all wipe patterns can 
be used.
The following illustration shows the action in a wipe.

Wipe from a 4:3 image to a 16:9 image

Side flag areas

4:3 image (Side flags on)

16:9 image
Side Flags
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Wipe from a 4:3 image to another 4:3 image (when side flags are 
on for both images)

DME Wipe Action for an Image With Side Flags

When a DME wipe is carried out on an image with side flags, all wipe patterns 
can be used.
Depending on the setting (On/Off) of [Auto Crop] in the Engineering Setup 
>Switcher >Config menu, the appearance of the 4:3 image changes.
• For signals with the following DME wipe pattern selected on the DME 

external video bus (gray part shown in the pattern illustration), side flags are 
not applied when auto side flags are set to Off.
– Two-channel frame in-out
– Two-channel brick

The following illustration shows the action in a DME wipe.

Side flag areas

4:3 image (Side flags on) The circles indicate the 
position of the wipe pattern 
edge when the transition is 
half finished.

Side flag areas
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DME wipe from a 4:3 image to a 16:9 image

Wipe action using slide (No. 1001)

DME wipe from a 4:3 image to another 4:3 image (when side flags 
are on for both images)

Wipe action using squeeze (No. 1031)

Auto crop on

4:3 image (Side flags on)

Auto crop off
Side flag area

16:9 image

Side flag areas

Auto crop on

4:3 image (Side flags on)

Auto crop off
Side flag areas a)

4:3 image (Side flags on)

Side flag areas

Side flag areas
Side Flags
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Simple P/P Software

Overview

By installing the BZS-6250 Simple P/P Software in the MVS-6000 Switcher 
Processor, you can use a separate program/preset function without using the M/
E hardware.

Getting access to the software
To use the Simple P/P Software, you are required to enter an install key which 
validates the software. (If the software has been factory installed, the install key 
is not required.)
For the method of obtaining an install key, contact your Sony representative. 
On that occasion, you may be required to submit the unique device ID of the 
switcher you are using. You can check the unique device ID in the Install menu 
of the switcher. For details of operating procedures, see “Installation and 
Device Setup (Install/Unit Config Menu)” in Chapter 18 (Volume 3).

Restrictions on Use

Since this software is a simple version of the program/preset function, there are 
some restrictions on use. The following lists the points at which operation is 
different from a normal program/preset function. For details of the normal 
operations, set the relevant sections of this manual.

Restrictions on using a downstream key
• DSK3 and DSK4 cannot be used.

For the key priority, set priority 1 or priority 2.
• The following downstream key types cannot be used.

– Chroma key
– Color vector key
– Key wipe pattern key

• When using a matte as the key fill for a downstream key, a mix color cannot 
be used.

• It is not possible to modify a downstream key edge. The edge blink also 
cannot be used.

• For a downstream key, mask cannot be used.
439Simple P/P Software
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• A processed key cannot be used. Therefore, it is not possible to apply a DME 
effect to a downstream key.

• As an independent key transition type, wipe and DME wipe cannot be used.
• The resizer cannot be used. 
• The key frame delay mode cannot be used. 

Restrictions on executing transitions in the transition control 
block

• Wipes can be used, but there are restrictions on use. For details, see the next 
item, “Restrictions when using wipes.”

• You can use a DME wipe for a background transition only. For details, see 
“Restrictions when using DME wipes” (page 440).

Restrictions when using wipes
• The wipe patterns that can be used are pattern numbers 1 to 24 only.
• When a border or soft border is selected for a wipe edge, the signal to be 

inserted in the edge (edge fill) is restricted as follows.
– The utility bus cannot be selected.
– When using a matte, a mix color cannot be used.

Restrictions when using DME wipes
• You can use a DME wipe for a background transition only.
• The patterns that can be selected are as follows. (One-channel patterns only)
Slide/Squeeze: slide and squeeze
Door: door
Flip Tumble: flip tumble
Frame I/O/P in P: frame in-out, picture-in-picture
Mosaic/Defocus: mosaic and defocus
Brick: brick

Notes
• For flip tumble, the background is filled with the same color as the wipe 

border matte (single color).
• Door patterns 1045 to 1048 cannot be used.

Restrictions on utility buses
The utility bus cannot be used.
Simple P/P Software
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Assignment of signals to output connectors

Note
The output connector OUT24 cannot be used.

Connectors to which the P/P row output signal assignment is fixed
The assignment of the following signals to output connectors OUT17 to OUT2
2 is fixed. 
Except for Preset, you can select these signals on the AUX bus for output.

a) Depends on the setting in the Engineering Setup >Switcher >Config >M/E Output Assign menu. 

Logical assignment of the physical PGM/PST
In the Engineering Setup >Switcher >Config >Logical M/E Assign menu, it is 
not possible to assign the physical PGM/PST as a logical PGM/PST.
In the <Logical M/E to Physical P/P> group, you can select from M/E-1, M/E-
2, and M/E-3.

Configuration of the switcher bank outputs
If Multi Program mode is selected in setup (M/E Config in the Switcher 
>Config menu), then for Bkgd in the PGM Config menu, it is only possible to 
select Clean.

Assigning a simple P/P re-entry signal to a primary input
When returning output from a simple P/P to a primary input, use the following 
procedure to set where the signal returns.

1 In the Switcher >Output menu, select [Output Assign] and press [Simple 
P/P Re-Entry Assign].

The Simple P/P Re-Entry Assign menu appears.

Output 
connector

Fixed assigned outputs

Standard mode Multi-program mode

OUT17 Program P/P OUT1 a)

OUT18 Program P/P OUT1 a)

OUT19 Preview P/P OUT2 a)

OUT20 Clean P/P OUT3 a)

OUT21 Key preview P/P OUT4 a)

OUT22 Preset Preset
441Simple P/P Software
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The status area shows the output ports and assigned primary inputs on the 
left, and a list of primary inputs that can be assigned on the right.

2 Using any of the following methods, select the output port number and 
signal to be assigned.

• Press directly on the list in the status area to make the selection.
• Press the arrow keys to scroll the reverse video cursor.
• Turn the knobs.

3 Press [Set].

This assigns the primary input to the selected output port.

To clear a primary input assignment
Press [Inhibit].
This clears the assignment and “No Assign” is displayed in the Re-Entry 
column.

Simple P/P Output Signal Selection on an M/E

You can select a simple P/P output on an M/E.

Preparations

Interface connection
Connect the simple P/P output signal to return to a primary input via a BNC 
cable.

System setup
In the Engineering Setup >Switcher >Output >Simple P/P R-Entry Assign 
menu, specifies the primary input to which the simple P/P output signal returns.

Selecting the input on an M/E bank
Select a primary input on the cross-point control block of an M/E bank. You 
can select a simple P/P output signal with the same phase as that of the other 
input signals.

Knob Parameter Adjustment Setting values

V1 Output No. Output port number 1 to 23

V2 Source No. Primary input number 0 to 49
Simple P/P Software



Appendix (Volume 1)
Wipe Pattern List .....................................................................................444
DME Wipe Pattern List ...........................................................................445

DME Wipe Patterns Available in One-Channel Mode .....................445
DME Wipe Patterns Available in Two-Channel Mode .....................449

Resizer DME Wipe Pattern List .............................................................452
Menu Tree .................................................................................................454

Recalling Menus ................................................................................454
M/E-1 to M/E-3 Menus .....................................................................454
PGM/PST Menu ................................................................................457
Frame Memory Menu ........................................................................459
Color Bkgd Menu ..............................................................................460
AUX/MON Menu ..............................................................................460
CCR Menu .........................................................................................461
Copy/Swap Menu ..............................................................................462
Misc Menu .........................................................................................462
Status Menu .......................................................................................462
DME Menu ........................................................................................463
Global Effect Menu ...........................................................................464
Device Menu .....................................................................................464
Macro Menu ......................................................................................465
Key Frame Menu ...............................................................................466
Effect Menu .......................................................................................467
Snapshot Menu ..................................................................................468
Shotbox Menu ...................................................................................469
File Menu ..........................................................................................470
Engineering Setup Menu ...................................................................471
Diagnostic Menu ...............................................................................475



  A
ppendix (V

olum
e 1)

444
Wipe Pattern List

1 2 3 4

5 6 7 8

9 10 11 12

13 14 15 16

17 18 19 20

21 22 23 24
Wipe Pattern List
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DME Wipe Pattern List

DME Wipe Patterns Available in One-Channel Mode

Slide

Squeeze

1001 1002 1003 1004

1005 1006 1007 1008

1021 1022 1023 1024

1025 1026 1027 1028

1029 1030 1031
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Door

2D trans

1041 1042 1043 1044

1045 1046 1047 1048

1051 1052 1053 1054

1055 1056 1057 1058

1061 1062 1063 1064

1068
DME Wipe Pattern List
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3D trans

Flip tumble

1071 1072 1074 1076

1077 1088 1091 1092

1093 1094

1101 1102 1103 1104

1124 1131 1132 1133

1135

1109 1110 1121 1122
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Frame in-out

Picture-in-picture

Mosaic

Defocus

1201 1202 1203 1204

1221 1222 1223 1224

1205 1206 1207 1208

1251

1701

1702
DME Wipe Pattern List
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User programmable DME
The illustrations for patterns 1901 to 1999 show an effect register number or 
register name.

DME Wipe Patterns Available in Two-Channel Mode

Slide

Squeeze

1901 1999

2601 2602 2603 2604

2605 2606 2607 2608

2621 2622 2623 2624

2625 2626 2627 2628
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3D trans

Picture-in-picture

Brick

2631 2632 2633 2634

2642 2644

2651 2652

2801 2802 2803 2804

2811 2812 2813 2814
DME Wipe Pattern List
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Frame in-out

User programmable DME
The illustrations for patterns 2901 to 2999 show an effect register number or 
register name.

2851 2852 2853 2854

2861 2862 2863 2864

2901 2999
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Resizer DME Wipe Pattern List

Slide

Squeeze

7001 7002 7003 7004

7005 7006 7007 7008

7021 7022 7023 7024

7025 7026 7027 7028

7029 7030 7031
Resizer DME Wipe Pattern List
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Frame in-out

7201 7202 7203 7204

7221 7222 7223 7224

7205 7206 7207 7208
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Menu Tree

Recalling Menus

This section details the menu structure, and shows the top menu selection 
buttons in the menu control block which are used to access the menus.

Menu control block

Some menus can also be accessed by pressing other buttons twice in rapid 
succession.

For more details, see “Menu Organization” (page 103).

Note
Some menus may not appear, depending on the model.

M/E-1 to M/E-3 Menus

The functions in the M/E-1, M/E-2, and M/E-3 menus are the same, but the 
menu page numbers are distinguished as follows.

M/E-1 menus: 11xx, M/E-2 menus: 12xx, M/E-3 menus: 13xx

EXT
DISPL

M/E
1

M/E
2

M/E
3

P/P

MENU
COPY

FRAME
MEM

COLOR
BKGD

AUX
/MON

COPY
SWAP

MISC

DME GLB
EFF

RTR DEV

KEY
FRAME

SNAP
SHOT

SHOT
BOX

MCRO

FILE USER
SETUP

ENG
SETUP

DIAG

PREFS
1

PREFS
2

PREFS
3

PREFS
4

PREFS
5

PREFS
6

PREFS
7

PREFS
8

Top menu selection buttons
Menu Tree



  A
ppendix (V

olum
e 1)
In this section, the numbers for the M/E-1 menus are given as examples.

M/E
1

M/E
2

M/E
3

M/E-1

HF1: Type (1111)

HF2: Edge (1112)a)

HF3: Main Mask (1113)

HF5: Processed Key (1115)

HF6: Transition (1116)

HF7: Video Process (1117)

Chroma Adjust (1111.1)

Matte Adjust (1111.2)

Key Priority (1173)

Matte Adjust (1112.1)

Zabton Adjust (1112.3)

Key Delay Mode (1112.4)

Mask Ptn Select (1113.1)

Monitor (1115.1)

Border/Crop (1115.2)a)

Resizer Process (1115.3)a)

Enhanced Effect (1115.4)a)

Wipe Adjust (1116.1)

DME Wipe Adjust (1116.3)

Mix Ptn Select (1112.2)

Pattern Select (1116.2)

Matte Adjust (1112.1)

Wipe Adjust (1116.1)

Mix Ptn Select (1112.2)

Pattern Select (1116.2)

Mix Ptn Select (1112.2)

Main Mask(1113)

Matte Adjust (1112.1)

Wipe Adjust (1116.1)

Pattern Select (1116.2)

Pattern Select (1116.4)
Remove From Begin 
(1116.7)

VF1: Key1

VF2: Key2

VF3: Key3

VF4: Key4

VF5: Wipe

VF6: DME Wipe

VF7: Misc

[M/E 1], [M/E 2], and [M/E 3] buttons

The functions in the Key 2 to Key 4 menus are the 
same as those in the Key 1 menu, with the following 
menu page numbers.
Key 2 menu: 112x, Key 3 menu: 113x, Key 4 menu: 
114x

to next page

a) For Key 1 and Key 2 menus only
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VF1: Key1

VF2: Key2

VF3: Key3

VF4: Key4

VF5: Wipe

VF6: DME Wipe

VF7: Misc

HF1: Main Pattern (1151)

HF4: Edge/Direction (1154)

HF5: Main Modify (1155)

HF7: Wipe Snapshot (1157)

HF1: 1ch (1161)

HF2: 2ch (1162)

HF4: Edge/Direction (1164)

HF5: Modify (1165)

HF7: DME Wipe Snapshot (1167)

HF1: Transition (1171)

HF2: Video Process (1172)

HF3: Key Priority (1173)

HF4: Next Key Priority (1174)

HF6: Clip Transition (1176)

HF7: Snapshot (1177)

Matte Adjust (1154.1)

Remove From Begin (1165.1)

Clip (1176.1)

Transition (1171)

Snapshot (1177)

Mix Pattern Select (1154.2)

M/E
1

M/E
2

M/E
3

M/E-1

[M/E 1], [M/E 2], and [M/E 3] buttons

to previous page
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PGM/PST Menu

HF1: Type (1411)

HF2: Edge (1412)a)

HF3: Main Mask (1413)

HF5: Processed Key (1415)

HF6: Transition (1416)

HF7: Video Process (1417)

Chroma Adjust (1411.1)

Matte Adjust (1411.2)

Key Priority (1473)

Matte Adjust (1412.1)

Zabton Adjust (1412.3)

Key Delay Mode (1412.4)

Mask Ptn Select (1413.1)

Monitor (1415.1)

Border/Crop (1415.2)a)

Resizer Process (1415.3)a)

Enhanced Effect (1415.4)a)

Wipe Adjust (1416.1)

DME Wipe Adjust (1416.3)

Pattern Select (1416.2)

Mix Ptn Select (1412.2)

Matte Adjust (1412.1)

Wipe Adjust (1416.1)

Mix Ptn Select (1412.2)

Pattern Select (1416.2)

Mix Ptn Select (1412.2)

Main Mask(1413)

Matte Adjust (1412.1)

Wipe Adjust (1416.1)

Pattern Select (1416.2)

Pattern Select (1416.4)

Remove From Begin 
(1416.7)

PGM/PST

P/P

VF1: DSK1

VF2: DSK2

VF3: DSK3

VF4: DSK4

VF5: Wipe

VF6: DME Wipe

VF7: Misc

[P/P] button

The functions in the DSK 2 to DSK 4 menus are the same as those in the DSK 
1 menu, with the following menu page numbers.
DSK 2 menu: 142x, DSK 3 menu: 143x, DSK 4 menu: 144x

to next page

a)For DSK 1 and DSK 2 menus only
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HF1: Main Pattern (1451)

HF4: Edge/Direction (1454)

HF5: Main Modify (1455)

HF7: Wipe Snapshot (1457)

HF1: 1ch (1461)

HF2: 2ch (1462)

HF4: Edge/Direction (1464)

HF5: Modify (1465)

HF7: DME Wipe Snapshot (1467)

HF1: Transition (1471)

HF2: Video Process (1472)

HF3: Key Priority (1473)

HF4: Next Key Priority (1474)

HF6: Clip Transition (1476)

HF7: Snapshot (1477)

Matte Adjust (1454.1)

Remove From Begin (1465.1)

Clip (1476.1)

Transition (1471)

Snapshot (1477)

Mix Pattern Select (1454.2)

PGM/PST

VF1: DSK1

VF2: DSK2

VF3: DSK3

VF4: DSK4

VF5: Wipe

VF6: DME Wipe

VF7: Misc

P/P [P/P] button

to previous page
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Frame Memory Menu

Frame Memory

VF1: Still

VF2: Clip

VF3: Reposition/Lock

VF4: File

VF5: Folder (2551)

VF6: External HDD

FRAME
MEM

HF1: Recall (2511)

HF2: Freeze/Store (2512)

HF3: Composite (2513)

HF4: Animation Record (2514)

HF5: Create Key Frame (2515)

HF1: Recall (2521)

HF2: Play (2522)

HF3: Record (2523)

HF4: Ancillary Enable (2525)

HF1: Reposition (2531)

HF2: Lock (2532)

HF1: Pair Recombination (2541)

HF4: Move (2544)

HF5: Delete (2545)

HF6: Rename (2546)

HF1: Format (2561)

HF2: Backup/Restore (2562)

Input Adjust (2513.1)

Pattern Adjust (2513.2)

Pattern Select (2513.3)

[FRAME MEM] button
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Color Bkgd Menu

AUX/MON Menu

Color Bkgd

VF1: Color Bkgd1 (2210) Mix Pattern Select (2210.1)

COLOR
BKGD

[COLOR BKGD] button

AUX
MON

Aux/Mon

VF1: Aux Bus (2311)

[AUX MON] button
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CCR Menu

HF1: Input Process (2411)

HF2: Primary CCR (2412)

HF3: Secondary CCR (2413)

HF4: RGB Clip(2414)

HF5: Luminance Process (2415)

HF6: Spot CCR/Output (2416)

HF7: YUV Clip (2417)

HF1: Input Process (2421)

HF2: Primary CCR (2422)

HF3: Secondary CCR (2423)

HF4: RGB Clip(2424)

HF5: Luminance Process (2425)

HF6: Spot CCR/Output (2426)

HF7: YUV Clip (2427)

Mask 1 Adjust (2412.1)

Mask 2 Adjust (2412.3)

Mask 1 Adjust (2412.1)

Mask 2 Adjust (2412.3)

Mask 1 Adjust (2412.1)

Mask 2 Adjust (2412.3)

 

Mask 1 Adjust (2412.1)

Mask 2 Adjust (2412.3)

Mask 1 Adjust (2422.1)

Mask 2 Adjust (2422.3)

Mask 1 Adjust (2422.1)

Mask 2 Adjust (2422.3)

Mask 1 Adjust (2422.1)

Mask 2 Adjust (2422.3)

 

Mask 1 Adjust (2422.1)

Mask 2 Adjust (2422.3)

Mask Ptn Select (2412.2)

Mask Ptn Select (2412.4)

Mask Ptn Select (2412.2)

Mask Ptn Select (2412.4)

Mask Ptn Select (2412.2)

Mask Ptn Select (2412.4)

Mask Ptn Select (2412.2)

Mask Ptn Select (2412.4)

Mask Ptn Select (2422.2)

Mask Ptn Select (2422.4)

Mask Ptn Select (2422.2)

Mask Ptn Select (2422.4)

Mask Ptn Select (2422.2)

Mask Ptn Select (2422.4)

Mask Ptn Select (2422.2)

Mask Ptn Select (2422.4)

VF1: CCR1

VF2: CCR2

VF3: Copy/Swap 
        (2431)

CCR

CCR

[CCR] button
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Copy/Swap Menu

Misc Menu

Status Menu

HF1: M/E (3111)

HF2: Key (3112)

HF3: Wipe (3113)

HF4: DME Wipe (3114)

HF5: Matte (3115)

HF6: Color (3116)

HF7: DME (3117)

HF1: Format Converter (3121)

VF1: Copy/Swap

VF2: Copy

COPY
SWAP

Copy/Swap

[COPY SWAP] button

VF1: Enable

VF2: Safe Title (3221)

VF3: Transition (3231)

MISC

Misc

HF1: Port Enable (3211)

HF2: Plug-In Editor (3212)

HF3: Side Flags (3213) Side Flags (7331.7)

Side Flags Button Assign (7322.10)

[MISC] button

VF1: DME Status (3311)

STATS

Status

[STATS] button
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DME Menu

DME

VF1: Edge

VF2: Video Modify

VF3: Freeze

VF4: Non-Linear

VF5: Light/Trail

VF6: Input/Output

VF7: Enhanced
         Video Modify

HF1: Defocus/Blur (4121)

HF2: Multi Move (4122)

HF3: Color Modify (4123)

HF4: Mosaic (4124)

HF7: Mask (4127)

HF1: Border/Crop (4111)

HF2: Beveled Edge (4112)

HF3: Key Border (4113)

HF4: Art Edge (4114)

HF5: Flex Shadow (4115)

HF6: Wipe Crop (4116)

HF7: Color Mix (4117)

Pattern Select (4116.1)

Mix Pattern Select (4117.1)

HF1: Freeze (4131)

HF1: Lighting (4151)

HF2: Trail (4152)

HF3: Motion Decay (4153)

HF4: KF Strobe (4154)

HF5: Wind (4155)

HF6: Spot Lighting (4156)

HF1: Bkgd (4161) 

HF2: Video/Key (4162) 

HF3: Process (4163) 

HF4: Graphic (4164)

HF1: Sketch (4171) 

HF2: Metal (4172) 

HF3: Dim & Fade (4173) 

HF4: Glow (4174) 

Mask(4127) 

Mask(4127) 

  

Mask(4127)

HF1: Type (4141)

DME

Wave (4141.1)

Mosaic Glass (4141.2)

Flag (4141.3)

Twist (4141.4)

Ripple (4141.5)

Rings (4141.7)

Broken Glass (4141.8)

Flying Bars (4141.9)

Blind (4141.10)

Split (4141.11)

Split Slide (4141.12)

Mirror (4141.13)

Multi Mirror (4141.14)

Texture Ptn Select (4156.1)

Copy/Swap (4156.2)

Light1 (4156.3)

Light2 (4156.5)

Light3 (4156.7)

Color Mix (4117) Mix Pattern Select (4117.1)

Light Color Adjust (4156.4)

Light Color Adjust (4156.6)

Light Color Adjust (4156.8)

Kaleidoscope (4141.15)

Lens (4141.16)

Circle (4141.17)

Panorama (4141.18)

Page Turn (4141.19)

Roll (4141.20)

Cylinder (4141.21)

Sphere (4141.22)

Explosion (4141.25)

Swirl (4141.26)

Melt (4141.27)

Character Trail (4141.28)

Mask (4127)

Mask (4127)

Mask (4127)

[DME] button
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Global Effect Menu

Device Menu

Global Effect

VF1: Ch1-Ch4a)

VF2: Ch5-Ch8

HF1: Combiner Priority (4211)

HF2: Brick (4212)

HF3: Shadow (4213)

HF7: Combine Gp Select (4217)

HF1: Combiner Priority (4221)

HF2: Brick (4222)

HF3: Shadow (4223)

HF7: Combine Gp Select (4227)

GLB
EFF

[GLB EFF] button

a)When using the MKS-6470 DME 
Board Set, the button is indicated 
as “VF1: Ch1-Ch2”.

VF1: GPI Timeline

VF2: P-Bus Timeline

VF3: DDR/VTR

HF1: GPI Timeline (5311)

HF1: P-Bus Timeline (5321)

HF1: Cueup & Play (5331)

HF2: Timeline (5332)

HF3: File List (5333)

Device

DEV

Rewind Action (5311.1)

Rewind Action (5321.1)

Rewind Action (5332.1) 

[DEV] button
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Macro Menu

MCRO

Macro

VF1: Register

VF2: Attachment (5421)

VF3: Menu Macro Register

VF4: Timeline

HF2: Lock (5412)

HF3: Copy (5413)

HF6: Delete (5416)

HF7: Rename (5417)

HF1: Recall & Run (5431)

HF2: Lock (5432)

HF3: Copy (5433)

HF6: Delete (5436)

HF7: Rename (5437)

HF1: Timeline (5441)

On Line Edit (7142.2)

Off Line Edit (7143.2)

Menu Macro Edit (7144.2)

Rewind Action (5441.1)

[MCRO] button
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Key Frame Menu

Key Frame HF1: Time Line (6111) 

HF3: Path (6113)

HF4: DME User PGM (6114)

HF5: Timeline Assign (6115)

HF7: Region Select (6117)

KEY
FRAME M/E-1 (6113.1)

M/E-2 (6113.2)

M/E-3 (6113.3)

P/P (6113.4)

User1 (6113.5)

User2 (6113.6)

User3 (6113.7)

User4 (6113.8)

User5 (6113.9)

User6 (6113.10)

User7 (6113.11)

User8 (6113.12)

DME 3D Trans Local (6113.13)

DME 3D Trans Global (6113.14)

DME Effect (6113.15)

DME Global Effect (6113.16)

10 Key Region Assign (7321.7)

[KEY FRAME] button
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Effect Menu

EFF
HF1: Store (6211)

HF2: Lock (6212)

HF3: Copy (6213)

HF4: Move (6214)

HF5: Swap (6215)

HF6: Delete (6216)

HF7: Rename (6217)

HF1: Attribute (6221)

HF2: Lock (6222)

HF3: Copy/Merge (6223)

HF4: Move (6224)

HF5: Swap (6225)

HF6: Delete (6226)

HF7: Rename (6227)

HF1: Attribute (6231)

HF2: Lock (6232)

HF3: Copy/Merge (6233)

HF4: Move (6234)

HF5: Swap (6235)

HF6: Delete (6236)

HF7: Rename (6237)

HF1: Attribute (6241)

HF2: Lock (6242)

HF3: Copy/Merge (6243)

HF4: Move (6244)

HF5: Swap (6245)

HF6: Delete (6246)

HF7: Rename (6247)

Edit (6211.1)

VF1: Master Timeline

VF2: Effect 1-99

VF3: Effect 101-199

VF4: Effect 201-299

Status (6200)

Effect

[EFF] button
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Snapshot Menu

Status (6300)

Xpt Hold (6321.1)

Clip Event (6321.2)

HF1: Attribute (6321) 

HF2: Lock (6322) 

HF3: Copy (6323) 

HF4: Move (6324) 

HF5: Swap (6325) 

HF6: Delete (6326) 

HF7: Rename (6327) 

Snapshot

VF1: Master Snapshot

VF2: Snapshot 

VF3: Wipe Snapshot

VF4: DME Snapshot  

VF5: Key Snapshot

SNAP
SHOT Edit (6311.1)

HF2: Lock (6332) 

HF3: Copy (6333) 

HF4: Move (6334) 

HF5: Swap (6335) 

HF6: Delete (6336) 

HF7: Rename (6337) 

HF1: Store (6311) 

HF2: Lock (6312)

HF3: Copy (6313)

HF4: Move (6314)

HF5: Swap (6315)

HF6: Delete (6316)

HF7: Rename (6317)

HF2: Lock (6342) 

HF3: Copy (6343) 

HF4: Move (6344) 

HF5: Swap (6345) 

HF6: Delete (6346) 

HF7: Rename (6347) 

HF1: Attribute (6351) 

HF2: Lock (6352) 

HF3: Copy (6353) 

HF4: Move (6354) 

HF5: Swap (6355) 

HF6: Delete (6356) 

HF7: Rename (6357) 

[SNAPSHOT] button
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Shotbox Menu

Shotbox

VF1: Register

VF2: Module Like Control

HF1: Store/Recall (6411) 

HF2: Lock (6412) 

HF3: Copy (6413) 

HF4: Move (6414) 

HF5: Swap (6415) 

HF6: Delete (6416) 

HF7: Rename (6417)

HF2: Bank1-4 

SHOT
BOX

Edit (6411.1)

[SHOTBOX] button
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File Menu

HF1: Setup (7111)

HF2: Initial Status (7112)

HF3: Key Memory (7113)

HF4: Video Proc Memory (7114)

HF1: Effect 1-99 (7121)

HF2: Effect 101-199 (7122)

HF3: Effect 201-299 (7123)

HF1: Snapshot (7131)

HF2: Wipe Snapshot (7132)

HF3: DME Snapshot (7133)

HF4: Key Snapshot (7134)

HF1: Shotbox (7141)

HF2: Macro (7142)

HF3: Macro Attachment (7143)

HF4: Menu Macro (7144)

HF1: Frame Memory (7151)

HF2: Frame Memory Folder (7152)

HF1: All (7161)

HF2: Import / Export (7162)

HF1: Directory (7171)

HF2: Unit ID Copy (7172)

HF3: Group ID Copy (7173)

File

VF1: Setup, Init, VK Mem

VF2: Effect

VF3: Snapshot

VF4: Shotbox, Macro

VF5: Frame Mem

VF6: All, External File

VF7: Configure

FILE

File Edit (7111.1)

File Edit (7112.1)

File Edit (7113.1)

File Edit (7114.1)

File Edit (7121.1)

File Edit (7122.1)

File Edit (7123.1)

File Edit (7131.1)

File Edit (7132.1)

File Edit (7133.1)

File Edit (7134.1)

File Edit (7141.1)

File Edit (7142.1)

File Edit (7143.1)

File Edit (7144.1)

 

File Edit (7151.1)

On Line Edit (7142.2)

Off Line Edit (7142.3)

Menu Macro Edit (7144.2)

[FILE] button
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Engineering Setup Menu

HF1: Network Config (7311) 

HF2: System Config (7312)

HF3: Format (7313)

HF4: Start Up (7314) 

HF5: Initialize (7315)

HF6: Install/Unit Config (7316)

HF7: Maintenance (7317)

Panel Assign (7312.1)

Switcher Assign (7312.2)

Aspect (7313.1)

Detail Information (7316.1)

License (7316.6)

Unit Config (7316.8)

Texture Package (7316.9)

Install (7316.10)

Setup Operation Lock (7317.1)

Switcher Aspect (7313.2)

DME Aspect (7313.3)

License Management (7316.7)

Engineering Setup

VF1: System

VF2: Panel

VF3: Switcher

VF4: DME

VF5: DCU

VF6: Router/Tally

ENG
SETUP

[ENG SETUP] button

to following pages
471Menu Tree



  A
ppendix (V

olum
e 1)

472
Table Assign (7323.3)

Engineering Setup

VF1: System

VF2: Panel

VF3: Switcher

VF4: DME

VF5: DCU

VF6: Router/Tally

HF1: Config (7321)

HF2: Xpt Assign (7322)

HF3: Aux Assign (7323)

HF4: Prefs/Utility (7324)

HF5: Device Interface (7325)

HF6: Operation (7326)

HF7: Maintenance (7327)

ENG
SETUP Link Table Adjust (7321.5)

Link Matrix Adjust (7321.4)

Link Bus Adjust (7321.6)

Mode Sel Assign (7321.21)

Eff Edit Assign (7321.22)

Macro Edit Assign (7321.23)

DSK Fader Assign (7321.1)

10 Key Region Assign (7321.7)

Link/Program Button (7321.8)

MP2 Main/Sub Assign (7321.11)

Compact Key Module Assign (7321.15)

M/E Operation Inhibit (7321.18)

Table Button Assign (7322.1)

Main,V/K Pair Assign (7322.5)

Src Name/LCD Color (7322.6)

Table Copy (7322.8)

Name Export (7322.9)

Side Flags Button Assign (7322.10)

Mixer Xpt Assign (7322.11)

RTR Mode Setting (7323.1)

Utility Module Assign (7324.1)

Key 2/4 Bus Button Assign (7324.2)

GPI Input (7325.1)

GPI Output (7325.3)

DCU Serial Port Assign (7325.4)

Effect Mode (7326.2)

Flexi Pad Mode (7326.3)

Custom Button (7326.4)

Sensitivity (7326.5)

Macro (7326.6)

Button Tally (7326.9)

Key Trans Link (7321.2)

External Bus Link (7321.3)

Transition Module (7321.9)

Flexi Pad Module (7321.10)

Xpt Module (7321.12)

Fade To Black Module (7321.13)

DSK/FTB Module (7321.14)

Device Control Module (7321.16)

Joystick/Trackball Module (7321.17)

Menu Panel (7321.19)

Multi Function (7321.20)a)

Extension Panel (7321.24)

Main, V/K Pair Assign (7322.5)

Src Name/LCD Color (7322.6)

Main,V/K Pair Assign (7322.5)

Source Table Assign (7323.2)

Level Button Assigh (7323.4)

H/L Set (7325.2)

CCP-6000/8000 Button (7326.7)

to following 
pages

to previous pages

a) For CCP-6224/6324 only
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HF1: Config (7331) 

HF2: Input (7332)

HF3: Output (7333)

HF4: Transition (7334)

HF5: Key/Wipe/FM/CCR (7335)

HF6: Link (7336) 

HF7: Device Interface (7337)

M/E Output Assign (7331.1)

PGM Config (7331.2)

K-PVW Config (7331.3)

User 1-8 Config (7331.4)

Logical M/E Assign (7331.5)

DME Config (7331.6)

Side Flags (7331.7)

Switching Timing (7331.8)

Video Process (7332.1)

FC Adjust (7332.2) a)

Output Assign (7333.1)

Video Clip (7333.2)

V Blank/Through (7333.3)

Safe Titile (7333.4)

4:3 Crop (7333.5)

FC Adjust (7333.6) a)

Simple P/P Re-Entry Assign (7333.8) a)

Preset Color Mix (7334.1)

Transition Curve (7334.2)

Show Key (7335.1)

Key Auto Drop (7335.2)

Internal Bus Link (7336.1)

GPI Link (7336.4)

M/E Link (7336.6)

Key Transition Link (7336.7)

Remote Assign (7337.1)

GPI Input (7337.2)

GPI Output (7337.4)

Aux Control (7337.5)

Editor I/F (7337.8)

Side Flags (3213)

Side Flags Button Assign (7322.10)

Link Bus Select (7336.2)

Link Table Select (7336.3)

GPI Link Adjust (7336.5)

H/L Set (7337.3)

Engineering Setup

VF1: System

VF2: Panel

VF3: Switcher

VF4: DME

VF5: DCU

VF6: Router/Tally

ENG
SETUP

to previous pages

[ENG SETUP] button

to next page

a) With the optional board installed only
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HF1: Input (7341)

HF3: Output (7343)

HF4: Device Interface (7344)

HF1: Input Config (7351)

HF2: GPI Input Assign (7352)

HF3: Output Config (7353)

HF4: GPI Output Assign (7354)

HF5: Serial Port Assign (7355)

HF1: Router (7361) 

HF2: Group Tally (7362) 

HF3: Wiring (7363)

HF4: Tally Enable (7364)

HF5: Tally Copy (7365)

HF6: Parallel Tally (7366)

HF7: Serial Tally (7367)

 TBC Center (7341.1)

Monitor Output (7343.1)

DME1 GPI Input (7344.1) 

DME2 GPI Input (7344.4)

DME2 GPI Output (7344.6)

H/L Set (7352.1)

 

P-Bus Setting (7355.1)

VTR Setting (7355.2)

DDR SD9P Setting (7355.3)

DDR VDCP Setting (7355.4)

Extended VTR Setting (7355.5)

External Box Assign (7361.1)

New (7363.1)

Modify (7363.2)

New (7364.1)

Modify (7364.2)

New (7365.1)

Modify (7365.2)

Set (7366.1)

Source Assign (7367.1)

H/L Set (7344.2)

H/L Set (7344.5)

Engineering Setup

VF1: System

VF2: Panel

VF3: Switcher

VF4: DME

VF5: DCU

VF6: Router/Tally

ENG
SETUP

to previous pages

[ENG SETUP] button
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Diagnostic Menu

Diagnostic

VF1: Error Info

VF3: System Info

HF1: Error Status (7411)

HF2: Error Log (7412)

LAN Status (7431)

DIAG [DIAG] button
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   Index
Index

A
Additive mix   207
Ancillary data   364, 375
Angle   274
Aspect ratio   276, 282
Audio mixer   143
Auto

chroma key adjustments   
210

transition   170
AUTO button   72
AUTO DELEG button   57
AUTO INS button   69
AUTO TRANS button   49, 51, 

96
Auto/manual transition 

combination   172
AUX

bus settings   406
delegation buttons   73
menu operations   406

AUX Panel-less Function   139
AUX/MON menu   460
Auxiliary bus control block

for AUX buses   72
for router control   75

B
Background

A/B row   44
changing   20
mask   202

Bank selection buttons   82
Basic menu operations   103
Blink

function   227
Border   199

parameters   234
BS button   123
Bus fixed mode

fader operation   173

wipe direction   175
Bus selection   136
Button

numbers   140, 141

C
Caps Lock button   123
CCP-6224

AUX Panel-less Function   
139

CCP-6224 2M/E Control 
Panel   96

CCP-6324
AUX Panel-less Function   

139
CCP-6324 3M/E Control 

Panel   97
CCR menu   461
Chroma key   198

adjustments   208
composition   207
window   209

Clean mode   198
Clear button   122, 124
Clip function   364
Clip transition   147

operations   378
Close button   122, 123
Color

combination   390, 391
matte settings   158
vector key   197

Color background
setting operations   390
settings menu   390

Color Bkgd menu   460
Color cancel   208

adjustments   211
Color corrector   413
Color data

copy   396
swap   396

Color mix   390, 391
for edge fill matte   270
for key fill   216

Color palette window   125
Control panel   37

configuration 1   37
configuration 2   40
configuration 3   42

Copy   394, 398
Copy/Swap menu   462
Cross-point

button numbers   44
buttons   43
control block   43

Cut   147
CUT button   49, 96

D
Dead zone   330
Default recall button   115
Del button   124
Delegation buttons   54
DEST button   73
Device

menu   464
DEVICE connectors   79
Device control block

joystick   62
search dial   63
trackball   58

Diagnostic menu   475
Digital multi effects   29
Direction   268, 280, 310
Display   56, 71
DME   29, 48, 50, 95

applying to a key   226, 
239

channel selection buttons   
56

menu   463
DME channel

copy   397
Index



  Index

swap   397

DME monitor   56, 71, 93
DME override   402
DME patterns

user programmable   326
DME wipe pattern   298

edge modification   310
groups   298
selection   308

DME wipe pattern list
for one-channel mode   445
for two-channel mode   

449
DME wipe settings   308

for independent key 
transitions   318

DME wipes   25, 297
copy   395, 396
direction   310
modifiers   310
modify clear   317
position   311, 319
resizer   322
snapshot   324
swap   395, 396

Door   446
Downstream key control block   

90
Drop border   200

parameters   235
Duration

setting buttons   68

E
Edge

fill   201
modifiers   199

EDIT ENBL button   67
Edit point specification 

buttons   67
Editing buttons   67
EFF LOOP button   69
Effect

menu   467
resizer   257

Effect execution direction 
selection buttons   68

Emboss   200
Engineering Setup menu   471
Enter button   122, 124
External

key   353
External devices   30
External hard disk drive   385

F
Fade to black   187

control block   71
transition rate   188

Fader lever   49, 91, 95
File menu   470
Files   33

deleting   383
renaming   384

Flexi Pad control block
simple type   83
standard type   51

Flip tumble   447
Frame

in-out   448, 453
Memory menu   459

Frame input mode   162
Frame memory

clip function   364
continuously capturing 

still images (record)   
359

pair file processing   381
recalling a continuous 

sequence of still images 
(animation)   361

Frame memory operations   
341

capturing an input image   
347

clip   366
input image selection   345
menu display   342
preparations   341
selecting frame memory   

346
selecting outputs   346

FTB button   71
Function

button area   114
selection buttons   70

G
Global

Effect menu   464

H
HF buttons   114

I
Image

data management   381
Image file

deletion   383
renaming   384

Independent key transition   
23, 177

DME wipe settings   318
simple transitions   192
type   182
type selection buttons   50, 

88, 90
wipe modifiers   280
wipe settings   279

Independent key transition 
control block

simple type   88
standard type   180

Independent key transition 
execution section   50, 89, 
91, 96

Independent key transition rate   
183

display   185
setting by a menu 

operation   185
setting in the Flexi Pad 

control block   183
setting in the numeric 

keypad control block   
184

Input
string   123
value   122

Item display   122, 123
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   Index
J
Joystick   62

K
Key   24

1/2 row   43
bus selection buttons   44
control block   54
default   203
delegation buttons   50, 90
deleting   21
edge modifications   216, 

234
Frame menu   466
inserting   21
mask   202
memory   202
modifier buttons   55
modifiers   199
modify clear   227
output status display   155, 

191
signal adjustments   211
status display   50, 87, 96

Key active   208
adjustment   210

KEY button   73
Key fill

selection   214
selection buttons   55

Key priority   151
display   155, 191
selecting   151
setting by a menu 

operation   153
setting in the transition 

control block   151
Key setting

using menus   204
Key snapshot   259

buttons   51, 91
recalling   260, 264
saving   259, 263
setting buttons   51, 91
using simple transition 

module   262
Key source

name display   51, 91
selection   214
selection buttons   55

Key transition
selection buttons   86

Key type
selection buttons   55
setting   205

Keyboard window   123
Keyer

copy   394
swap   394

Keyframe   30
control block   66
status   115

KF button   50
Knob   56, 78

parameter buttons   114
K-SS button   89

L
Left button   124
Level selection buttons   74
Line feed button   124
Linear key   197
Lock function   359
Luminance key   197

M
M/E

bank display   45
copy   394
swap   394

M/E-1 to M/E-3 menus   454
Macro   32

attachment   33
menu   465
timeline   32

Magnitude   275
Main mask

using   224, 238
Main menu site   127
Manual transition   171
Masks   201, 223, 238
Matte data

copy   396

swap   396
Max./min. value indication   

122
Memory

card slot   79
recall buttons   82

Memory card/USB adaptor 
block   79

“Memory Stick”/USB 
connections block   80

“Memory Sticks”   80
Menu

accessing   104, 112
control block   78
display   78
operations   115
organization   103
page number button   113
screen   113
shortcut menu   127
shutting down   125
switching between the 

main menu sites   127
title button   113
top menu list   103

MENU button   61
Menu tree   454
Minus button   122
Misc menu operations   401
MIX   48, 50, 95, 353
Mix   145
Mode selection buttons   52, 

69, 87
MORE button   56
Multi   277, 283
Multifunction Flexi Pad 

Control Block
DME Wipe Pattern 

Operations   331
Key Adjustment 

Operations   242
Wipe Pattern Operations   

290

N
NAM   48, 95, 145, 353
Next transition   145
Index



  Index

selecting   145
selection buttons   48, 94

Non-additive mix   48, 95, 145
Non-Sync state   172
Normal

edge   237
mix   207

Numeric display   53, 87
Numeric keypad   70

control block   69
window   122

O
ON AIR indicators   56
One-stroke mode   158
One-time mode   158
Operation

buttons   59
modes   340

Outline   200
parameters   236

Output
destination specification 

buttons   56
OVERRIDE button   56

P
Pair file processing   381
Pair mode   339
Parameter group button   114
Pattern key   353
Pattern limit   167

buttons   49, 86
setting by a menu 

operation   168
setting with the fader lever   

168
transition   169

PGM/PST
menu   457

Picture-in-picture   448, 450
Plane function   207
Positioner   273, 280, 311, 319
Preset color mix   146
Preview   175

selection buttons   71

Previous page button   114
PRIOR SET button   50, 96
PST COLOR MIX   48, 95

R
Reentry buttons   44, 136
Regions

selection buttons   70
Related manuals   17
Replication   283
Resizer DME wipe   322
Resizer DME wipe patterns   

452
Right button   124
Rotation   274, 282
RTR button   74

S
Search dial   63
Second (2ND) button   73
Selected

bus display   73
source name displays   73

Setup   34
Shadow   200

parameters   235
SHIFT button   45
Shift button   124
Shortcut   127
Shotbox   32
Shotbox menu   469
SHOW KEY button   56
Show key function   240
Side flags

DME wipe action   437
MISC menu   434
wipe action   436

Signal
assignment to buttons   139
name display   143
selection   135

Simple
transition   189

Simple P/P Software   439
Slide   445, 449, 452
Snapshot   31

menu   468
Soft edge   200, 280
Softening

edge   237
wipe pattern edge   280

Source
name displays   73

Space button   124
Speed   275
Split

fader   192
Squeeze   445, 449, 452
Status area   114
Status menu   407, 462
STOP NEXT KF button   68
Subsidiary menu site   127
SUPER MIX   48, 95
Super mix   146

settings   157
Swap   394, 398

T
TC button   122
Time offset execution   178
Timecode input mode   162
Top menu list   103
Top menu selection buttons   

78
Top menu window   124
TRACE button   57
TRANS PVW button   49, 96
Transition

execution   161
indicator   91
next   145
preview   175

Transition control block
simple type   83
standard type   47

Transition execution
section   49, 86, 95
with the fader lever   171

Transition indicator   49, 95
function   161

Transition rate   162
display   49, 95
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   Index
setting by a menu 
operation   166

setting in the Flexi Pad 
control block   163

setting in the MISC menu   
404

setting in the numeric 
keypad control block   
164

Transition type   145
selecting by a menu 

operation   156
selection buttons   48, 85, 

95
Trim button   122

U
UNDO button   53, 87
User preference button   78
User programmable DME   

449, 451
Notes on keyframe 

creation   327
patterns   326
transition mode   300, 326

UTIL button   45
Utility   32
Utility/shotbox control block   

82

V
V/K mode   340
VF buttons   114
Video

processing   133, 228
signal adjustment   210

Video process   410
memory   411
settings   412

W
Window adjustment   209, 212
WIPE   48, 50, 95
Wipe   25, 146

copy   395
modify clear   278

pattern list   444
swap   395

Wipe direction   268, 280
selection buttons   49, 86, 

96
Wipe modifiers   268
Wipe pattern

aspect ratio   276, 282
edge modification   269
replication   277, 283
rotation   274
selection   267

Wipe position   273, 280
Wipe settings   267

for independent key 
transitions   279

Wipe snapshot   284
deleting   287
recalling   286
saving   286

X
XPT HOLD

buttons   44, 73
status display   87

Y
Y balance   209

adjustment   213

Z
Zabton   200, 222, 237
Z-ring   60
Index
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